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CHAPTER 1

Préambule

This document is the original user guide of the described software QGIS. The software and hardware described
in this document are in most cases registered trademarks and are therefore subject to legal requirements. QGIS is
subject to the GNU General Public License. Find more information on the QGIS homepage, http://www.qgis.org.

Les détails, données et résultats inclus dans ce document ont été écrits et vérifiés au mieux des connaissances des
auteurs et des éditeurs. Néanmoins, il est possible que des erreurs subsistent.

Ainsi l’ensemble des données ne saurait faire l’objet d’une garantie. Les auteurs et les éditeurs ne sauraient être
responsables de tout dommage direct, indirect, secondaire ou accessoire découlant de l’utilisation de ce manuel.
Les éventuelles corrections sont toujours les bienvenues.

This document has been typeset with reStructuredText. It is available as reST source code via github and online
as HTML and PDF via http://www.qgis.org/en/docs/. Translated versions of this document can be downloaded in
several formats via the documentation area of the QGIS project as well. For more information about contributing
to this document and about translating it, please visit http://www.qgis.org/wiki/.

Références de ce document

Ce document contient des références internes et externes sous forme de lien. Cliquer sur un lien interne provoque
un déplacement dans le document, tandis que cliquer sur un lien externe ouvrira une adresse internet dans le
navigateur choisi par défaut. Dans le PDF, les liens internes et externes sont indiqués en bleu et sont gérés par le
navigateur du logiciel. En HTML, le navigateur affiche et gère les deux types de liens de la même façon.

Auteurs et éditeurs :
Tara Athan Radim Blazek Godofredo Contreras Otto Dassau Martin Dobias
Peter Ersts Anne Ghisla Stephan Holl N. Horning Magnus Homann
Werner Macho Carson J.Q. Farmer Tyler Mitchell K. Koy Lars Luthman
Claudia A. Engel Brendan Morely David Willis Jürgen E. Fischer Marco Hugentobler
Larissa Junek Diethard Jansen Paolo Corti Gavin Macaulay Gary E. Sherman
Tim Sutton Alex Bruy Raymond Nijssen Richard Duivenvoorde Andreas Neumann
Astrid Emde Yves Jacolin Alexandre Neto Andy Schmid Hien Tran-Quang

Copyright (c) 2004 - 2014 QGIS Development Team

Internet : http://www.qgis.org

Licence de ce document

La permission de copier, distribuer, modifier ce document est accordée sous les termes de la GNU Free Docu-
mentation License, dans sa version 1.3 ou plus récente telle que publiée par la Free Software Foundation; sans
modification de son contenu, sans ajouts la précédant ou la suivant. Une copie de la licence est incluse dans la
section Licence GNU de documentation libre.

.
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CHAPTER 2

Conventions

Cette section décrit les styles utilisés uniformément dans ce manuel.

2.1 Conventions pour les éléments d’interface

Les conventions de styles de l’interface (GUI) dans le texte ressemblent autant que possible à l’apparence du
logiciel. En général, le style reflètera l’apparence des éléments lorsque la souris ne passe pas dessus, l’objectif
étant de permettre à l’utilisateur de repérer plus facilement les éléments mentionnés dans les instructions.

• Options du menu : Couches → Ajouter une couche raster ou Préférences → Barre d’outils → Numérisation

• Tool: Add a Raster Layer

• Bouton : [Sauvegarder par défaut]

• Titre de boîte de dialogue : Propriétés de la couche

• Onglet : Général

• Case à cocher : Rendu

• Radio Button: Postgis SRID EPSG ID

• Select a number:

• Select a string:

• Browse for a file:

• Select a color:

• Barre coulissante :

• Input Text:

Une ombre indique un élément de l’interface qui peut être cliqué.

2.2 Text or Keyboard Conventions

This manual also includes styles related to text, keyboard commands and coding to indicate different entities, such
as classes or methods. These styles do not correspond to the actual appearance of any text or coding within QGIS.

• Liens hypertexte : http://qgis.org

• Combinaisons de touches : appuyez sur Ctrl+B, signifie qu’il faut rester en appui sur la touche Contrôle
(Ctrl) tout en pressant la touche B.

5
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• Nom d’un fichier : lakes.shp

• Nom d’une classe : NewLayer

• Méthode : classFactory

• Serveur : myhost.de

• Texte pour l’utilisateur : qgis --help

Les lignes de code sont indiquées comme suit :

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

2.3 Instructions spécifiques à un système d’exploitation

GUI sequences and small amounts of text may be formatted inline: Click File QGIS → Quit to close
QGIS. This indicates that on Linux, Unix and Windows platforms, you should click the File menu first, then Quit,
while on Macintosh OS X platforms, you should click the QGIS menu first, then Quit.

Les textes plus longs seront formatés comme des listes :

• Faites ceci

• Faites cela

• Faites autre chose

ou comme des paragraphes :

Faites ceci et cela. Puis cela et ceci pour obtenir ça, etc.

Faites ceci et cela. Puis cela et ceci pour obtenir ça, etc.

Les copies d’écrans ont été prises sous différentes plateformes, un icône à la fin de la légende de la figure indique
le système en question.

.
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CHAPTER 3

Avant-propos

Bienvenue dans le monde merveilleux des Systèmes d’Informations Géographiques (SIG) !

QGIS is an Open Source Geographic Information System. The project was born in May of 2002 and was estab-
lished as a project on SourceForge in June of the same year. We’ve worked hard to make GIS software (which
is traditionally expensive proprietary software) a viable prospect for anyone with basic access to a personal com-
puter. QGIS currently runs on most Unix platforms, Windows, and OS X. QGIS is developed using the Qt toolkit
(http://qt.digia.com) and C++. This means that QGIS feels snappy and has a pleasing, easy-to-use graphical user
interface (GUI).

QGIS aims to be a user-friendly GIS, providing common functions and features. The initial goal of the project
was to provide a GIS data viewer. QGIS has reached the point in its evolution where it is being used by many for
their daily GIS data-viewing needs. QGIS supports a number of raster and vector data formats, with new format
support easily added using the plugin architecture.

QGIS is released under the GNU General Public License (GPL). Developing QGIS under this license means that
you can inspect and modify the source code, and guarantees that you, our happy user, will always have access to
a GIS program that is free of cost and can be freely modified. You should have received a full copy of the license
with your copy of QGIS, and you also can find it in Appendix licence GNU General Public License.

Astuce: Documentation à jour
The latest version of this document can always be found in the documentation area of the QGIS website at
http://www.qgis.org/en/docs/.

.
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CHAPTER 4

Fonctionnalités

QGIS offers many common GIS functionalities provided by core features and plugins. A short summary of six
general categories of features and plugins is presented below, followed by first insights into the integrated Python
console.

4.1 Visualiser des données

Vous pouvez afficher et superposer des couches de données rasters et vecteurs dans différents formats et projections
sans avoir à faire de conversion dans un format commun. Les formats supportés incluent :

• Les tables spatiales et les vues PostGIS, SpatiaLite, MS SQL Spatial et Oracle Spatial, les formats vecteurs
supportés par la bibliothèque OGR installée, ce qui inclut les shapefiles ESRI, MapInfo, SDTS, GML et
beaucoup d’autres. voir Les données vectorielles.

• Les formats raster supportés par la bibliothèque GDAL (Geospatial Data Abstraction Library) tels que
GeoTIFF, ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG et beaucoup d’autres, voir section Les données
raster.

• Les formats raster et vecteur provenant des bases de données GRASS. Voir section Intégration du SIG
GRASS.

• Les données spatiales en ligne diffusées comme services web de l’OGC qui incluent le WMS, WMTS,
WCS, WFS et WFS-T. Voir la section Les données OGC.

4.2 Parcourir les données et créer des cartes

Vous pouvez créer des cartes et les parcourir de manière interactive avec une interface intuitive. Les outils
disponibles dans l’interface sont :

• QGIS browser

• La reprojection à la volée

• DB Manager

• La composition de carte

• Le panneau d’aperçu

• Les signets géospatiaux

• Les outils d’annotation

• L’identification et la sélection des entités

• L’affichage, l’édition et la recherche de données attributaires

• Data-defined feature labeling
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• Les outils de style définis par les données vecteur et raster

• Création d’atlas avec des couches de carroyage

• La flèche indiquant le nord, la barre d’échelle et l’étiquette de droits d’auteur

• Gestion de la sauvegarde et de la restauration des projets

4.3 Créer, éditer, gérer et exporter des données

You can create, edit, manage and export vector and raster layers in several formats. QGIS offers the following:

• Numérisation pour les formats gérés par OGR et les couches vectorielles de GRASS

• Création et édition des shapefiles et des couches vectorielles de GRASS

• Extension de géoréférencement pour géoréférencer des images

• Outils GPS pour importer et exporter des données GPX et convertir d’autres formats GPS vers le GPX ou
l’envoi, la réception directement vers une unité GPS (pour Linux, le port USB a été ajouté à la liste des ports
utilisables).

• Visualisation et édition des données OpenStreetMap

• Création de tables de base de données à partir de shapefiles avec l’extension DB Manager

• Amélioration de la gestion des tables spatiales issues de bases de données

• Outils pour la gestion des tables d’attributs des couches vectorielles

• Possibilité d’enregistrer des captures d’écran en tant qu’images géoréférencées

• Outil Export-DXF avec capacités améliorées pour exporter les styles et des extensions fournissant des fonc-
tions similaires à celle d’une CAO.

4.4 Analyse data

You can perform spatial data analysis on spatial databases and other OGR- supported formats. QGIS currently of-
fers vector analysis, sampling, geoprocessing, geometry and database management tools. You can also use the in-
tegrated GRASS tools, which include the complete GRASS functionality of more than 400 modules. (See section
Intégration du SIG GRASS.) Or, you can work with the Processing Plugin, which provides a powerful geospatial
analysis framework to call native and third-party algorithms from QGIS, such as GDAL, SAGA, GRASS, fTools
and more. (See section Introduction.)

4.5 Publier des cartes sur Internet

QGIS can be used as a WMS, WMTS, WMS-C or WFS and WFS-T client, and as a WMS, WCS or WFS server.
(See section Les données OGC.) Additionally, you can publish your data on the Internet using a webserver with
UMN MapServer or GeoServer installed.

4.6 Extend QGIS functionality through plugins

QGIS can be adapted to your special needs with the extensible plugin architecture and libraries that can be used
to create plugins. You can even create new applications with C++ or Python!
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4.6.1 Extensions principales

Les extensions principales sont :

1. Saisie de coordonnées (Enregistrer les coordonnées du pointeur de la souris dans un SCR différent)

2. DB Manager (Exchange, edit and view layers and tables; execute SQL queries)

3. Convertisseur Dxf2Shp (Convertir des fichiers DXF en shapefiles)

4. eVIS (Visualiser des événements)

5. fTools (Analyser et gérer des données vectorielles)

6. GDALTools (Integrate GDAL Tools into QGIS)

7. Géoréférenceur GDAL (Ajouter une projection à un raster via GDAL)

8. Outils GPS (Importer et exporter des données GPS)

9. GRASS (Intégration du SIG GRASS)

10. Carte de chaleur (Générer des cartes de chaleur raster à partir de données ponctuelles)

11. Extension d’interpolation (Interpoler une surface en utilisant une couche vectorielle de points)

12. Client MetaSearch pour les Services de Catalogage

13. Édition hors connexion (Éditer hors connexion et synchroniser avec une base de données)

14. GeoRaster d’Oracle Spatial

15. Traitements (anciennement SEXTANTE)

16. Analyse de terrain raster (Analyser des rasters de données d’élévation)

17. Extension de Graphe routier (Analyser le chemin le plus court sur un réseau)

18. Extension de requête spatiale

19. SPIT (Import shapefiles to PostgreSQL/PostGIS)

20. Vérificateur de topologie (Chercher des erreurs de topologie dans les couches vectorielles)

21. Extension de statistiques zonales (Calculer le nombre, la somme et la moyenne d’un raster pour chaque
entité d’une couche de polygones)

4.6.2 Extensions Python externes

QGIS offers a growing number of external Python plugins that are provided by the community. These plugins
reside in the official Plugins Repository and can be easily installed using the Python Plugin Installer. See Section
La fenêtre des Extensions.

4.7 Console Python

For scripting, it is possible to take advantage of an integrated Python console, which can be opened from menu:
Plugins → Python Console. The console opens as a non-modal utility window. For interaction with the QGIS en-
vironment, there is the qgis.utils.iface variable, which is an instance of QgsInterface. This interface
allows access to the map canvas, menus, toolbars and other parts of the QGIS application. You can create a script,
then drag and drop it into the QGIS window and it will be executed automatically.

For further information about working with the Python console and programming QGIS plugins and applications,
please refer to PyQGIS-Developer-Cookbook.
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4.8 Problèmes connus

4.8.1 Limite du nombre de fichiers ouverts

Si vous ouvrez un gros projet QGIS et êtes sûrs que toutes les couches sont valides, mais que certaines sont
signalées comme mauvaises, vous faites probablement face à ce problème. Linux (et d’autres OSs, d’ailleurs) a
une limite de fichiers ouverts par processus. Les limites de ressource sont par processus et héritées. La commande
ulimit, qui est intégrée dans l’interpréteur de commandes, change les limites seulement pour le processus en
cours de l’interpréteur; la nouvelle limite sera héritée par n’importe quel processus enfant.

Vous pouvez voir toutes les infos ulimit en cours en tapant

user@host:~$ ulimit -aS

You can see the current allowed number of opened files per proccess with the following command on a console

user@host:~$ ulimit -Sn

Pour modifier les limites d’une session existante, vous devriez pouvoir utiliser quelque chose comme ceci

user@host:~$ ulimit -Sn #number_of_allowed_open_files
user@host:~$ ulimit -Sn
user@host:~$ qgis

Pour le régler définitivement

Sur la plupart des systèmes Linux, les limites des ressources sont définies à la connexion par le module
pam_limits conformément aux paramètres contenus dans le fichier /etc/security/limits.conf ou
/etc/security/limits.d/*.conf. Vous devriez pouvoir éditer ces fichiers si vous avez le droit root
(aussi possible via sudo), mais il vous faudra vous reconnecter avant que ces modifications ne prennent effet.

Plus d’infos :

http://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/ http://linuxaria.com/article/open-
files-in-linux?lang=en

.

12 Chapter 4. Fonctionnalités

http://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/
http://linuxaria.com/article/open-files-in-linux?lang=en
http://linuxaria.com/article/open-files-in-linux?lang=en


CHAPTER 5

What’s new in QGIS 2.8

Cette version contient de nouvelles fonctionnalités et étend l’interface de programmation par rapport aux anciennes
versions. Nous recommandons d’utiliser cette version préférentiellement aux précédentes.

This release includes hundreds of bug fixes and many new features and enhancements
that will be described in this manual. You may also review the visual changelog at
http://qgis.org/en/site/forusers/visualchangelog28/index.html.

5.1 Application

• Map rotation: A map rotation can be set in degrees from the status bar

• Bookmarks: You can share and transfer your bookmarks

• Expressions:

– when editing attributes in the attribute table or forms, you can now enter expressions directly into spin
boxes

– the expression widget is extended to include a function editor where you are able to create your own
Python custom functions in a comfortable way

– in any spinbox of the style menu you can enter expressions and evaluate them immediately

– a get and transform geometry function was added for using expressions

– a comment functionality was inserted if for example you want to work with data defined labeling

• Joins: You can specify a custom prefix for joins

• Layer Legend: Show rule-based renderer’s legend as a tree

• DB Manager: Run only the selected part of a SQL query

• Attribute Table: support for calculations on selected rows through a ‘Update Selected’ button

• Measure Tools: change measurement units possible

5.2 Data Providers

• DXF Export tool improvements: Improved marker symbol export

• WMS Layers: Support for contextual WMS legend graphics

• Temporary Scratch Layers: It is possible to create empty editable memory layers
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5.3 Digitizing

• Advanced Digitizing:

– digitise lines exactly parallel or at right angles, lock lines to specific angles and so on with the advanced
digitizing panel (CAD-like features)

– simplify tool: specify with exact tolerance, simplify multiple features at once ...

• Snapping Options: new snapping mode ‘Snap to all layers’

5.4 Map Composer

• Composer GUI improvements: hide bounding boxes, full screen mode for composer toggle display of
panels

• Grid improvements: You now have finer control of frame and annotation display

• Label item margins: You can now control both horizontal and vertical margins for label items. You can
now specify negative margins for label items.

• optionally store layer styles

• Attribute Table Item: options ‘Current atlas feature’ and ‘Relation children’ in Main properties

5.5 Plugins

• Python Console: You can now drag and drop python scripts into the QGIS window

5.6 QGIS Server

• Python plugin support

5.7 Symbology

• live heatmap renderer creates dynamic heatmaps from point layers

• raster image symbol fill type

• more data-defined symbology settings: the data-defined option was moved next to each data definable
property

• support for multiple styles per map layer, optionally store layer styles

5.8 User Interface

• Projection: Improved/consistent projection selection. All dialogs now use a consistent projection selection
widget, which allows for quickly selecting from recently used and standard project/QGIS projections

.
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CHAPTER 6

Premiers Pas

This chapter gives a quick overview of installing QGIS, some sample data from the QGIS web page, and running
a first and simple session visualizing raster and vector layers.

6.1 Installation

Installation of QGIS is very simple. Standard installer packages are available for MS Windows and Mac OS X. For
many flavors of GNU/Linux, binary packages (rpm and deb) or software repositories are provided to add to your in-
stallation manager. Get the latest information on binary packages at the QGIS website at http://download.qgis.org.

6.1.1 Installation à partir des sources

If you need to build QGIS from source, please refer to the installation instructions. They are dis-
tributed with the QGIS source code in a file called INSTALL. You can also find them online at
http://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html

6.1.2 Installation sur un support amovible

QGIS allows you to define a --configpath option that overrides the default path for user configuration (e.g.,
~/.qgis2 under Linux) and forces QSettings to use this directory, too. This allows you to, for instance, carry a
QGIS installation on a flash drive together with all plugins and settings. See section Menu Système for additional
information.

6.2 Échantillon de données

The user guide contains examples based on the QGIS sample dataset.

The Windows installer has an option to download the QGIS sample dataset. If checked, the data will be down-
loaded to your My Documents folder and placed in a folder called GIS Database. You may use Windows
Explorer to move this folder to any convenient location. If you did not select the checkbox to install the sample
dataset during the initial QGIS installation, you may do one of the following:

• Utiliser des données que vous possédez déjà.

• Télécharger des données exemples sur http://qgis.org/downloads/data/qgis_sample_data.zip

• Uninstall QGIS and reinstall with the data download option checked (only recommended if the above solu-
tions are unsuccessful)

For GNU/Linux and Mac OS X, there are not yet dataset installation packages available as rpm,
deb or dmg. To use the sample dataset, download the file qgis_sample_data as a ZIP archive from
http://qgis.org/downloads/data and unzip the archive on your system.
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The Alaska dataset includes all GIS data that are used for examples and screenshots in the user guide; it also
includes a small GRASS database. The projection for the QGIS sample dataset is Alaska Albers Equal Area with
units feet. The EPSG code is 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

If you intend to use QGIS as a graphical front end for GRASS, you can find a selection of sample locations (e.g.,
Spearfish or South Dakota) at the official GRASS GIS website, http://grass.osgeo.org/download/sample-data/.

6.3 Sample Session

Now that you have QGIS installed and a sample dataset available, we would like to demonstrate a short
and simple QGIS sample session. We will visualize a raster and a vector layer. We will use the
landcover raster layer, qgis_sample_data/raster/landcover.img, and the lakes vector layer,
qgis_sample_data/gml/lakes.gml.

6.3.1 Start QGIS

• Start QGIS by typing “QGIS” at a command prompt, or if using a precompiled binary, by using the
Applications menu.

• Start QGIS using the Start menu or desktop shortcut, or double click on a QGIS project file.

• Double click the icon in your Applications folder.

6.3.2 Load raster and vector layers from the sample dataset

1. Click on the Add Raster Layer icon.

2. Parcourez le dossier qgis_sample_data/raster/, sélectionnez le fichier ERDAS IMG
landcover.img et cliquez sur [Ouvrir].

3. If the file is not listed, check if the Files of type combo box at the bottom of the dialog is set on the
right type, in this case “Erdas Imagine Images (*.img, *.IMG)”.

4. Now click on the Add Vector Layer icon.

5. File should be selected as Source Type in the new Add vector layer dialog. Now click [Browse] to select
the vector layer.
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6. Browse to the folder qgis_sample_data/gml/, select ‘Geography Markup Language [GML] [OGR]

(.gml,.GML)’ from the Filter combo box, then select the GML file lakes.gml and click [Open].
In the Add vector layer dialog, click [OK]. The Coordinate Reference System Selector dialog opens with
NAD27 / Alaska Alberts selected, click [OK].

7. Zoom in a bit to your favorite area with some lakes.

8. Double-cliquez sur la couche lakes dans la liste des couches pour ouvrir la fenêtre Propriétés des couches.

9. Cliquez sur l’onglet Style et sélectionnez le bleu comme couleur de remplissage.

10. Click on the Labels tab and check the Label this layer with checkbox to enable labeling. Choose the
“NAMES” field as the field containing labels.

11. To improve readability of labels, you can add a white buffer around them by clicking “Buffer” in the list on

the left, checking Draw text buffer and choosing 3 as buffer size.

12. Cliquez sur [Appliquez]. Vérifiez si le résultat est satisfaisant et enfin cliquez sur [OK].

You can see how easy it is to visualize raster and vector layers in QGIS. Let’s move on to the sections that follow
to learn more about the available functionality, features and settings, and how to use them.

6.4 Starting and Stopping QGIS

In section Sample Session you already learned how to start QGIS. We will repeat this here, and you will see that
QGIS also provides further command line options.

• Assuming that QGIS is installed in the PATH, you can start QGIS by typing qgis at a command prompt
or by double clicking on the QGIS application link (or shortcut) on the desktop or in the Applications menu.

• Start QGIS using the Start menu or desktop shortcut, or double click on a QGIS project file.

• Double click the icon in your Applications folder. If you need to start QGIS in a shell, run
/path-to-installation-executable/Contents/MacOS/Qgis.

To stop QGIS, click the menu option File QGIS → Quit, or use the shortcut Ctrl+Q.

6.5 Options de ligne de commande

QGIS supports a number of options when started from the command line. To get a list of the options, enter
qgis --help on the command line. The usage statement for QGIS is:

qgis --help
QGIS - 2.6.0-Brighton ’Brighton’ (exported)
QGIS is a user friendly Open Source Geographic Information System.
Usage: /usr/bin/qgis.bin [OPTION] [FILE]
OPTION:

[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--customizationfile] use the given ini file as GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--code path] run the given python file on load
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[--defaultui] start by resetting user ui settings to default
[--help] this text

FILE:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Astuce: Exemple utilisant des options de ligne de commande
You can start QGIS by specifying one or more data files on the command line. For example, assuming you are
in the qgis_sample_data directory, you could start QGIS with a vector layer and a raster file set to load on
startup using the following command: qgis ./raster/landcover.img ./gml/lakes.gml

Option de ligne de commande --snapshot

Cette option permet de créer une capture d’écran de l’affichage courant au format PNG. C’est pratique quand vous
avez une longue série de projets et que vous voulez générer un aperçu de vos données.

L’image est créée au format PNG et fait 800x600 pixels. Cette commande peut être adaptée en utilisant les
arguments --width pour la largeur et --height pour la hauteur. Un nom de fichier peut être ajouté après
--snapshot.

Option de ligne de commande --lang

Based on your locale, QGIS selects the correct localization. If you would like to change your language, you can
specify a language code. For example, --lang=it starts QGIS in italian localization.

Option de ligne de commande --project

Starting QGIS with an existing project file is also possible. Just add the command line option --project
followed by your project name and QGIS will open with all layers in the given file loaded.

Option de ligne de commande --extent

Pour démarrer avec une étendue cartographique spécifique, utilisez cette option. Vous devez ajouter les limites de
votre étendue dans l’ordre suivant en les séparant par une virgule :

--extent xmin,ymin,xmax,ymax

Option de ligne de commande --nologo

This command line argument hides the splash screen when you start QGIS.

Option de ligne de commande --noplugins

Si vous avez un problème au démarrage lié à une extension, cette option permet de lancer QGIS sans les charger.
Elles seront toujours accessibles dans le Gestionnaire d’extension.

Option en ligne de commande --customizationfile

Utiliser cette commande vous permettra de définir un fichier de personnalisation de l’interface dès le démarrage.

Option de ligne de commande --nocustomization

Utiliser cette commande empêchera la personnalisation de l’interface au démarrage.

Option de ligne de commande --optionspath

You can have multiple configurations and decide which one to use when starting QGIS with this option. See
Options to confirm where the operating system saves the settings files. Presently, there is no way to specify a file
to write settings to; therefore, you can create a copy of the original settings file and rename it. The option specifies
path to directory with settings. For example, to use /path/to/config/QGIS/QGIS2.ini settings file, use option:
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--optionspath /path/to/config/

Option de ligne de commande --configpath

This option is similar to the one above, but furthermore overrides the default path for user configuration
(~/.qgis2) and forces QSettings to use this directory, too. This allows users to, for instance, carry a QGIS
installation on a flash drive together with all plugins and settings.

Option en ligne de commande --code

This option can be used to run a given python file directly after QGIS has started.

Par exemple si vous avez un fichier python nommé load_alaska.py et avec le contenu suivant :

from qgis.utils import iface
raster_file = "/home/gisadmin/Documents/qgis_sample_data/raster/landcover.img"
layer_name = "Alaska"
iface.addRasterLayer(raster_file, layer_name)

Assuming you are in the directory where the file load_alaska.py is located, you can start QGIS, load the
raster file landcover.img and give the layer the name ‘Alaska’ using the following command: qgis --code
load_alaska.py

6.6 Les projets

The state of your QGIS session is considered a project. QGIS works on one project at a time. Settings are
considered as being either per-project or as a default for new projects (see section Options). QGIS can save the

state of your workspace into a project file using the menu options Project → Save or Project → Save
As....

Load saved projects into a QGIS session using Project → Open..., Project → New from template or Project
→ Open Recent →.

If you wish to clear your session and start fresh, choose Project → New. Either of these menu options will
prompt you to save the existing project if changes have been made since it was opened or last saved.

Les types d’informations enregistrées dans un projet sont :

• les couches ajoutées,

• les couches qui peuvent être interrogées,

• les propriétés des couches comprenant notamment les symboles associés et leur style,

• la projection de la carte,

• l’étendue de la dernière zone de visualisation,

• les compositions d’impression,

• les éléments des compositions d’impression ainsi que leurs paramètres,

• les paramètres des atlas parmi les compositions d’impression,

• les paramètres d’édition,

• les relations de tables,

• les macros du projet,

• les styles par défaut du projet,

• les paramètres des extensions,

• les paramètres de QGIS Server définis dans l’onglet Serveur OWS des propriétés du projet,

• les requêtes stockées dans le Gestionnaire de base de données.
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The project file is saved in XML format, so it is possible to edit the file outside QGIS if you know what you are
doing. The file format has been updated several times compared with earlier QGIS versions. Project files from
older QGIS versions may not work properly anymore. To be made aware of this, in the General tab under Settings
→ Options you can select:

• Prompt to save project and data source changes when required

• Warn when opening a project file saved with an older version of QGIS

Whenever you save a project in QGIS a backup of the project file is made with the extension ~.

6.7 Sortie graphique

There are several ways to generate output from your QGIS session. We have discussed one already in section Les
projets, saving as a project file. Here is a sampling of other ways to produce output files:

• Menu option Project → Save as Image opens a file dialog where you select the name, path and type of
image (PNG,JPG and many other formats). A world file with extension PNGW or JPGW saved in the same
folder georeferences the image.

• Menu option Project → DXF Export ... opens a dialog where you can define the ‘Symbology mode’, the
‘Symbology scale’ and vector layers you want to export to DXF. Through the ‘Symbology mode’ symbols
from the original QGIS Symbology can be exported with high fidelity.

• Menu option Project → New Print Composer opens a dialog where you can layout and print the current
map canvas (see section Composeur d’Impression).

.
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CHAPTER 7

QGIS GUI

When QGIS starts, you are presented with the GUI as shown in the figure (the numbers 1 through 5 in yellow
circles are discussed below).

Figure 7.1: QGIS GUI with Alaska sample data

Note: Le style des fenêtres peut apparaître différemment en fonction de votre système d’exploitation et de votre
gestionnaire de fenêtres.

The QGIS GUI is divided into five areas:

1. Barre de Menu

2. Tool Bar

3. Map Legend

4. Affichage de la carte

5. Barre d’état

These five components of the QGIS interface are described in more detail in the following sections. Two more
sections present keyboard shortcuts and context help.
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7.1 Barre de Menu

The menu bar provides access to various QGIS features using a standard hierarchical menu. The top-level menus
and a summary of some of the menu options are listed below, together with the associated icons as they appear on
the toolbar, and keyboard shortcuts. The shortcuts presented in this section are the defaults; however, keyboard
shortcuts can also be configured manually using the Configure shortcuts dialog, opened from Settings → Configure
Shortcuts....

Bien que les options de menu aient des outils qui leur correspondent et vice-versa, les menus ne sont pas organisés
comme les barres d’outils. La barre contenant l’outil est affichée sous chaque option de menu en tant que case
à cocher. Certaines entrées n’apparaissent que lorsque les extensions correspondantes sont activées. Pour plus
d’informations sur les outils et les barres d’outils, veuillez lire la section Barre d’outils.

7.1.1 Projet

Barre de Menu Raccourci Référence Barre d’outils

New Ctrl+N voir Les projets Projet

Open Ctrl+O voir Les projets Projet
Nouveau depuis un modèle → voir Les projets Projet
Open Recent → voir Les projets

Save Ctrl+S voir Les projets Projet

Save As... Ctrl+Shift+S voir Les projets Projet

Save as Image... voir Sortie graphique
DXF Export ... voir Sortie graphique

New Print Composer Ctrl+P voir Composeur d’Impression Projet

Composer manager ... voir Composeur d’Impression Projet
Composeurs d’impression → voir Composeur d’Impression

Exit QGIS Ctrl+Q
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7.1.2 Éditer

Barre de Menu Raccourci Référence Barre d’outils

Undo Ctrl+Z voir Numérisation avancée Numérisation
avancée

Redo Ctrl+Shift+Z voir Numérisation avancée Numérisation
avancée

Cut Features Ctrl+X voir Numériser une couche
existante

Numérisation

Copy Features Ctrl+C voir Numériser une couche
existante

Numérisation

Paste Features Ctrl+V voir Numériser une couche
existante

Numérisation

Coller les entités comme → voir Working with the Attribute
Table

Add Feature Ctrl+. voir Numériser une couche
existante

Numérisation

Move Feature(s) voir Numériser une couche
existante

Numérisation

Delete Selected voir Numériser une couche
existante

Numérisation

Rotate Feature(s) voir Numérisation avancée Numérisation
avancée

Simplify Feature voir Numérisation avancée Numérisation
avancée

Add Ring voir Numérisation avancée Numérisation
avancée

Add Part voir Numérisation avancée Numérisation
avancée

Fill Ring voir Numérisation avancée Numérisation
avancée

Delete Ring voir Numérisation avancée Numérisation
avancée

Delete Part voir Numérisation avancée Numérisation
avancée

Reshape Features voir Numérisation avancée Numérisation
avancée

Offset Curve voir Numérisation avancée Numérisation
avancée

Split Features voir Numérisation avancée Numérisation
avancée

Split Parts voir Numérisation avancée Numérisation
avancée

Merge Selected Features voir Numérisation avancée Numérisation
avancée

Merge Attr. of Selected
Features

voir Numérisation avancée Numérisation
avancée

Node Tool voir Numériser une couche
existante

Numérisation

Rotate Point Symbols voir Numérisation avancée Numérisation
avancée

24 Chapter 7. QGIS GUI



QGIS User Guide, Version 2.8

After activating Toggle editing mode for a layer, you will find the Add Feature icon in the Edit menu depend-
ing on the layer type (point, line or polygon).

7.1.3 Éditer (selon le type de couche)

Barre de Menu Raccourci Référence Barre d’outils

Add Feature voir Numériser une couche existante Numérisation

Add Feature voir Numériser une couche existante Numérisation

Add Feature voir Numériser une couche existante Numérisation

7.1.4 Affichage de la carte

Barre de Menu Raccourci Référence Barre d’outils

Pan Map Navigateur de carte

Pan Map to Selection Navigateur de carte

Zoom In Ctrl++ Navigateur de carte

Zoom Out Ctrl+- Navigateur de carte
Sélection → voir Sélectionner et désélectionner des entités Attributs

Identify Features Ctrl+Shift+I Attributs
Mesure → voir Mesurer Attributs

Zoom Full Ctrl+Shift+F Navigateur de carte

Zoom To Layer Navigateur de carte

Zoom To Selection Ctrl+J Navigateur de carte

Zoom Last Navigateur de carte

Zoom Next Navigateur de carte

Zoom Actual Size Navigateur de carte
Décorations → voir Décorations
Mode d’affichage →

Map Tips Attributs

New Bookmark Ctrl+B voir Signets spatiaux Attributs

Show Bookmarks Ctrl+Shift+B voir Signets spatiaux Attributs

Refresh F5 Navigateur de carte
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7.1.5 Couche

Barre de Menu Raccourci Référence Barre d’outils
Créer une couche → voir Créer de nouvelles couches vecteur Contrôle des couches
Ajouter une couche → Contrôle des couches
Embed Layers and Groups ... voir Inclusion de projets
Add from Layer Definition File ...

Copy style see Onglet Style

Paste style see Onglet Style

Open Attribute Table voir Working with the Attribute Table Attributs

Toggle Editing voir Numériser une couche existante Numérisation

Save Layer Edits voir Numériser une couche existante Numérisation

Current Edits → voir Numériser une couche existante Numérisation
Save as...
Save as layer definition file...

Remove Layer/Group Ctrl+D

Duplicate Layers (s)
Définir l’échelle de visibilité
Set CRS of Layer(s) Ctrl+Shift+C
Set project CRS from Layer
Properties ...
Query...

Labeling

Add to Overview Ctrl+Shift+O Contrôle des couches

Add All To Overview

Remove All From Overview

Show All Layers Ctrl+Shift+U Contrôle des couches

Hide All Layers Ctrl+Shift+H Contrôle des couches

Show selected Layers

Hide selected Layers
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7.1.6 Préférences

Barre de Menu Raccourci Référence Barre
d’outils

Panneaux → voir Panels and Toolbars
Barres d’outils → voir Panels and Toolbars
Toggle Full Screen
Mode

F 11

Project Properties
...

Ctrl+Shift+P voir Les projets

Custom CRS ... voir Système de Coordonnées de Référence
personnalisé

Gestionnaire de
symboles...

voir Presentation

Configure shortcuts
...

Customization ... voir Personnalisation
Options ... voir Options

Snapping Options ...

7.1.7 Extensions

Barre de Menu Raccourci Référence Barre d’outils

Manage and Install Plugins ... voir La fenêtre des Extensions
Python Console Ctrl+Alt+P

When starting QGIS for the first time not all core plugins are loaded.

7.1.8 Vecteur

Barre de Menu Raccourci Référence Barre d’outils
Open Street Map → voir Charger des vecteurs OpenStreetMap

Outils d’analyse → voir Extension fTools

Outils de recherche → voir Extension fTools

Outils de géotraitement → voir Extension fTools

Outils de géométrie → voir Extension fTools

Outils de gestion de données → voir Extension fTools

When starting QGIS for the first time not all core plugins are loaded.

7.1.9 Raster

Barre de Menu Raccourci Référence Barre d’outils
Raster calculator ... see Calculatrice Raster

When starting QGIS for the first time not all core plugins are loaded.

7.1.10 Base de données

Barre de Menu Raccourci Référence Barre d’outils
Base de données → voir Extension DB Manager Base de données
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When starting QGIS for the first time not all core plugins are loaded.

7.1.11 Web

Barre de Menu Raccourci Référence Barre d’outils
Metasearch voir Client MetaSearch pour les Services de Catalogage Internet

When starting QGIS for the first time not all core plugins are loaded.

7.1.12 Traitement

Barre de Menu Raccourci Référence Barre d’outils

Toolbox voir La boîte à outils

Graphical Modeler ... voir Le modeleur graphique

History and log ... voir Le gestionnaire d’historique

Options ... voir Configurer le Module de Traitements

Results viewer ... voir Configuration des applications tierces

Commander Ctrl+Alt+M voir La ligne de commande QGIS

When starting QGIS for the first time not all core plugins are loaded.

7.1.13 Aide

Barre de Menu Raccourci Référence Barre d’outils

Help Contents F1 Aide

What’s This? Shift+F1 Aide
API Documentation
Need commercial support?

QGIS Home Page Ctrl+H

Check QGIS Version

About

QGIS Sponsors

Please note that for Linux , the menu bar items listed above are the default ones in the KDE window manager.
In GNOME, the Settings menu has different content and its items have to be found here:

Custom CRS Edit
Style Manager Edit

Configure Shortcuts Edit
Customization Edit
Options Edit

Snapping Options ... Edit

7.2 Barre d’outils

La barre d’outils fournit un accès à la majorité des fonctions des menus en plus d’outils additionnels destinés à
interagir avec la carte. Chaque outil dispose d’une bulle d’aide qui s’affiche lorsque vous placez votre curseur
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au-dessus. Celle-ci affiche une courte description du rôle de l’outil.

Every menu bar can be moved around according to your needs. Additionally, every menu bar can be switched off
using your right mouse button context menu, holding the mouse over the toolbars (read also Panels and Toolbars).

Astuce: Restaurer des barres d’outils
If you have accidentally hidden all your toolbars, you can get them back by choosing menu option Settings →
Toolbars →. If a toolbar disappears under Windows, which seems to be a problem in QGIS from time to time, you
have to remove key \HKEY_CURRENT_USER\Software\QGIS\qgis\UI\state in the registry. When
you restart QGIS, the key is written again with the default state, and all toolbars are visible again.

7.3 Map Legend

The map legend area lists all the layers in the project. The checkbox in each legend entry can be used to show or
hide the layer. The Legend toolbar in the map legend are list allow you to Add group, Manage Layer Visibility
of all layers or manage preset layers combination, Filter Legend by Map Content, Expand All or Collapse All

and Remove Layer or Group. The button allows you to add Presets views in the legend. It means that
you can choose to display some layer with specific categorization and add this view to the Presets list. To add a

preset view just click on , choose Add Preset... from the drop down menu and give a name to the preset.

After that you will see a list with all the presets that you can recall pressing on the button.

Toutes les vues prédéfinies ajoutées sont également présentes dans le composeur de carte pour vous permettre de
créer une mise en page de carte basée sur des vues spécifiques (consultez Propriétés principales).

Une couche peut être sélectionnée et glissée vers le haut ou le bas dans la légende pour modifier l’ordre
d’empilement des couches. Une couche se situant au sommet de la liste de cette légende sera affichée au-dessus
de celles qui se situent plus bas dans la liste.

Note: This behaviour can be overridden by the ‘Layer order’ panel.

Layers in the legend window can be organised into groups. There are two ways to do this:

1. Press the icon to add a new group. Type in a name for the group and press Enter. Now click on an
existing layer and drag it onto the group.

2. Sélectionnez des couches, faites un clic droit dans la légende et choisissez Grouper la sélection. Les couches
sélectionnées seront automatiquement placées dans un nouveau groupe.

Pour retirer une couche d’un groupe, il suffit de pointer votre curseur sur elle, de la glisser-déposer en dehors ou
de faire un clic droit et de choisir Mettre l’objet au-dessus. Un groupe peut contenir d’autres groupes.

La case à cocher d’un groupe permet d’afficher ou de cacher toutes les couches du groupe en un seul clic.

The content of the right mouse button context menu depends on whether the selected legend item is a raster or a

vector layer. For GRASS vector layers, Toggle editing is not available. See section Numérisation et édition de
couche vectorielle GRASS for information on editing GRASS vector layers.

Right mouse button menu for raster layers

• Zoom to Layer

• Show in overview

• Zoom to Best Scale (100%)

• Remove

• Duplicate

• Définir l’échelle de visibilité
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• Set Layer CRS

• Définir le SCR du projet depuis cette couche

• Styles →

• Save as ...

• Save As Layer Definition File ...

• Propriétés...

• Renommer

Additionally, according to layer position and selection

• Monter au premier-plan

• Grouper la sélection

Right mouse button menu for vector layers

• Zoom to Layer

• Show in overview

• Remove

• Duplicate

• Définir l’échelle de visibilité

• Set Layer CRS

• Définir le SCR du projet depuis cette couche

• Styles →

• Open Attribute Table

• Toggle Editing (not available for GRASS layers)

• Save As ...

• Save As Layer Definition Style

• Filtrer

• Show Feature Count

• Propriétés...

• Renommer

Additionally, according to layer position and selection

• Monter au premier-plan

• Grouper la sélection

Right mouse button menu for layer groups

• Zoom to Group

• Remove

• Set Group CRS

• Renommer

• Add Group

Il est possible de sélectionner plus d’une couche ou groupe à la fois en tenant appuyée la touche Ctrl pendant
que vous sélectionnez les couches avec le bouton gauche de la souris. Vous pouvez alors déplacer en une fois
toutes les couches sélectionnées dans un nouveau groupe.
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You may also delete more than one layer or group at once by selecting several layers with the Ctrl key and
pressing Ctrl+D afterwards. This way, all selected layers or groups will be removed from the layers list.

7.3.1 Travailler avec un ordre des couches dans la légende indépendant du
rendu cartographique

There is a panel that allows you to define an independent drawing order for the map legend. You can activate
it in the menu Settings → Panels → Layer order. This feature allows you to, for instance, order your layers in

order of importance, but still display them in the correct order (see figure_layer_order). Checking the Control
rendering order box underneath the list of layers will cause a revert to default behavior.

Figure 7.2: Define a legend independent layer order

7.4 Affichage de la carte

This is the “business end” of QGIS — maps are displayed in this area! The map displayed in this window will
depend on the vector and raster layers you have chosen to load (see sections that follow for more information on
how to load layers). The map view can be panned, shifting the focus of the map display to another region, and
it can be zoomed in and out. Various other operations can be performed on the map as described in the toolbar
description above. The map view and the legend are tightly bound to each other — the maps in view reflect
changes you make in the legend area.

Astuce: Zoomer sur la carte avec la molette de la souris
Vous pouvez utiliser la molette de la souris pour changer le niveau de zoom de la carte. Placez votre curseur dans
la zone d’affichage de la carte et faites rouler la molette vers l’avant pour augmenter l’échelle, vers vous pour la
réduire. La vue sera recentrée sur la position du curseur de la souris. Vous pouvez modifier le comportement de la
molette de la souris en utilisant l’onglet Outils cartographiques dans le menu Préférences → Options.

Astuce: Se déplacer sur la carte avec les flèches et la barre espace
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Vous pouvez utiliser les flèches du clavier pour vous déplacer sur la carte. Placez le curseur sur la carte et appuyez
sur la flèche droite pour décaler la vue vers l’Est, la flèche gauche pour la décaler vers l’Ouest, la flèche supérieure
vers le Nord et la flèche inférieure vers le Sud. Vous pouvez aussi déplacer la carte en gardant la touche espace
appuyée et en bougeant la souris ou encore simplement en gardant la molette de la souris appuyée.

7.5 Barre d’état

The status bar shows you your current position in map coordinates (e.g., meters or decimal degrees) as the mouse
pointer is moved across the map view. To the left of the coordinate display in the status bar is a small button that
will toggle between showing coordinate position or the view extents of the map view as you pan and zoom in and
out.

Next to the coordinate display you will find the scale display. It shows the scale of the map view. If you zoom in or
out, QGIS shows you the current scale. There is a scale selector, which allows you to choose between predefined
scales from 1:500 to 1:1000000.

À droite de l’affichage de l’échelle, vous pouvez définir un angle de rotation horaire en degrés à appliquer à la
carte.

A progress bar in the status bar shows the progress of rendering as each layer is drawn to the map view. In some
cases, such as the gathering of statistics in raster layers, the progress bar will be used to show the status of lengthy
operations.

If a new plugin or a plugin update is available, you will see a message at the far left of the status bar. On the right
side of the status bar, there is a small checkbox which can be used to temporarily prevent layers being rendered to

the map view (see section Rendu below). The icon immediately stops the current map rendering process.

To the right of the render functions, you find the EPSG code of the current project CRS and a projector icon.
Clicking on this opens the projection properties for the current project.

Astuce: Calculer l’échelle correcte de la carte
When you start QGIS, the default units are degrees, and this means that QGIS will interpret any coordinate in your
layer as specified in degrees. To get correct scale values, you can either change this setting to meters manually in

the General tab under Settings → Project Properties, or you can select a project CRS clicking on the Current CRS:

icon in the lower right-hand corner of the status bar. In the last case, the units are set to what the project projection
specifies (e.g., ‘+units=m’).

.
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CHAPTER 8

Outils généraux

8.1 Raccourcis clavier

QGIS provides default keyboard shortcuts for many features. You can find them in section Barre de Menu. Ad-
ditionally, the menu option Settings → Configure Shortcuts.. allows you to change the default keyboard shortcuts
and to add new keyboard shortcuts to QGIS features.

Figure 8.1: Define shortcut options (Gnome)

Configuration is very simple. Just select a feature from the list and click on [Change], [Set none] or [Set default].
Once you have finished your configuration, you can save it as an XML file and load it to another QGIS installation.

8.2 Aide contextuelle

Lorsque vous avez besoin d’aide sur un sujet spécifique, vous pouvez accéder à l’aide contextuelle via le bouton
[Aide] disponible dans la plupart des fenêtres — notez que les extensions additionnelles peuvent pointer vers des
pages web dédiées.

8.3 Rendu

By default, QGIS renders all visible layers whenever the map canvas is refreshed. The events that trigger a refresh
of the map canvas include:

• l’ajout d’une couche
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• le déplacement ou le zoom

• Resizing the QGIS window

• la modification de la visibilité d’une ou plusieurs couches

QGIS allows you to control the rendering process in a number of ways.

8.3.1 Rendu dépendant de l’échelle

Le rendu dépendant de l’échelle permet de spécifier des échelles minimale et maximale auxquelles la couche doit
être visible. Pour définir une échelle de rendu, ouvrez la fenêtre de Propriétés en double-cliquant sur une couche

dans la légende et dans l’onglet Général, cochez la case Visibilité dépendante de l’échelle puis saisissez les
valeurs voulues.

You can determine the scale values by first zooming to the level you want to use and noting the scale value in the
QGIS status bar.

8.3.2 Contrôler le rendu

Map rendering can be controlled in the various ways, as described below.

Suspendre le rendu

To suspend rendering, click the Render checkbox in the lower right corner of the status bar. When the
Render checkbox is not checked, QGIS does not redraw the canvas in response to any of the events described in
section Rendu. Examples of when you might want to suspend rendering include:

• Ajouter plusieurs couches et réaliser leur symbologie avant de les afficher

• Ajouter une ou plusieurs couches et définir leur dépendance d’échelle avant de les afficher

• Ajouter une ou plusieurs couches et zoomer à une vue spécifique avant de les afficher

• N’importe quelle combinaison des éléments précédents

Cocher la case Rendu activera de nouveau le rendu et provoquera un rafraîchissement immédiat de la carte.

Définir les options d’ajout de couche

Il est possible de définir une option qui chargera toutes les nouvelles couches sans les dessiner, elles seront ajoutées
à la carte, mais la case de visibilité sera décochée par défaut. Pour définir cette option, sélectionnez l’option

Préférences → Options et cliquez sur l’onglet Rendu. Décochez la case Par défaut les couches supplémentaires
sont affichées. Les nouvelles couches ajoutées à la carte seront invisibles par défaut.

Arrêter le rendu

Pour arrêter le rendu de la carte, appuyez sur la touche ESC. Ceci stoppera le rafraîchissement de la vue de la
carte et laissera la carte partiellement dessinée. Il est possible qu’il y ait un délai entre le moment où la touche est
pressée et le moment où le rendu de la carte est effectivement arrêté.

Note: Il n’est maintenant plus possible d’arrêter le rendu — cela a été désactivé dans Qt4 à cause de problèmes
et de crashes dans l’interface utilisateur (IHM).
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Updating the Map Display During Rendering

You can set an option to update the map display as features are drawn. By default, QGIS does not display any
features for a layer until the entire layer has been rendered. To update the display as features are read from the
datastore, choose menu option Settings → Options and click on the Rendering tab. Set the feature count to an
appropriate value to update the display during rendering. Setting a value of 0 disables update during drawing (this
is the default). Setting a value too low will result in poor performance, as the map canvas is continually updated
during the reading of the features. A suggested value to start with is 500.

Influencer la qualité du rendu

To influence the rendering quality of the map, you have two options. Choose menu option Settings → Options,
click on the Rendering tab and select or deselect following checkboxes:

• Make lines appear less jagged at the expense of some drawing performance

• Fix problems with incorrectly filled polygons

Accéler le rendu

There are two settings that allow you to improve rendering speed. Open the QGIS options dialog using Settings
→ Options, go to the Rendering tab and select or deselect the following checkboxes:

• Enable back buffer. This provides better graphics performance at the cost of losing the possibility to
cancel rendering and incrementally draw features. If it is unchecked, you can set the Number of features to
draw before updating the display, otherwise this option is inactive.

• Utiliser le cache du rendu si possible pour accélérer l’affichage

8.4 Mesurer

Measuring works within projected coordinate systems (e.g., UTM) and unprojected data. If the loaded map is
defined with a geographic coordinate system (latitude/longitude), the results from line or area measurements will
be incorrect. To fix this, you need to set an appropriate map coordinate system (see section Utiliser les projections).
All measuring modules also use the snapping settings from the digitizing module. This is useful, if you want to
measure along lines or areas in vector layers.

To select a measuring tool, click on and select the tool you want to use.

8.4.1 Measure length, areas and angles

Measure Line: QGIS is able to measure real distances between given points according to a defined ellipsoid.
To configure this, choose menu option Settings → Options, click on the Map tools tab and select the appropriate
ellipsoid. There, you can also define a rubberband color and your preferred measurement units (meters or feet) and
angle units (degrees, radians and gon). The tool then allows you to click points on the map. Each segment length,
as well as the total, shows up in the measure window. To stop measuring, click your right mouse button. Note
that you can interactively change the measurement units in the measurement dialog. It overrides the Preferred
measurement units in the options. There is an info section in the dialog that shows which CRS settings are being
used during measurement calculations.

Measure Area: Areas can also be measured. In the measure window, the accumulated area size appears. In
addition, the measuring tool will snap to the currently selected layer, provided that layer has its snapping tolerance
set (see section Définir le rayon de tolérance d’accrochage et de recherche). So, if you want to measure exactly
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Figure 8.2: Measure Distance (Gnome)

along a line feature, or around a polygon feature, first set its snapping tolerance, then select the layer. Now, when
using the measuring tools, each mouse click (within the tolerance setting) will snap to that layer.

Figure 8.3: Measure Area (Gnome)

Measure Angle: You can also measure angles. The cursor becomes cross-shaped. Click to draw the first segment
of the angle you wish to measure, then move the cursor to draw the desired angle. The measure is displayed in a
pop-up dialog.

Figure 8.4: Measure Angle (Gnome)

8.4.2 Sélectionner et désélectionner des entités

The QGIS toolbar provides several tools to select features in the map canvas. To select one or several features,

just click on and select your tool:

• Select Single Feature

• Select Features by Rectangle

• Select Features by Polygon

• Select Features by Freehand

• Select Features by Radius

To deselect all selected features click on Deselect features from all layers.
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Select feature using an expression allow user to select feature using expression dialog. See Expressions chapter for
some example.

Users can save features selection into a New Memory Vector Layer or a New Vector Layer using Edit → Paste
Feature as ... and choose the mode you want.

8.5 Identifier les entités

The Identify tool allows you to interact with the map canvas and get information on features in a pop-up window.

To identify features, use View → Identify features or press Ctrl + Shift + I, or click on the Identify features

icon in the toolbar.

If you click on several features, the Identify results dialog will list information about all the selected features. The
first item is the number of the layer in the list of results, followed by the layer name. Then, its first child will be the
name of a field with its value. The first field is the one selected in Properties → Display. Finally, all information
about the feature is displayed.

Cette fenêtre se personnalise pour afficher les champs choisis mais par défaut, trois types d’information sont
affichés :

• Actions: Actions can be added to the identify feature windows. When clicking on the action label, action
will be run. By default, only one action is added, to view feature form for editing.

• Derived: This information is calculated or derived from other information. You can find clicked coordinate,
X and Y coordinates, area in map units and perimeter in map units for polygons, length in map units for
lines and feature ids.

• Data attributes: This is the list of attribute fields from the data.

Figure 8.5: Identify feaures dialog (Gnome)

At the top of the window, you have five icons:

• Expand tree

• Collapse tree

• Default behaviour

• Copy attributes

• Print selected HTML response
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At the bottom of the window, you have the Mode and View comboboxes. With the Mode combobox you can define
the identify mode: ‘Current layer’, ‘Top down, stop at first’, ‘Top down’ and ‘Layer selection’. The View can be
set as ‘Tree’, ‘Table’ and ‘Graph’.

The identify tool allows you to auto open a form. In this mode you can change the feautures attributes.

D’autres fonctions peuvent être trouvées dans le menu contextuel d’un élément identifié, via un clic droit. Par
exemple, depuis le menu contextuel, vous pouvez :

• Voir le formulaire d’entité

• Zoomer sur l’entité

• Copier l’entité : copie toute la géométrie et les attributs d’une entité

• Toggle feature selection: adds identified feature to selection

• Copier les valeurs d’attributs : copie uniquement les valeurs d’attributs de l’entité identifiée

• Copy feature attributes: Copy only attributes

• Lâcher les résultats : la fenêtre de résultats est vidée

• Masquer la surbrillance : la surbrillance des entités identifiées sur la carte est retirée

• Tout mettre en surbrillance

• Mettre la couche en surbrillance

• Activer une couche : Choisir la couche à activer

• Propriétés : ouvre la fenêtre des propriétés de la couche

• Tout déplier

• Tout replier

8.6 Décorations

The Decorations of QGIS include the Grid, the Copyright Label, the North Arrow and the Scale Bar. They are
used to ‘decorate’ the map by adding cartographic elements.

8.6.1 Grille

Grille vous permet d’ajouter un graticule et des coordonnées à la carte.

1. Sélectionnez via le menu Vue → Décorations → Grille. La fenêtre s’affiche (voir figure_decorations_1).

2. Cochez la case Activer la grille et définissez les paramètres de la grille en fonction des couches chargées
dans le canevas de carte.

3. Cochez la case Dessiner une annotation et définissez les propriétés de l’annotation en fonction des
couches chargées dans le canevas de carte.

4. Click [Apply] to verify that it looks as expected.

5. Click [OK] to close the dialog.

8.6.2 Étiquette de Copyright

Copyright label adds a copyright label using the text you prefer to the map.

1. Sélectionnez via le menu Vue → Décorations → Étiquette de Copyright. La fenêtre s’affiche (voir fig-
ure_decorations_2).
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Figure 8.6: The Grid Dialog

Figure 8.7: The Copyright Dialog

8.6. Décorations 39



QGIS User Guide, Version 2.8

2. Entrez le texte que vous souhaitez afficher sur la carte. Vous pouvez utiliser du code HTML comme le
montre l’exemple.

3. Choose the placement of the label from the Placement combo box.

4. Assurez-vous que la case Activer l’étiquette des droits d’auteur est cochée.

5. Click [OK].

In the example above, which is the default, QGIS places a copyright symbol followed by the date in the lower
right-hand corner of the map canvas.

8.6.3 Flèche du nord

North Arrow places a simple north arrow on the map canvas. At present, there is only one style available. You
can adjust the angle of the arrow or let QGIS set the direction automatically. If you choose to let QGIS determine
the direction, it makes its best guess as to how the arrow should be oriented. For placement of the arrow, you have
four options, corresponding to the four corners of the map canvas.

Figure 8.8: The North Arrow Dialog

8.6.4 Échelle graphique

Scale Bar adds a simple scale bar to the map canvas. You can control the style and placement, as well as the
labeling of the bar.

Figure 8.9: The Scale Bar Dialog

QGIS only supports displaying the scale in the same units as your map frame. So if the units of your layers are in
meters, you can’t create a scale bar in feet. Likewise, if you are using decimal degrees, you can’t create a scale
bar to display distance in meters.
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Pour ajouter une échelle graphique :

1. Sélectionnez le menu Vue → Décorations → Échelle graphique. Une fenêtre s’affiche (voir fig-
ure_decorations_4).

2. Choose the placement from the Placement combo box.

3. Choose the style from the Scale bar style combo box.

4. Select the color for the bar Color of bar or use the default black color.

5. Set the size of the bar and its label Size of bar .

6. Assurez-vous que la case Activer l’échelle graphique est cochée.

7. Optionally, check Automatically snap to round number on resize.

8. Click [OK].

Astuce: Paramètre des décorations
Lorsque vous sauvegardez un projet .qgs, toutes modifications faites sur le Carroyage, la Flèche du Nord, la
Barre d’Échelle et le Copyright seront sauvées dans le fichier de projet et restaurées à la prochaine ouverture du
projet.

8.7 Outils d’annotation

The Text Annotation tool in the attribute toolbar provides the possibility to place formatted text in a balloon on the
QGIS map canvas. Use the Text Annotation tool and click into the map canvas.

Figure 8.10: Annotation text dialog

Un double clic sur l’annotation ouvre une fenêtre avec diverses options. Il y a un éditeur de texte pour entrer du
texte formaté et d’autres options notamment la possibilité de figer la position de l’annotation dans la carte (montré
par un symbole de marqueur) ou d’avoir la position de l’annotation relativement à l’écran (non liée à la carte). La
position de l’élément peut être déplacé sur la carte (en déplaçant le marqueur de carte) ou en déplaçant seulement
la bulle. Les icônes font partie du thème SIG et sont utilisées par défaut dans les autres thèmes, aussi.

The Move Annotation tool allows you to move the annotation on the map canvas.
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8.7.1 Annotations HTML

The Html Annotation tools in the attribute toolbar provides the possibility to place the content of an html file in a
balloon on the QGIS map canvas. Using the Html Annotation tool, click into the map canvas and add the path to
the html file into the dialog.

8.7.2 Annotations SVG

The SVG Annotation tool in the attribute toolbar provides the possibility to place an SVG symbol in a balloon on
the QGIS map canvas. Using the SVG Annotation tool, click into the map canvas and add the path to the SVG file
into the dialog.

8.7.3 Formulaire d’annotation

Additionally, you can also create your own annotation forms. The Form Annotation tool is useful to display
attributes of a vector layer in a customized Qt Designer form (see figure_custom_annotation). This is similar
to the designer forms for the Identify features tool, but displayed in an annotation item. Also see this video
https://www.youtube.com/watch?v=0pDBuSbQ02o from Tim Sutton for more information.

Figure 8.11: Customized qt designer annotation form

Note: Si vous pressez les touches Ctrl+T alors que l’outil Annotation est activé (déplacement d’annotation,
annotation de texte ou formulaire d’annotation), les annotations sont automatiquement cachées ou, inversement,
rendues visibles.

8.8 Signets spatiaux

Spatial Bookmarks allow you to “bookmark” a geographic location and return to it later.
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8.8.1 Créer un signet

Pour créer un signet :

1. Déplacez-vous sur la zone concernée.

2. Select the menu option View → New Bookmark or press Ctrl-B.

3. Entrez un nom pour décrire le signet (jusqu’à 255 caractères).

4. Press Enter to add the bookmark or [Delete] to remove the bookmark.

Notez que vous pouvez avoir plusieurs signets portant le même nom.

8.8.2 Travailler avec les signets

To use or manage bookmarks, select the menu option View → Show Bookmarks. The Geospatial Bookmarks
dialog allows you to zoom to or delete a bookmark. You cannot edit the bookmark name or coordinates.

8.8.3 Zooming to a Bookmark

From the Geospatial Bookmarks dialog, select the desired bookmark by clicking on it, then click [Zoom To]. You
can also zoom to a bookmark by double-clicking on it.

8.8.4 Deleting a Bookmark

To delete a bookmark from the Geospatial Bookmarks dialog, click on it, then click [Delete]. Confirm your choice
by clicking [Yes], or cancel the delete by clicking [No].

8.8.5 Import or export a bookmark

To share or transfer your bookmarks between computers you can use the Share pull down menu in the Geospatial
Bookmarks dialog.

8.9 Inclusion de projets

Si vous souhaitez inclure dans votre projet QGIS des couches ou des groupes de couches issus d’un autre projet,
utilisez le menu Couches → Intégrer des couches et des groupes.

8.9.1 Intégrer des couches

La fenêtre suivante vous permet d’intégrer des couches provenant d’autres projets QGIS :

1. Press to look for another project from the Alaska dataset.

2. Select the project file grassland. You can see the content of the project (see figure_embed_dialog).

3. Press Ctrl and click on the layers grassland and regions. Press [OK]. The selected layers are
embedded in the map legend and the map view now.

Bien que les couches intégrées soient éditables, vous ne pouvez pas en modifier le style et l’étiquetage.
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Figure 8.12: Select layers and groups to embed

8.9.2 Supprimer des couches intégrées

Right-click on the embedded layer and choose Remove.

.
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CHAPTER 9

QGIS Configuration

QGIS is highly configurable through the Settings menu. Choose between Panels, Toolbars, Project Properties,
Options and Customization.

Note: QGIS follows desktop guidelines for the location of options and project properties item. Consequently
related to the OS you are using, location of some of items described above could be located in the View menu
(Panels and Toolbars) or in Project for Options.

9.1 Panels and Toolbars

In the Panels→ menu, you can switch on and off QGIS widgets. The Toolbars→ menu provides the possibility to
switch on and off icon groups in the QGIS toolbar (see figure_panels_toolbars).

Figure 9.1: The Panels and Toolbars menu

Astuce: Activating the QGIS Overview
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In QGIS, you can use an overview panel that provides a full extent view of layers added to it. It can be selected
under the menu Settings → Panels or View → Panels. Within the view is a rectangle showing the current
map extent. This allows you to quickly determine which area of the map you are currently viewing. Note that
labels are not rendered to the map overview even if the layers in the map overview have been set up for labeling.
If you click and drag the red rectangle in the overview that shows your current extent, the main map view will
update accordingly.

Astuce: Show Log Messages

It’s possible to track the QGIS messages. You can activate Log Messages in the menu Settings → Panels
or View → Panels and follow the messages that appear in the different tabs during loading and operation.

9.2 Propriétés du projet

In the properties window for the project under Settings → Project Properties (kde) or Project → Project
Properties (Gnome), you can set project-specific options. These include:

• In the General menu, the project title, selection and background color, layer units, precision, and the option
to save relative paths to layers can be defined. If the CRS transformation is on, you can choose an ellipsoid
for distance calculations. You can define the canvas units (only used when CRS transformation is disabled)
and the precision of decimal places to use. You can also define a project scale list, which overrides the
global predefined scales.

• Le menu SCR vous permet de choisir le Système de Coordonnées de Référence pour le projet et d’activer la
projection à la volée des couches raster et vecteur définies dans un SCR différent.

• With the third Identify layers menu, you set (or disable) which layers will respond to the identify tool (see
the “Map tools” paragraph from the Options section to enable identifying of multiple layers).

• The Default Styles menu lets you control how new layers will be drawn when they do not have an existing
.qml style defined. You can also set the default transparency level for new layers and whether symbols
should have random colours assigned to them. There is also an additional section where you can define
specific colors for the running project. You can find the added colors in the drop down menu of the color
dialog window present in each renderer.

• The tab OWS Server allows you to define information about the QGIS Server WMS and WFS capabilities,
extent and CRS restrictions.

• Le menu Macros permet d’éditer des modules Python pour les projets. Actuellement, seules trois macros
sont disponibles : openProject(), saveProject() et closeProject().

• L’onglet Relations permet de définir des relations 1:n. Les relations sont définies dans la fenêtre des pro-
priétés du projet. Une fois les relations définies sur une couche, un nouvel élément apparaît dans la vue
formulaire de cette couche (par exemple, lors de l’identification d’une entité et l’ouverture du formulaire
associé) et vous liste les entités qui lui sont reliées. Ceci fournit un moyen puissant d’exprimer, par exemple,
l’historique d’inspection le long d’une pipeline ou d’un tronçon de route. Vous trouverez de plus amples
informations sur les relation 1:n dans la section Creating one to many relations.

9.3 Options

Some basic options for QGIS can be selected using the Options dialog. Select the menu option Settings →
Options. The tabs where you can customize your options are described below.
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Figure 9.2: Macro settings in QGIS

9.3.1 Onglet Général

Application

• Select the Style (QGIS restart required) and choose between ‘Oxygen’,’Windows’,’Motif’,’CDE’,
‘Plastique’ and ‘Cleanlooks’ ( ).

• Define the Icon theme . Currently only ‘default’ is possible.

• Define the Icon size .

• Define the Font. Choose between Qt default and a user-defined font.

• Change the Timeout for timed messages or dialogs .

• Cacher l’écran de démarrage

• Montrer les astuces au démarrage

• Titre des groupes de couches en gras

• Style QGIS pour les groupes de couches

• Utiliser les fenêtres natives de choix de couleur

• Fenêtres de choix de couleur avec mise à jour dynamique

• Style personnalisé de la barre latérale

• Rotation du canevas de la carte (expérimental, redémarrage requis)

Fichiers projet

• Open project on launch (choose between ‘New’, ‘Most recent’ and ‘Specific’). When choosing

‘Specific’ use the to define a project.

• Créer les nouveaux projets à partir du projet par défaut. Vous pouvez choisir d’Utiliser le projet courant
comme défaut ou de Réinitialiser le projet par défaut. Vous pouvez parcourir vos fichiers et sélectionner
le répertoire où sont stockés vos modèles de projets personnalisés. Cela créera une nouvelle entrée dans le
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menu Projet → Nouveau depuis un modèle si vous cochez Créer les nouveaux projets à partir du projet
par défaut et sauvegardez un projet dans le répertoire de modèles de projets spécifié.

• Demander de sauver le projet et les sources de données quand nécessaire

• Demander une confirmation lorsqu’une couche va être supprimée

• M’avertir lors de l’ouverture d’un fichier projet sauvegardé avec une version précédente de QGIS

• Enable macros . This option was created to handle macros that are written to perform an action on
project events. You can choose between ‘Never’, ‘Ask’, ‘For this session only’ and ‘Always (not recom-
mended)’.

9.3.2 Menu Système

Environnement

Les variables d’environnement Système peuvent maintenant être visualisées et configurées pour certains dans
le groupe Environnement (voir figure_environment_variables). Ceci est pratique sur certaines plateformes, no-
tamment sur Mac, ou une application avec interface graphique n’hérite pas nécessairement des paramètres de
l’environnement en ligne de commande de l’utilisateur. Ceci est aussi utile pour paramétrer/visualiser les variables
d’environnement des outils externes contrôlés par la boîte à outils de traitement (par exemple SAGA, GRASS) et
activer les sorties de débogage pour des sections spécifiques du code source.

• Utiliser des variables personnalisées (redémarrage requis - inclure des séparateurs). Vous pouvez
[Ajouter] et [Supprimer] des variables. Les variables d’environnement déjà définies sont affichées dans

Variables d’environnement courantes, et il est possible de les filtrer en activant Afficher uniquement les
variables liées à QGIS.

Figure 9.3: System environment variables in QGIS

Chemins vers les extensions

48 Chapter 9. QGIS Configuration



QGIS User Guide, Version 2.8

[Ajouter] ou [Supprimer] un ou des Chemin(s) vers des extensions C++ supplémentaires

9.3.3 Onglet Sources de données

Attributs et tables

• Ouvrir la table d’attributs dans une fenêtre intégrée (redémarrage requis)

• Copy geometry in WKT representation from attribute table. When using Copy selected rows to clipboard

from the Attribute table dialog, this has the result that the coordinates of points or vertices are also copied
to the clipboard.

• Attribute table behaviour . There are three possibilities: ‘Show all features’, ‘Show selected features’
and ‘Show features visible on map’.

• Attribute table row cache . This row cache makes it possible to save the last loaded N attribute rows
so that working with the attribute table will be quicker. The cache will be deleted when closing the attribute
table.

• Représentation des valeurs NULL permet de définir une valeur par défaut pour les champs contenant la
valeur NULL.

Gestion des sources de données

• Scan for valid items in the browser dock . You can choose between ‘Check extension’ and ‘Check file
contents’.

• Scan for contents of compressed files (.zip) in browser dock . ‘No’, ‘Basic scan’ and ‘Full scan’ are
possible.

• Demande à l’ouverture s’il y a des sous-couches raster. Certains rasters comportent des sous-couches
- appelées sous-jeux de données dans GDAL. Par exemple les fichiers netCDF - s’il y a de nombreuses
variables netCDF, GDAL considérera chaque variable comme un sous-jeux de données. L’option vous
permet de choisir comment traiter les sous-jeux de données quand un fichier avec des sous-couches est
ouvert. Vous avez les choix suivants :

– ‘Toujours’ : Demande toujours (s’il existe des sous-couches)

– ‘Si nécessaire’ : Demande si la couche n’a pas de bande, mais qu’elle possède des sous-couches

– ‘Jamais’ : Ne demande jamais, mais ne charge rien

– ‘Charger tout’ : Ne demande jamais, mais charge toutes les sous-couches

• Ignore shapefile encoding declaration. If a shapefile has encoding information, this will be ignored by
QGIS.

• Ajouter des couches PostGIS avec un double-clic et sélectionner en mode étendu

• Ajouter les couches Oracle par double-clic et sélection en mode étendu

9.3.4 Onglet Rendu

Rendering behaviour

• Par défaut les couches supplémentaires sont affichées

• Utiliser le cache du rendu si possible pour accélérer l’affichage

• Rendu des couches en parallèle en utilisant plusieurs cœurs du processeur

• Nombre de cœurs à utiliser
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• Intervalle de rafraîchissement de l’affichage de la carte (par défaut de 250 ms)

• Enable feature simplication by default for newly added layers

• Seuil de simplification

• Réaliser la simplification par le prestataire de service lorsque c’est possible

• Échelle maximale à partir de laquelle la couche doit être simplifiée

Qualité du rendu

• Les lignes semblent moins déchiquetées aux dépends d’une certaine vitesse d’exécution

Rasters

• Avec la Sélection de bande RVB, vous pouvez définir la valeur des bandes Rouge, Verte et Bleue.

Amélioration du contraste

• Single band gray . A single band gray can have ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip
to MinMax’ and also ‘Clip to MinMax’.

• Multi band color (byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Multi band color (>byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Limits (minimum/maximum) . Options are ‘Cumulative pixel count cut’, ‘Minimum/Maximum’,
‘Mean +/- standard deviation’.

• Limite de découpe pour le comptage cumulé de pixels

• Multiplicateur de l’écart-type

Déboggage

• Actualisation de la carte

9.3.5 Onglet couleurs

Cet onglet vous permet d’ajouter des couleurs personnalisées supplémentaires que vous pouvez trouver dans
chaque fenêtre de dialogue des rendus de couleur. Vous verrez un jeu de couleurs prédéfinies dans l’onglet :
vous pouvez supprimer ou éditer chacune d’entre elles. Vous pouvez également ajouter la couleur que vous voulez
et effectuer une opération de copier-coller. Finalement, vous pouvez importer ou exporter un jeu de couleurs
comme fichier gpl.

9.3.6 Onglet Carte et légende

Apparence de la carte par défaut (écrasée par les propriétés du projet si définies)

• Définir la Couleur de la sélection et la Couleur de fond.

Légende des couches

• Double click action in legend . You can either ‘Open layer properties’ or ‘Open attribute table’ with
the double click.

• Les Styles des objets de la légende peuvent être :

– Noms de couches en majuscules

– Noms de couches en gras
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– Noms de groupes de couches en gras

– Afficher le nom du champ de classification

– Créer des icônes raster dans la légende (lent)

9.3.7 Onglet Outils cartographiques

This menu offers some options regarding the behaviour of the Identify tool.

• Rayon de recherche pour identifier les entités et afficher les infobulles est un facteur de tolérance exprimé
comme un pourcentage de la largeur de la carte. Cela signifie que l’outil identifier illustrera les résultats tant
que vous cliquez à l’intérieur de cette tolérance.

• Couleur de surbrillance vous permet de choisir avec quelle couleur les entités qui devraient être identifiées
sont en surbrillance.

• Buffer expressed as a percentage of the map width, determines a buffer distance to be rendered from the
outline of the identify highlight.

• Minimum width expressed as a percentage of the map width, determines how thick should the outline of a
highlighted object be.

Outils de mesure

• Définir la Couleur du trait des outils de mesure

• Définir le Nombre de décimales

• Keep base unit

• Preferred measurements units (‘Meters’, ‘Feet’, ‘Nautical Miles’ or ‘Degrees’)‘

• Preferred angle units (‘Degrees’, ‘Radians’ or ‘Gon’)

Déplacement et zoom

• Define Mouse wheel action (‘Zoom’, ‘Zoom and recenter’, ‘Zoom to mouse cursor’, ‘Nothing’)

• Définir le Facteur de zoom pour la molette de la souris

Échelles prédéfinies

Here, you find a list of predefined scales. With the [+] and [-] buttons you can add or remove your individual
scales.

9.3.8 Onglet Composeur d’impression

Valeurs par défaut pour les compositions

Vous pouvez définir une Police par défaut ici.

Apparence de la grille

• Define the Grid style (‘Solid’, ‘Dots’, ‘Crosses’)

• Définir la Couleur de la grille

Grille et guide par défaut

• Define the Grid spacing

• Define the Grid offset for x and y

• Define the Snap tolerance
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9.3.9 Onglet Numérisation

Création d’entités

• Supprimer les fenêtres d’avertissements lors de la création de chaque entité

• Réutiliser la dernière valeur attributaire saisie

• Validate geometries. Editing complex lines and polygons with many nodes can result in very slow rendering.
This is because the default validation procedures in QGIS can take a lot of time. To speed up rendering, it is
possible to select GEOS geometry validation (starting from GEOS 3.3) or to switch it off. GEOS geometry
validation is much faster, but the disadvantage is that only the first geometry problem will be reported.

Contours d’édition

• Définissez la Largeur de ligne et la Couleur de ligne du trait lors de l’édition.

Accrochage

• Ouvrir les options d’accrochage dans une fenêtre intégrée (redémarrage de QGIS requis)

• Define Default snap mode (‘To vertex’, ‘To segment’, ‘To vertex and segment’, ‘Off’)

• Définir Tolérance d’accrochage par défaut en unités de carte ou en pixels

• Définir le Rayon de recherche pour l’édition des sommets en unités de carte ou en pixels

Symbole des sommets

• Montrer les symboles uniquement pour les entités sélectionnées

• Define vertex Marker style (‘Cross’ (default), ‘Semi transparent circle’ or ‘None’)

• Définir la Taille du marqueur des sommets

Outil de décalage de courbe

The next 3 options refer to the Offset Curve tool in Numérisation avancée. Through the various settings, it is
possible to influence the shape of the line offset. These options are possible starting from GEOS 3.3.

• Style de jointure

• Segments de quadrant

• Limite de la pointe

9.3.10 Onglet GDAL

GDAL est une bibliothèque qui permet de gérer les fichiers raster. Dans cet onglet, vous pouvez Modifier les
options des pyramides et Modifier les options de création des différents formats raster ainsi que définir quel pilote
GDAL utiliser dans le cas où plus d’un est disponible.

9.3.11 Onglet SCR

SCR par défaut pour les nouveaux projets

• Don’t enable ‘on the fly’ reprojection

• Automatically enable ‘on the fly’ reprojection if layers have different CRS

• Enable ‘on the fly’ reprojection by default

• Sélectionner un SCR et Toujours lancer ce SCR pour les nouveaux projets

52 Chapter 9. QGIS Configuration



QGIS User Guide, Version 2.8

SCR pour les nouvelles couches

Cet espace vous permet de définir une action à faire lorsqu’une nouvelle couche est créée ou lorsqu’une couche
sans SCR est chargée.

• Prompt for CRS

• Use project CRS

• Use default CRS

Transformations géodésiques par défaut

• Demander un datum pour la conversion de coordonnées lorsque aucun n’est défini par défaut

• Si vous avez utilisé la ‘projection à la volée’, vous pouvez visualiser les transformations effectuées en
bas de la fenêtre. Vous y trouverez des informations sur le ‘SCR source’ et le ‘SCR cible’ ainsi que la
‘Transformation géodésique source’, appliquée au SCR source, et la ‘Transformation géodésique cible’,
appliquée au SCR cible.

9.3.12 Onglet Langue

• Écraser la langue du système et la Langue à utiliser

• Informations sur les paramètres de langue du système

9.3.13 Onglet Réseau

Général

• Définir l’Adresse de recherche WMS, par défaut : http://geopole.org/wms/search?search=\%1\&type=rss

• Définir le Délai d’abandon pour les requêtes réseaux (ms) - la valeur par défaut est 60000

• Définir le Délai d’expiration pour les tuiles WMSC/WMTS (en heures)- la valeur par défaut est 24

• Définir le Nombre d’essais maximum lors d’une erreur de requête vers une tuile

• Définir le User-Agent

Paramètres du cache

Définir le Répertoire et la Taille du cache.

• Utiliser un proxy pour l’accès internet et définir l’‘Hôte’, le ‘Port’, l’‘Utilisateur’, et le ‘Mot de passe’.

• Set the Proxy type according to your needs.

– Default Proxy : le proxy est déterminé sur la base du proxy de l’application

– Socks5Proxy : proxy générique pour tout type de connexion. Supporte le TCP, UDP, binding à un port
(connexions entrantes) et l’authentification.

– HttpProxy : implémenté avec la commande “CONNECT” , supporte uniquement les connexions TCP
sortantes, supporte l’authentification.

– HttpCachingProxy : implémenté via les commandes HTTP normales, utile uniquement dans un con-
texte de requêtes HTTP.

– FtpCachingProxy : implémenté avec un proxy FTP, utile uniquement dans un contexte de requêtes
FTP.

Vous pouvez exclure certaines adresses en les ajoutant dans la zone de texte sous les paramètres de proxy (voir
Figure_Network_Tab).
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Figure 9.4: Proxy-settings in QGIS

54 Chapter 9. QGIS Configuration



QGIS User Guide, Version 2.8

Si vous avez besoin d’informations plus détaillées sur les différents paramètres de proxy, référez-vous au manuel
de la bibliothèque sous-jacente QT : http://doc.trolltech.com/4.5/qnetworkproxy.html#ProxyType-enum.

Astuce: Utiliser les proxy
L’utilisation de proxy peut se révéler difficile. Il est utile de tester les types de proxy décrits ci-dessus et vérifier
s’ils conviennent.

You can modify the options according to your needs. Some of the changes may require a restart of QGIS before
they will be effective.

• Les paramètres sont sauvegardés dans un fichier texte : $HOME/.config/QGIS/QGIS2.conf

• Les paramètres se trouvent dans: $HOME/Library/Preferences/org.qgis.qgis.plist

• Les paramètres sont stockés dans la base de registre, sous:
HKEY\CURRENT_USER\Software\QGIS\qgis

9.4 Personnalisation

The customization tool lets you (de)activate almost every element in the QGIS user interface. This can be very
useful if you have a lot of plugins installed that you never use and that are filling your screen.

Figure 9.5: The Customization dialog

QGIS Customization is divided into five groups. In Menus, you can hide entries in the Menu bar. In Panels,
you find the panel windows. Panel windows are applications that can be started and used as a floating, top-level

window or embedded to the QGIS main window as a docked widget (see also Panels and Toolbars). In the

Status Bar, features like the coordinate information can be deactivated. In Toolbars, you can (de)activate the

toolbar icons of QGIS, and in Widgets, you can (de)activate dialogs as well as their buttons.

With Switch to catching widgets in main application, you can click on elements in QGIS that you want to be hidden and
find the corresponding entry in Customization (see figure_customization). You can also save your various setups
for different use cases as well. Before your changes are applied, you need to restart QGIS.

.
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CHAPTER 10

Utiliser les projections

QGIS allows users to define a global and project-wide CRS (coordinate reference system) for layers without a
pre-defined CRS. It also allows the user to define custom coordinate reference systems and supports on-the-fly
(OTF) projection of vector and raster layers. All of these features allow the user to display layers with different
CRSs and have them overlay properly.

10.1 Aperçu de la gestion des projections

QGIS has support for approximately 2,700 known CRSs. Definitions for each CRS are stored in a SQLite database
that is installed with QGIS. Normally, you do not need to manipulate the database directly. In fact, doing so may
cause projection support to fail. Custom CRSs are stored in a user database. See section Système de Coordonnées
de Référence personnalisé for information on managing your custom coordinate reference systems.

The CRSs available in QGIS are based on those defined by the European Petroleum Search Group (EPSG) and
the Institut Geographique National de France (IGNF) and are largely abstracted from the spatial reference tables
used in GDAL. EPSG identifiers are present in the database and can be used to specify a CRS in QGIS.

In order to use OTF projection, either your data must contain information about its coordinate reference system or
you will need to define a global, layer or project-wide CRS. For PostGIS layers, QGIS uses the spatial reference
identifier that was specified when the layer was created. For data supported by OGR, QGIS relies on the presence
of a recognized means of specifying the CRS. In the case of shapefiles, this means a file containing the well-known
text (WKT) specification of the CRS. This projection file has the same base name as the shapefile and a .prj
extension. For example, a shapefile named alaska.shp would have a corresponding projection file named
alaska.prj.

Whenever you select a new CRS, the layer units will automatically be changed in the General tab of the Project
Properties dialog under the Project (Gnome, OS X) or Settings (KDE, Windows) menu.

10.2 Spécification globale d’une projection

QGIS starts each new project using the global default projection. The global default CRS is EPSG:4326 - WGS 84
(proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs), and it comes predefined in QGIS. This
default can be changed via the [Select...] button in the first section, which is used to define the default coordinate
reference system for new projects, as shown in figure_projection_1. This choice will be saved for use in subsequent
QGIS sessions.

When you use layers that do not have a CRS, you need to define how QGIS responds to these layers. This can be
done globally or project-wide in the CRS tab under Settings → Options.

Les options montrées sur figure_projection_1 sont :

• Prompt for CRS

• Use project CRS
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Figure 10.1: CRS tab in the QGIS Options Dialog
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• Use default CRS displayed below

If you want to define the coordinate reference system for a certain layer without CRS information, you can also
do that in the General tab of the raster and vector properties dialog (see Onglet Général for rasters and Onglet
Général for vectors). If your layer already has a CRS defined, it will be displayed as shown in Vector Layer
Properties Dialog .

Astuce: SCR depuis la légende de la carte
Un clic-droit sur une couche dans la légende (section Map Legend) propose deux raccourcis concernant les SCR.
Définir le SCR de la couche ouvre directement la fenêtre de sélection de SCR (voir figure_projection_2). Définir
le SCR du projet depuis cette couche applique le SCR de la couche au projet.

10.3 Définir la projection à la volée

QGIS supports OTF reprojection for both raster and vector data. However, OTF is not activated by default. To use

OTF projection, you must activate the Enable on the fly CRS transformation checkbox in the CRS tab of the

Project Properties dialog.

Il y a trois manières de le faire :

1. Select Project Properties from the Project (Gnome, OSX) or Settings (KDE, Windows) menu.

2. Cliquer sur l’icône Statut de la projection depuis le coin inférieur droit de la barre d’état.

3. Choisir d’activer la projection à la volée par défaut en cochant la case Activer la reprojection ‘à la volée’
par défaut dans l’onglet SCR de la fenêtre des Options ou Activer automatiquement la projection à la volée
si les couches ont des SCR différents.

Si vous avez déjà chargé une couche, et désirez activer la projection à la volée, la meilleure façon de faire est
d’ouvrir l’onglet SCR de la fenêtre des Propriétés du projet, de sélectionner le SCR de la couche chargée, et de

cocher la case Activer la projection ‘à la volée’. L’icône Statut de la projection ne sera plus grisé et toutes les
couches chargées plus tard seront projetées à la volée dans le SCR défini qui apparait à gauche de l’icône.

L’onglet SCR de la fenêtre de Propriétés du projet contient cinq composants importants, comme indiqué sur la
figure Figure_projection_2 et décrit ci-dessous :

1. Activer la projection ‘à la volée’ — Cette case à cocher est utilisée pour activer ou désactiver la projection
à la volée. Lorsqu’elle est décochée, chaque couche est dessinée en utilisant les coordonnées lues dans la
source de données et les composants décrits ci-dessous sont inactifs. Lorsqu’elle est activée, les coordonnées
de chaque couche sont projetées dans le système de coordonnées de référence défini pour la carte.

2. Rechercher — Si vous connaissez le code EPSG, l’identifiant ou le nom d’un système de coordonnées de
référence, vous pouvez utiliser la fonction rechercher pour le retrouver. Entrez le code EPSG, l’identifiant
ou le nom à chercher.

3. système de coordonnées de référence récemment uilisés — Si vous utilisez certains SCR fréquemment
dans vos travaux quotidiens, ils seront affichés dans cette liste. Cliquez sur l’un d’entre eux pour sélectionner
le SCR du projet.

4. Coordinate reference systems of the world — This is a list of all CRSs supported by QGIS, including
Geographic, Projected and Custom coordinate reference systems. To define a CRS, select it from the list by
expanding the appropriate node and selecting the CRS. The active CRS is preselected.

5. Texte PROJ.4 — C’est la liste des paramètres décrivant le SCR telle qu’elle est utilisée par le moteur de
projection Proj4. Ce texte est en lecture seule et est fourni à titre informatif.

Astuce: Fenêtre Propriétés du projet
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Figure 10.2: Project Properties Dialog

Si vous ouvrez la fenêtre Propriétés du projet à partir du menu Projet, vous devez cliquer sur l’onglet SCR pour
voir les définitions des SCR.

Ouvrir la fenêtre à partir de l’icône Statut de la projection vous amènera directement dans l’onglet Système
de Coordonnées de Référence.

10.4 Système de Coordonnées de Référence personnalisé

If QGIS does not provide the coordinate reference system you need, you can define a custom CRS. To define a

CRS, select Custom CRS... from the Settings menu. Custom CRSs are stored in your QGIS user database. In
addition to your custom CRSs, this database also contains your spatial bookmarks and other custom data.

Defining a custom CRS in QGIS requires a good understanding of the PROJ.4 projection library. To begin, refer to
“Cartographic Projection Procedures for the UNIX Environment - A User’s Manual” by Gerald I. Evenden, U.S.
Geological Survey Open-File Report 90-284, 1990 (available at ftp://ftp.remotesensing.org/proj/OF90-284.pdf).

This manual describes the use of the proj.4 and related command line utilities. The cartographic parameters
used with proj.4 are described in the user manual and are the same as those used by QGIS.

La fenêtre Définir un système de coordonnées de référence personnalisé nécessite seulement deux paramètres pour
définir un SCR personnalisé :

1. Un nom descriptif

2. Les paramètres cartographiques au format PROJ.4.

To create a new CRS, click the Add new CRS button and enter a descriptive name and the CRS parameters.

Remarquez que les Paramètres doivent débuter par un bloc +proj= pour représenter le nouveau système de
coordonnées de référence.
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Figure 10.3: Custom CRS Dialog

Vous pouvez tester vos paramètres de SCR pour voir s’ils produisent des résultats valides. Entrez des latitude et
longitude connues en WGS 84 dans les champs Nord et Est respectivement. Cliquez sur le bouton [Calculer] et
comparez les résultats avec les valeurs connues dans votre système de coordonnées de référence.

10.5 Transformations géodésiques par défaut

OTF depends on being able to transform data into a ‘default CRS’, and QGIS uses WGS84. For some CRS there
are a number of transforms available. QGIS allows you to define the transformation used otherwise QGIS uses a
default transformation.

In the CRS tab under Settings → Options you can:

• set QGIS to ask you when it needs define a transformation using Ask for datum transformation when no
default is defined

• éditer une liste de transformations par défaut de l’utilisateur.

QGIS asks which transformation to use by opening a dialogue box displaying PROJ.4 text describing the source
and destination transforms. Further information may be found by hovering over a transform. User defaults can be
saved by selecting Remember selection.

.
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CHAPTER 11

QGIS Browser

The QGIS Browser is a panel in QGIS that lets you easily navigate in your filesystem and manage geodata. You
can have access to common vector files (e.g., ESRI shapefiles or MapInfo files), databases (e.g., PostGIS, Oracle,
SpatiaLite or MS SQL Spatial) and WMS/WFS connections. You can also view your GRASS data (to get the data
into QGIS, see Intégration du SIG GRASS).

Figure 11.1: QGIS browser as a stand alone application

Use the QGIS Browser to preview your data. The drag-and-drop function makes it easy to get your data into the
map view and the map legend.

1. Activate the QGIS Browser: Right-click on the toolbar and check Browser or select it from Settings →
Panels.

2. Drag the panel into the legend window and release it.

3. Click on the Browser tab.

4. Browse in your filesystem and choose the shapefile folder from qgis_sample_data directory.

5. Press the Shift key and select the airports.shp and alaska.shp files.

6. Press the left mouse button, then drag and drop the files into the map canvas.
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7. Right-click on a layer and choose Set project CRS from layer. For more information see Utiliser les projec-
tions.

8. Click on Zoom Full to make the layers visible.

There is a second browser available under Settings → Panels. This is handy when you need to move files or layers
between locations.

1. Activate a second QGIS Browser: Right-click on the toolbar and check Browser (2), or select it from
Settings → Panels.

2. Drag the panel into the legend window.

3. Navigate to the Browser (2) tab and browse for a shapefile in your file system.

4. Select a file with the left mouse button. Now you can use the Add Selected Layers icon to add it into the
current project.

QGIS automatically looks for the coordinate reference system (CRS) and zooms to the layer extent if you work
in a blank QGIS project. If there are already files in your project, the file will just be added, and in the case that
it has the same extent and CRS, it will be visualized. If the file has another CRS and layer extent, you must first
right-click on the layer and choose Set Project CRS from Layer. Then choose Zoom to Layer Extent.

The Filter files function works on a directory level. Browse to the folder where you want to filter files and enter
a search word or wildcard. The Browser will show only matching filenames – other data won’t be displayed.

It’s also possible to run the QGIS Browser as a stand-alone application.

Lancer l’explorateur QGIS

• Tapez “qbrowser” dans une console.

• Start the QGIS Browser using the Start menu or desktop shortcut.

• The QGIS Browser is available from your Applications folder.

In figure_browser_standalone_metadata, you can see the enhanced functionality of the stand-alone QGIS Browser.
The Param tab provides the details of your connection-based datasets, like PostGIS or MSSQL Spatial. The
Metadata tab contains general information about the file (see Onglet Métadonnées). With the Preview tab, you
can have a look at your files without importing them into your QGIS project. It’s also possible to preview the
attributes of your files in the Attributes tab.

.
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CHAPTER 12

Les données vectorielles

.

12.1 Formats de données gérés

QGIS uses the OGR library to read and write vector data formats, including ESRI shapefiles, MapInfo and Mi-
croStation file formats, AutoCAD DXF, PostGIS, SpatiaLite, Oracle Spatial and MSSQL Spatial databases, and
many more. GRASS vector and PostgreSQL support is supplied by native QGIS data provider plugins. Vector
data can also be loaded in read mode from zip and gzip archives into QGIS. As of the date of this document, 69
vector formats are supported by the OGR library (see OGR-SOFTWARE-SUITE in Bibliographie). The complete
list is available at http://www.gdal.org/ogr/ogr_formats.html.

Note: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries, or the GDAL/OGR installation of your OS may not have been built to support the format
you want to use. Only those formats that have been well tested will appear in the list of file types when loading a
vector into QGIS. Other untested formats can be loaded by selecting *.*.

Le travail sur des couches vectorielles GRASS est décrit dans la Section Intégration du SIG GRASS.

This section describes how to work with several common formats: ESRI shapefiles, PostGIS layers, SpatiaLite
layers, OpenStreetMap vectors, and Comma Separated data (CSV). Many of the features available in QGIS work
the same, regardless of the vector data source. This is by design, and it includes the identify, select, labeling and
attributes functions.

12.1.1 Shapefiles ESRI

The standard vector file format used in QGIS is the ESRI shapefile. Support is provided by the OGR Simple
Feature Library (http://www.gdal.org/ogr/).

Un shapefile est en réalité composé de plusieurs fichiers. Les trois suivants sont requis :

1. .shp fichier contenant la géométrie des entités.

2. .dbf fichier contenant les attributs au format dBase.

3. .shx fichier d’index.

Un shapefile inclus également un fichier ayant l’extension .prj qui contient les informations sur le système
de coordonnées. Bien que ces informations soient très utiles elles ne sont pas obligatoires. Il peut y avoir
encore d’autres fichiers associés aux données shapefile. Si vous souhaitez avoir plus de détails, nous vous
recommandons de vous reporter aux spécifications techniques du format shapefile, qui se trouve notamment sur
http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.
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Loading a Shapefile

To load a shapefile, start QGIS and click on the Add Vector Layer toolbar button, or simply press Ctrl+Shift+V.
This will bring up a new window (see figure_vector_1).

Figure 12.1: Add Vector Layer Dialog

From the available options check File. Click on [Browse]. That will bring up a standard open file dialog (see
figure_vector_2), which allows you to navigate the file system and load a shapefile or other supported data source.

The selection box Filter allows you to preselect some OGR-supported file formats.

You can also select the encoding for the shapefile if desired.

Selecting a shapefile from the list and clicking [Open] loads it into QGIS. Figure_vector_3 shows QGIS after
loading the alaska.shp file.

Astuce: Couleur des couches
Quand vous ajoutez une couche sur une carte, une couleur aléatoire lui est assignée. En ajoutant plusieurs couches
en une fois, différentes couleurs sont assignées à chacune des couches.

Once a shapefile is loaded, you can zoom around it using the map navigation tools. To change the style of a layer,
open the Layer Properties dialog by double clicking on the layer name or by right-clicking on the name in the
legend and choosing Properties from the context menu. See section Onglet Style for more information on setting
symbology of vector layers.

Astuce: Charger une couche et un projet depuis un lecteur externe sous OS X
Sous OS X, les lecteurs portables qui sont montés à côté du disque dur primaire n’apparaissent pas dans Fichier
→ Ouvrir un Projet. Nous travaillons sur le support des fenêtres d’ouverture/enregistrement natives d’OS X pour
résoudre ce problème. Pour y pallier, vous pouvez taper /Volumes dans la boîte Nom de fichier et appuyer sur
Entrée. Vous pouvez ensuite parcourir les lecteurs externes et réseaux montés.

Improving Performance for Shapefiles

To improve the performance of drawing a shapefile, you can create a spatial index. A spatial index will improve
the speed of both zooming and panning. Spatial indexes used by QGIS have a .qix extension.

Voici les étapes de création d’un index spatial :

• Load a shapefile by clicking on the Add Vector Layer toolbar button or pressing Ctrl+Shift+V.
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Figure 12.2: Open an OGR Supported Vector Layer Dialog

Figure 12.3: QGIS with Shapefile of Alaska loaded
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• Ouvrez la fenêtre Propriétés de la Couche en double-cliquant sur le nom de la couche dans la légende ou
en faisant un clic droit et en choisissant Propriétés dans le menu qui apparait.

• Dans l’onglet Général, cliquez sur le bouton [Créer un index spatial].

Problem loading a shape .prj file

If you load a shapefile with a .prj file and QGIS is not able to read the coordinate reference system from that
file, you will need to define the proper projection manually within the General tab of the Layer Properties dialog
of the layer by clicking the [Specify...] button. This is due to the fact that .prj files often do not provide the
complete projection parameters as used in QGIS and listed in the CRS dialog.

For the same reason, if you create a new shapefile with QGIS, two different projection files are created: a .prj
file with limited projection parameters, compatible with ESRI software, and a .qpj file, providing the complete
parameters of the used CRS. Whenever QGIS finds a .qpj file, it will be used instead of the .prj.

12.1.2 Loading a MapInfo Layer

To load a MapInfo layer, click on the Add Vector Layer toolbar button; or type Ctrl+Shift+V, change the

file type filter Files of type : to ‘Mapinfo File [OGR] (*.mif *.tab *.MIF *.TAB)’ and select the MapInfo
layer you want to load.

12.1.3 Loading an ArcInfo Binary Coverage

To load an ArcInfo Binary Coverage, click on the Add Vector Layer toolbar button or press Ctrl+Shift+V
to open the Add Vector Layer dialog. Select Directory as Source type. Change the file type filter Files of type

to ‘Arc/Info Binary Coverage’. Navigate to the directory that contains the coverage file, and select it.

Similarly, you can load directory-based vector files in the UK National Transfer Format, as well as the raw TIGER
Format of the US Census Bureau.

12.1.4 Fichiers de Texte Délimité

Les données séparées par des tabulations sont utilisées très couramment pour leur simplicité et leur lisibilité, les
données pouvant être lues et modifiées dans un éditeur de texte basique. Les données séparées par un délimiteur
sont écrites par lignes dans lesquelles les données sont séparées par un caractère défini (virgule, point-virgule,
espace, etc) La première ligne contient généralement le nom des colonnes. Le CSV (Comma Separated Values =
Données Séparées par une Virgule) est très courant.

De tels fichiers de données peuvent aussi contenir des informations de positionnement dans deux formes dif-
férentes :

• Avec des coordonnées de points en colonnes séparées

• Avec une représentation well-known text (WKT) de la géométrie

QGIS allows you to load a delimited text file as a layer or ordinal table. But first check that the file meets the
following requirements:

1. Le fichier doit avoir une ligne d’entête délimitée avec les noms des champs. Il doit s’agir de la première
ligne du fichier.

2. La ligne d’entête doit contenir un ou plusieurs champs stockant la géométrie. Ils peuvent porter n’importe
quel nom.

3. Les coordonnées X et Y doivent être de type numérique (si la géométrie est définie par des coordonnées).
Le système de coordonnées n’est pas important.
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As an example of a valid text file, we import the elevation point data file elevp.csv that comes with the QGIS
sample dataset (see section Échantillon de données):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Notons les points suivants à propos du fichier texte :

1. Le fichier texte d’exemple utilise le ; comme délimiteur. N’importe quel caractère peut être utilisé comme
délimiteur de champ.

2. La première ligne est la ligne d’entête. Elle contient les champs X, Y et ELEV.

3. Aucun guillemet (") n’est utilisé pour délimiter les champs textes.

4. Les coordonnées X sont stockées dans le champ X.

5. Les coordonnées Y sont stockées dans le champ Y.

Charger un fichier texte délimité

Click the toolbar icon Add Delimited Text Layer in the Manage layers toolbar to open the Create a Layer from a
Delimited Text File dialog, as shown in figure_delimited_text_1.

Figure 12.4: Delimited Text Dialog

First, select the file to import (e.g., qgis_sample_data/csv/elevp.csv) by clicking on the [Browse]
button. Once the file is selected, QGIS attempts to parse the file with the most recently used delimiter. To
enable QGIS to properly parse the file, it is important to select the correct delimiter. You can specify a delimiter
by activating Custom delimiters, or by activating Regular expression delimiter and entering text into the
Expression field. For example, to change the delimiter to tab, use \t (this is a regular expression for the tab
character).

Once the file is parsed, set Geometry definition to Point coordinates and choose the X and Y fields from the

dropdown lists. If the coordinates are defined as degrees/minutes/seconds, activate the DMS coordinates
checkbox.
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Finally, enter a layer name (e.g., elevp), as shown in figure_delimited_text_1. To add the layer to the map, click
[OK]. The delimited text file now behaves as any other map layer in QGIS.

Il y a aussi une option qui vous aide à supprimer les espaces de début et de fin des champs, à savoir Réduire

les champs. Vous pouvez aussi Ignorer les champs vides dans chaque enregistrement ou si nécessaire, définir

la Virgule en séparateur décimal.

If spatial information is represented by WKT, activate the Well Known Text option and select the field with the
WKT definition for point, line or polygon objects. If the file contains non-spatial data, activate No geometry
(attribute only table) and it will be loaded as an ordinal table.

Additionaly, you can enable:

• Index spatial pour améliorer les performances d’affichage et de sélection spatiale des entités.

• Index des sous-ensembles.

• Watch file to watch for changes to the file by other applications while QGIS is running.

12.1.5 Données OpenStreetMap

In recent years, the OpenStreetMap project has gained popularity because in many countries no free geodata such
as digital road maps are available. The objective of the OSM project is to create a free editable map of the world
from GPS data, aerial photography or local knowledge. To support this objective, QGIS provides suppport for
OSM data.

Charger des vecteurs OpenStreetMap

QGIS integrates OpenStreetMap import as a core functionality.

• Pour vous connecter au serveur OSM et télécharger des données, ouvrez le menu Vecteur → OpenStreetMap
→ Télécharger des données OSM.... Vous pouvez ignorer cette étape si vous avez déjà obtenu un fichier
XML .osm à l’aide du logiciel JOSM, de l’Overpass API ou de toute autre source.

• Le menu Vecteur → OpenStreetMap → Importer la topologie depuis un XML... convertira votre fichier .osm
en une base de données Spatialite, et créera la connexion à la base.

• The menu Vector → Openstreetmap → Export topology to SpatiaLite then allows you to open the database
connection, select the type of data you want (points, lines, or polygons) and choose tags to import. This

creates a SpatiaLite geometry layer that you can add to your project by clicking on the Add SpatiaLite Layer

toolbar button or by selecting the Add SpatiaLite Layer... option from the Layer menu (see section
Couches SpatiaLite).

12.1.6 Couches PostGIS

PostGIS layers are stored in a PostgreSQL database. The advantages of PostGIS are the spatial indexing, filter-
ing and query capabilities it provides. Using PostGIS, vector functions such as select and identify work more
accurately than they do with OGR layers in QGIS.

Créer une connexion enregistrée

The first time you use a PostGIS data source, you must create a connection to the PostgreSQL database that

contains the data. Begin by clicking on the Add PostGIS Layer toolbar button, selecting the Add PostGIS
Layer... option from the Layer menu, or typing Ctrl+Shift+D. You can also open the Add Vector Layer dialog
and select Database. The Add PostGIS Table(s) dialog will be displayed. To access the connection manager,
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click on the [New] button to display the Create a New PostGIS Connection dialog. The parameters required for a
connection are:

• Nom : Un nom pour cette connexion. Il peut être identique à Base de données.

• Service : Paramètre de service à utiliser en alternative à l’hôte et le port (et potentiellement la base de
données). Il peut être défini dans pg_service.conf.

• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Port : numéro de port que le serveur de base de données PostgreSQL écoute. Le port par défaut est 5432.

• Base de données : nom de la base de données.

• SSL mode: How the SSL connection will be negotiated with the server. Note that massive speedups in
PostGIS layer rendering can be achieved by disabling SSL in the connection editor. The following options
are available:

– Désactive : Essaye uniquement une connexion SSL non cryptée.

– Permet : Essaye une connexion non-SSL. En cas d’échec, essaye une connexion SSL.

– Préfère (par défaut) : Essaye une connexion SSL. En cas d’échec, essaye une connexion non-SSL.

– Requiert : Essaye uniquement une connexion SSL.

• Nom d’utilisateur : Nom d’utilisateur utilisé pour se connecter à la base de données.

• Mot de passe : mot de passe associé au Nom d’utilisateur pour se connecter à la base de données.

Vous pouvez également activer les options suivantes :

• Enregistrer le nom d’utilisateur

• Enregistrer le mot de passe

• Ne regarder que dans la table geometry_columns

• Ne pas résoudre le type pour les géométries non restreintes (GEOMETRY)

• Ne regarder que dans le schéma ‘public’

• Lister les tables sans géométrie

• Utiliser la table des métadonnées estimées

Une fois que tous les paramètres et les options sont définis, vous pouvez tester la connexion en cliquant sur le
bouton [Test la connexion].

Charger une couche PostGIS

Once you have one or more connections defined, you can load layers from the PostgreSQL database. Of
course, this requires having data in PostgreSQL. See section Importer des données dans PostgreSQL for a discus-
sion on importing data into the database.

Pour charger une couche PostGIS, suivez ces étapes :

• If the Add PostGIS layers dialog is not already open, selecting the Add PostGIS Layer... option from the
Layer menu or typing Ctrl+Shift+D opens the dialog.

• Choisissez la connexion dans la liste déroulante et cliquez sur [Connecter].

• Cochez ou décochez selon votre besoin Lister les tables sans géométrie
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• Utilisez si besoin des Options de recherche pour définir quelles entités charger ou utilisez le bouton
[Construire une requête] pour ouvrir la fenêtre Construction de requête.

• Trouvez la ou les couches que vous souhaitez ajouter dans la liste des couches disponibles.

• Sélectionnez-la en cliquant dessus. Vous pouvez sélectionner plusieurs couches en maintenant la touche
Shift enfoncée quand vous cliquez. Référez-vous à la section Constructeur de requête pour plus
d’informations sur l’utilisation du Constructeur de requête de PostgreSQL pour mieux définir la couche.

• Cliquez sur le bouton [Ajouter] pour ajouter la couche à la carte.

Astuce: Couches PostGIS
Normally, a PostGIS layer is defined by an entry in the geometry_columns table. From version 0.9.0 on, QGIS
can load layers that do not have an entry in the geometry_columns table. This includes both tables and views.
Defining a spatial view provides a powerful means to visualize your data. Refer to your PostgreSQL manual for
information on creating views.

Quelques éléments de détail à propos des couches PostgreSQL

This section contains some details on how QGIS accesses PostgreSQL layers. Most of the time, QGIS should
simply provide you with a list of database tables that can be loaded, and it will load them on request. However,
if you have trouble loading a PostgreSQL table into QGIS, the information below may help you understand any
QGIS messages and give you direction on changing the PostgreSQL table or view definition to allow QGIS to
load it.

QGIS requires that PostgreSQL layers contain a column that can be used as a unique key for the layer. For tables,
this usually means that the table needs a primary key, or a column with a unique constraint on it. In QGIS, this
column needs to be of type int4 (an integer of size 4 bytes). Alternatively, the ctid column can be used as primary
key. If a table lacks these items, the oid column will be used instead. Performance will be improved if the column
is indexed (note that primary keys are automatically indexed in PostgreSQL).

If the PostgreSQL layer is a view, the same requirement exists, but views do not have primary keys or columns
with unique constraints on them. You have to define a primary key field (has to be integer) in the QGIS dialog
before you can load the view. If a suitable column does not exist in the view, QGIS will not load the layer. If this
occurs, the solution is to alter the view so that it does include a suitable column (a type of integer and either a
primary key or with a unique constraint, preferably indexed).

QGIS offers a checkbox Select at id that is activated by default. This option gets the ids without the attributes
which is faster in most cases. It can make sense to disable this option when you use expensive views.

Astuce: Sauvegarde d’une base de données PostGIS ayant des couches sauvées par QGIS
If you want to make a backup of your PostGIS database using the pg_dump and pg_restore commands
the default layer styles as saved by QGIS are failing to restore afterwards. You need to set the XML option to
DOCUMENT and the restore will work.

12.1.7 Importer des données dans PostgreSQL

Data can be imported into PostgreSQL/PostGIS using several tools, including the SPIT plugin and the command
line tools shp2pgsql and ogr2ogr.

DB Manager

QGIS comes with a core plugin named DB Manager. It can be used to load shapefiles and other data formats, and
it includes support for schemas. See section Extension DB Manager for more information.
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shp2pgsql

PostGIS intègre un utilitaire nommé shp2pgsql qui peut être utilisé pour importer des shapefiles dans une base
de données PostgreSQL/PostGIS. Par exemple, pour importer un shapefile nommé lakes.shp dans une base
PostgreSQL nommé gis_data, utilisez la commande suivante :

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

Ceci crée une nouvelle couche nommée lakes_new dans la base de données gis_data. La nouvelle couche
aura l’identifiant de référence spatiale (SRID) 2964. Référez-vous à la section Utiliser les projections pour plus
d’informations sur les systèmes de référence spatiale et les projections.

Astuce: Exporter des jeux de données depuis PostGIS
De la même manière que l’outil d’importation shp2pgsql, il y a également un outil d’exportation de jeux de
données PostGIS en shapefile : pgsql2shp. Cet outil est inclus dans la distribution de PostGIS.

ogr2ogr

En plus de shp2pgsql et DB Manager, un autre outil est fourni pour importer des données géographiques dans
PostGIS : ogr2ogr. Il est inclus dans GDAL.

Pour importer un shapefile dans PostGIS, lancez la commande suivante :

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

Ceci va importer le shapefile alaska.shp dans la base de données PostGIS nommée postgis en utilisant
l’utilisateur postgres avec le mot de passe topsecret sur l’hôte myhost.de.

Notez qu’OGR doit être compilé avec PostgreSQL pour gérer PostGIS. Vous pouvez le vérifier en tapant (sous
):

ogrinfo --formats | grep -i post

Si vous préférez utiliser la commande COPY de PostgreSQL au lieu de la méthode INSERT INTO par défaut,

vous pouvez exporter la variable d’environnement suivante (au moins sur et ):

export PG_USE_COPY=YES

ogr2ogr ne crée pas d’index spatial comme le fait shp2pgsl. Vous devez donc effectuer une étape supplémentaire
en le créant manuellement avec la commande SQL classique CREATE INDEX (comme détaillé dans la section
suivante Améliorer les performances).

Améliorer les performances

Retrieving features from a PostgreSQL database can be time-consuming, especially over a network. You can
improve the drawing performance of PostgreSQL layers by ensuring that a PostGIS spatial index exists on
each layer in the database. PostGIS supports creation of a GiST (Generalized Search Tree) index to speed
up spatial searches of the data (GiST index information is taken from the PostGIS documentation available at
http://postgis.refractions.net).

La syntaxe pour créer un index GiST est la suivante :

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Notez que pour de grandes tables, créer un index peut prendre du temps. Une fois cet index créé, vous devriez
faire une VACUUM ANALYZE. Référez-vous à la documentation de PostGIS (POSTGIS-PROJECT Bibliographie)
pour plus d’informations.
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Voici un exemple de création d’un index GiST :

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

12.1.8 Couches vectorielles dépassant les 180° de longitude

Many GIS packages don’t wrap vector maps with a geographic reference system (lat/lon) crossing the 180 degrees
longitude line (http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html). As result, if
we open such a map in QGIS, we will see two far, distinct locations, that should appear near each other. In
Figure_vector_4, the tiny point on the far left of the map canvas (Chatham Islands) should be within the grid, to
the right of the New Zealand main islands.

Figure 12.5: Map in lat/lon crossing the 180° longitude line

Une solution est de transformer les valeurs longitudinales en utilisant PostGIS et la fonction ST_Shift_Longitude.
Cette fonction lit chaque point/sommet de chacune des entités dans une géométrie et si la coordonnée de longitude
est inférieure à 0°, elle lui ajoute 360°. Le résultat est une version 0° - 360° des données sur une carte centrée à
180°.

Figure 12.6: Traversée de la longitude 180° en utilisant la fonction ST_Shift_Longitude
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Usage

• Importer des données dans PostGIS (Importer des données dans PostgreSQL) en utilisant, par exemple,
l’extension DB Manager.

• Utiliser l’interface en ligne de commande PostGIS pour exécuter la commande suivante (dans cet
exemple, “TABLE” est bien le nom de votre table PostGIS): gis_data=# update TABLE set
the_geom=ST_Shift_Longitude(the_geom);

• Si tout s’est bien passé, vous devriez recevoir une confirmation sur le nombre d’entités qui ont été mises à
jour. Ensuite, vous pouvez charger la carte et voir la différence (Figure_vector_5).

12.1.9 Couches SpatiaLite

The first time you load data from a SpatiaLite database, begin by clicking on the Add SpatiaLite Layer

toolbar button, or by selecting the Add SpatiaLite Layer... option from the Layer menu, or by typing
Ctrl+Shift+L. This will bring up a window that will allow you either to connect to a SpatiaLite database
already known to QGIS, which you can choose from the drop-down menu, or to define a new connection to a new
database. To define a new connection, click on [New] and use the file browser to point to your SpatiaLite database,
which is a file with a .sqlite extension.

Si vous souhaitez sauvegarder une couche vecteur au format SpatiaLite, vous pouvez le faire par un clic-droit sur
la couche dans la légende. Cliquez ensuite sur Enregistrer sous..., définissez le nom du fichier et le SCR en sortie,
choisisez ‘SpatiaLite’ comme format. Vous pouvez également sélectionner ‘SQLite’ comme format et ajouter
SPATIALITE=YES comme source de données dans les options OGR de création. OGR crée alors une base de
données SpatiaLite. Voir également http://www.gdal.org/ogr/drv_sqlite.html.

QGIS also supports editable views in SpatiaLite.

Créer une nouvelle couche SpatiaLite

Si vous souhaitez créer une nouvelle couche SpatiaLite, référez-vous à la section Créer une nouvelle couche
SpatiaLite.

Astuce: Extensions de gestion de données SpatiaLite
For SpatiaLite data management, you can also use several Python plugins: QSpatiaLite, SpatiaLite Manager or
DB Manager (core plugin, recommended). If necessary, they can be downloaded and installed with the Plugin
Installer.

12.1.10 Couches MSSQL Spatial

QGIS also provides native MS SQL 2008 support. The first time you load MSSQL Spatial data, begin by

clicking on the Add MSSQL Spatial Layer toolbar button or by selecting the Add MSSQL Spatial Layer... option
from the Layer menu, or by typing Ctrl+Shift+M.

12.1.11 Couches Oracle Spatial

The spatial features in Oracle Spatial aid users in managing geographic and location data in a native type within
an Oracle database. QGIS now has support for such layers.
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Créer une connexion enregistrée

The first time you use an Oracle Spatial data source, you must create a connection to the database that

contains the data. Begin by clicking on the Add Orcale Spatial Layer toolbar button, selecting the Add Orcale
Spatial Layer... option from the Layer menu, or typing Ctrl+Shift+O. To access the connection manager, click
on the [New] button to display the Create a New Oracle Spatial Connection dialog. The parameters required for
a connection are:

• Nom : Un nom pour cette connexion. Il peut être identique à Base de données.

• Base de données : SID ou SERVICE_NAME de l’instance Oracle.

• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Port : numéro de port que le serveur de base de données Oracle écoute. Le port par défaut est 1521.

• Nom d’utilisateur : Nom d’utilisateur utilisé pour se connecter à la base de données.

• Mot de passe : mot de passe associé au Nom d’utilisateur pour se connecter à la base de données.

Vous pouvez également activer les options suivantes :

• Enregistrer le nom d’utilisateur indique s’il faut ou non sauvegarder le nom de l’utilisateur de la base
de données dans la configuration de la connexion.

• Enregistrer le mot de passe indique s’il faut ou non sauvegarder le mot de passe de connexion à la base
de données dans les paramètres de connexion.

• Chercher uniquement dans la table de métadonnées restreint la liste des tables affichées à celles qui sont
dans la vue all_sdo_geom_metadata. Ceci peut accélerer l’affichage initial des tables spatiales.

• Chercher uniquement les tables de l’utilisateur limite la recherche des tables spatiales à celles dont
l’utilisateur est propriétaire.

• Lister les tables sans géométries indique que les tables sans géométrie seront aussi listées par défaut.

• Utilisez la table de métadonnées estimées quand la couche est définie, plusieurs métadonnées sont
nécessaires pour la table Oracle. Cela inclut des informations sur le nombre de lignes de la table, le type
de géométrie et l’étendue spatiale des données pour la colonne géométrique. Si cette table contient un
grand nombre de lignes, déterminer cette métadonnée est coûteuse en temps. En activant cette option, les
opérations rapides suivantes sur les métadonnées de la table sont réalisées : le décompte des lignes est
réalisé à partir de all_tables.num_rows. Les étendues des tables sont toujours déterminées avec la
fonction SDO_TUNE.EXTENTS_OF même si un filtre est appliqué sur la couche. La géométrie de la table
est déterminée à partir des 100 premières lignes dans la table.

• Seulement les types de géométrie existants liste seulement les types géométriques existants et ne permet
pas d’ajouter les autres.

Une fois que tous les paramètres et les options sont définis, vous pouvez tester la connexion en cliquant sur le
bouton [Test la connexion].

Astuce: Paramètres utilisateur de QGIS et Sécurité
Depending on your computing environment, storing passwords in your QGIS settings may be a security risk.
Passwords are saved in clear text in the system configuration and in the project files! Your customized settings for
QGIS are stored based on the operating system:

• Les paramètres sont stockés dans votre répertoire home dans ~/.qgis2.

• Les paramètres sont stockés dans la base de registre.
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Charger une couche Oracle Spatial

Once you have one or more connections defined, you can load layers from the Oracle database. Of course,
this requires having data in Oracle.

Pour charger une couche Oracle Spatial, suivez ces étapes :

• If the Add Oracle Spatial layers dialog is not already open, click on the Add Oracle Spatial Layer toolbar
button.

• Choisissez la connexion dans la liste déroulante et cliquez sur [Connecter].

• Cochez ou décochez selon votre besoin Lister les tables sans géométrie

• Utilisez si besoin des Options de recherche pour définir quelles entités charger ou utilisez le bouton
[Construire une requête] pour ouvrir la fenêtre Construction de requête.

• Trouvez la ou les couches que vous souhaitez ajouter dans la liste des couches disponibles.

• Sélectionnez-la en cliquant dessus. Vous pouvez sélectionner plusieurs couches en gardant la touche Shift
enfoncée quand vous cliquez. Référez-vous à la section Constructeur de requête pour plus d’informations
sur l’utilisation du Constructeur de requête d’Oracle pour mieux définir la couche.

• Cliquez sur le bouton [Ajouter] pour ajouter la couche à la carte.

Astuce: Couches Oracle Spatial
Normalement, une couche Oracle Spatial est définie par une entrée dans la table USER_SDO_METADATA.

.

12.2 Le Gestionnaire de symboles

12.2.1 Presentation

The Symbol Library is the place where users can create generic symbols to be used in several QGIS projects. It
allows users to export and import symbols, groups symbols and add, edit and remove symbols. You can open it
with the Settings → Style Library or from the Style tab in the vector layer’s Properties.

Share and import symbols

Users can export and import symbols in two main formats: qml (QGIS format) and SLD (OGC standard). Note
that SLD format is not fully supported by QGIS.

share item displays a drop down list to let the user import or export symbols.

Groupes et groupes intelligents

Groups are categories of Symbols and smart groups are dynamic groups.

To create a group, right-click on an existing group or on the main Groups directory in the left of the library. You

can also select a group and click on the add item button.

To add a symbol into a group, you can either right click on a symbol then choose Apply group and then the group

name added before. There is a second way to add several symbols into group: just select a group and click
and choose Group Symbols. All symbols display a checkbox that allow you to add the symbol into the selected
groups. When finished, you can click on the same button, and choose Finish Grouping.
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Create Smart Symbols is similar to creating group, but instead select Smart Groups. The dialog box allow user
to choose the expression to select symbols in order to appear in the smart group (contains some tags, member of
a group, have a string in its name, etc.)

Add, edit, remove symbol

With the Style manager from the [Symbol] menu you can manage your symbols. You can add item,
edit item, remove item and share item. ‘Marker’ symbols, ‘Line’ symbols, ‘Fill’ patterns and ‘colour ramps’

can be used to create the symbols. The symbols are then assigned to ‘All Symbols’, ‘Groups’ or ‘Smart groups’.

Pour chaque type de symboles, vous trouverez toujours le même type de fenêtre :

• at the top left side a symbol representation

• under the symbol representation the symbol tree show the symbol layers

• at the right you can setup some parameter (unit,transparency, color, size and rotation)

• under these parameters you find some symbol from the symbols library

The symbol tree allow adding, removing or protect new simple symbol. You can move up or down the symbol
layer.

More detailed settings can be made when clicking on the second level in the Symbol layers dialog. You can define
Symbol layers that are combined afterwards. A symbol can consist of several Symbol layers. Settings will be
shown later in this chapter.

Astuce: Note that once you have set the size in the lower levels of the Symbol layers dialog, the size of the
whole symbol can be changed with the Size menu in the first level again. The size of the lower levels changes
accordingly, while the size ratio is maintained.

12.2.2 Symboles ponctuels

Les symboles ponctuels peuvent être de plusieurs types :

• Symbole d’ellipse

• Symbole de police

• Symbole simple (par défaut)

• Symbole SVG

• Symbole de champ vectoriel

The following settings are possible:

• Type de symbole : Vous avez le choix entre Symbole d’ellipse, Symbole de police, Symbole simple, Symbole
SVG et Symbole de champ vectoriel.

• Couleurs

• Taille

• Style de bordure externe

• Largeur de bordure externe

• Angle

• Décalage X,Y : vous pouvez déplacer les symboles en x ou y.

• Point d’ancrage

• Source de définition des propriétés ...
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12.2.3 Symboles de ligne

Les symboles de ligne n’ont que de deux types possibles :

• Ligne de symboles

• Ligne simple (par défaut)

The default symbol layer type draws a simple line whereas the other display a marker point regularly on the line.
You can choose different location vertex, interval or central point. Marker line can have offset along the line or
offset line. Finally, rotation allows you to change the orientation of the symbol.

The following settings are possible:

• couleur

• Épaisseur

• Décalage

• Style de ligne

• Style de jointure

• Style de fin de ligne

• Utiliser un modèle de tiret personnalisé

• Unité du tiret

• Source de définition des propriétés ...

12.2.4 Symboles de polygone

Les symboles de polygones peuvent également être de plusieurs types :

• Remplissage de centroïde

• Remplissage en dégradé

• Motif de ligne

• Motif de point

• Remplissage image raster

• Remplissage SVG

• Remplissage dégradé suivant la forme

• Remplissage simple (par défaut)

• Bordure : Ligne de symboles (même principe que pour les symboles de ligne)

• Bordure : Ligne simple (même principe que pour les symboles de ligne)

The following settings are possible:

• Couleurs : pour la bordure et le remplissage.

• Style de remplissage

• Style de la bordure

• Largeur de bordure

• Décalage X, Y

• Source de définition des propriétés ...
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Using the color combo box, you can drag and drop color for one color button to another button, copy-paste color,
pick color from somewhere, choose a color from the palette or from recent or standard color. The combo box
allow you to fill in the feature with transparency. You can also just click on the button to open the palettte dialog.
Note that you can import color from some external software like GIMP.

Avec le ‘Remplissage image par raster’ vous pouvez remplir les polygones avec une image raster tuilée. Les
options comprennent le nom de fichier, l’opacité, la taille de l’image (en pixels, mm ou unités cartographiques),
le mode de coordonnées (entité ou vue) et la rotation (toutes pouvant être définies par les données).

‘Gradient Fill’ Symbol layer type allows you to select between a Two color and Color ramp setting. You

can use the Feature centroid as Referencepoint. All fills ‘Gradient Fill‘ Symbol layer type is also available
through the Symbol menu of the Categorized and Graduated Renderer and through the Rule properties menu of
the Rule-based renderer. Other possibility is to choose a ‘shapeburst fill’ which is a buffered gradient fill, where a
gradient is drawn from the boundary of a polygon towards the polygon’s centre. Configurable parameters include
distance from the boundary to shade, use of color ramps or simple two color gradients, optional blurring of the fill
and offsets.

Il est possible de ne tracer les bordures d’un polygone qu’à l’intérieur du polygone. En utilisant ‘Bordure : Ligne

simple’ sélectionnez Dessiner la ligne seulement dans le polygone.

12.2.5 Color ramp

You can create a custom color ramp choosing New color ramp... from the color ramp drop-down menu. A dialog
will prompt for the ramp type: Gradient, Random, colorBrewer, or cpt-city. The first three have options for number

of steps and/or multiple stops in the color ramp. You can use the Invert option while classifying the data with
a color ramp. See figure_symbology_3 for an example of custom color ramp and figure_symbology_3a for the
cpt-city dialog.

Figure 12.7: Example of custom gradient color ramp with multiple stops

Le type cpt-city ouvre une fenêtre qui permet de choisir parmi des centaines de palettes prédéfinies.

.
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Figure 12.8: cpt-city dialog with hundreds of color ramps
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12.3 Fenêtre Propriétés d’une couche vecteur

The Layer Properties dialog for a vector layer provides information about the layer, symbology settings and
labeling options. If your vector layer has been loaded from a PostgreSQL/PostGIS datastore, you can also alter
the underlying SQL for the layer by invoking the Query Builder dialog on the General tab. To access the Layer
Properties dialog, double-click on a layer in the legend or right-click on the layer and select Properties from the
pop-up menu.

Figure 12.9: Vector Layer Properties Dialog

12.3.1 Onglet Style

The Style menu provides you with a comprehensive tool for rendering and symbolizing your vector data. You can
use Layer rendering → tools that are common to all vector data, as well as special symbolizing tools that were
designed for the different kinds of vector data.

Renderers

The renderer is responsible for drawing a feature together with the correct symbol. There are four types of
renderers: single symbol, categorized, graduated and rule-based. There is no continuous color renderer, because it
is in fact only a special case of the graduated renderer. The categorized and graduated renderers can be created by
specifying a symbol and a color ramp - they will set the colors for symbols appropriately. For point layers, there
is a point displacement renderer available. For each data type (points, lines and polygons), vector symbol layer
types are available. Depending on the chosen renderer, the Style menu provides different additional sections. On
the bottom right of the symbology dialog, there is a [Symbol] button, which gives access to the Style Manager
(see Presentation). The Style Manager allows you to edit and remove existing symbols and add new ones.
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After having made any needed changes, the symbol can be added to the list of current style symbols (using

[Symbol] Save in symbol library), and then it can easily be used in the future. Furthermore, you can use

the [Save Style] button to save the symbol as a QGIS layer style file (.qml) or SLD file (.sld). SLDs can be
exported from any type of renderer – single symbol, categorized, graduated or rule-based – but when importing
an SLD, either a single symbol or rule-based renderer is created. That means that categorized or graduated styles
are converted to rule-based. If you want to preserve those renderers, you have to stick to the QML format. On the
other hand, it can be very handy sometimes to have this easy way of converting styles to rule-based.

Si, en travaillant sur le style d’une couche vectorielle, vous changez de mode de rendu, les changements effectués
sur le symbole sont mémorisés. Notez que cela ne fonctionne qu’une seule fois. Si vous changez à nouveau de
mode de rendu, les paramètres seront perdus.

If the datasource of the layer is a database (PostGIS or Spatialite for example), you can save your layer style inside
a table of the database. Just click on Save Style comboxbox and choose Save in database item then fill in the
dialog to define a style name, add a description, an ui file and if the style is a default style. When loading a layer
from the database, if a style already exists for this layer, QGIS will load the layer and its style. You can add several
style in the database. Only one will be the default style anyway.

Figure 12.10: Save Style in database Dialog

Astuce: Sélectionner et modifier plusieurs symboles
Il est possible de sélectionner plusieurs symboles, de faire un clic-droit dessus et de changer en une seule opération
leur couleur, leur transparence, leur taille ou leur épaisseur.

Single Symbol Renderer

The Single Symbol Renderer is used to render all features of the layer using a single user-defined symbol. The
properties, which can be adjusted in the Style menu, depend partially on the type of layer, but all types share the
following dialog structure. In the top-left part of the menu, there is a preview of the current symbol to be rendered.
On the right part of the menu, there is a list of symbols already defined for the current style, prepared to be used
by selecting them from the list. The current symbol can be modified using the menu on the right side. If you
click on the first level in the Symbol layers dialog on the left side, it’s possible to define basic parameters like Size,
Transparency, color and Rotation. Here, the layers are joined together.

In any spinbox in this dialog you can enter expressions. E.g. you can calculate simple math like multiplying the
existing size of a point by 3 without resorting to a calculator.

If you click on the second level in the Symbol layers dialog a ‘Data-defined override’ for nearly all settings is
possible. When using a data-defined color one may want to link the color to a field ‘budged’. Here a comment
functionality is inserted.

/* This expression will return a color code depending on the field value.

* Negative value: red

* 0 value: yellow

* Positive value: green
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Figure 12.11: Single symbol line properties

Figure 12.12: Expression in Size spinbox
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*/
CASE

WHEN value < 0 THEN ’#DC143C’ -- Negative value: red
WHEN value = 0 THEN ’#CCCC00’ -- Value 0: yellow
ELSE ’#228B22’ -- Positive value: green

END

static/user_manual/working_with_vector/symbol_data_defined_edit.png

Figure 12.13: Data-defined symbol with Edit... menu

Categorized Renderer

The Categorized Renderer is used to render all features from a layer, using a single user-defined symbol whose
color reflects the value of a selected feature’s attribute. The Style menu allows you to select:

• The attribute (using the Column listbox or the Set column expression function, see Expressions)

• The symbol (using the Symbol dialog)

• The colors (using the color Ramp listbox)

Then click on Classify button to create classes from the distinct value of the attribute column. Each classes can
be disabled unchecking the checkbox at the left of the class name.

You can change symbol, value and/or label of the class, just double click on the item you want to change.

Un clic-droit vous propose de Copier / Coller, Modifier la couleur, Modifier la transparence, Modifier l’unité
de sortie ou Modifier la taille.

The [Advanced] button in the lower-right corner of the dialog allows you to set the fields containing rotation and
size scale information. For convenience, the center of the menu lists the values of all currently selected attributes
together, including the symbols that will be rendered.

The example in figure_symbology_6 shows the category rendering dialog used for the rivers layer of the QGIS
sample dataset.

Graduated Renderer

The Graduated Renderer is used to render all the features from a layer, using a single user-defined symbol whose
color reflects the assignment of a selected feature’s attribute to a class.

Like the Categorized Renderer, the Graduated Renderer allows you to define rotation and size scale from specified
columns.

Also, analogous to the Categorized Renderer, the Style tab allows you to select:

• The attribute (using the Column listbox or the Set column expression function, see Expressions chapter)

• The symbol (using the Symbol Properties button)

• The colors (using the color Ramp list)

Additionally, you can specify the number of classes and also the mode for classifying features within the classes
(using the Mode list). The available modes are:

• Intervalles égaux : toutes les classes sont de même taille (par exemple, avec des valeurs allant de 0 à 16 et
4 classes, chaque classe aura une taille de 4);

• Quantile : toutes les classes auront le même effectif (même principe que pour les boîtes à moustache);

• Ruptures naturelles (Jenks) : la variance de chaque classe est minimale tandis que la variance entre les
différentes classes est maximale;

12.3. Fenêtre Propriétés d’une couche vecteur 85



QGIS User Guide, Version 2.8

Figure 12.14: Categorized Symbolizing options

Figure 12.15: Graduated Symbolizing options
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• Écart-type : les classes sont construites en fonction le l’écart-type calculé sur l’ensemble des valeurs;

• Pretty Breaks: the same of natural breaks but the extremes number of each class are integers.

La zone de liste dans la partie centrale du menu Style répertorie les classes ainsi que leurs étendues, étiquettes et
symboles de rendu.

Click on Classify button to create classes using the choosen mode. Each classes can be disabled unchecking the
checkbox at the left of the class name.

You can change symbol, value and/or label of the clic, just double clicking on the item you want to change.

Un clic-droit vous propose de Copier / Coller, Modifier la couleur, Modifier la transparence, Modifier l’unité
de sortie ou Modifier la taille.

The example in figure_symbology_7 shows the graduated rendering dialog for the rivers layer of the QGIS sample
dataset.

Astuce: Cartes thématiques utilisant une expression
Categorized and graduated thematic maps can now be created using the result of an expression. In the properties
dialog for vector layers, the attribute chooser has been augmented with a Set column expression function. So
now you no longer need to write the classification attribute to a new column in your attribute table if you want the
classification attribute to be a composite of multiple fields, or a formula of some sort.

Rule-based rendering

The Rule-based Renderer is used to render all the features from a layer, using rule based symbols whose color
reflects the assignment of a selected feature’s attribute to a class. The rules are based on SQL statements. The
dialog allows rule grouping by filter or scale, and you can decide if you want to enable symbol levels or use only
the first-matched rule.

The example in figure_symbology_8 shows the rule-based rendering dialog for the rivers layer of the QGIS sample
dataset.

To create a rule, activate an existing row by double-clicking on it, or click on ‘+’ and click on the new rule. In the

Rule properties dialog, you can define a label for the rule. Press the button to open the expression string
builder. In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched.
To add an attribute to the field calculator Expression field, double click its name in the Fields and Values list.
Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box (see Expressions). You can create a new rule by copying and pasting an existing rule with
the right mouse button. You can also use the ‘ELSE’ rule that will be run if none of the other rules on that level
match. Since QGIS 2.8 the rules appear in a tree hierarchy in the map legend. Just double-klick the rules in the
map legend and the Style menu of the layer properties appears showing the rule that is the background for the
symbol in the tree.

Point displacement

The Point Displacement Renderer works to visualize all features of a point layer, even if they have the same
location. To do this, the symbols of the points are placed on a displacement circle around a center symbol.

Astuce: Exporter le style d’une couche vecteur
You have the option to export vector symbology from QGIS into Google *.kml, *.dxf and MapInfo *.tab files. Just
open the right mouse menu of the layer and click on Save selection as → to specify the name of the output file and
its format. In the dialog, use the Symbology export menu to save the symbology either as Feature symbology →
or as Symbol layer symbology →. If you have used symbol layers, it is recommended to use the second setting.

Inverted Polygon

Inverted polygon renderer allows user to define a symbol to fill in outside of the layer’s polygons. As before you
can select subrenderers. These subrenderers are the same as for the main renderers.

Astuce: Switch quickly between styles
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Figure 12.16: Rule-based Symbolizing options

Figure 12.17: Point displacement dialog
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Figure 12.18: Inverted Polygon dialog

Once you created one of the above mentioned styles you can right-klick on the layer and choose Styles → Add to
save your style. Now you can easily switch between styles you created using the Styles → menu again.

Heatmap

With the Heatmap renderer you can create live dynamic heatmaps for (multi)point layers. You can specify the
heatmap radius in pixels, mm or map units, choose a color ramp for the heatmap style and use a slider for selecting
a tradeoff between render speed and quality. When adding or removing a feature the heatmap renderer updates the
heatmap style automatically.

Color Picker

Regardless the type of style to be used, the select color dialog will show when you click to choose a color - either

border or fill color. This dialog has four different tabs which allow you to select colors by color ramp,
color wheel, color swatches or color picker.

Whatever method you use, the selected color is always described through color sliders for HSV (Hue, Saturation,
Value) and RGB (Red, Green, Blue) values. There is also an opacity slider to set transparency level. On the lower
left part of the dialog you can see a comparison between the current and the new color you are presently selecting
and on the lower right part you have the option to add the color you just tweaked into a color slot button.

With color ramp or with color wheel, you can browse to all possible color combinations. There are other

possibilities though. By using color swatches you can choose from a preselected list. This selected list is
populated with one of three methods: Recent colors, Standard colors or Project colors

Another option is to use the color picker which allows you to sample a color from under your mouse pointer at
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Figure 12.19: Color picker ramp tab

Figure 12.20: Color picker swatcher tab
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any part of QGIS or even from another application by pressing the space bar. Please note that the color picker is
OS dependent and is currently not supported by OSX.

Astuce: quick color picker + copy/paste colors
You can quickly choose from Recent colors, from Standard colors or simply copy or paste a color by clicking the
drop-down arrow that follows a current color box.

Figure 12.21: Quick color picker menu

Rendu de couche

• Transparence de la couche : permet de rendre visible les couches situées en dessous.
Utiliser le curseur pour adapter la visibilité de la couche vectorielle à vos besoins. Vous pouvez également
définir directement le pourcentage de transparence dans la zone de texte située à côté.

• Layer blending mode and Feature blending mode: You can achieve special rendering effects with these tools
that you may previously only know from graphics programs. The pixels of your overlaying and underlaying
layers are mixed through the settings described below.

– Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to blend with
the pixel beneath it. The colors aren’t mixed.

– Lighten: This selects the maximum of each component from the foreground and background pixels.
Be aware that the results tend to be jagged and harsh.

– Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This
mode is most useful for mixing the texture of one layer with another layer (e.g., you can use a hillshade
to texture another layer).

– Dodge: Dodge will brighten and saturate underlying pixels based on the lightness of the top pixel. So,
brighter top pixels cause the saturation and brightness of the underlying pixels to increase. This works
best if the top pixels aren’t too bright; otherwise the effect is too extreme.

– Addition: This blend mode simply adds pixel values of one layer with the other. In case of values
above one (in the case of RGB), white is displayed. This mode is suitable for highlighting features.

– Darken: This creates a resultant pixel that retains the smallest components of the foreground and
background pixels. Like lighten, the results tend to be jagged and harsh.

– Multiply: Here, the numbers for each pixel of the top layer are multiplied with the corresponding
pixels for the bottom layer. The results are darker pictures.

– Burn: Darker colors in the top layer cause the underlying layers to darken. Burn can be used to tweak
and colorise underlying layers.

– Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light
parts become lighter and dark parts become darker.

– Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge.
This is supposed to emulate shining a soft light onto an image.
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– Hard light: Hard light is also very similar to the overlay mode. It’s supposed to emulate projecting a
very intense light onto an image.

– Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to
always get a positive value. Blending with black produces no change, as the difference with all colors
is zero.

– Subtract: This blend mode simply subtracts pixel values of one layer from the other. In case of negative
values, black is displayed.

12.3.2 Onglet Étiquettes

The Labels core application provides smart labeling for vector point, line and polygon layers, and it only
requires a few parameters. This new application also supports on-the-fly transformed layers. The core functions
of the application have been redesigned. In QGIS, there are a number of other features that improve the labeling.
The following menus have been created for labeling the vector layers:

• Texte

• Formatage

• Tampon

• Fond

• Ombre

• Emplacement

• Rendu

Let us see how the new menus can be used for various vector layers. Labeling point layers

Start QGIS and load a vector point layer. Activate the layer in the legend and click on the Layer Labeling Options

icon in the QGIS toolbar menu.

The first step is to activate the Label this layer with checkbox and select an attribute column to use for labeling.
Click if you want to define labels based on expressions - See labeling_with_expressions.

The following steps describe a simple labeling without using the Data defined override functions, which are
situated next to the drop-down menus.

You can define the text style in the Text menu (see Figure_labels_1 ). Use the Type case option to influence the text
rendering. You have the possibility to render the text ‘All uppercase’, ‘All lowercase’ or ‘Capitalize first letter’.
Use the blend modes to create effects known from graphics programs (see blend_modes).

In the Formatting menu, you can define a character for a line break in the labels with the ‘Wrap on character’

function. Use the Formatted numbers option to format the numbers in an attribute table. Here, decimal places
may be inserted. If you enable this option, three decimal places are initially set by default.

To create a buffer, just activate the Draw text buffer checkbox in the Buffer menu. The buffer color is variable.
Here, you can also use blend modes (see blend_modes).

If the color buffer’s fill checkbox is activated, it will interact with partially transparent text and give mixed
color transparency results. Turning off the buffer fill fixes that issue (except where the interior aspect of the buffer’s
stroke intersects with the text’s fill) and also allows you to make outlined text.

In the Background menu, you can define with Size X and Size Y the shape of your background. Use Size type to
insert an additional ‘Buffer’ into your background. The buffer size is set by default here. The background then
consists of the buffer plus the background in Size X and Size Y. You can set a Rotation where you can choose
between ‘Sync with label’, ‘Offset of label’ and ‘Fixed’. Using ‘Offset of label’ and ‘Fixed’, you can rotate the
background. Define an Offset X,Y with X and Y values, and the background will be shifted. When applying
Radius X,Y, the background gets rounded corners. Again, it is possible to mix the background with the underlying
layers in the map canvas using the Blend mode (see blend_modes).
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Use the Shadow menu for a user-defined Drop shadow. The drawing of the background is very variable. Choose
between ‘Lowest label component’, ‘Text’, ‘Buffer’ and ‘Background’. The Offset angle depends on the orienta-

tion of the label. If you choose the Use global shadow checkbox, then the zero point of the angle is always
oriented to the north and doesn’t depend on the orientation of the label. You can influence the appearance of the
shadow with the Blur radius. The higher the number, the softer the shadows. The appearance of the drop shadow
can also be altered by choosing a blend mode (see blend_modes).

Choose the Placement menu for the label placement and the labeling priority. Using the Offset from point
setting, you now have the option to use Quadrants to place your label. Additionally, you can alter the angle of
the label placement with the Rotation setting. Thus, a placement in a certain quadrant with a certain rotation is
possible. In the priority section you can define with which priority the labels are rendered. It interacts with labels
of the other vector layers in the map canvas. If there are labels from different layers in the same location then the
label with the higher priority will be displayed and the other will be left out.

In the Rendering menu, you can define label and feature options. Under Label options, you find the scale-based

visibility setting now. You can prevent QGIS from rendering only selected labels with the Show all labels for
this layer (including colliding labels) checkbox. Under Feature options, you can define whether every part of a
multipart feature is to be labeled. It’s possible to define whether the number of features to be labeled is limited

and to Discourage labels from covering features.

Figure 12.22: Smart labeling of vector point layers

Labeling line layers

The first step is to activate the Label this layer checkbox in the Label settings tab and select an attribute column
to use for labeling. Click if you want to define labels based on expressions - See labeling_with_expressions.
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After that, you can define the text style in the Text menu. Here, you can use the same settings as for point layers.

Also, in the Formatting menu, the same settings as for point layers are possible.

The Buffer menu has the same functions as described in section labeling_point_layers.

The Background menu has the same entries as described in section labeling_point_layers.

Also, the Shadow menu has the same entries as described in section labeling_point_layers.

In the Placement menu, you find special settings for line layers. The label can be placed Parallel, Curved

or Horizontal. With the Parallel and Curved option, you can define the position Above line,

On line and Below line. It’s possible to select several options at once. In that case, QGIS will look for the
optimal position of the label. Remember that here you can also use the line orientation for the position of the label.
Additionally, you can define a Maximum angle between curved characters when selecting the Curved option
(see Figure_labels_2 ).

You can set up a minimum distance for repeating labels. Distance can be in mm or in map units.

Some Placement setup will display more options, for example, Curved and Parallel Placements will allow the user
to set up the position of the label (above, below or on the line), distance from the line and for Curved, the user can
also setup inside/outside max angle between curved label. As for point vector layers you have the possibility to
define a Priority for the labels.

The Rendering menu has nearly the same entries as for point layers. In the Feature options, you can now Suppress
labeling of features smaller than.

Figure 12.23: Smart labeling of vector line layers
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Labeling polygon layers

The first step is to activate the Label this layer checkbox and select an attribute column to use for labeling.
Click if you want to define labels based on expressions - See labeling_with_expressions.

In the Text menu, define the text style. The entries are the same as for point and line layers.

The Formatting menu allows you to format multiple lines, also similar to the cases of point and line layers.

As with point and line layers, you can create a text buffer in the Buffer menu.

Use the Background menu to create a complex user-defined background for the polygon layer. You can use the
menu also as with the point and line layers.

The entries in the Shadow menu are the same as for point and line layers.

In the Placement menu, you find special settings for polygon layers (see Figure_labels_3). Offset from centroid,
Horizontal (slow), Around centroid, Free and Using perimeter are possible.

In the Offset from centroid settings, you can specify if the centroid is of the visible polygon or whole
polygon. That means that either the centroid is used for the polygon you can see on the map or the centroid is
determined for the whole polygon, no matter if you can see the whole feature on the map. You can place your
label with the quadrants here, and define offset and rotation. The Around centroid setting makes it possible to
place the label around the centroid with a certain distance. Again, you can define visible polygon or whole
polygon for the centroid. With the Using perimeter settings, you can define a position and a distance for the

label. For the position, Above line, On line, Below line and Line orientation dependent position
are possible.

Related to the choice of Label Placement, several options will appear. As for Point Placement you can choose the
distance for the polygon outline, repeat the label around the polygon perimeter.

As for point and line vector layers you have the possibility to define a Priority for the polygon vector layer.

The entries in the Rendering menu are the same as for line layers. You can also use Suppress labeling of features
smaller than in the Feature options. Define labels based on expressions

Figure 12.24: Smart labeling of vector polygon layers
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QGIS allows to use expressions to label features. Just click the icon in the Labels menu of the properties
dialog. In figure_labels_4 you see a sample expression to label the alaska regions with name and area size, based
on the field ‘NAME_2’, some descriptive text and the function ‘$area()’ in combination with ‘format_number()’
to make it look nicer.

Figure 12.25: Using expressions for labeling

Expression based labeling is easy to work with. All you have to take care of is, that you need to combine all
elements (strings, fields and functions) with a string concatenation sign ‘||’ and that fields a written in “double
quotes” and strings in ‘single quotes’. Let’s have a look at some examples:

# label based on two fields ’name’ and ’place’ with a comma as separater
"name" || ’, ’ || "place"

-> John Smith, Paris

# label based on two fields ’name’ and ’place’ separated by comma
’My name is ’ || "name" || ’and I live in ’ || "place"

-> My name is John Smith and I live in Paris

# label based on two fields ’name’ and ’place’ with a descriptive text
# and a line break (\n)
’My name is ’ || "name" || ’\nI live in ’ || "place"

-> My name is John Smith
I live in Paris

# create a multi-line label based on a field and the $area function
# to show the place name and its area size based on unit meter.
’The area of ’ || "place" || ’has a size of ’ || $area || ’m²’

-> The area of Paris has a size of 105000000 m²

# create a CASE ELSE condition. If the population value in field
# population is <= 50000 it is a town, otherwise a city.
’This place is a ’ || CASE WHEN "population <= 50000" THEN ’town’ ELSE ’city’ END

-> This place is a town
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Comme vous pouvez le constater dans le constructeur d’expressions, vous avez à votre disposition une centaine
de fonctions pour créer des expressions simples ou très complexes afin d’étiqueter vos données avec QGIS. Voir
Expressions pour plus d’informations et des exemples d’expressions.

Using data-defined override for labeling

With the data-defined override functions, the settings for the labeling are overridden by entries in the attribute
table. You can activate and deactivate the function with the right-mouse button. Hover over the symbol and you
see the information about the data-defined override, including the current definition field. We now describe an

example using the data-defined override function for the Move label function (see figure_labels_5 ).

1. Import lakes.shp from the QGIS sample dataset.

2. Double-click the layer to open the Layer Properties. Click on Labels and Placement. Select Offset from
centroid.

3. Look for the Data defined entries. Click the icon to define the field type for the Coordinate. Choose
‘xlabel’ for X and ‘ylabel’ for Y. The icons are now highlighted in yellow.

4. Zoomez sur un lac.

5. Go to the Label toolbar and click the icon. Now you can shift the label manually to another position
(see figure_labels_6 ). The new position of the label is saved in the ‘xlabel’ and ‘ylabel’ columns of the
attribute table.

Figure 12.26: Labeling of vector polygon layers with data-defined override

12.3.3 Onglet Champs

Within the Fields menu, the field attributes of the selected dataset can be manipulated. The buttons
New Column and Delete Column can be used when the dataset is in Editing mode.

Outils d’édition
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Figure 12.27: Move labels

Figure 12.28: Dialog to select an edit widget for an attribute column
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Dans le menu Champs se trouve également une colonne Outil d’édition. Cette colonne peut être utilisée pour
définir des valeurs ou des plages de valeurs à utiliser pour ce champ précis de la table attributaire. Si vous cliquez
sur [Outil d’édition], il s’ouvre une fenêtre de dialogue dans laquelle vous pouvez définir différentes modalités.
Celles-ci sont :

• Boîte à cocher : Affiche une case à cocher et vous pouvez définir quelle valeur stocker quand la case est
cochée ou pas.

• Classification : Affiche une liste déroulante avec les valeurs utilisées pour la classification, si vous avez
choisi le style ‘Catégorisé’ dans l’onglet Style de la fenêtre de propriétés.

• Couleur : Affiche un bouton de couleur permettant de choisir une couleur via la fenêtre Sélectionner une
couleur.

• Date/Heure : Affiche un champ de type date/heure qui peut ouvrir un calendrier permettant de choisir une
date, une heure ou les deux. Le champ doit être de type texte. Vous pouvez choisir un format personnalisé,
l’affichage d’un calendrier, etc.

• Énumération : Ouvre une liste déroulante avec les valeurs qui peuvent être utilisées selon la définition du
type de champ. Ce mode d’édition n’est actuellement disponible que pour les couches PostgreSQL.

• Nom de fichier : Simplifie la sélection d’un fichier par l’ouverture d’un explorateur de fichiers.

• Cachée : Un attribut caché sera invisible. L’utilisateur ne pourra pas visualiser son contenu.

• Photo : Champ contenant le nom d’un fichier de photo. La largeur et la hauteur peuvent être précisées.

• Plage : Vous permet de spécifier une plage de valeurs numériques disponibles. Il peut s’agir d’une barre
coulissante ou d’une zone de texte éditable.

• Relation Reference: This widged lets you embed the feature form of the referenced layer on the feature
form of the actual layer. See Creating one to many relations.

• Édition de texte (par défait) : Ceci permet l’édition d’un texte simple ou multi-ligne. Si vous choisissez
Multi-ligne, vous pouvez spécifier s’il s’agit d’un contenu en HTML.

• Valeurs uniques : Vous pouvez sélectionner l’une des valeurs déjà utilisées dans cette colonne. Une ligne
est affichée avec le support de l’auto-complétion si la case ‘Éditable’ est cochée, une boîte de saisie est
utilisée sinon.

• Générateur d’UUID : Champ en lecture seule qui génère un UUID (Identifiant Unique Universel) lorsqu’il
est vide.

• Liste de valeurs : Une liste déroulante avec des valeurs prédéfinies. La valeur est stockée dans l’attribut, la
description est affichée dans la liste. Vous pouvez définir des valeurs manuellement ou les charger depuis la
couche ou depuis un fichier CSV.

• Value Relation: Offers values from a related table in a combobox. You can select layer, key column and
value column.

• Vue web : Champ contenant une URL. La largeur et la hauteur sont variables.

Note: QGIS has an advanced ‘hidden’ option to define your own field widget using python and add it to this
impressive list of widgets. It is tricky but it is very well explained in following excellent blog that explains how
to create a real time validation widget that can be used like described widgets. See http://blog.vitu.ch/10142013-
1847/write-your-own-qgis-form-elements

With the Attribute editor layout, you can now define built-in forms (see figure_fields_2). This is usefull for data
entry jobs or to identify objects using the option auto open form when you have objects with many attributes. You
can create an editor with several tabs and named groups to present the attribute fields.

Choose ‘Drag and drop designer’ and an attribute column. Use the icon to create a category to insert a tab or
a named group (see figure_fields_3). When creating a new category, QGIS will insert a new tab or named group
for the category in the built-in form. The next step will be to assign the relevant fields to a selected category with

the icon. You can create more categories and use the same fields again.
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Other options in the dialog are ‘Autogenerate’ and ‘Provide ui-file’.

• ‘Autogenerate’ just creates editors for all fields and tabulates them.

• The ‘Provide ui-file’ option allows you to use complex dialogs made with the Qt-Designer. Us-
ing a UI-file allows a great deal of freedom in creating a dialog. For detailed information, see
http://nathanw.net/2011/09/05/qgis-tips-custom-feature-forms-with-python-logic/.

QGIS dialogs can have a Python function that is called when the dialog is opened. Use this function to add extra
logic to your dialogs. An example is (in module MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidged,"My line edit")

Reference in Python Init Function like so: MyForms.open

MyForms.py must live on PYTHONPATH, in .qgis2/python, or inside the project folder.

Figure 12.29: Fenêtre de création de catégories avec la Mise en page de l’éditeur d’attribut

12.3.4 Onglet Général

Utilisez cet onglet pour définir les paramètres généraux de la couche vecteur. Plusieurs options sont
disponibles :

Informations sur la couche

• Changez le nom affiché de la couche dans Nom de la couche

• Définissez le fichier Source de la couche vectorielle
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Figure 12.30: Formulaire intégré obtenu avec onglets et groupes nommés

• Définissez l’Encodage de la source des données pour spécifier le type d’encodage utilisé dans les données
source et pour pouvoir les lire correctement

Système de Coordonnées de Référence

• Sélectionner le SCR, système de coordonnées de référence. Ici vous pouvez visualiser ou modifier le SCR
de la couche.

• Créer un index spatial (uniquement pour les formats gérés par OGR),

• Mettre à jour l’emprise dans les informations de la couche,

• Voir ou modifier la projection de la couche vecteur en cliquant sur Sélectionner le SCR

Scale dependent visibility

• You can set the Maximum (inclusive) and Minimum (exclusive) scale. The scale can also be set by the
[Current] buttons.

Feature subset

• With the [Query Builder] button, you can create a subset of the features in the layer that will be visualized
(also refer to section Constructeur de requête).

12.3.5 Onglet Rendu

QGIS 2.2 introduces support for on-the-fly feature generalisation. This can improve rendering times when drawing

many complex features at small scales. This feature can be enabled or disabled in the layer settings using the
Simplify geometry option. There is also a new global setting that enables generalisation by default for newly added
layers (see section Options). Note: Feature generalisation may introduce artefacts into your rendered output
in some cases. These may include slivers between polygons and inaccurate rendering when using offset-based
symbol layers.
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Figure 12.31: General menu in vector layers properties dialog
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12.3.6 Onglet Infobulles

This menu is specifically created for Map Tips. It includes a new feature: Map Tip display text in HTML.
While you can still choose a Field to be displayed when hovering over a feature on the map, it is now possible
to insert HTML code that creates a complex display when hovering over a feature. To activate Map Tips, select
the menu option View → MapTips. Figure Display 1 shows an example of HTML code.

Figure 12.32: HTML code for map tip

Figure 12.33: Map tip made with HTML code

12.3.7 Onglet Actions

QGIS provides the ability to perform an action based on the attributes of a feature. This can be used to
perform any number of actions, for example, running a program with arguments built from the attributes of a
feature or passing parameters to a web reporting tool.
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Figure 12.34: Overview action dialog with some sample actions

Les actions sont utiles si vous voulez exécuter fréquemment une application externe ou charger une page web
basée sur une ou plusieurs valeurs de votre couche vecteur. Il en existe six types qui peuvent être utilisés de la
sorte :

• Les actions de type Générique, Mac, Windows et Unix lancent un processus externe.

• Les actions Python lancent un code Python.

• Les actions de type Générique et Python sont disponibles quel que soit le système d’exploitation.

• Les actions Mac, Windows et Unix sont disponibles uniquement depuis les systèmes d’exploitation corre-
spondants (c’est à dire que vous pouvez définir trois actions ‘Éditer’ qui ouvrent un éditeur et les utilisateurs
ne verront que l’action correspondant à leur système d’exploitation).

Quelques exemples d’actions sont fournis. Vous pouvez les charger en cliquant sur [Ajouter les actions par
défaut]. Un des exemples effectue une recherche basée sur la valeur d’un attribut. C’est ce qui est développé par
la suite.

Defining Actions

Les actions sur les attributs sont définies depuis la fenêtre Propriétés de la couche vecteur. Pour définir une
action, ouvrez la fenêtre Propriétés de la couche vecteur et cliquez sur le menu Actions. Allez à Propriétés de
l’action. Sélectionnez le type ‘Générique’ et fournissez un nom d’identification à l’action. Le texte de l’action doit
lui-même contenir le nom de l’application qui sera exécutée lorsque l’action est invoquée. Vous pouvez ajouter
un ou plusieurs champs en arguments pour l’application. Lorsque l’action est invoquée, tout jeu de caractères
commençant par % suivi d’un champ sera remplacé par la valeur de ce champ. Les caractères spéciaux %% sont
remplacés par la valeur du champ sélectionné dans la fenêtre Identifier les résultats ou dans la Table attributaire (
voir using_actions ci-après). Les guillemets double peuvent être utilisés pour regrouper le texte dans un argument
unique pour l’application, le script ou le programme. Ils sont ignorés lorsque précédés d’un antislash.

If you have field names that are substrings of other field names (e.g., col1 and col10), you should indicate that
by surrounding the field name (and the % character) with square brackets (e.g., [%col10]). This will prevent
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the %col10 field name from being mistaken for the %col1 field name with a 0 on the end. The brackets will be
removed by QGIS when it substitutes in the value of the field. If you want the substituted field to be surrounded
by square brackets, use a second set like this: [[%col10]].

Using the Identify Features tool, you can open the Identify Results dialog. It includes a (Derived) item that contains
information relevant to the layer type. The values in this item can be accessed in a similar way to the other fields
by preceeding the derived field name with (Derived).. For example, a point layer has an X and Y field, and
the values of these fields can be used in the action with %(Derived).X and %(Derived).Y. The derived
attributes are only available from the Identify Results dialog box, not the Attribute Table dialog box.

Deux exemples d’action sont proposés ci-dessous :

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

Dans le premier exemple, le navigateur internet konqueror est lancé avec une URL. L’URL effectue une
recherche Google sur la valeur du champ nam de la couche vecteur. Notez que l’application ou le script ap-
pelé par l’action doit être dans le path sinon vous devez fournir le chemin complet vers l’application. Pour
être certain, nous pouvons réécrire le premier exemple de cette manière : /opt/kde3/bin/konqueror
http://www.google.com/search?q=%nam. Ceci assurera que l’application konqueror sera exécutée
quand l’action sera invoquée.

Le deuxième exemple utilise la notation %% dont la valeur ne dépend pas d’un champ en particulier. Quand
l’action est invoquée, %% sera remplacé par la valeur du champ sélectionné dans les résultats de l’identification
ou dans la table d’attributs. Using Actions

Actions can be invoked from either the Identify Results dialog, an Attribute Table dialog or from Run Fea-

ture Action (recall that these dialogs can be opened by clicking Identify Features or Open Attribute Table or
Run Feature Action). To invoke an action, right click on the record and choose the action from the pop-up menu. Ac-
tions are listed in the popup menu by the name you assigned when defining the action. Click on the action you
wish to invoke.

Si vous faites appel à une action qui utilise la notation %%, faites un clic droit sur la valeur du champ que vous
souhaitez passer à l’application ou au script, dans la fenêtre Identifier les résultats ou dans la Table attributaire.

Here is another example that pulls data out of a vector layer and inserts it into a file using bash and the echo com-

mand (so it will only work on or perhaps ). The layer in question has fields for a species name taxon_name,
latitude lat and longitude long. We would like to be able to make a spatial selection of localities and export
these field values to a text file for the selected record (shown in yellow in the QGIS map area). Here is the action
to achieve this:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

Après avoir sélectionné quelques localités et lancé l’action sur chacune d’entre elles, le fichier de destination
ressemblera à ceci :

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

Comme exercice, nous allons créer une action qui réalise une recherche Google sur la couche lakes. Tout
d’abord, nous avons besoin de déterminer l’URL nécessaire pour effectuer une recherche sur un mot clé. Il suffit
simplement d’aller sur Google et faire une recherche simple puis récupérer l’URL dans la barre d’adresse de votre
navigateur. De cela, nous en déduisons la formulation : http://google.com/search?q=qgis, où qgis est le terme
recherché. À partir de tout cela, nous pouvons poursuivre :

1. Assurez-vous que la couche lakes est chargée.

2. Open the Layer Properties dialog by double-clicking on the layer in the legend, or right-click and choose
Properties from the pop-up menu.

3. Cliquez sur l’onglet Actions
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4. Entrez un nom pour l’action, par exemple Recherche Google.

5. Pour l’action, nous devons fournir le nom du programme externe à lancer. Dans ce cas, nous allons utiliser
Firefox. Si le programme n’est pas dans votre path, vous devez fournir le chemin complet.

6. A la suite du nom de l’application externe, ajoutez l’URL utilisée pour faire la recherche Google, jusqu’au
terme de recherche, mais sans l’ajouter : http://google.com/search?q=

7. Le texte dans le champ Action devrait ressembler à ceci : firefox
http://google.com/search?q=

8. Cliquez sur le menu déroulant contenant les noms des champs pour la couche lakes. Il est situé juste à
gauche du bouton [Insérer un champ].

9. Sélectionnez le champ ‘NAMES’ du menu déroulant et cliquez sur [Insérer un champ].

10. Votre texte Action ressemble maintenant à :

firefox http://google.com/search?q=%NAMES

11. Pour finaliser l’action, cliquez sur le bouton [Ajouter l’action à la liste].

L’action est donc entièrement définie et prête à être utilisée. Le texte final de l’action devrait correspondre à ça :

firefox http://google.com/search?q=%NAMES

Nous pouvons maintenant utiliser l’action. Fermez la fenêtre Propriétés de la couche et zoomez sur une zone
d’intérêt. Assurez-vous que la couche lakes est active puis identifiez un lac. Dans la fenêtre de résultats, vous
constatez que notre action est maintenant visible :

Figure 12.35: Select feature and choose action

Quand vous cliquez sur l’action, cela ouvre Firefox et charge l’URL http://www.google.com/search?q=Tustumena.
Il est également possible d’ajouter d’autres champs attributs à l’action. Pour faire cela, vous pouvez ajouter un +
à la fin du texte de l’action, sélectionnez un autre champ et cliquez sur [Insérer un champ]. Dans cet exemple, la
recherche sur un autre champ n’aurait pas de sens.

Vous pouvez définir de multiples actions pour une couche et chacune apparaitra dans la fenêtre Identifier les
résultats.

Vous pouvez imaginer toutes sortes d’utilisations pour ces actions. Par exemple, si vous avez une couche de
points contenant la localisation d’images ou de photos ainsi qu’un nom de fichier, vous pouvez créer une action
qui lancera un visualiseur pour afficher les images. Vous pouvez également utiliser les actions pour lancer des
rapports sur internet pour un champ attributaire ou une combinaison de champs, en les spécifiant de la même
manière que dans l’exemple d’une recherche Google.
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Nous pouvons également fournir des exemples plus complexes, notamment sur la manière d’utiliser des actions
Python.

D’ordinaire, lorsque l’on crée une action pour ouvrir un fichier avec une application externe, on peut utiliser un
chemin absolu ou relatif. Dans ce dernier cas, le chemin dépend donc de l’emplacement du fichier d’exécution du
programme externe. Mais si nous souhaitons utiliser des chemins relatifs à la couche sélectionnée (stockée sous
forme de fichier comme un shapefile ou une base SpatiaLite) ? Le code suivant permet de le faire :

command = "firefox";
imagerelpath = "images_test/test_image.jpg";
layer = qgis.utils.iface.activeLayer();
import os.path;
layerpath = layer.source() if layer.providerType() == ’ogr’

else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == ’spatialite’ else None);

path = os.path.dirname(str(layerpath));
image = os.path.join(path,imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

Il faut simplement se rappeler qu’il s’agit d’une action Python et qu’il faut modifier les variables command et
imagerelpath selon vos besoins.

Et si le chemin relatif doit dépendre du fichier de projet (sauvegardé) ? Le code de l’action Python deviendra :

command="firefox";
imagerelpath="images/test_image.jpg";
projectpath=qgis.core.QgsProject.instance().fileName();
import os.path; path=os.path.dirname(str(projectpath)) if projectpath != ’’ else None;
image=os.path.join(path, imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

Un autre exemple d’action Python consiste à ajouter de nouvelles couche au projet. L’exemple qui suit montre
comment ajouter une couche vecteur et un raster. Les noms des fichiers à ajouter au projet et les noms à donner
aux couches dépendent de données attributaires (filename et layername sont deux champs de la table attributaire
de la couche sur laquelle l’action est créée) :

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,’[% "layername" %]’,
’ogr’)

Pour ajouter un raster (ici une image TIF), cela devient :

qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,’[% "layername" %]
’)

12.3.8 Onglet Jointures

The Joins menu allows you to join a loaded attribute table to a loaded vector layer. After clicking , the
Add vector join dialog appears. As key columns, you have to define a join layer you want to connect with the
target vector layer. Then, you have to specify the join field that is common to both the join layer and the target

layer. Now you can also specify a subset of fields from the joined layer based on the checkbox Choose which
fields are joined. As a result of the join, all information from the join layer and the target layer are displayed in
the attribute table of the target layer as joined information. If you specified a subset of fields only these fields are
displayed in the attribute table of the target layer.

QGIS currently has support for joining non-spatial table formats supported by OGR (e.g., CSV, DBF and Excel),
delimited text and the PostgreSQL provider (see figure_joins_1).

De plus, la fenêtre de jointure vous permet de :

• Mettre la couche jointe en cache dans la mémoire virtuelle
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Figure 12.36: Join an attribute table to an existing vector layer

• Créer un index des attributs joins

• Choisir les champs à joindre

• Personnaliser le préfixe du champ

12.3.9 Onglet Diagrammes

L’onglet Diagrammes permet d’ajouter une couche de graphiques sur une couche vecteur (voir fig-
ure_diagrams_1).

The current core implementation of diagrams provides support for pie charts, text diagrams and histograms.

The menu is divided into four tabs: Appearance, Size, Postion and Options.

In the cases of the text diagram and pie chart, text values of different data columns are displayed one below the
other with a circle or a box and dividers. In the Size tab, diagram size is based on a fixed size or on linear scaling
according to a classification attribute. The placement of the diagrams, which is done in the Position tab, interacts
with the new labeling, so position conflicts between diagrams and labels are detected and solved. In addition,
chart positions can be fixed manually.

We will demonstrate an example and overlay on the Alaska boundary layer a text diagram showing temperature
data from a climate vector layer. Both vector layers are part of the QGIS sample dataset (see section Échantillon
de données).

1. First, click on the Load Vector icon, browse to the QGIS sample dataset folder, and load the two vector
shape layers alaska.shp and climate.shp.
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Figure 12.37: Vector properties dialog with diagram menu

2. Double-cliquez sur la couche climate dans la légende pour ouvrir la fenêtre de Propriétés de la Couche.

3. Click on the Diagrams menu, activate Display diagrams, and from the Diagram type combo box,
select ‘Text diagram’.

4. Dans l’onglet Apparence, nous choisissons le bleu clair comme couleur de fond et définissons une taille fixe
de 18 mm dans l’onglet Taille.

5. Dans l’onglet Position, l’emplacement défini est Autour du point.

6. In the diagram, we want to display the values of the three columns T_F_JAN, T_F_JUL and T_F_MEAN.

First select T_F_JAN as Attributes and click the button, then T_F_JUL, and finally T_F_MEAN.

7. Now click [Apply] to display the diagram in the QGIS main window.

8. You can adapt the chart size in the Size tab. Deactivate the Fixed size and set the size of the diagrams on
the basis of an attribute with the [Find maximum value] button and the Size menu. If the diagrams appear

too small on the screen, you can activate the Increase size of small diagrams checkbox and define the
minimum size of the diagrams.

9. Change the attribute colors by double clicking on the color values in the Assigned attributes field. Fig-
ure_diagrams_2 gives an idea of the result.

10. Cliquez enfin sur [OK].

N’oubliez pas que, dans l’onglet Position, en cochant la case Source de définition de la position, vous pouvez
utiliser des valeurs d’attributs pour choisir l’emplacement des diagrammes. Par ailleurs, dans l’onglet Apparence,
vous pouvez définir la visibilité en fonction de l’échelle.

The size and the attributes can also be an expression. Use the button to add an expression. See Expressions
chapter for more information and example.
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Figure 12.38: Diagram from temperature data overlayed on a map

12.3.10 Onglet Métadonnées

The Metadata menu consists of Description, Attribution, MetadataURL and Properties sections.

In the Properties section, you get general information about the layer, including specifics about the type and
location, number of features, feature type, and editing capabilities. The Extents table provides you with layer
extent information and the Layer Spatial Reference System, which is information about the CRS of the layer. This
is a quick way to get information about the layer.

Additionally, you can add or edit a title and abstract for the layer in the Description section. It’s also possible to
define a Keyword list here. These keyword lists can be used in a metadata catalogue. If you want to use a title from
an XML metadata file, you have to fill in a link in the DataUrl field. Use Attribution to get attribute data from an
XML metadata catalogue. In MetadataUrl, you can define the general path to the XML metadata catalogue. This
information will be saved in the QGIS project file for subsequent sessions and will be used for QGIS server.

.

12.4 Expressions

The Expressions feature are available through the field calculator or the add a new column button in the attribut
table or the Field tab in the Layer properties ; through the graduaded, categorized and rule-based rendering in the

Style tab of the Layer properties ; through the expression-based labeling in the Labeling core application
; through the feature selection and through the diagram tab of the Layer properties as well as the Main properties
of the label item and the Atlas generation tab in the Print Composer.

They are a powerful way to manipulate attribute value in order to dynamically change the final value in order to
change the geometry style, the content of the label, the value for diagram, select some feature or create virtual
column.

12.4.1 Liste de fonctions

The Function List contains functions as well as fields and values. View the help function in the Selected Func-
tion Help. In Expression you see the calculation expressions you create with the Function List. For the most
commonly used operators, see Operators.
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Figure 12.39: Metadata menu in vector layers properties dialog

In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched. To add
an attribute to the Field calculator Expression field, double click its name in the Fields and Values list. Generally,
you can use the various fields, values and functions to construct the calculation expression, or you can just type it
into the box. To display the values of a field, you just right click on the appropriate field. You can choose between
Load top 10 unique values and Load all unique values. On the right side, the Field Values list opens with the
unique values. To add a value to the Field calculator Expression box, double click its name in the Field Values
list.

The Operators, Math, Conversions, String, Geometry and Record groups provide several functions. In Operators,
you find mathematical operators. Look in Math for mathematical functions. The Conversions group contains
functions that convert one data type to another. The String group provides functions for data strings. In the
Geometry group, you find functions for geometry objects. With Record group functions, you can add a numeration
to your data set. To add a function to the Field calculator Expression box, click on the > and then double click the
function.

Opérateurs

This group contains operators (e.g., +, -, *).

a + b a plus b
a - b a minus b
a * b a multiplied by b
a / b a divided by b
a % b a modulo b (for example, 7 % 2 = 1, or 2 fits into 7 three

times with remainder 1)
a ^ b a power b (for example, 2^2=4 or 2^3=8)
a = b a and b are equal
a > b a is larger than b
a < b a is smaller than b
a <> b a and b are not equal
a != b a and b are not equal
a <= b a is less than or equal to b
a >= b a is larger than or equal to b
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a ~ b a matches the regular expression b
+ a positive sign
- a negative value of a
|| joins two values together into a string ’Hello’ || ’ world’
LIKE returns 1 if the string matches the supplied pattern
ILIKE returns 1 if the string matches case-insensitive the supplied

pattern (ILIKE can be used instead of LIKE to make the match
case-insensitive)

IS returns 1 if a is the same as b
OR returns 1 when condition a or b is true
AND returns 1 when condition a and b are true
NOT returns 1 if a is not the same as b
column name "column name" value of the field column name, take

care to not be confused with simple
quote, see below

’string’ a string value, take care to not be
confused with double quote, see above

NULL null value
a IS NULL a has no value
a IS NOT NULL a has a value
a IN (value[,value]) a is below the values listed
a NOT IN (value[,value]) a is not below the values listed

Quelques exemples :

• Joint une chaîne et une valeur depuis un nom de colonne:

’My feature’s id is: ’ || "gid"

• Teste si la “description” du champ d’attribut commence avec la chaîne ‘Hello’ dans la valeur (notez la
position du caractère %):

"description" LIKE ’Hello%’

Conditions

Ce groupe contient des fonctions permettant de gérer des conditions dans les expressions.

CASE evaluates multiple expressions and returns a
result

CASE ELSE evaluates multiple expressions and returns a
result

coalesce returns the first non-NULL value from the
expression list

regexp_match returns true if any part of a string matches
the supplied regular expression

Quelques exemples:

• Envoie une valeur en retour si la première condition est vraie, sinon une autre valeur:

CASE WHEN "software" LIKE ’%QGIS%’ THEN ’QGIS’ ELSE ’Other’

Fonctions mathématiques

Ce groupe contient des fonctions mathématiques (par ex. racine carré, sin et cos).

sqrt(a) square root of a
abs returns the absolute value of a number
sin(a) sine of a
cos(a) cosine of a
tan(a) tangent of a
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asin(a) arcsin of a
acos(a) arccos of a
atan(a) arctan of a
atan2(y,x) arctan of y/x using the signs of the two

arguments to determine the quadrant of the
result

exp exponential of a value
ln value of the natural logarithm of the passed

expression
log10 value of the base 10 logarithm of the passed

expression
log value of the logarithm of the passed value

and base
round round to number of decimal places
rand random integer within the range specified by

the minimum
and maximum argument (inclusive)

randf random float within the range specified by
the minimum
and maximum argument (inclusive)

max largest value in a set of values
min smallest value in a set of values
clamp restricts an input value to a specified

range
scale_linear transforms a given value from an input

domain to an output
range using linear interpolation

scale_exp transforms a given value from an input
domain to an output
range using an exponential curve

floor rounds a number downwards
ceil rounds a number upwards
$pi pi as value for calculations

Conversions

Ce groupe contient des fonctions pour convertir un type de données en un autre (par ex. chaîne à entier, entier à
chaîne).

toint converts a string to integer number
toreal converts a string to real number
tostring converts number to string
todatetime converts a string into Qt data time type
todate converts a string into Qt data type
totime converts a string into Qt time type
tointerval converts a string to an interval type (can be

used to take days, hours, months, etc. off a
date)

Fonctions de Date et Heure

Ce groupe contient des fonctions permettant de gérer des données de date et d’heure.

$now current date and time
age difference between two dates
year extract the year part from a date, or the number of years from

an interval
month extract the month part from a date, or the number of months

from an interval
week extract the week number from a date, or the number of weeks
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from an interval
day extract the day from a date, or the number of days from an

interval
hour extract the hour from a datetime or time, or the number

of hours from an interval
minute extract the minute from a datetime or time, or the number

of minutes from an interval
second extract the second from a datetime or time, or the number

of minutes from an interval

Quelques exemples:

• Obtenir le mois et l’année d’aujourd’hui dans le format “10/2014”

month($now) || ’/’ || year($now)

Fonctions de Chaîne

Ce groupe contient des fonctions qui opèrent sur des chaînes (par ex. qui remplace, convertit en majuscule).

lower convert string a to lower case
upper convert string a to upper case
title converts all words of a string to title

case (all words lower case with leading
capital letter)

trim removes all leading and trailing white
space (spaces, tabs, etc.) from a string

wordwrap returns a string wrapped to a maximum/
minimum number of characters

length length of string a
replace returns a string with the supplied string

replaced
regexp_replace(a,this,that) returns a string with the supplied regular

expression replaced
regexp_substr returns the portion of a string which matches

a supplied regular expression
substr(*a*,from,len) returns a part of a string
concat concatenates several strings to one
strpos returns the index of a regular expression

in a string
left returns a substring that contains the n

leftmost characters of the string
right returns a substring that contains the n

rightmost characters of the string
rpad returns a string with supplied width padded

using the fill character
lpad returns a string with supplied width padded

using the fill character
format formats a string using supplied arguments
format_number returns a number formatted with the locale

separator for thousands (also truncates the
number to the number of supplied places)

format_date formats a date type or string into a custom
string format

Fonctions de Couleur

Ce groupe contient des fonctions pour manipuler les couleurs.

color_rgb returns a string representation of a color based on its
red, green, and blue components
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color_rgba returns a string representation of a color based on its
red, green, blue, and alpha (transparency) components

ramp_color returns a string representing a color from a color ramp
color_hsl returns a string representation of a color based on its

hue, saturation, and lightness attributes
color_hsla returns a string representation of a color based on its

hue, saturation, lightness and alpha (transparency)
attributes

color_hsv returns a string representation of a color based on its
hue, saturation, and value attributes

color_hsva returns a string representation of a color based on its
hue, saturation, value and alpha (transparency) attributes

color_cmyk returns a string representation of a color based on its
cyan, magenta, yellow and black components

color_cmyka returns a string representation of a color based on its
cyan, magenta, yellow, black and alpha (transparency)
components

Fonctions de Géométrie

Ce groupe contient des fonctions qui opèrent sur des objets géométriques (par ex. longueur, aire).

$geometry returns the geometry of the current feature (can be used
for processing with other functions)

$area returns the area size of the current feature
$length returns the length size of the current feature
$perimeter returns the perimeter length of the current feature
$x returns the x coordinate of the current feature
$y returns the y coordinate of the current feature
xat retrieves the nth x coordinate of the current feature.

n given as a parameter of the function
yat retrieves the nth y coordinate of the current feature.

n given as a parameter of the function
xmin returns the minimum x coordinate of a geometry.

Calculations are in the Spatial Reference System of this
Geometry

xmax returns the maximum x coordinate of a geometry.
Calculations are in the Spatial Reference System of this
Geometry

ymin returns the minimum y coordinate of a geometry.
Calculations are in the Spatial Reference System of this
Geometry

ymax returns the maximum y coordinate of a geometry.
Calculations are in the Spatial Reference System of this
Geometry

geomFromWKT returns a geometry created from a well-known text (WKT)
representation

geomFromGML returns a geometry from a GML representation of geometry
bbox
disjoint returns 1 if the geometries do not share any space

together
intersects returns 1 if the geometries spatially intersect

(share any portion of space) and 0 if they don’t
touches returns 1 if the geometries have at least one point in

common, but their interiors do not intersect
crosses returns 1 if the supplied geometries have some, but not

all, interior points in common
contains returns true if and only if no points of b lie in the

exterior of a, and at least one point of the interior
of b lies in the interior of a

overlaps returns 1 if the geometries share space, are of the
same dimension, but are not completely contained by
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each other
within returns 1 if geometry a is completely inside geometry b
buffer returns a geometry that represents all points whose

distance from this geometry is less than or equal to
distance

centroid returns the geometric center of a geometry
bounds returns a geometry which represents the bounding box of

an input geometry. Calculations are in the Spatial
Reference System of this Geometry.

bounds_width returns the width of the bounding box of a geometry.
Calculations are in the Spatial Reference System of
this Geometry.

bounds_height returns the height of the bounding box of a geometry.
Calculations are in the Spatial Reference System of
this Geometry.

convexHull returns the convex hull of a geometry (this represents
the minimum convex geometry that encloses all geometries
within the set)

difference returns a geometry that represents that part of geometry
a that does not intersect with geometry b

distance returns the minimum distance (based on spatial ref)
between two geometries in projected units

intersection returns a geometry that represents the shared portion
of geometry a and geometry b

symDifference returns a geometry that represents the portions of a and
b that do not intersect

combine returns the combination of geometry a and geometry b
union returns a geometry that represents the point set union of

the geometries
geomToWKT returns the well-known text (WKT) representation of the

geometry without SRID metadata
geometry returns the feature’s geometry
transform returns the geometry transformed from the source CRS to

the dest CRS

Fonctions d’Enregistrement

Ce groupe contient des fonctions qui permettent d’accéder aux identifiants des enregistrements.

$rownum returns the number of the current row
$id returns the feature id of the current row
$currentfeature returns the current feature being evaluated.

This can be used with the ’attribute’ function
to evaluate attribute values from the current
feature.

$scale returns the current scale of the map canvas
$uuid generates a Universally Unique Identifier (UUID)

for each row. Each UUID is 38 characters long.
getFeature returns the first feature of a layer matching a

given attribute value.
attribute returns the value of a specified attribute from

a feature.
$map returns the id of the current map item if the map

is being drawn in a composition, or "canvas" if
the map is being drawn within the main QGIS
window.

Champs et Valeurs

Contains a list of fields from the layer. Sample values can also be accessed via right-click.
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Select the field name from the list, then right-click to access a context menu with options to load sample values
from the selected field.

Fields name should be double-quoted. Values or string should be simple-quoted.

.

12.5 Éditer

QGIS supports various capabilities for editing OGR, SpatiaLite, PostGIS, MSSQL Spatial and Oracle Spatial
vector layers and tables.

Note: La procédure pour éditer des couches GRASS est différente - voir section Numérisation et édition de
couche vectorielle GRASS pour plus de détails.

Astuce: Éditions simultanées
This version of QGIS does not track if somebody else is editing a feature at the same time as you are. The last
person to save their edits wins.

12.5.1 Définir le rayon de tolérance d’accrochage et de recherche

Before we can edit vertices, we must set the snapping tolerance and search radius to a value that allows us an
optimal editing of the vector layer geometries.

Tolérance d’accrochage

Snapping tolerance is the distance QGIS uses to search for the closest vertex and/or segment you are trying to
connect to when you set a new vertex or move an existing vertex. If you aren’t within the snapping tolerance,
QGIS will leave the vertex where you release the mouse button, instead of snapping it to an existing vertex and/or
segment. The snapping tolerance setting affects all tools that work with tolerance.

1. A general, project-wide snapping tolerance can be defined by choosing Settings → Options. On Mac, go
to QGIS → Preferences.... On Linux: Edit → Options. In the Digitizing tab, you can select between
‘to vertex’, ‘to segment’ or ‘to vertex and segment’ as default snap mode. You can also define a default
snapping tolerance and a search radius for vertex edits. The tolerance can be set either in map units or in
pixels. The advantage of choosing pixels is that the snapping tolerance doesn’t have to be changed after
zoom operations. In our small digitizing project (working with the Alaska dataset), we define the snapping
units in feet. Your results may vary, but something on the order of 300 ft at a scale of 1:10000 should be a
reasonable setting.

2. A layer-based snapping tolerance can be defined by choosing Settings → (or File →) Snapping options... to
enable and adjust snapping mode and tolerance on a layer basis (see figure_edit_1 ).

Note that this layer-based snapping overrides the global snapping option set in the Digitizing tab. So, if you need
to edit one layer and snap its vertices to another layer, then enable snapping only on the snap to layer, then
decrease the global snapping tolerance to a smaller value. Furthermore, snapping will never occur to a layer that
is not checked in the snapping options dialog, regardless of the global snapping tolerance. So be sure to mark the
checkbox for those layers that you need to snap to.

The Snapping options enables you to make a quick and simple general setting for all layers in the project so that
the pointer snaps to all existing vertices and/or segments when using the ‘All layers’ snapping mode. In most cases
it is sufficient to use this snapping mode.

It is important to consider that the per-layer tolerance in ‘map units’ was actually in layer units. So if working
with a layer in WGS84 reprojected to UTM, setting tolerance to 1 map unit (i.e. 1 meter) wouldn’t work correctly
because the units would be actually degrees. So now the ‘map units’ has been relabeled to ‘layer units’ and the
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Figure 12.40: Edit snapping options on a layer basis (Advanced mode)

new entry ‘map units’ operates with units of the map view. While working with ‘on-the-fly’ CRS transformation
it is now possible to use a snapping tolerance that refers to either the units of the reprojected layer (setting ‘layer
units’) or the units of the map view (setting ‘map units’).

Rayon de recherche

Search radius is the distance QGIS uses to search for the closest vertex you are trying to move when you click
on the map. If you aren’t within the search radius, QGIS won’t find and select any vertex for editing, and it will
pop up an annoying warning to that effect. Snap tolerance and search radius are set in map units or pixels, so you
may find you need to experiment to get them set right. If you specify too big of a tolerance, QGIS may snap to the
wrong vertex, especially if you are dealing with a large number of vertices in close proximity. Set search radius
too small, and it won’t find anything to move.

The search radius for vertex edits in layer units can be defined in the Digitizing tab under Settings → Options.
This is the same place where you define the general, project- wide snapping tolerance.

12.5.2 Zooming and Panning

Before editing a layer, you should zoom in to your area of interest. This avoids waiting while all the vertex markers
are rendered across the entire layer.

Apart from using the pan and zoom-in / zoom-out icons on the toolbar with the mouse, navigating can also
be done with the mouse wheel, spacebar and the arrow keys.

Zooming and panning with the mouse wheel

While digitizing, you can press the mouse wheel to pan inside of the main window, and you can roll the mouse
wheel to zoom in and out on the map. For zooming, place the mouse cursor inside the map area and roll it forward
(away from you) to zoom in and backwards (towards you) to zoom out. The mouse cursor position will be the
center of the zoomed area of interest. You can customize the behavior of the mouse wheel zoom using the Map
tools tab under the Settings → Options menu.

Panning with the arrow keys

Panning the map during digitizing is possible with the arrow keys. Place the mouse cursor inside the map area,
and click on the right arrow key to pan east, left arrow key to pan west, up arrow key to pan north, and down arrow
key to pan south.

You can also use the space bar to temporarily cause mouse movements to pan the map. The PgUp and PgDown
keys on your keyboard will cause the map display to zoom in or out without interrupting your digitizing session.
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12.5.3 Édition topologique

Besides layer-based snapping options, you can also define topological functionalities in the Snapping options...

dialog in the Settings (or File) menu. Here, you can define Enable topological editing, and/or for polygon

layers, you can activate the column Avoid Int., which avoids intersection of new polygons.

Activer l’édition topologique

The option Enable topological editing is for editing and maintaining common boundaries in polygon mosaics.
QGIS ‘detects’ a shared boundary in a polygon mosaic, so you only have to move the vertex once, and QGIS will
take care of updating the other boundary.

Éviter les intersections de nouveaux polygones

The second topological option in the Avoid Int. column, called Avoid intersections of new polygons, avoids
overlaps in polygon mosaics. It is for quicker digitizing of adjacent polygons. If you already have one polygon,
it is possible with this option to digitize the second one such that both intersect, and QGIS then cuts the second
polygon to the common boundary. The advantage is that you don’t have to digitize all vertices of the common
boundary.

Activer l’accrochage sur les intersections

Une autre possibilité est de cocher Activer l’accrochage sur les intersections. Cela vous permet d’accrocher
les nouveaux nœuds sur une intersection entre les autres couches, même s’il n’y a pas de nœud à cette intersection.

12.5.4 Numériser une couche existante

By default, QGIS loads layers read-only. This is a safeguard to avoid accidentally editing a layer if there is a
slip of the mouse. However, you can choose to edit any layer as long as the data provider supports it, and the
underlying data source is writable (i.e., its files are not read-only).

In general, tools for editing vector layers are divided into a digitizing and an advanced digitiz-
ing toolbar, described in section Numérisation avancée. You can select and unselect both under
View → Toolbars →. Using the basic digitizing tools, you can perform the following functions:

Bouton Fonction Bouton Fonction

Éditions en cours Basculer en mode édition

Adding Features: Capture Point Adding Features: Capture Line

Adding Features: Capture Polygon Déplacer l’entité

Outil de noeud Supprimer les entités sélectionnées

Couper les entités Copier les entités

Coller les entités Enregistrer les modifications de la couche

Tableau Numérisation : barre d’outils basiques de numérisation pour les couches vectorielles

All editing sessions start by choosing the Toggle editing option. This can be found in the context menu after right
clicking on the legend entry for a given layer.

Alternatively, you can use the Toggle Editing Toggle editing button from the digitizing toolbar to start or stop the
editing mode. Once the layer is in edit mode, markers will appear at the vertices, and additional tool buttons on
the editing toolbar will become available.
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Astuce: Sauvegardez régulièrement

Remember to Save Layer Edits regularly. This will also check that your data source can accept all the changes.

Ajouter des entités

You can use the Add Feature, Add Feature or Add Feature icons on the toolbar to put the QGIS cursor into
digitizing mode.

For each feature, you first digitize the geometry, then enter its attributes. To digitize the geometry, left-click on
the map area to create the first point of your new feature.

For lines and polygons, keep on left-clicking for each additional point you wish to capture. When you have
finished adding points, right-click anywhere on the map area to confirm you have finished entering the geometry
of that feature.

The attribute window will appear, allowing you to enter the information for the new feature. Figure_edit_2 shows
setting attributes for a fictitious new river in Alaska. In the Digitizing menu under the Settings → Options menu,

you can also activate Suppress attributes pop-up windows after each created feature and Reuse last entered
attribute values.

Figure 12.41: Enter Attribute Values Dialog after digitizing a new vector feature

With the Move Feature(s) icon on the toolbar, you can move existing features.

Astuce: Attribute Value Types
For editing, the attribute types are validated during entry. Because of this, it is not possible to enter a number into
a text column in the dialog Enter Attribute Values or vice versa. If you need to do so, you should edit the attributes
in a second step within the Attribute table dialog.

Current Edits

This feature allows the digitization of multiple layers. Choose Save for Selected Layers to save all changes

you made in multiple layers. You also have the opportunity to Rollback for Selected Layers, so that the

digitization may be withdrawn for all selected layers. If you want to stop editing the selected layers, Cancel
for Selected Layer(s) is an easy way.

Les mêmes fonctions sont disponibles pour l’édition de toutes les couches du projet.

Outil de noeud

For shapefile-based layers as well as SpatialLite, PostgreSQL/PostGIS, MSSQL Spatial, and Oracle Spatial tables,

the Node Tool provides manipulation capabilities of feature vertices similar to CAD programs. It is possible to
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simply select multiple vertices at once and to move, add or delete them altogether. The node tool also works with
‘on the fly’ projection turned on, and it supports the topological editing feature. This tool is, unlike other tools in
QGIS, persistent, so when some operation is done, selection stays active for this feature and tool. If the node tool
is unable to find any features, a warning will be displayed.

It is important to set the property Settings → Options → Digitizing → Search Radius: to a number
greater than zero (i.e., 10). Otherwise, QGIS will not be able to tell which vertex is being edited.

Astuce: Marqueurs de sommets
The current version of QGIS supports three kinds of vertex markers: ‘Semi-transparent circle’, ‘Cross’ and ‘None’.
To change the marker style, choose Options from the Settings menu, click on the Digitizing tab and select the
appropriate entry.

Opérations basiques

Start by activating the Node Tool and selecting a feature by clicking on it. Red boxes will appear at each vertex
of this feature.

• Selecting vertices: You can select vertices by clicking on them one at a time, by clicking on an edge to
select the vertices at both ends, or by clicking and dragging a rectangle around some vertices. When a
vertex is selected, its color changes to blue. To add more vertices to the current selection, hold down the
Ctrl key while clicking. Hold down Ctrl or Shiftwhen clicking to toggle the selection state of vertices
(vertices that are currently unselected will be selected as usual, but also vertices that are already selected
will become unselected).

• Ajouter des sommets : Pour ajouter un sommet, double-cliquez simplement sur un segment, un nouveau
sommet apparaîtra sur le segment proche du curseur. Notez que le sommet est créé sur le segment et pas
forcément exactement à l’emplacement du curseur, il est donc peut-être nécessaire de le déplacer.

• Deleting vertices: After selecting vertices for deletion, click the Delete key. Note that you cannot use the
Node Tool to delete a complete feature; QGIS will ensure it retains the minimum number of vertices for

the feature type you are working on. To delete a complete feature use the Delete Selected tool.

• Moving vertices: Select all the vertices you want to move. Click on a selected vertex or edge and drag in
the direction you wish to move. All the selected vertices will move together. If snapping is enabled, the
whole selection can jump to the nearest vertex or line.

Each change made with the node tool is stored as a separate entry in the Undo dialog. Remember that all operations
support topological editing when this is turned on. On-the-fly projection is also supported, and the node tool
provides tooltips to identify a vertex by hovering the pointer over it.

Couper, Copier et Coller des entités

Selected features can be cut, copied and pasted between layers in the same QGIS project, as long as destination

layers are set to Toggle editing beforehand.

Features can also be pasted to external applications as text. That is, the features are represented in CSV format,
with the geometry data appearing in the OGC Well-Known Text (WKT) format.

However, in this version of QGIS, text features from outside QGIS cannot be pasted to a layer within QGIS. When
would the copy and paste function come in handy? Well, it turns out that you can edit more than one layer at a
time and copy/paste features between layers. Why would we want to do this? Say we need to do some work on a
new layer but only need one or two lakes, not the 5,000 on our big_lakes layer. We can create a new layer and
use copy/paste to plop the needed lakes into it.

Comme exemple, nous allons copier quelques lacs dans une nouvelle couche :

1. Chargez la couche dont vous voulez copier des entités (couche source)
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2. Chargez ou créez la couche sur laquelle vous voulez coller des entités (couche cible)

3. Lancez l’édition pour la couche cible

4. Assurez-vous que la couche source est active en cliquant dessus dans la légende

5. Use the Select Single Feature tool to select the feature(s) on the source layer

6. Click on the Copy Features tool

7. Assurez-vous que la couche cible est active en cliquant dessus dans la légende

8. Click on the Paste Features tool

9. Stoppez l’édition et sauvegardez les changements

What happens if the source and target layers have different schemas (field names and types are not the same)?
QGIS populates what matches and ignores the rest. If you don’t care about the attributes being copied to the target
layer, it doesn’t matter how you design the fields and data types. If you want to make sure everything - the feature
and its attributes - gets copied, make sure the schemas match.

Astuce: Conformité des entités copiées
If your source and destination layers use the same projection, then the pasted features will have geometry identical
to the source layer. However, if the destination layer is a different projection, then QGIS cannot guarantee the ge-
ometry is identical. This is simply because there are small rounding-off errors involved when converting between
projections.

Astuce: Copier une chaîne d’attribut dans une autre
If you have created a new column in your attribute table with type ‘string’ and want to paste values from another
attribute column that has a greater length the length of the column size will be extended to the same amount. This
is because the GDAL Shapefile driver starting with GDAL/OGR 1.10 knows to auto-extend string and integer
fields to dynamically accomodate for the length of the data to be inserted.

Supprimer les entités sélectionnées

If we want to delete an entire polygon, we can do that by first selecting the polygon using the regular
Select Single Feature tool. You can select multiple features for deletion. Once you have the selection set, use the

Delete Selected tool to delete the features.

The Cut Features tool on the digitizing toolbar can also be used to delete features. This effectively deletes the

feature but also places it on a “spatial clipboard”. So, we cut the feature to delete. We could then use the
Paste Features tool to put it back, giving us a one-level undo capability. Cut, copy, and paste work on the currently
selected features, meaning we can operate on more than one at a time.

Sauvegarder les couches éditées

When a layer is in editing mode, any changes remain in the memory of QGIS. Therefore, they are not commit-
ted/saved immediately to the data source or disk. If you want to save edits to the current layer but want to continue

editing without leaving the editing mode, you can click the Save Layer Edits button. When you turn editing mode

off with Toggle editing (or quit QGIS for that matter), you are also asked if you want to save your changes or
discard them.

If the changes cannot be saved (e.g., disk full, or the attributes have values that are out of range), the QGIS
in-memory state is preserved. This allows you to adjust your edits and try again.
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Astuce: Intégrité des données
It is always a good idea to back up your data source before you start editing. While the authors of QGIS have
made every effort to preserve the integrity of your data, we offer no warranty in this regard.

12.5.5 Numérisation avancée

Bouton Fonction Bouton Fonction

Annuler Refaire

Pivoter l’entité Simplifier l’entité

Ajouter un anneau Ajouter une partie

Remplir l’anneau Effacer un anneau

Effacer une partie Remodeler les entités

Décalage X,Y Séparer les entités

Séparer les parties Fusionner les entités sélectionnées

Fusionner les attributs des entités sélectionnées Rotation des symboles de point

Tableau Numérisation avancée : barre d’outils de numérisation avancée pour les couches vectorielles

Annuler et refaire

The Undo and Redo tools allows you to undo or redo vector editing operations. There is also a dockable
widget, which shows all operations in the undo/redo history (see Figure_edit_3). This widget is not displayed by
default; it can be displayed by right clicking on the toolbar and activating the Undo/Redo checkbox. Undo/Redo
is however active, even if the widget is not displayed.

Figure 12.42: Redo and Undo digitizing steps

When Undo is hit, the state of all features and attributes are reverted to the state before the reverted operation
happened. Changes other than normal vector editing operations (for example, changes done by a plugin), may or
may not be reverted, depending on how the changes were performed.

Pour utiliser l’historique Annuler/Refaire, cliquez simplement sur une opération dans la liste de l’historique.
Toutes les entités retrouveront leur état antérieur à cette opération.
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Pivoter l’entité

Use Rotate Feature(s) to rotate one or multiple features in the map canvas. Press the Rotate Feature(s) icon and then
click on the feature to rotate. Either click on the map to place the rotated feature or enter an angle in the user input
widget. If you want to rotate several features, they shall be selected first.

Si vous activez l’outil avec des entités sélectionnées, son ou leur centroïde apparaît et sera le point d’ancrage pour
la rotation. Si vous souhaitez déplacer ce point d’ancrage, appuyer sur la touche Ctrl et cliquez sur la carte pour
le positionner.

Si vous appuyez sur la touche Shift avant de cliquer sur la carte, la rotation appliquée suivra un pas de 45 degrés,
ce qui peut être modifié par la suite dans le gadget de saisie de l’utilisateur.

Simplifier l’entité

The Simplify Feature tool allows you to reduce the number of vertices of a feature, as long as the geometry
doesn’t change. With the tool you can also simplify multi-part features. First, drag a rectangle over the feature.
The vertices will be highlighted in red while the color of the feature will change and a dialog where you can define
a tolerance in map units or pixels will appear. QGIS calculates the amount of vertices that can be deleted while
maintaining the geometry using the given tolerance. The higher the tolerance is the more vertices can be deleted.
After gaining the statistics about the simplification just klick the OK button. The tolerance you used will be saved
when leaving a project or when leaving an edit session. So you can go back to the same tolerance the next time
when simplifying a feature.

Ajouter un anneau

You can create ring polygons using the Add Ring icon in the toolbar. This means that inside an existing area, it
is possible to digitize further polygons that will occur as a ‘hole’, so only the area between the boundaries of the
outer and inner polygons remains as a ring polygon.

Ajouter une partie

You can add part polygons to a selected multipolygon. The new part polygon must be digitized outside the
selected multi-polygon.

Remplir l’anneau

You can use the Fill Ring function to add a ring to a polygon and add a new feature to the layer at the same time.

Thus you need not first use the Add Ring icon and then the Add feature function anymore.

Effacer un anneau

The Delete Ring tool allows you to delete ring polygons inside an existing area. This tool only works with
polygon layers. It doesn’t change anything when it is used on the outer ring of the polygon. This tool can be used
on polygon and multi-polygon features. Before you select the vertices of a ring, adjust the vertex edit tolerance.
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Effacer une partie

The Delete Part tool allows you to delete parts from multifeatures (e.g., to delete polygons from a multi-polygon
feature). It won’t delete the last part of the feature; this last part will stay untouched. This tool works with all
multi-part geometries: point, line and polygon. Before you select the vertices of a part, adjust the vertex edit
tolerance.

Remodeler les entités

You can reshape line and polygon features using the Reshape Features icon on the toolbar. It replaces the line or
polygon part from the first to the last intersection with the original line. With polygons, this can sometimes lead
to unintended results. It is mainly useful to replace smaller parts of a polygon, not for major overhauls, and the
reshape line is not allowed to cross several polygon rings, as this would generate an invalid polygon.

Par exemple, vous pouvez modifier les limites d’un polygone avec cet outil. Tout d’abord, cliquez à l’intérieur
du polygone près de la zone où vous souhaitez ajouter un nœud. Franchissez ensuite la limite et positionnez
les nœuds à extérieur du polygone. Pour terminer cliquez à nouveau à l’intérieur du polygone. L’outil ajoute
automatiquement un nœud à l’endroit où la ligne intersecte la limite du polygone. Il est possible également de
supprimer des morceaux de polygones en commençant à l’extérieur du polygone puis en ajoutant des nœuds à
l’intérieur et en terminant à l’extérieur par un clic droit.

Note: L’outil de remodelage peut altérer la position de départ d’un anneau polygonal ou d’une ligne close, le
point “double” ne sera plus le même. Ce n’est pas un problème pour la plupart des applications, mais c’est quelque
chose à considérer.

Décalage X,Y

The Offset Curve tool creates parallel shifts of line layers. The tool can be applied to the edited layer (the
geometries are modified) or also to background layers (in which case it creates copies of the lines / rings and adds
them to the the edited layer). It is thus ideally suited for the creation of distance line layers. The displacement is
shown at the bottom left of the taskbar.

To create a shift of a line layer, you must first go into editing mode and activate the Offset Curve tool. Then click
on a feature to shift it. Move the mouse and click where wanted or enter the desired distance in the user input
widget. Your changes may then be saved with the|mActionSaveEdits|:sup:Save Layer Edits tool.

QGIS options dialog (Digitizing tab then Curve offset tools section) allows you to configure some parameters
like Join style, Quadrant segments, Miter limit.

Séparer les entités

You can split features using the Split Features icon on the toolbar. Just draw a line across the feature you want to
split.

Séparer les parties

In QGIS 2.0 it is now possible to split the parts of a multi part feature so that the number of parts is increased. Just

draw a line across the part you want to split using the Split Parts icon.
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Fusionner les entités sélectionnées

The Merge Selected Features tool allows you to merge features. A new dialog will allow you to choose which value
to choose between each selected features or select a function (Minimum, Maximum, Median, Sum, Skip Attribute)
to use for each column. If features don’t have a common boundaries, a multipolygon will be created.

Fusionner les attributs des entités sélectionnées

The Merge Attributes of Selected Features tool allows you to merge attributes of features with common boundaries

and attributes without merging their boundaries. First, select several features at once. Then press the
Merge Attributes of Selected Features button. Now QGIS asks you which attributes are to be applied to all selected objects.
As a result, all selected objects have the same attribute entries.

Rotation des symboles de point

Rotate Point Symbols allows you to change the rotation of point symbols in the map canvas. You must first define
a rotation column from the attribute table of the point layer in the Advanced menu of the Style menu of the Layer

Properties. Also, you will need to go into the ‘SVG marker’ and choose Data defined properties .... Activate
Angle and choose ‘rotation’ as field. Without these settings, the tool is inactive.

Figure 12.43: Rotate Point Symbols

To change the rotation, select a point feature in the map canvas and rotate it, holding the left mouse button pressed.
A red arrow with the rotation value will be visualized (see Figure_edit_4). When you release the left mouse button
again, the value will be updated in the attribute table.

Note: Si vous gardez la touche Ctrl enfoncée, la rotation se fera par palier de 15 degrés.

12.5.6 Le panneau Numérisation avancée

When capturing new geometries or geometry parts you also have the possibility to use the Advanced Digitizing
panel. You can digitize lines exactly parallel or at a specific angle or lock lines to specific angles. Furthermore
you can enter coordinates directly so that you can make a precise definition for your new geomtry.

_figure_advanced_edit 1:

Les outils ne sont pas disponibles si la vue de la carte est en coordonnées géographiques.

126 Chapter 12. Les données vectorielles



QGIS User Guide, Version 2.8

Figure 12.44: The Advanced Digitizing panel

12.5.7 Créer de nouvelles couches vecteur

QGIS allows you to create new shapefile layers, new SpatiaLite layers, new GPX layers and New Temporary
Scratch Layers. Creation of a new GRASS layer is supported within the GRASS plugin. Please refer to section
Création d’une nouvelle couche vectorielle GRASS for more information on creating GRASS vector layers.

Créer une nouvelle couche Shapefile

To create a new shape layer for editing, choose New → New Shapefile Layer... from the Layer menu. The
New Vector Layer dialog will be displayed as shown in Figure_edit_5. Choose the type of layer (point, line or
polygon) and the CRS (coordinate reference system).

Note that QGIS does not yet support creation of 2.5D features (i.e., features with X,Y,Z coordinates).

Figure 12.45: Creating a new Shapefile layer Dialog

To complete the creation of the new shapefile layer, add the desired attributes by clicking on the [Add to attributes
list] button and specifying a name and type for the attribute. A first ‘id’ column is added as default but can be

removed, if not wanted. Only Type: real , Type: integer , Type: string and Type:date
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attributes are supported. Additionally and according to the attribute type, you can also define the width and
precision of the new attribute column. Once you are happy with the attributes, click [OK] and provide a name for
the shapefile. QGIS will automatically add a .shp extension to the name you specify. Once the layer has been
created, it will be added to the map, and you can edit it in the same way as described in section Numériser une
couche existante above.

Créer une nouvelle couche SpatiaLite

To create a new SpatiaLite layer for editing, choose New → New SpatiaLite Layer... from the Layer menu.
The New SpatiaLite Layer dialog will be displayed as shown in Figure_edit_6.

Figure 12.46: Creating a New SpatiaLite layer Dialog

The first step is to select an existing SpatiaLite database or to create a new SpatiaLite database. This can be done

with the browse button to the right of the database field. Then, add a name for the new layer, define the

layer type, and specify the coordinate reference system with [Specify CRS]. If desired, you can select Create
an autoincrementing primary key.

To define an attribute table for the new SpatiaLite layer, add the names of the attribute columns you want to create
with the corresponding column type, and click on the [Add to attribute list] button. Once you are happy with the
attributes, click [OK]. QGIS will automatically add the new layer to the legend, and you can edit it in the same
way as described in section Numériser une couche existante above.

D’autres opérations de gestion des couches SpatiaLite peuvent être effectuées via DB Manager. Voir Extension
DB Manager.
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Créer une nouvelle couche GPS

To create a new GPX file, you need to load the GPS plugin first. Plugins → Plugin Manager... opens the

Plugin Manager Dialog. Activate the GPS Tools checkbox.

When this plugin is loaded, choose New → Create new GPX Layer... from the Layer menu. In the Save new
GPX file as dialog, you can choose where to save the new GPX layer.

Créer une nouvelle couche en mémoire temporaire

Empty, editable memory layers can be defined using Layer → Create Layer → New Temporary Scratch Layer.
Here you can even create Multipoint, Multiline and Multipolygon Layers beneath Point, Line and

Polygon Layers. Temporary Scratch Layers are not saved and will be discarded when QGIS is closed. See also
paste_into_layer .

12.5.8 Working with the Attribute Table

The attribute table displays features of a selected layer. Each row in the table represents one map feature, and
each column contains a particular piece of information about the feature. Features in the table can be searched,
selected, moved or even edited.

To open the attribute table for a vector layer, make the layer active by clicking on it in the map legend area. Then,

from the main Layer menu, choose Open Attribute Table. It is also possible to right click on the layer and

choose Open Attribute Table from the drop-down menu, and to click on the Open Attribute Table button
in the Attributes toolbar.

This will open a new window that displays the feature attributes for the layer (figure_attributes_1). The number
of features and the number of selected features are shown in the attribute table title.

Figure 12.47: Attribute Table for regions layer

Selecting features in an attribute table

Each selected row in the attribute table displays the attributes of a selected feature in the layer. If the set of
features selected in the main window is changed, the selection is also updated in the attribute table. Likewise, if
the set of rows selected in the attribute table is changed, the set of features selected in the main window will be
updated.
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Rows can be selected by clicking on the row number on the left side of the row. Multiple rows can be marked by
holding the Ctrl key. A continuous selection can be made by holding the Shift key and clicking on several
row headers on the left side of the rows. All rows between the current cursor position and the clicked row are
selected. Moving the cursor position in the attribute table, by clicking a cell in the table, does not change the row
selection. Changing the selection in the main canvas does not move the cursor position in the attribute table.

The table can be sorted by any column, by clicking on the column header. A small arrow indicates the sort order
(downward pointing means descending values from the top row down, upward pointing means ascending values
from the top row down).

For a simple search by attributes on only one column, choose the Column filter → from the menu in the bottom
left corner. Select the field (column) on which the search should be performed from the drop-down menu, and hit
the [Apply] button. Then, only the matching features are shown in the attribute table.

To make a selection, you have to use the Select features using an Expression icon on top of the attribute table.
Select features using an Expression allows you to define a subset of a table using a Function List like in the Field Calculator

(see Calculatrice de champ). The query result can then be saved as a new vector layer. For example, if you want
to find regions that are boroughs from regions.shp of the QGIS sample data, you have to open the Fields and
Values menu and choose the field that you want to query. Double-click the field ‘TYPE_2’ and also [Load all
unique values] . From the list, choose and double-click ‘Borough’. In the Expression field, the following query
appears:

"TYPE_2" = ’Borough’

Here you can also use the Function list → Recent (Selection) to make a selection that you used before. The
expression builder remembers the last 20 used expressions.

The matching rows will be selected, and the total number of matching rows will appear in the title bar of the
attribute table, as well as in the status bar of the main window. For searches that display only selected features on
the map, use the Query Builder described in section Constructeur de requête.

To show selected records only, use Show Selected Features from the menu at the bottom left.

The field calculator bar allows you to make calculations on the selected rows only. For example, you can alter the
number of the ID field of the file:regions.shp with the expression

ID+5

as shown in figure_attributes_1 .

The other buttons at the top of the attribute table window provide the following functionality:

• Toggle editing mode to edit single values and to enable functionalities described below (also with Ctrl+E)

• Save Edits (also with Ctrl+S)

• Unselect all (also with Ctrl+U)

• Move selected to top (also with Ctrl+T)

• Invert selection (also with Ctrl+R)

• Copy selected rows to clipboard (also with Ctrl+C)

• Zoom map to the selected rows (also with Ctrl+J)

• Pan map to the selected rows (also with Ctrl+P)

• Delete selected features (also with Ctrl+D)

• New Column for PostGIS layers and for OGR layers with GDAL version >= 1.6 (also with Ctrl+W)
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• Delete Column for PostGIS layers and for OGR layers with GDAL version >= 1.9 (also with Ctrl+L)

• Open field calculator (also with Ctrl+I)

Below these buttons is the Field Calculator bar, which allows calculations to be quickly applied attributes visible

in the table. This bar uses the same expressions as the Field Calculator (see Calculatrice de champ).

Astuce: Skip WKT geometry

If you want to use attribute data in external programs (such as Excel), use the Copy selected rows to clipboard button.
You can copy the information without vector geometries if you deactivate Settings → Options → Data sources

menu Copy geometry in WKT representation from attribute table.

Save selected features as new layer

The selected features can be saved as any OGR-supported vector format and also transformed into another coordi-
nate reference system (CRS). Just open the right mouse menu of the layer and click on Save as to define the name

of the output file, its format and CRS (see section Map Legend). To save the selection ensure that the Save
only selected features is selected. It is also possible to specify OGR creation options within the dialog.

Paste into new layer

Features that are on the clipboard may be pasted into a new layer. To do this, first make a layer editable. Select
some features, copy them to the clipboard, and then paste them into a new layer using Edit → Paste Features as
and choosing New vector layer or New memory layer.

This applies to features selected and copied within QGIS and also to features from another source defined using
well-known text (WKT).

Working with non spatial attribute tables

QGIS allows you also to load non-spatial tables. This currently includes tables supported by OGR and delimited
text, as well as the PostgreSQL, MSSQL and Oracle provider. The tables can be used for field lookups or just
generally browsed and edited using the table view. When you load the table, you will see it in the legend field. It

can be opened with the Open Attribute Table tool and is then editable like any other layer attribute table.

As an example, you can use columns of the non-spatial table to define attribute values, or a range of values that are
allowed, to be added to a specific vector layer during digitizing. Have a closer look at the edit widget in section
Onglet Champs to find out more.

12.5.9 Creating one to many relations

Relations are a technique often used in databases. The concept is, that features (rows) of different layers (tables)
can belong to each other.

As an example you have a layer with all regions of alaska (polygon) which provides some attributes about its name
and region type and a unique id (which acts as primary key).

Foreign keys

Then you get another point layer or table with information about airports that are located in the regions and you
also want to keep track of these. If you want to add them to the region layer, you need to create a one to many
relation using foreign keys, because there are several airports in most regions.
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Figure 12.48: Alaska region with airports

In addition to the already existing attributes in the airports attribute table another field fk_region which acts as a
foreign key (if you have a database, you will probably want to define a constraint on it).

This field fk_region will always contain an id of a region. It can be seen like a pointer to the region it belongs
to. And you can design a custom edit form for the editing and QGIS takes care about the setup. It works with
different providers (so you can also use it with shape and csv files) and all you have to do is to tell QGIS the
relations between your tables.

Layers

QGIS makes no difference between a table and a vector layer. Basically, a vector layer is a table with a geometry.
So can add your table as a vector layer. To demostrate you can load the ‘region’ shapefile (with geometries) and
the ‘airport’ csv table (without geometries) and a foreign key (fk_region) to the layer region. This means, that
each airport belongs to exactly one region while each region can have any number of airports (a typical one to
many relation).

Definition (Relation Manager)

The first thing we are going to do is to let QGIS know about the relations between the layer. This is done in
Settings → Project Properties. Open the Relations menu and click on Add.

• name is going to be used as a title. It should be a human readable string, describing, what the relation is
used for. We will just call say “Airports” in this case.

• referencing layer is the one with the foreign key field on it. In our case this is the airports layer

• referencing field will say, which field points to the other layer so this is fk_region in this case

• referenced layer is the one with the primary key, pointed to, so here it is the regions layer

• referenced field is the primary key of the referenced layer so it is ID

• id will be used for internal purposes and has to be unique. You may need it to build custom forms once this
is supported. If you leave it empty, one will be generated for you but you can assign one yourself to get one
that is easier to handle.

Forms

Now that QGIS knows about the relation, it will be used to improve the forms it generates. As we did not change
the default form method (autogenerated) it will just add a new widget in our form. So let’s select the layer region
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Figure 12.49: Relation Manager

in the legend and use the identify tool. Depending on your settings, the form might open directly or you will have
to choose to open it in the identification dialog under actions.

Figure 12.50: Identification dialog regions with relation to airports

As you can see, the airports assigned to this particular region are all shown in a table. And there are also some
buttons available. Let’s review them shortly

• The button is for toggling the edit mode. Be aware that it toggles the edit mode of the airport layer,
although we are in the feature form of a feature from the region layer. But the table is representing features
of the airport layer.

• The button will add a new feature to the airport layer. And it will assign the new airport to the current
region by default.

• The button will delete the selected airport permanently.

• The symbol will open a new dialog where you can select any existing airport which will then be assigned

12.5. Éditer 133



QGIS User Guide, Version 2.8

to the current region. This may be handy if you created the airport on the wrong region by accident.

• The symbol will unlink the selected airport from the current region, leaving them unassigned (the
foreign key is set to NULL) effectively.

• The two buttons to the right switch between table view and form view where the later let’s you view all the
airports in their respective form.

If you work on the airport table, a new widget type is available which lets you embed the feature form of the
referenced region on the feature form of the airports. It can be used when you open the layer properties of the
airports table, switch to the Fields menu and change the widget type of the foreign key field ‘fk_region’ to Relation
Reference.

If you look at the feature dialog now, you will see, that the form of the region is embedded inside the airports form
and will even have a combobox, which allows you to assign the current airport to another region.

Figure 12.51: Identification dialog airport with relation to regions

.

12.6 Constructeur de requête

The Query Builder allows you to define a subset of a table using a SQL-like WHERE clause and to display the
result in the main window. The query result can then be saved as a new vector layer.

12.6.1 Requête

Open the Query Builder by opening the Layer Properties and going to the General menu. Under Feature subset,
click on the [Query Builder] button to open the Query builder. For example, if you have a regions layer with a
TYPE_2 field, you could select only regions that are borough in the Provider specific filter expression box of the
Query Builder. Figure_attributes_2 shows an example of the Query Builder populated with the regions.shp
layer from the QGIS sample data. The Fields, Values and Operators sections help you to construct the SQL-like
query.

The Fields list contains all attribute columns of the attribute table to be searched. To add an attribute column to
the SQL WHERE clause field, double click its name in the Fields list. Generally, you can use the various fields,
values and operators to construct the query, or you can just type it into the SQL box.

The Values list lists the values of an attribute table. To list all possible values of an attribute, select the attribute in
the Fields list and click the [all] button. To list the first 25 unique values of an attribute column, select the attribute
column in the Fields list and click the [Sample] button. To add a value to the SQL WHERE clause field, double
click its name in the Values list.

The Operators section contains all usable operators. To add an operator to the SQL WHERE clause field, click
the appropriate button. Relational operators ( = , > , ...), string comparison operator (LIKE), and logical operators
(AND, OR, ...) are available.
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Figure 12.52: Constructeur de requête

The [Test] button shows a message box with the number of features satisfying the current query, which is useful
in the process of query construction. The [Clear] button clears the text in the SQL WHERE clause text field.
The [OK] button closes the window and selects the features satisfying the query. The [Cancel] button closes the
window without changing the current selection.

QGIS treats the resulting subset acts as if it where the entire layer. For example if you applied the filter above for
‘Borough’, you can not display, query, save or edit Anchorage, because that is a ‘Municipality’ and therefore not
part of the subset.

The only exception is that unless your layer is part of a database, using a subset will prevent you from editing the
layer.

.

12.7 Calculatrice de champ

The Field Calculator button in the attribute table allows you to perform calculations on the basis of existing
attribute values or defined functions, for instance, to calculate length or area of geometry features. The results can
be written to a new attribute field, a virtual field, or they can be used to update values in an existing field.

Astuce: Virtual Fields
• Virtual fields are not permanent and are not saved.

• To make a field virtual it must be done when the field is made.

The field calculator is now available on any layer that supports edit. When you click on the field calculator icon
the dialog opens (see figure_attributes_3). If the layer is not in edit mode, a warning is displayed and using the
field calculator will cause the layer to be put in edit mode before the calculation is made.

The quick field calculation bar on top of the attribute table is only visible if the layer is editable.
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In quick field calculation bar, you first select the existing field name then open the expression dialog to create your
expression or write it directly in the field then click on Update All button.

12.7.1 Expression tab

In the field calculator dialog, you first must select whether you want to only update selected features, create a new
attribute field where the results of the calculation will be added or update an existing field.

Figure 12.53: Calculatrice de champ

If you choose to add a new field, you need to enter a field name, a field type (integer, real or string), the total field
width, and the field precision (see figure_attributes_3). For example, if you choose a field width of 10 and a field
precision of 3, it means you have 6 digits before the dot, then the dot and another 3 digits for the precision.

A short example illustrates how field calculator works when using the Expression tab. We want to calculate the
length in km of the railroads layer from the QGIS sample dataset:

1. Load the shapefile railroads.shp in QGIS and press Open Attribute Table.

2. Cliquez sur Basculer en mode édition et ouvrez la Calculatrice de champs.

3. Select the Create a new field checkbox to save the calculations into a new field.

4. Add length as Output field name and real as Output field type, and define Output field width to be 10
and Precision, 3.

5. Now double click on function $length in the Geometry group to add it into the Field calculator expression
box.
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6. Terminez en rentrant ‘/ 1000’ à la fin de l’expression et en cliquant sur le bouton [Ok].

7. You can now find a new field length in the attribute table.

The available functions are listed in Expressions chapter.

12.7.2 Function Editor tab

With the Function Editor you are able to define your own Python custom functions in a comfortable way. The
function editor will create new Python files in qgis2pythonexpressions and will auto load all functions
defined when starting QGIS. Be aware that new functions are only saved in the expressions folder and not in
the project file. If you have a project that uses one of your custom functions you will need to also share the .py file
in the expressions folder.

Here’s a short example on how to create your own functions:

@qgsfunction(args="auto", group=’Custom’)
def myfunc(value1, value2 feature, parent):

pass

The short example creates a function ‘myfunc’ that will give you a function with two values. When using the
args=’auto’ function argument the number of function arguments required will be calculated by the number of
arguments the function has been defined with in Python (minus 2 - feature, and parent).

This function then can be used with the following expression:

myfunc(’test1’, ’test2’)

Your function will be implemented in the ‘Custom’ Functions of the Expression tab after using the Run Script
button.

Further information about creating Python code can be found on http://www.qgis.org/html/en/docs/pyqgis_developer_cookbook/index.html.

The function editor is not only limited to working with the field calculator, it can be found whenever you work
with expressions. See also Expressions.

.
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CHAPTER 13

Les données raster

.

13.1 Les données raster

This section describes how to visualize and set raster layer properties. QGIS uses the GDAL library to read and
write raster data formats, including ArcInfo Binary Grid, ArcInfo ASCII Grid, GeoTIFF, ERDAS IMAGINE, and
many more. GRASS raster support is supplied by a native QGIS data provider plugin. The raster data can also be
loaded in read mode from zip and gzip archives into QGIS.

A ce jour, plus de 100 formats raster sont gérés par la bibliothèque GDAL (voir GDAL-SOFTWARE-SUITE dans
Bibliographie). La liste complète est disponible sur cette page : http://www.gdal.org/formats_list.html.

Note: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries, or the GDAL installation of your OS may not have been built to support the format you want
to use. Only those formats that have been well tested will appear in the list of file types when loading a raster into
QGIS. Other untested formats can be loaded by selecting the [GDAL] All files (*) filter.

La gestion des données raster GRASS est décrite dans la section Intégration du SIG GRASS.

13.1.1 Qu’est ce qu’un raster ?

Raster data in GIS are matrices of discrete cells that represent features on, above or below the earth’s surface. Each
cell in the raster grid is the same size, and cells are usually rectangular (in QGIS they will always be rectangular).
Typical raster datasets include remote sensing data, such as aerial photography, or satellite imagery and modelled
data, such as an elevation matrix.

Unlike vector data, raster data typically do not have an associated database record for each cell. They are geocoded
by pixel resolution and the x/y coordinate of a corner pixel of the raster layer. This allows QGIS to position the
data correctly in the map canvas.

QGIS makes use of georeference information inside the raster layer (e.g., GeoTiff) or in an appropriate world file
to properly display the data.

13.1.2 Loading raster data in QGIS

Raster layers are loaded either by clicking on the Add Raster Layer icon or by selecting the Layer → Add
Raster Layer menu option. More than one layer can be loaded at the same time by holding down the Ctrl or
Shift key and clicking on multiple items in the Open a GDAL Supported Raster Data Source dialog.

Une fois la couche raster chargée vous pouvez faire un clic-droit sur son nom dans la légende de la carte pour
sélectionner et activer des paramètres spécifiques à la couche ou pour ouvrir la fenêtre de propriétés de la couche.

139

http://www.gdal.org/formats_list.html


QGIS User Guide, Version 2.8

Menu du bouton droit de la souris pour les couches raster

• Zoomer sur la couche

• Zoom à la meilleur échelle (100%)

• Étirer sur l’emprise actuelle

• Afficher dans l’aperçu

• Supprimer

• Dupliquer

• Définir le SCR d’une couche

• Définir le SCR du projet depuis cette couche

• Enregistrer sous...

• Propriétés

• Renommer

• Copier le style

• Ajouter un groupe

• Étendre tout

• Réduire tout

• Mettre à jour l’ordre de rendu

.

13.2 Fenêtre Propriétés de la couche raster

Pour voir et définir les propriétés d’une couche raster, double-cliquez sur le nom de la couche dans la légende de la
carte ou faites un clic-droit son nom et choisissez Propriétés dans le menu qui apparaît. La fenêtre des Propriétés
de la couche apparaîtra (voir figure_raster_1).

Il y a plusieurs onglets dans cette fenêtre :

• Général

• Style

• Transparence

• Pyramides

• Histogramme

• Métadonnées

13.2.1 Onglet Général

Informations sur la couche

L’onglet Général affiche des informations basiques sur le raster sélectionné, dont la source de la couche, le nom
affiché dans la légende (qui peut être modifié), le nombre de colonnes, lignes et les valeurs ‘no-data’.

Système de coordonnées de référence

Le système de coordonnées de référence (SCR) est également affiché ici au format PROJ.4. S’il est incorrect, il
peut être modifié en cliquant sur le bouton [Spécifier].
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Figure 13.1: Raster Layers Properties Dialog

Visibilité dépendante de l’échelle

La visibilité en fonction de l’échelle se définit également dans cet onglet. Vous devez activer la case à cocher et
définir une échelle appropriée pour l’affichage de vos données sur la carte.

Tout en bas, sont affichés un aperçu de la couche, son symbole de légende et sa palette.

13.2.2 Onglet Style

Rendu des bandes raster

QGIS offers four different Render types. The renderer chosen is dependent on the data type.

1. Couleur à Bandes Multiples - Si le fichier raster est multibande et contient plusieurs bandes (par exemple,
avec une image satellite)

2. Palette - Si le fichier ne contient qu’une seule bande indexée (par exemple, pour les cartes topographiques)

3. Singleband gray - (one band of) the image will be rendered as gray; QGIS will choose this renderer if the
file has neither multibands nor an indexed palette nor a continous palette (e.g., used with a shaded relief
map)

4. Pseudo-Couleur à Banque Unique - vous pouvez utiliser ce rendu pour les fichiers contenant une palette
continue ou des cartes en couleur (par exemple pour une carte des altitudes)

Couleur à bandes multiples

Avec ce type de rendu, trois bandes de l’image seront utilisées, chacune correspondant à la composante rouge,
verte ou bleue de l’image colorée finale. Vous pouvez choisir parmi différentes méthodes d’Amélioration du
contraste : ‘Pas d’amélioration’, ‘Étirer jusqu’au MinMax’, ‘Étirer et couper jusqu’au MinMax’ ou ‘Couper
jusqu’au MinMax’.
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Figure 13.2: Raster Renderer - Multiband color

This selection offers you a wide range of options to modify the appearance of your raster layer. First of all, you
have to get the data range from your image. This can be done by choosing the Extent and pressing [Load]. QGIS
can Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Now you can scale the colors with the help of the Load min/max values section. A lot of images have a few very
low and high data. These outliers can be eliminated using the Cumulative count cut setting. The standard data
range is set from 2% to 98% of the data values and can be adapted manually. With this setting, the gray character
of the image can disappear. With the scaling option Min/max, QGIS creates a color table with all of the data
included in the original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8
bit bands). You can also calculate your color table using the Mean +/- standard deviation x . Then,
only the values within the standard deviation or within multiple standard deviations are considered for the color
table. This is useful when you have one or two cells with abnormally high values in a raster grid that are having a
negative impact on the rendering of the raster.

All calculations can also be made for the Current extent.

Astuce: Visualiser une seule bande d’un raster multibande
Si vous désirez visualiser une seule bande d’une image multibande (par exemple la bande rouge), vous pouvez
penser que vous pourriez définir les bandes Verte et Bleue à “Non définie”. Mais ce n’est pas la manière correcte.
Pour afficher la bande Rouge, définissez le type d’image à Bande grise unique, puis sélectionnez la bande Rouge
comme bande à utiliser pour le gris.

Palette

This is the standard render option for singleband files that already include a color table, where each pixel value
is assigned to a certain color. In that case, the palette is rendered automatically. If you want to change colors
assigned to certain values, just double-click on the color and the Select color dialog appears. Also, in QGIS 2.2.
it’s now possible to assign a label to the color values. The label appears in the legend of the raster layer then.

Amélioration de contraste

Note: When adding GRASS rasters, the option Contrast enhancement will always be set automatically to stretch
to min max, regardless of if this is set to another value in the QGIS general options.

Bande grise unique

This renderer allows you to render a single band layer with a Color gradient: ‘Black to white’ or ‘White to black’.
You can define a Min and a Max value by choosing the Extent first and then pressing [Load]. QGIS can
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Figure 13.3: Raster Renderer - Paletted

Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Figure 13.4: Raster Renderer - Singleband gray

With the Load min/max values section, scaling of the color table is possible. Outliers can be eliminated using the
Cumulative count cut setting. The standard data range is set from 2% to 98% of the data values and can be

adapted manually. With this setting, the gray character of the image can disappear. Further settings can be made
with Min/max and Mean +/- standard deviation x . While the first one creates a color table with
all of the data included in the original image, the second creates a color table that only considers values within
the standard deviation or within multiple standard deviations. This is useful when you have one or two cells with
abnormally high values in a raster grid that are having a negative impact on the rendering of the raster.

Pseudo-couleur à bande unique

This is a render option for single-band files, including a continous palette. You can also create individual color
maps for the single bands here. Trois manières de faire une interpolation de couleurs sont disponibles :

1. Discrète
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Figure 13.5: Raster Renderer - Singleband pseudocolor
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2. Linéaire

3. Exacte

In the left block, the button Add values manually adds a value to the individual color table. The button
Remove selected row deletes a value from the individual color table, and the Sort colormap items button sorts the color
table according to the pixel values in the value column. Double clicking on the value column lets you insert a
specific value. Double clicking on the color column opens the dialog Change color, where you can select a color
to apply on that value. Further, you can also add labels for each color, but this value won’t be displayed when you

use the identify feature tool. You can also click on the button Load color map from band, which tries to load the table

from the band (if it has any). And you can use the buttons Load color map from file or Export color map to file to load
an existing color table or to save the defined color table for other sessions.

In the right block, Generate new color map allows you to create newly categorized color maps. For the Classi-

fication mode ‘Equal interval’, you only need to select the number of classes and press the button

Classify. You can invert the colors of the color map by clicking the Invert checkbox. In the case of the Mode

‘Continous’, QGIS creates classes automatically depending on the Min and Max. Defining Min/Max values
can be done with the help of the Load min/max values section. A lot of images have a few very low and high data.
These outliers can be eliminated using the Cumulative count cut setting. The standard data range is set from
2% to 98% of the data values and can be adapted manually. With this setting, the gray character of the image can
disappear. With the scaling option Min/max, QGIS creates a color table with all of the data included in the
original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8 bit bands). You can
also calculate your color table using the Mean +/- standard deviation x . Then, only the values within
the standard deviation or within multiple standard deviations are considered for the color table.

Rendu des couleurs

Pour chaque type de Rendu par bande, des options de Rendu de la couleur sont disponibles.

Vous pouvez réaliser des effets spéciaux sur le rendu de vos rasters en utilisant un des modes de fusion (voir
Fenêtre Propriétés d’une couche vecteur).

Further settings can be made in modifiying the Brightness, the Saturation and the Contrast. You can also use a
Grayscale option, where you can choose between ‘By lightness’, ‘By luminosity’ and ‘By average’. For one hue
in the color table, you can modify the ‘Strength’.

Ré-échantillonnage

Les options de Ré-échantillonnage déterminent l’apparence d’un raster quand vous zoomez ou dé-zoomez. Dif-
férents modes de ré-échantillonnage permettent d’optimiser l’apparence d’un raster. Ils calculent une nouvelle
matrice de valeurs via une transformation géométrique.

En appliquant la méthode ‘Plus proche voisin’, le raster peut apparaître pixelisé lorsque l’on zoome dessus. Ce
rendu peut être amélioré en choisissant les méthodes ‘Bilinéaire’ ou ‘Cubique’ qui adoucissent les angles. L’image
est alors lissée. Ces méthodes sont adaptées par exemple aux rasters d’élévation.

13.2.3 Onglet Transparence

QGIS has the ability to display each raster layer at a different transparency level. Use the transparency slider

to indicate to what extent the underlying layers (if any) should be visible though the current
raster layer. This is very useful if you like to overlay more than one raster layer (e.g., a shaded relief map overlayed
by a classified raster map). This will make the look of the map more three dimensional.

De plus, vous pouvez entrer une valeur raster qui sera traitée comme NODATA dans Valeur nulle supplémentaire.
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Figure 13.6: Raster Rendering - Resampling

Un moyen encore plus flexible de personnaliser la transparence est d’utiliser la section Options de transparence
personnalisée. La transparence de chaque pixel peut être définie dans cet onglet.

As an example, we want to set the water of our example raster file landcover.tif to a transparency of 20%.
The following steps are neccessary:

1. Chargez le raster landcover.tif.

2. Ouvrez la boîte de dialogue Propriétés de la couche en double-cliquant sur le nom du raster dans la légende
ou avec un clic droit et en choisissant Propriétés dans le menu qui apparaît.

3. Sélectionnez l’onglet Transparence.

4. Dans la liste Bande de transparence, choisissez ‘Aucune’.

5. Click the Add values manually button. A new row will appear in the pixel list.

6. Entrez la valeur raster dans les colonnes ‘De’ et ‘Vers’ (mettez la valeur 0) puis ajustez la transparence à
20%.

7. Cliquez sur le bouton [Appliquer] et regardez la carte.

Vous pouvez répéter les étapes 5 et 6 pour personnaliser la transparence d’autres valeurs.

As you can see, it is quite easy to set custom transparency, but it can be quite a lot of work. Therefore, you

can use the button Export to file to save your transparency list to a file. The button Import from file loads your
transparency settings and applies them to the current raster layer.

13.2.4 Onglet Pyramides

Large resolution raster layers can slow navigation in QGIS. By creating lower resolution copies of the data (pyra-
mids), performance can be considerably improved, as QGIS selects the most suitable resolution to use depending
on the level of zoom.

Vous devez avoir accès en écriture dans le répertoire où les données originelles sont stockées pour construire les
pyramides.

Plusieurs méthodes de ré-échantillonnage peuvent être utilisées pour calculer les pyramides :

• Plus proche voisin

• Moyenne

• Gauss
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• Cubique

• Mode

• Aucune

If you choose ‘Internal (if possible)’ from the Overview format menu, QGIS tries to build pyramids internally.
You can also choose ‘External’ and ‘External (Erdas Imagine)’.

Figure 13.7: The Pyramids Menu

Notez que construire des pyramides peut altérer le fichier original et, une fois créées, elles ne peuvent plus être
supprimées. Si vous désirez préserver une version ‘sans pyramide’ de vos raster, réalisez une copie de sauvegarde
avant de les construire.

13.2.5 Onglet Histogramme

The Histogram menu allows you to view the distribution of the bands or colors in your raster. The histogram is
generated automatically when you open the Histogram menu. All existing bands will be displayed together. You

can save the histogram as an image with the button. With the Visibility option in the Prefs/Actions menu,
you can display histograms of the individual bands. You will need to select the option Show selected band.
The Min/max options allow you to ‘Always show min/max markers’, to ‘Zoom to min/max’ and to ‘Update style
to min/max’. With the Actions option, you can ‘Reset’ and ‘Recompute histogram’ after you have chosen the
Min/max options.

13.2.6 Onglet Métadonnées

L’onglet Métadonnées affiche de nombreuses informations sur la couche raster, dont les statistiques sur chaque
bande de la couche raster. Les informations sont regroupées par section : Description, Attribution, URL Métadon-
nées et Propriétés. Les statistiques sont recueillies ‘à la demande’, de sorte qu’il est possible que les statistiques
sur une couche n’aient pas encore été collectées.

.
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Figure 13.8: Raster Histogram

Figure 13.9: Raster Metadata
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13.3 Calculatrice Raster

The Raster Calculator in the Raster menu allows you to perform calculations on the basis of existing raster pixel
values (see figure_raster_10). The results are written to a new raster layer with a GDAL-supported format.

Figure 13.10: Calculatrice Raster

The Raster bands list contains all loaded raster layers that can be used. To add a raster to the raster calculator
expression field, double click its name in the Fields list. You can then use the operators to construct calculation
expressions, or you can just type them into the box.

In the Result layer section, you will need to define an output layer. You can then define the extent of the calculation
area based on an input raster layer, or based on X,Y coordinates and on columns and rows, to set the resolution of
the output layer. If the input layer has a different resolution, the values will be resampled with the nearest neighbor
algorithm.

The Operators section contains all available operators. To add an operator to the raster calculator expression box,
click the appropriate button. Mathematical calculations (+, -, *, ... ) and trigonometric functions (sin, cos,
tan, ... ) are available. Stay tuned for more operators to come!

With the Add result to project checkbox, the result layer will automatically be added to the legend area and
can be visualized.

13.3.1 Exemples

Convert elevation values from meters to feet

Creating an elevation raster in feet from a raster in meters, you need to use the conversion factor for meters to feet:
3.28. The expression is:
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"elevation@1" * 3.28

Utilisation d’un masque

If you want to mask out parts of a raster – say, for instance, because you are only interested in elevations above 0
meters – you can use the following expression to create a mask and apply the result to a raster in one step.

("elevation@1" >= 0) * "elevation@1"

In other words, for every cell greater than or equal to 0, set its value to 1. Otherwise set it to 0. This creates the
mask on the fly.

If you want to classify a raster – say, for instance into two elevation classes, you can use the following expression
to create a raster with two values 1 and 2 in one step.

("elevation@1" < 50) * 1 + ("elevation@1" >= 50) * 2

In other words, for every cell less than 50 set its value to 1. For every cell greater than or equal 50 set its value to
2.

.
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Les données OGC

.

14.1 QGIS as OGC Data Client

L’OGC (Open Geospatial Consortium) est une organisation internationale à laquelle participent plus de 300 or-
ganisations commerciales, gouvernementales, associatives et laboratoires de recherche à travers le monde. Ses
membres développent et implémentent des standards pour les services et le contenu géospatial, le traitement de
données SIG et les formats d’échange.

Un nombre croissant de spécifications décrivant les modèles de données géographiques sont développées
par l’OGC pour servir des besoins spécifiques dans des situations nécessitant une interopérabilité et des
technologies géospatiales, dont les SIG. Des informations supplémentaires peuvent être trouvées sur le site
http://www.opengeospatial.org/.

Important OGC specifications supported by QGIS are:

• WMS — Web Map Service (Client WMS / WMTS)

• WMTS — Web Map Tile Service (Client WMS / WMTS)

• WFS — Web Feature Service (Client WFS et WFS-T)

• WFS-T — Web Feature Service - Transactional (Client WFS et WFS-T)

• WCS — Web Coverage Service (Client WCS)

• SFS — Simple Features for SQL (Couches PostGIS)

• GML — Geography Markup Language

OGC services are increasingly being used to exchange geospatial data between different GIS implementations and
data stores. QGIS can deal with the above specifications as a client, being SFS (through support of the PostgreSQL
/ PostGIS data provider, see section Couches PostGIS).

14.1.1 Client WMS / WMTS

Aperçu de la gestion du WMS

QGIS currently can act as a WMS client that understands WMS 1.1, 1.1.1 and 1.3 servers. In particular, it has
been tested against publicly accessible servers such as DEMIS.

A WMS server acts upon requests by the client (e.g., QGIS) for a raster map with a given extent, set of layers,
symbolization style, and transparency. The WMS server then consults its local data sources, rasterizes the map,
and sends it back to the client in a raster format. For QGIS, this format would typically be JPEG or PNG.

WMS is generically a REST (Representational State Transfer) service rather than a full-blown Web service. As
such, you can actually take the URLs generated by QGIS and use them in a web browser to retrieve the same
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images that QGIS uses internally. This can be useful for troubleshooting, as there are several brands of WMS
server on the market and they all have their own interpretation of the WMS standard.

Des couches WMS peuvent être ajoutées assez simplement, du moment que vous connaissez l’URL pour accéder
au serveur WMS, vous avez une connexion sous forme de service sur ce serveur, et celui-ci comprend le protocole
HTTP comme mécanisme de transport.

Aperçu du support WMTS

QGIS can also act as a WMTS client. WMTS is an OGC standard for distributing tile sets of geospatial data.
This is a faster and more efficient way of distributing data than WMS because with WMTS, the tile sets are pre-
generated, and the client only requests the transmission of the tiles, not their production. A WMS request typically
involves both the generation and transmission of the data. A well-known example of a non-OGC standard for
viewing tiled geospatial data is Google Maps.

Afin d’afficher des données à différentes échelles proches de celles souhaitées par l’utilisateur, les dalles WMTS
sont produites à différents niveaux d’échelle et peuvent être demandées par une application SIG cliente.

Ce diagramme illustre le concept de tuiles prédéfinies:

Figure 14.1: Le concept de tuiles prédéfinies WMTS

The two types of WMTS interfaces that QGIS supports are via Key-Value-Pairs (KVP) and RESTful. These two
interfaces are different, and you need to specify them to QGIS differently.

1) In order to access a WMTS KVP service, a QGIS user must open the WMS/WMTS interface and add the
following string to the URL of the WMTS tile service:

"?SERVICE=WMTS&REQUEST=GetCapabilities"

Un exemple de ce type d’adresse est

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

Pour les tests, la couche topo2 de ce WMTS fonctionne correctement. Ajouter cette chaîne indique que le service
web WMTS est utilisé à la place du service WMS.

2. Le service RESTful WMTS prend la forme différente d’une URL classique. Le format recommandé par
l’OGC est le suivant:

{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml

This format helps you to recognize that it is a RESTful address. A RESTful WMTS is accessed in QGIS by simply
adding its address in the WMS setup in the URL field of the form. An example of this type of address for the case
of an Austrian basemap is http://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml.

152 Chapter 14. Les données OGC

http://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml


QGIS User Guide, Version 2.8

Note: You can still find some old services called WMS-C. These services are quite similar to WMTS (i.e., same
purpose but working a little bit differently). You can manage them the same as you do WMTS services. Just
add ?tiled=true at the end of the url. See http://wiki.osgeo.org/wiki/Tile_Map_Service_Specification for more
information about this specification.

Lorsque vous lisez WMTS, vous pouvez également penser WMS-C.

Sélection des serveurs WMS/WMTS

The first time you use the WMS feature in QGIS, there are no servers defined.

Begin by clicking the Add WMS layer button on the toolbar, or selecting Layer → Add WMS Layer....

La fenêtre Ajouter des couches depuis un serveur pour ajouter des couches d’un serveur WMS s’ouvre.
Vous pouvez ajouter des serveurs pour tester en cliquant le bouton [Ajouter les serveurs par défaut].
Cela ajoutera deux serveurs WMS de démonstration, celui de DM Solutions Group et celui de Lizardtech.
Pour définir un nouveau serveur WMS, dans l’onglet Couches, cliquez sur le bouton [Nouveau] puis en-
trez les paramètres de connexion du serveur WMS désiré, comme listé dans le tableau table_OGC_1:

Nom Un nom pour cette connexion. Ce nom sera utilisé dans la liste déroulante des connexions
aux serveurs afin que vous puissiez le distinguer des autres serveurs WMS.

URL URL du serveur fournissant les données. Cela doit être un nom d’hôte publique – le
même format que si vous l’utilisiez pour ouvrir une connexion Telnet ou pinguer un hôte
(ou dans un navigateur Internet).

Nom utilisateur Nom d’utilisateur pour accéder à un serveur WMS sécurisé. Ce paramètre est optionnel.
Mot de Passe Mot de passe pour une authentification basique à un serveur WMS. Ce paramètre est

optionnel.

Ignorer l’adresse
GetMap

Ignorer l’adresse GetMap signalée : force l’utilisation de l’adresse précisée dans le
champ URL ci-dessus.

Ignorer l’adresse
GetFeatureInfo

Ignorer l’adresse GetFeatureInfo signalée : force l’utilisation de l’adresse précisée
dans le champ URL ci-dessus.

Table OGC 1 : Paramètres de connexion à un serveur WMS

If you need to set up a proxy server to be able to receive WMS services from the internet, you can add your proxy
server in the options. Choose Settings → Options and click on the Network & Proxy tab. There, you can add your

proxy settings and enable them by setting Use proxy for web access. Make sure that you select the correct

proxy type from the Proxy type drop-down menu.

Once the new WMS server connection has been created, it will be preserved for future QGIS sessions.

Astuce: À propos des URL des serveurs WMS
Assurez-vous, lorsque vous entrez l’URL du serveur WMS, d’avoir uniquement l’URL de base. Par exemple,
vous ne devez pas avoir de paramètres tels que request=GetCapabilities ou version=1.0.0 dans
votre URL.

Chargement des couches WMS/WMTS

Une fois que vous avez remplis les paramètres, vous pouvez utiliser le bouton [Connect] pour récupérer les
propriétés du serveur sélectionné. Cela inclut l’encodage des images, les couches, les styles de couches et les
projections. Étant donné qu’il s’agit d’une opération réseau, la vitesse de réponse dépend de la qualité de la
connexion réseau au serveur WMS. Lorsque les données sont téléchargées depuis le serveur WMS, la progression
du téléchargement est visible dans le coin inférieur gauche de la boîte de dialogue WMS.

Votre écran devrait maintenant ressembler à la figure_OGR_1, qui montre la réponse fournie par le serveur WMS
du Portail Européen du Sol.

Format d’image
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Figure 14.2: Dialog for adding a WMS server, showing its available layers
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La section Format d’image liste les formats qui sont gérés à la fois par le client et leur serveur. Choisissez en
fonction de votre besoin de précision de l’image.

Astuce: Format d’image
Les serveurs WMS vous offriront typiquement le choix entre les formats d’image JPEG et PNG. Le JPEG est un
format de compression avec perte alors que le PNG reproduit fidèlement les données raster brutes.

Utilisez le JPEG si vous vous attendez à ce que les données WMS soient de nature photographiques et/ou si vous
acceptez une perte de qualité dans l’image. Ce compromis réduit généralement de cinq fois le temps de transfert
des données par rapport au PNG.

Utilisez le PNG si vous voulez une représentation précise des données d’origine, et vous acceptez des temps de
transfert des données plus longs.

Options

La zone Options de la fenêtre dispose d’un champ textuel où vous pouvez saisir le Nom de la couche WMS. Ce
nom sera affiché dans la légende après le chargement de la couche.

Sous le nom de la couche vous pouvez définir la Taille de tuile (par exemple 256x256), si vous souhaitez diviser
la requête WMS en plusieurs requêtes.

Limite d’entité de GetFeatureInfo permet de définir quelles entités requêter sur le serveur.

Si vous sélectionnez un WMS depuis la liste, la projection par défaut, fournie par mapserver, apparaît. Si le bouton
[Modifications...] est actif, vous pouvez cliquer dessus pour changer cette projection par défaut pour une autre,
fournie par le serveur WMS.

Enfin, vous pouvez activer Utiliser la légende WMS contextuelle si le serveur WMS prend en charge cette
fonctionnalité. Sera alors affichée une légende adaptée aux éléments présents dans l’extension courante de la
carte, les éléments de légende qui correspondent à des éléments non affichés ne seront pas inclus dans la légende.

Ordre des couches

L’onglet Ordre des couches liste les couches sélectionnées disponibles pour le serveur WMS actuellement con-
necté. Certaines couches seront peut-être dépliables, cela signifie que différents styles sont disponibles pour cette
couche.

You can select several layers at once, but only one image style per layer. When several layers are selected, they
will be combined at the WMS server and transmitted to QGIS in one go.

Astuce: Ordonner les couches WMS
Les couches WMS sont superposées par le serveur dans l’ordre listé dans la section Couches, du haut vers le bas.
Si vous souhaitez changer cet ordre, utilisez l’onglet Ordre des couches.

Transparence

In this version of QGIS, the Global transparency setting from the Layer Properties is hard coded to be always on,
where available.

Astuce: Transparence des couches WMS
La disponibilité de la transparence de l’image WMS dépend du format d’image utilisé : les formats PNG et GIF
gèrent la transparence, tandis que le format JPEG ne le gère pas.

Système de Coordonnées de Référence

A coordinate reference system (CRS) is the OGC terminology for a QGIS projection.

Chaque couche WMS peut être représentée dans plusieurs projections (ou SCR), en fonction des possibilités du
serveur WMS.
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Pour choisir un SCR, cliquez sur le bouton [Modifications...] et une fenêtre similaire à la figure de la section
Utiliser les projections apparaitra. La principale différence est qu’ici seules les projections gérées par le serveur
seront listées.

Recherche de serveur

Within QGIS, you can search for WMS servers. Figure_OGC_2 shows the Server Search tab with the Add Layer(s)
from a Server dialog.

Figure 14.3: Dialog for searching WMS servers after some keywords

As you can see, it is possible to enter a search string in the text field and hit the [Search] button. After a short
while, the search result will be populated into the list below the text field. Browse the result list and inspect your
search results within the table. To visualize the results, select a table entry, press the [Add selected row to WMS
list] button and change back to the Layers tab. QGIS has automatically updated your server list, and the selected
search result is already enabled in the list of saved WMS servers in the Layers tab. You only need to request the list
of layers by clicking the [Connect] button. This option is quite handy when you want to search maps by specific
keywords.

Fondamentalement cette option est un front end à l’API de http://geopole.org.

Jeux de Tuiles

Lorsque vous utilisez des services WMTS (WMS en cache) tel que:

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

you are able to browse through the Tilesets tab given by the server. Additional information like tile size, formats
and supported CRS are listed in this table. In combination with this feature, you can use the tile scale slider by
selecting Settings → Panels (KDE and Windows) or View → Panels (Gnome and MacOSX), then choosing Tile
scale. This gives you the available scales from the tile server with a nice slider docked in.
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Utiliser l’outil Identifier

Once you have added a WMS server, and if any layer from a WMS server is queryable, you can then use the
Identify tool to select a pixel on the map canvas. A query is made to the WMS server for each selection made. The
results of the query are returned in plain text. The formatting of this text is dependent on the particular WMS
server used. Sélection du format

Si le serveur gère plusieurs formats de sortie, une liste déroulante des format gérés est automatiquement ajoutée à
la boîte de dialogue des résultats et le format sélectionné peut être stocké dans le fichier de projet pour la couche.
Support du format GML

The Identify tool supports WMS server response (GetFeatureInfo) in GML format (it is called Feature in the
QGIS GUI in this context). If “Feature” format is supported by the server and selected, results of the Identify tool
are vector features, as from a regular vector layer. When a single feature is selected in the tree, it is highlighted
in the map and it can be copied to the clipboard and pasted to another vector layer. See the example setup of the
UMN Mapserver below to support GetFeatureInfo in GML format.

# in layer METADATA add which fields should be included and define geometry (example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"

# Then there are two possibilities/formats available, see a) and b):

# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is send as multipart and contains XSD)
# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

Visualiser les propriétés

Une fois que vous avez ajouté un serveur WMS, vous pouvez voir ses propriétés en faisant un clic-droit sur la
couche dans la légende et en sélectionnant Propriétés. Onglet Métadonnées

L’onglet Métadonnées affiche la richesse des informations du serveur WMS, généralement collectées à partir de
la requête capabilities renvoyée par le serveur. Beaucoup de définitions peuvent être obtenues par la lecture des
normes WMS (voir OPEN-GEOSPATIAL-CONSORTIUM Bibliographie), mais en voici quelques-unes :

• Propriétés du serveur

– Version du WMS — La version de WMS gérée par le serveur.

– Image Formats — The list of MIME-types the server can respond with when drawing the map.
QGIS supports whatever formats the underlying Qt libraries were built with, which is typically at least
image/png and image/jpeg.

– Identity Formats — The list of MIME-types the server can respond with when you use the Identify
tool. Currently, QGIS supports the text-plain type.

• Propriétés de la couche

– Selectionnée — Si la couche a été sélectionnée quand le serveur correspondant a été ajouté au projet.
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– Visible — Whether or not this layer is selected as visible in the legend (not yet used in this version of
QGIS).

– Peut identifier — Si cette couche retournera des résultats quand l’outil Identifier est utilisé sur celle-ci.

– Can be Transparent — Whether or not this layer can be rendered with transparency. This version of
QGIS will always use transparency if this is Yes and the image encoding supports transparency.

– Can Zoom In — Whether or not this layer can be zoomed in by the server. This version of QGIS
assumes all WMS layers have this set to Yes. Deficient layers may be rendered strangely.

– Décompte des cascades — Les serveurs WMS peuvent agir comme un proxy à d’autres serveurs
WMS pour obtenir des données pour une couche. Cette entrée affiche le nombre de fois où la requête
pour cette couche est redirigée vers un autre serveur WMS pour obtenir un résultat.

– Fixed Width, Fixed Height — Whether or not this layer has fixed source pixel dimensions. This
version of QGIS assumes all WMS layers have this set to nothing. Deficient layers may be rendered
strangely.

– WGS 84 Bounding Box — The bounding box of the layer, in WGS 84 coordinates. Some WMS
servers do not set this correctly (e.g., UTM coordinates are used instead). If this is the case, then
the initial view of this layer may be rendered with a very ‘zoomed-out’ appearance by QGIS. The
WMS webmaster should be informed of this error, which they may know as the WMS XML elements
LatLonBoundingBox, EX_GeographicBoundingBox or the CRS:84 BoundingBox.

– Disponibilité des SCR — Les projections que l’on peut utiliser via le serveur WMS. Elles sont listées
dans le format natif du WMS.

– Disponibilité des styles — Les styles d’images que le serveur WMS peut utiliser pour le rendu de
cette couche.

Affiche la légende WMS dans la légende et dans le composeur

The QGIS WMS data provider is able to display a legend graphic in the table of contents’ layer list and in the
map composer. The WMS legend will be shown only if the WMS server has GetLegendGraphic capability and
the layer has getCapability url specified, so you additionally have to select a styling for the layer.

Si une légende graphique est disponible, elle est affichée sous la couche. Elle est de faible taille et vous devez
cliquer dessus pour l’afficher complètement (dû à une limite d’architecture de QgsLegendInterface). Cliquer sur
la légende de la couche ouvrira une fenêtre avec la légende en pleine résolution.

In the print composer, the legend will be integrated at it’s original (dowloaded) dimension. Resolution of the
legend graphic can be set in the item properties under Legend -> WMS LegendGraphic to match your printing
requirements

La légende affichera une information contextuelle basée sur l’échelle courante. La légende WMS sera affichée
uniquement si le serveur WMS dispose de la fonction GetLegendGraphic et si la couche dispose d’une url getCa-
pability pour pouvoir choisir son style.

Limitations du client WMS

Not all possible WMS client functionality had been included in this version of QGIS. Some of the more noteworthy
exceptions follow.

Éditer la configuration d’une couche WMS

Once you’ve completed the Add WMS layer procedure, there is no way to change the settings. A work-around is
to delete the layer completely and start again.

Serveurs WMS nécessitant une authentification

Actuellement les serveurs WMS publics et sécurisés sont gérés. Les serveurs sécurisés sont accessibles via authen-
tification publique. Vous pouvez ajouter ces informations d’authentification (optionnelles) au moment de l’ajout
d’un serveur WMS. Voir la section Sélection des serveurs WMS/WMTS pour les détails.
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Astuce: Accéder à des couches OGC sécurisées
Si vous avez besoin d’accéder à des couches sécurisées avec des méthodes sécurisées autres que la sim-
ple authentification, vous pouvez utiliser InteProxy comme proxy transparent, qui gère plusieurs méthodes
d’authentification. Vous pouvez trouver plus d’informations dans le manuel d’InteProxy que vous trouverez sur le
site http://inteproxy.wald.intevation.org.

Astuce: QGIS WMS Mapserver
Since Version 1.7.0, QGIS has its own implementation of a WMS 1.3.0 Mapserver. Read more about this in
chapter QGIS as OGC Data Server.

14.1.2 Client WCS

Un service Web Coverage (WCS) fournit un accès à des données raster sous une forme qui permet le rendu
côté client, comme une entrée vers des modèles scientifiques. WCS peut être comparé à WFS et WMS. Comme ces
services, WCS permet aux clients de choisir des portions de données issues du serveur basées sur des contraîntes
spatiales et d’autres critères de recherche.

QGIS has a native WCS provider and supports both version 1.0 and 1.1 (which are significantly different), but
currently it prefers 1.0, because 1.1 has many issues (i.e., each server implements it in a different way with various
particularities).

The native WCS provider handles all network requests and uses all standard QGIS network settings (especially
proxy). It is also possible to select cache mode (‘always cache’, ‘prefer cache’, ‘prefer network’, ‘always net-
work’), and the provider also supports selection of time position, if temporal domain is offered by the server.

14.1.3 Client WFS et WFS-T

In QGIS, a WFS layer behaves pretty much like any other vector layer. You can identify and select features, and
view the attribute table. Since QGIS 1.6, editing WFS-T is also supported.

Dans l’ensemble, l’ajout d’une couche WFS suit une procédure très similaire à celle des couches WMS. La
différence est qu’il n’y a pas de serveur défini par défaut, nous allons donc devoir en ajouter un.

Charger une couche WFS

Pour notre exemple nous utiliserons le serveur WFS de DM Solutions et afficherons une couche. L’URL est :
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Cliquez sur le bouton Ajouter une couche WFS de la barre d’outils Couches. La fenêtre Ajouter une couche
WFS d’un serveur apparaît.

2. Cliquez sur [Nouveau].

3. Entrez ‘DM Solutions’ pour le nom.

4. Entrez l’URL (voir ci-dessus).

5. Cliquez sur le bouton [OK].

6. Choose ‘DM Solutions’ from the Server Connections drop-down list.

7. Cliquez sur [Connexion].

8. Attendez que la liste des couches soit complète.

9. Cliquez sur la couche Parks dans la liste.

10. Cliquez sur [Appliquer] pour ajouter la couche à la carte.
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Figure 14.4: Adding a WFS layer

Il est à noter que tous paramètres de proxy que vous auriez renseignés dans vos options sont également reconnus.

You’ll notice the download progress is visualized in the lower left of the QGIS main window. Once the layer is
loaded, you can identify and select a province or two and view the attribute table.

Seul le WFS 1.0.0 est géré. Pour le moment il n’y a pas eu de test pour les autres versions des services WFS des
serveurs WFS. Si vous rencontrez des problèmes avec d’autres serveurs WFS, n’hésitez pas à contacter l’équipe
de développement. Référez-vous à la section Aide et support pour plus d’informations sur les listes de diffusions.

Astuce: Trouver des serveurs WFS
You can find additional WFS servers by using Google or your favorite search engine. There are a number of lists
with public URLs, some of them maintained and some not.

.

14.2 QGIS as OGC Data Server

QGIS Server is an open source WMS 1.3, WFS 1.0.0 and WCS 1 1.1.1 implementation that, in addition, im-
plements advanced cartographic features for thematic mapping. The QGIS Server is a FastCGI/CGI (Common
Gateway Interface) application written in C++ that works together with a web server (e.g., Apache, Lighttpd).
It has Python plugin support allowing for fast and efficient development and deployment of new features. It is
funded by the EU projects Orchestra, Sany and the city of Uster in Switzerland.

QGIS Server uses QGIS as back end for the GIS logic and for map rendering. Furthermore, the Qt library is
used for graphics and for platform-independent C++ programming. In contrast to other WMS software, the QGIS
Server uses cartographic rules as a configuration language, both for the server configuration and for the user-
defined cartographic rules.

As QGIS desktop and QGIS Server use the same visualization libraries, the maps that are published on the web
look the same as in desktop GIS.

In one of the following manuals, we will provide a sample configuration to set up a QGIS Server. For now, we
recommend to read one of the following URLs to get more information:

• http://karlinapp.ethz.ch/qgis_wms/

• http://hub.qgis.org/projects/quantum-gis/wiki/QGIS_Server_Tutorial
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• http://linfiniti.com/2010/08/qgis-mapserver-a-wms-server-for-the-masses/

14.2.1 Sample installation on Debian Squeeze

At this point, we will give a short and simple sample installation how-to for a minimal working configuration
using Apache2 on Debian Squeeze. Many other OSs provide packages for QGIS Server, too. If you have to build
it all from source, please refer to the URLs above.

Firstly, add the following debian GIS repository by adding the following repository:

$ cat /etc/apt/sources.list.d/debian-gis.list
deb http://qgis.org/debian trusty main
deb-src http://qgis.org/debian trusty main

$ # Add keys
$ sudo gpg --recv-key DD45F6C3
$ sudo gpg --export --armor DD45F6C3 | sudo apt-key add -

$ # Update package list
$ sudo apt-get update && sudo apt-get upgrade

Now, install QGIS-Server:

$ sudo apt-get install qgis-server python-qgis

Installez par exemple l’extension HelloWorld pour tester les serveurs. Créez un répertoire pour accueillir les
extensions serveur. Cela sera spécifié dans la configuration de l’hôte virtuel et passé au serveur par le biais d’une
variable d’environnement :

$ sudo mkdir -p /opt/qgis-server/plugins
$ cd /opt/qgis-server/plugins
$ sudo wget https://github.com/elpaso/qgis-helloserver/archive/master.zip
$ # In case unzip was not installed before:
$ sudo apt-get install unzip
$ sudo unzip master.zip
$ sudo mv qgis-helloserver-master HelloServer

Installez le serveur Apache dans un hôte virtuel séparé sur le port 80. Activez le module rewrite pour transmettre
les entêtes HTTP BASIC auth.

$ sudo a2enmod rewrite
$ cat /etc/apache2/conf-available/qgis-server-port.conf
Listen 80
$ sudo a2enconf qgis-server-port

Voici la configuration de l’hôte virtuel, stocké dans /etc/apache2/sites-available/001-qgis-server.conf
:

<VirtualHost *:80>
ServerAdmin webmaster@localhost
DocumentRoot /var/www/html

ErrorLog ${APACHE_LOG_DIR}/qgis-server-error.log
CustomLog ${APACHE_LOG_DIR}/qgis-server-access.log combined

# Longer timeout for WPS... default = 40
FcgidIOTimeout 120
FcgidInitialEnv LC_ALL "en_US.UTF-8"
FcgidInitialEnv PYTHONIOENCODING UTF-8
FcgidInitialEnv LANG "en_US.UTF-8"
FcgidInitialEnv QGIS_DEBUG 1
FcgidInitialEnv QGIS_SERVER_LOG_FILE /tmp/qgis-000.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0
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FcgidInitialEnv QGIS_PLUGINPATH "/opt/qgis-server/plugins"

# ABP: needed for QGIS HelloServer plugin HTTP BASIC auth
<IfModule mod_fcgid.c>

RewriteEngine on
RewriteCond %{HTTP:Authorization} .
RewriteRule .* - [E=HTTP_AUTHORIZATION:%{HTTP:Authorization}]

</IfModule>

ScriptAlias /cgi-bin/ /usr/lib/cgi-bin/
<Directory "/usr/lib/cgi-bin">

AllowOverride All
Options +ExecCGI -MultiViews +FollowSymLinks
# for apache2 > 2.4
Require all granted
#Allow from all

</Directory>
</VirtualHost>

Maintenant activez l’hôte virtuel et redémarrer Apache :

$ sudo a2ensite 001-qgis-server
$ sudo service apache2 restart

Testez le serveur avec l’extension HelloWorld :

$ wget -q -O - "http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=HELLO"
HelloServer!

You can have a look at the default GetCpabilities of the QGIS server at:
http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities

Astuce: If you work with a feature that has many nodes then modyfying and adding a new feature will fail. In
this case it is possible to insert the following code into the 001-qgis-server.conf file:

<IfModule mod_fcgid.c>
FcgidMaxRequestLen 26214400
FcgidConnectTimeout 60
</IfModule>

14.2.2 Creating a WMS/WFS/WCS from a QGIS project

To provide a new QGIS Server WMS, WFS or WCS, we have to create a QGIS project file with some data. Here,
we use the ‘Alaska’ shapefile from the QGIS sample dataset. Define the colors and styles of the layers in QGIS
and the project CRS, if not already defined.

Then, go to the OWS Server menu of the Project → Project Properties dialog and provide some information about
the OWS in the fields under Service Capabilities. This will appear in the GetCapabilities response of the WMS,

WFS or WCS. If you don’t check Service capabilities, QGIS Server will use the information given in the
wms_metadata.xml file located in the cgi-bin folder.

WMS capabilities

In the WMS capabilities section, you can define the extent advertised in the WMS GetCapabilities response by
entering the minimum and maximum X and Y values in the fields under Advertised extent. Clicking Use Current

Canvas Extent sets these values to the extent currently displayed in the QGIS map canvas. By checking CRS
restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server will offer to render maps.

Use the button below to select those CRS from the Coordinate Reference System Selector, or click Used to
add the CRS used in the QGIS project to the list.
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Figure 14.5: Definitions for a QGIS Server WMS/WFS/WCS project (KDE)
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If you have print composers defined in your project, they will be listed in the GetCapabilities response, and they
can be used by the GetPrint request to create prints, using one of the print composer layouts as a template. This
is a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print composer from

being published by the WMS, check Exclude composers and click the button below. Then, select a print
composer from the Select print composer dialog in order to add it to the excluded composers list.

If you want to exclude any layer or layer group from being published by the WMS, check Exclude Layers and

click the button below. This opens the Select restricted layers and groups dialog, which allows you to choose
the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want to select
multiple entries at once.

You can receive requested GetFeatureInfo as plain text, XML and GML. Default is XML, text or GML format
depends the output format choosen for the GetFeatureInfo request.

If you wish, you can check Add geometry to feature response. This will include in the GetFeatureInfo response
the geometries of the features in a text format. If you want QGIS Server to advertise specific request URLs in the
WMS GetCapabilities response, enter the corresponding URL in the Advertised URL field. Furthermore, you can
restrict the maximum size of the maps returned by the GetMap request by entering the maximum width and height
into the respective fields under Maximums for GetMap request.

If one of your layers uses the Map Tip display (i.e. to show text using expressions) this will be listed inside the
GetFeatureInfo output. If the layer uses a Value Map for one of his attributes, also this information will be shown
in the GetFeatureInfo output.

QGIS support the following request for WMS service:

• GetCapabilities

• GetMap

• GetFeatureInfo

• GetLegendGraphic (SLD profile)

• DescribeLayer (SLD profile)

• GetStyles (custom QGIS profile)

WFS capabilities

In the WFS capabilities area, you can select the layers that you want to publish as WFS, and specify if they
will allow the update, insert and delete operations. If you enter a URL in the Advertised URL field of the WFS
capabilities section, QGIS Server will advertise this specific URL in the WFS GetCapabilities response.

QGIS support the following request for WFS service:

• GetCapabilities

• DescribeFeatureType

• GetFeature

• Transaction

WCS capabilities

In the WCS capabilities area, you can select the layers that you want to publish as WCS. If you enter a URL in the
Advertised URL field of the WCS capabilities section, QGIS Server will advertise this specific URL in the WCS
GetCapabilities response.

Maintenant, sauvegarder la session dans un fichier de projet alaska.qgs. Pour founir le projet en WMS/WFS,
nous créons un nouveau répertoire /usr/lib/cgi-bin/project avec des provlèges d’administrateur et
nous ajoutons le fichier de projet alaska.qgs ainsi qu’une copie du fichier qgis_mapserv.fcgi. C’est
tout !

Now we test our project WMS, WFS and WCS. Add the WMS, WFS and WCS as described in Chargement des
couches WMS/WMTS, Client WFS et WFS-T and Client WCS to QGIS and load the data. The URL is:
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http://localhost/cgi-bin/project/qgis_mapserv.fcgi

QGIS support the following request for WCS service:

• GetCapabilities

• DescribeCoverage

• GetCoverage

Bien configurer votre OWS

For vector layers, the Fields menu of the Layer → Properties dialog allows you to define for each attribute if it
will be published or not. By default, all the attributes are published by your WMS and WFS. If you want a specific
attribute not to be published, uncheck the corresponding checkbox in the WMS or WFS column.

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG annotations
to the project file. See section Annotation Tools in Outils généraux for instructions on creating annotations. For
annotations to be displayed as watermarks on the WMS output, the Fixed map position check box in the Annotation
text dialog must be unchecked. This can be accessed by double clicking the annotation while one of the annotation
tools is active. For SVG annotations, you will need either to set the project to save absolute paths (in the General
menu of the Project → Project Properties dialog) or to manually modify the path to the SVG image in a way that
it represents a valid relative path.

Paramètres additionnels supportés par la requête WMS GetMap

In the WMS GetMap request, QGIS Server accepts a couple of extra parameters in addition to the standard
parameters according to the OCG WMS 1.3.0 specification:

• MAP parameter: Similar to MapServer, the MAP parameter can be used to specify the path to the QGIS
project file. You can specify an absolute path or a path relative to the location of the server executable
(qgis_mapserv.fcgi). If not specified, QGIS Server searches for .qgs files in the directory where the
server executable is located.

Exemple:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&MAP=/home/qgis/mymap.qgs&...

• Paramètre DPI : Le paramètre DPI peut être utilisé pour spécifier la résolution de sortie.

Exemple:

http://localhost/cgi-bin/qgis_mapserv.fcgi?REQUEST=GetMap&DPI=300&...

• Paramètre OPACITIES : L’opacité peut être définie sur la couche ou le groupe de couches. Les valeurs
possibles vont de 0 (transparence totale) à 255 (complètement opaque).

Exemple:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&LAYERS=mylayer1,mylayer2&OPACITIES=125,200&...

QGIS Server logging

To log requests send to server, set the following environment variables:

• QGIS_SERVER_LOG_FILE: indique le chemin et le nom de fichier du journal. Assurez-vous que le
serveur dispose des permissions adaptées pour écrire dans le fichier. Le fichier est créé automatiquement
lors de l’envoi de requêtes vers le serveur. S’il n’existe pas, vérifiez les permissions.
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• GIS_SERVER_LOG_LEVEL: indique le niveau de journalisation désiré. Les valeurs disponibles sont les
suivantes:

– 0 INFO (journalise toutes les requêtes),

– 1 WARNING,

– 2 CRITICAL (journalise uniquement les erreurs critiques, adapté à un fonctionnement en production).

Exemple:

SetEnv QGIS_SERVER_LOG_FILE /var/tmp/qgislog.txt
SetEnv QGIS_SERVER_LOG_LEVEL 0

Note

• Lorsque vous utilisez le module Fcgid, utilisez la clause FcgidInitialEnv à la place de SetEnv !

• Server logging is enabled also if executable is compiled in release mode.

Variables d’environnement

• QGIS_OPTIONS_PATH: The variable specifies path to directory with settings. It works
the same ways as QGIS application –optionspath option. It is looking for settings file in
<QGIS_OPTIONS_PATH>/QGIS/QGIS2.ini. For exaple, to set QGIS server on Apache to use
/path/to/config/QGIS/QGIS2.ini settings file, add to Apache config:

SetEnv QGIS_OPTIONS_PATH "/path/to/config/"

.
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CHAPTER 15

Les données GPS

.

15.1 Extension GPS

15.1.1 Qu’est ce que le GPS ?

GPS, the Global Positioning System, is a satellite-based system that allows anyone with a GPS receiver to find their
exact position anywhere in the world. GPS is used as an aid in navigation, for example in airplanes, in boats and
by hikers. The GPS receiver uses the signals from the satellites to calculate its latitude, longitude and (sometimes)
elevation. Most receivers also have the capability to store locations (known as waypoints), sequences of locations
that make up a planned route and a tracklog or track of the receiver’s movement over time. Waypoints, routes
and tracks are the three basic feature types in GPS data. QGIS displays waypoints in point layers, while routes
and tracks are displayed in linestring layers.

15.1.2 Charger des données GPS à partir d’un fichier

There are dozens of different file formats for storing GPS data. The format that QGIS uses is called GPX (GPS
eXchange format), which is a standard interchange format that can contain any number of waypoints, routes and
tracks in the same file.

To load a GPX file, you first need to load the plugin. Plugins → Plugin Manager... opens the Plugin Manager

Dialog. Activate the GPS Tools checkbox. When this plugin is loaded, a button with a small handheld GPS
device will show up in the toolbar and in Layer → Create Layer → :

• GPS Tools

• Create new GPX Layer

For working with GPS data, we provide an example GPX file available in the QGIS sample dataset:
qgis_sample_data/gps/national_monuments.gpx. See section Échantillon de données for more
information about the sample data.

1. Select Vector → GPS → GPS Tools or click the GPS Tools icon in the toolbar and open the Load GPX file
tab (see figure_GPS_1).

2. Naviguez vers le répertoire qgis_sample_data/gps/, sélectionnez le fichier
national_monuments.gpx et cliquez sur le bouton [Ouvrir].

Utilisez le bouton [Parcourir] pour sélectionner le fichier GPX, puis utilisez la case à cocher pour sélectionner
les types de géométrie que vous voulez charger à partir de ce fichier GPX. Chaque type d’objet sera chargé dans
une couche séparée lors du clic sur le bouton [OK]. Le fichier national_monuments.gpx ne contient que
des waypoints.
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Figure 15.1: The GPS Tools dialog window

Note: GPS units allow you to store data in different coordinate systems. When downloading a GPX file
(from your GPS unit or a web site) and then loading it in QGIS, be sure that the data stored in the GPX
file uses WGS 84 (latitude/longitude). QGIS expects this, and it is the official GPX specification. See
http://www.topografix.com/GPX/1/1/.

15.1.3 GPSBabel

Since QGIS uses GPX files, you need a way to convert other GPS file formats to GPX. This can be done for many
formats using the free program GPSBabel, which is available at http://www.gpsbabel.org. This program can also
transfer GPS data between your computer and a GPS device. QGIS uses GPSBabel to do these things, so it is
recommended that you install it. However, if you just want to load GPS data from GPX files you will not need it.
Version 1.2.3 of GPSBabel is known to work with QGIS, but you should be able to use later versions without any
problems.

15.1.4 Importer des données GPS

Pour importer des données d’un fichier qui n’est pas un fichier GPX, vous devez utiliser l’outil Importer un autre
fichier dans la fenêtre des outils GPS. Vous sélectionnez le fichier que vous voulez importer, le type de géométrie,
l’emplacement où stocker le fichier GPX converti et sous quel nom l’enregistrer. Tous les formats de données GPS
ne supportent pas les trois types d’entités, ne vous laissant le choix qu’entre un ou deux types.

15.1.5 Télécharger des données GPS à partir d’un périphérique

QGIS can use GPSBabel to download data from a GPS device directly as new vector layers. For this we use the
Download from GPS tab of the GPS Tools dialog (see Figure_GPS_2). Here, we select the type of GPS device,
the port that it is connected to (or USB if your GPS supports this), the feature type that you want to download, the
GPX file where the data should be stored, and the name of the new layer.

Le type de périphérique que vous sélectionnez dans le menu périphérique GPS détermine comment GPSBabel
tente de communiquer avec votre périphérique GPS. Si aucun des types ne fonctionne avec votre périphérique
GPS, vous pouvez créer un nouveau type adapté (voir la section Définir de nouveaux types de périphériques).

Le port peut être un nom de fichier ou n’importe quel autre nom que votre système d’exploitation utilise comme
référence vers le port physique de votre ordinateur sur lequel est connecté le périphérique GPS. Cela peut aussi
être de l’USB, si votre périphérique GPS fonctionne dans ce mode.

• Sous Linux, il s’agit de quelque chose qui ressemble à /dev/ttyS0 ou /dev/ttyS1.

• Sous Windows, il s’agit de COM1 ou COM2.
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Figure 15.2: L’outil de téléchargement

When you click [OK], the data will be downloaded from the device and appear as a layer in QGIS.

15.1.6 Envoyer des données GPS vers un appareil

You can also upload data directly from a vector layer in QGIS to a GPS device using the Upload to GPS tab of
the GPS Tools dialog. To do this, you simply select the layer that you want to upload (which must be a GPX
layer), your GPS device type, and the port (or USB) that it is connected to. Just as with the download tool, you
can specify new device types if your device isn’t in the list.

This tool is very useful in combination with the vector-editing capabilities of QGIS. It allows you to load a map,
create waypoints and routes, and then upload them and use them on your GPS device.

15.1.7 Définir de nouveaux types de périphériques

There are lots of different types of GPS devices. The QGIS developers can’t test all of them, so if you have one
that does not work with any of the device types listed in the Download from GPS and Upload to GPS tools, you
can define your own device type for it. You do this by using the GPS device editor, which you start by clicking
the [Edit devices] button in the download or the upload tab.

To define a new device, you simply click the [New device] button, enter a name, enter download and upload
commands for your device, and click the [Update device] button. The name will be listed in the device menus in
the upload and download windows – it can be any string. The download command is the command that is used to
download data from the device to a GPX file. This will probably be a GPSBabel command, but you can use any
other command line program that can create a GPX file. QGIS will replace the keywords %type, %in, and %out
when it runs the command.

%type sera remplacé par -w si vous téléchargez des waypoints, -r pour des routes et -t pour des tracks. Ce
sont des options de la ligne de commande qui précisent à GPSBabel quel type d’objet télécharger.

%in will be replaced by the port name that you choose in the download window and %out will be replaced by
the name you choose for the GPX file that the downloaded data should be stored in. So, if you create a device
type with the download command gpsbabel %type -i garmin -o gpx %in %out (this is actually the
download command for the predefined device type ‘Garmin serial’) and then use it to download waypoints from
port /dev/ttyS0 to the file output.gpx, QGIS will replace the keywords and run the command gpsbabel
-w -i garmin -o gpx /dev/ttyS0 output.gpx.

La commande de téléchargement est la commande qui est utilisée pour télécharger des données vers le pé-
riphérique. Les même mots-clés sont utilisés mais %in est maintenant remplacé par le nom du fichier GPX
pour la couche qui est à uploader et %out est remplacé par le nom du port.

Pour en savoir plus sur GPSBabel et les options de ligne de commande disponibles, référez-vous à
http://www.gpsbabel.org.
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Une fois le nouveau type de périphérique créé, celui-ci apparaîtra dans les listes de périphériques des outils de
téléchargement et d’upload.

15.1.8 Chargement de points/traces depuis un périphérique GPS

Comme précisé dans les sections précédentes, QGIS utilise GPSBabel pour télécharger les points et traces directe-
ment dans le projet. QGIS est fourni avec un profil pré-défini pour charger depuis des périphériques GPS Garmin.
Malheureusement il existe un bug #6318 qui ne permet pas de créer d’autres profils, aussi le téléchargement direct
dans QGIS depuis les Outils GPS est pour le moment limité aux périphériques Garmin.

Garmin GPSMAP 60cs

MS Windows

Installez les drivers USB Garmin depuis http://www8.garmin.com/support/download_details.jsp?id=591

Connectez le périphérique. Ouvrez les Outils GPS et utilisez Périphérique GPS=Garmin serial et
Port=usb: Remplissez les champs Nom de la couche and Fichier en sortie. Quelquefois il semble y avoir
des problèmes avec certains répertoire, cela fonctionne en général en utilisant un répertoire du style c:\temp.

Ubuntu/Mint GNU/Linux

Il est d’abord nécessaire de régler un problème concernant les permissions du périphérique, comme cela est ex-
pliqué à cette adresse : https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux. Vous pouvez essayer
de créer un fichier /etc/udev/rules.d/51-garmin.rules contenant cette règle

ATTRS{idVendor}=="091e", ATTRS{idProduct}=="0003", MODE="666"

Après cela il est nécessaire de s’assurer que le module du noyau garmin_gps n’est pas chargé

rmmod garmin_gps

vous pouvez alors utiliser les Outils GPS. Malheureusement il semble y avoir un bug #7182 et généralement QGIS
se bloque plusieurs fois avant que l’opération ne réussisse.

BTGP-38KM datalogger (seulement Bluetooth)

MS Windows

Un bug connu ne permet pas de télécharger les données depuis QGIS, aussi il est nécessaire d’utiliser GPSBabel
depuis la ligne de commande ou à travers son interface dédiée. La commande qui fonctionne est

gpsbabel -t -i skytraq,baud=9600,initbaud=9600 -f COM9 -o gpx -F C:/GPX/aaa.gpx

Ubuntu/Mint GNU/Linux

Avec Windows, utilisez la même commande (ou les mêmes paramètres si vous utilisez l’interface de GPSBabel).
Sous Linux il est possible que vous obteniez un message du genre

skytraq: Too many read errors on serial port

vous pouvez tenter d’allumer et d’éteindre le datalogger avant de réessayer.

BlueMax GPS-4044 datalogger (BT et USB)

MS Windows

Note: Il est nécessaire d’installer ses drivers avant l’utilisation dans Windows 7. Voir le site du fabricant pour le
téléchargement des drivers.
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Télécharger avec GPSBabel, aussi bien en USB ou BT retourne toujours une erreur du genre

gpsbabel -t -i mtk -f COM12 -o gpx -F C:/temp/test.gpx
mtk_logger: Can’t create temporary file data.bin
Error running gpsbabel: Process exited unsucessfully with code 1

Ubuntu/Mint GNU/Linux

Avec USB

Après avoir connecté le cable, utilisez la commande dmesg pour afficher le port qui est utilisé, par exemple
/dev/ttyACM3. Ensuite utilisez GPSBabel comme d’habitude depuis la ligne de commande ou son interface
dédiée.

gpsbabel -t -i mtk -f /dev/ttyACM3 -o gpx -F /home/user/bluemax.gpx

Avec Bluetooth

Utilisez le gestionnaire de périphériques Blueman (Blueman Device Manager) pour associer le périphérique et le
rendre accessible à travers un port du système, puis lancez GPSBabel

gpsbabel -t -i mtk -f /dev/rfcomm0 -o gpx -F /home/user/bluemax_bt.gpx

.

15.2 Suivi GPS en direct

To activate live GPS tracking in QGIS, you need to select Settings → Panels GPS information. You will get a
new docked window on the left side of the canvas.

Cette fenêtre propose quatre écrans différents :

• GPS position coordinates and an interface for manually entering vertices and features

• GPS signal strength of satellite connections

• GPS polar screen showing number and polar position of satellites

• GPS options screen (see figure_gps_options)

With a plugged-in GPS receiver (has to be supported by your operating system), a simple click on [Connect] con-
nects the GPS to QGIS. A second click (now on [Disconnect]) disconnects the GPS receiver from your computer.
For GNU/Linux, gpsd support is integrated to support connection to most GPS receivers. Therefore, you first have
to configure gpsd properly to connect QGIS to it.

Warning: Si vous désirez enregistrer votre position sur la carte, vous devez au préalable, créer une nouvelle
couche et la passer en mode édition.

15.2.1 Coordonnées de la position

If the GPS is receiving signals from satellites, you will see your position in latitude, longitude and altitude
together with additional attributes.

15.2.2 Force du signal GPS

Here, you can see the signal strength of the satellites you are receiving signals from.
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Figure 15.3: GPS tracking position and additional attributes

Figure 15.4: GPS tracking signal strength
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15.2.3 Graphe polaire

If you want to know where in the sky all the connected satellites are, you have to switch to the polar screen.
You can also see the ID numbers of the satellites you are receiving signals from.

Figure 15.5: GPS tracking polar window

15.2.4 Configuration GPS

In case of connection problems, you can switch between:

• Autodetect

• Internal

• Serial device

• gpsd (selecting the Host, Port and Device your GPS is connected to)

Cliquez à nouveau sur [Connecter] pour réinitialiser la connexion avec le récepteur GPS.

Vous pouvez activer Enregistrer automatiquement chaque entité ajoutée lorsque vous êtes en mode édition.

Ou vous pouvez activer Ajouter automatiquement des points en choisissant la largeur et la couleur.

En activant Curseur, utilisez le curseur pour augmenter ou diminuer la taille du curseur
marquant la position du GPS sur la carte.

Activating Map centering allows you to decide in which way the canvas will be updated. This includes
‘always’, ‘when leaving’, if your recorded coordinates start to move out of the canvas, or ‘never’, to keep map
extent.

Enfin, vous pouvez activer le Fichier journal et définir un fichier pour enregistrer les messages du suivi GPS.

If you want to set a feature manually, you have to go back to Position and click on [Add Point] or [Add track
point].

15.2.5 Connexion à un GPS Bluetooth pour le suivi en direct

Avec QGIS, vous pouvez vous connecter à une GPS Bluetooth pour la récupération de données terrain. Pour
réaliser cette tâhce, voux aurez besoin d’un GPS Bluetooth et d’un récepteur Bluetooth sur votre ordinateur.

Au démarrage, vous devez faire en sorte que votre GPS soit reconnue et appairé avec votre ordinateur. Allumez le
GPS, allez dans l’icône Bluetooth de votre barre de notification et rechercher un Nouveau Périphérique.
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Figure 15.6: GPS tracking options window
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Sur le côté droit du masque de sélection des périphériques, assurez-vous que tous les périphériques sont sélection-
nés pour garantir que votre unité GPS apparaissent dans cette sélection. Dans la prochaine étape, un service de
connexion série devrait être disponible. Sélectionnez-le et cliquez sur le bouton [Configurer].

Retenez le numéro du port COM affecté à la connexion GPS dans les propriétés Bluetooth.

After the GPS has been recognized, make the pairing for the connection. Usually the autorization code is 0000.

Now open GPS information panel and switch to GPS options screen. Select the COM port assigned to the GPS
connection and click the [Connect]. After a while a cursor indicating your position should appear.

Si QGIS ne peut recevoir de données GPS, vous devriez alors redémarrer votre GPS, attendre 5-10 secondes
et réessayer de le connecter. Généralement, celle solution fonctionne. Si vous avez de nouveau une erreur de
connexion, assurez-vous que vous n’avez pas un autre capteur Bluetooth à proximité, apparairé avec le GPS.

15.2.6 Utiliser un Garmin GPSMAP 60cs

MS Windows

Le moyen le plus facile pour le faire fonctionner est d’utiliser un logiciel intermédiaire (en freeware mais pas
libre) appelé GPSGate.

Launch the program, make it scan for GPS devices (works for both USB and BT ones) and then in QGIS just click
[Connect] in the Live tracking panel using the Autodetect mode.

Ubuntu/Mint GNU/Linux

Comme pour Windows le plus simple est d’utiliser un serveur intermédiaire, dans ce cas GPSD, donc

sudo apt-get install gpsd

Vous pouvez alors charger le module du noyau garmin_gps

sudo modprobe garmin_gps

Connectez ensuite l’unité. Vérifiez avec dmesg que le périphérique utilisé par l’unité, par exemple
/dev/ttyUSB0. Maintenant, vous pouvez lancer qpsd.

gpsd /dev/ttyUSB0

Connectez enfin avec l’outil de suivi en direct de QGIS.

15.2.7 Utiliser BTGP-38KM datalogger (seulement Bluetooth)

Utiliser GPSD (sous GNU/Linux) ou GPSGate (sous Windows) est très facile.

15.2.8 Utiliser BlueMax GPS-4044 datalogger (BT et USB)

MS Windows

The live tracking works for both USB and BT modes, by using GPSGate or even without it, just use the
Autodetect mode, or point the tool the right port.
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Ubuntu/Mint GNU/Linux

Via USB

Le suivi en direct fonctionne avec les deux sous GPSD.

gpsd /dev/ttyACM3

ou sans lui en connectant l’outil de suivi en direct de QGIS directement au périphérique (par exemple
/dev/ttyACM3).

Via Bluetooth

Le suivi en direct fonctionne avec les deux sous GPSD.

gpsd /dev/rfcomm0

ou sans lui en connectant l’outil de suivi en direct de QGIS directement au périphérique (par exemple
/dev/rfcomm0).

.
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CHAPTER 16

Intégration du SIG GRASS

The GRASS plugin provides access to GRASS GIS databases and functionalities (see GRASS-PROJECT in Bib-
liographie). This includes visualizing GRASS raster and vector layers, digitizing vector layers, editing vector
attributes, creating new vector layers and analysing GRASS 2-D and 3-D data with more than 400 GRASS mod-
ules.

In this section, we’ll introduce the plugin functionalities and give some examples of managing and working with
GRASS data. The following main features are provided with the toolbar menu when you start the GRASS plugin,
as described in section sec_starting_grass:

• Open mapset

• New mapset

• Close mapset

• Add GRASS vector layer

• Add GRASS raster layer

• Create new GRASS vector

• Edit GRASS vector layer

• Open GRASS tools

• Display current GRASS region

• Edit current GRASS region

16.1 Lancer l’extension GRASS

To use GRASS functionalities and/or visualize GRASS vector and raster layers in QGIS, you must select and load

the GRASS plugin with the Plugin Manager. Therefore, go to the menu Plugins → Manage Plugins, select

GRASS and click [OK].

You can now start loading raster and vector layers from an existing GRASS LOCATION (see section
sec_load_grassdata). Or, you can create a new GRASS LOCATION with QGIS (see section Créer un nouveau
SECTEUR GRASS) and import some raster and vector data (see section Importer des données dans un SECTEUR
GRASS) for further analysis with the GRASS Toolbox (see section La Boîte à outils GRASS).
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16.2 Charger des données GRASS raster et vecteur

With the GRASS plugin, you can load vector or raster layers using the appropriate button on the toolbar menu. As
an example, we will use the QGIS Alaska dataset (see section Échantillon de données). It includes a small sample
GRASS LOCATION with three vector layers and one raster elevation map.

1. Create a new folder called grassdata, download the QGIS ‘Alaska’ dataset
qgis_sample_data.zip from http://download.osgeo.org/qgis/data/ and unzip the file into
grassdata.

2. Start QGIS.

3. If not already done in a previous QGIS session, load the GRASS plugin clicking on Plugins → Manage

Plugins and activate GRASS. The GRASS toolbar appears in the QGIS main window.

4. In the GRASS toolbar, click the Open mapset icon to bring up the MAPSET wizard.

5. For Gisdbase, browse and select or enter the path to the newly created folder grassdata.

6. You should now be able to select the LOCATION alaska and the MAPSET demo.

7. Click [OK]. Notice that some previously disabled tools in the GRASS toolbar are now enabled.

8. Click on Add GRASS raster layer, choose the map name gtopo30 and click [OK]. The elevation layer will
be visualized.

9. Click on Add GRASS vector layer, choose the map name alaska and click [OK]. The Alaska boundary
vector layer will be overlayed on top of the gtopo30 map. You can now adapt the layer properties as
described in chapter Fenêtre Propriétés d’une couche vecteur (e.g., change opacity, fill and outline color).

10. Also load the other two vector layers, rivers and airports, and adapt their properties.

As you see, it is very simple to load GRASS raster and vector layers in QGIS. See the following sections for
editing GRASS data and creating a new LOCATION. More sample GRASS LOCATIONs are available at the
GRASS website at http://grass.osgeo.org/download/sample-data/.

Astuce: Charger des données GRASS
If you have problems loading data or QGIS terminates abnormally, check to make sure you have loaded the
GRASS plugin properly as described in section Lancer l’extension GRASS.

16.3 Secteur et Jeu de données GRASS

GRASS data are stored in a directory referred to as GISDBASE. This directory, often called grassdata, must
be created before you start working with the GRASS plugin in QGIS. Within this directory, the GRASS GIS
data are organized by projects stored in subdirectories called LOCATIONs. Each LOCATION is defined by its
coordinate system, map projection and geographical boundaries. Each LOCATION can have several MAPSETs
(subdirectories of the LOCATION) that are used to subdivide the project into different topics or subregions, or as
workspaces for individual team members (see Neteler & Mitasova 2008 in Bibliographie). In order to analyze vec-
tor and raster layers with GRASS modules, you must import them into a GRASS LOCATION. (This is not strictly
true – with the GRASS modules r.external and v.external you can create read-only links to external
GDAL/OGR-supported datasets without importing them. But because this is not the usual way for beginners to
work with GRASS, this functionality will not be described here.)

16.3.1 Créer un nouveau SECTEUR GRASS

As an example, here is how the sample GRASS LOCATION alaska, which is projected in Albers Equal Area
projection with unit feet was created for the QGIS sample dataset. This sample GRASS LOCATION alaska
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Figure 16.1: Données GRASS du SECTEUR Alaska

will be used for all examples and exercises in the following GRASS-related sections. It is useful to download and
install the dataset on your computer (see Échantillon de données).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. Visualize the alaska.shp shapefile (see section Loading a Shapefile) from the QGIS Alaska dataset (see
Échantillon de données).

3. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

4. Sélectionnez un répertoire existant de base de données GRASS (GISDBASE) grassdata ou créez en
un pour le nouveau SECTEUR avec le gestionnaire de fichiers de votre ordinateur. Cliquez sur le bouton
[Suivant].

5. We can use this wizard to create a new MAPSET within an existing LOCATION (see section Ajouter un
nouveau Jeu de données) or to create a new LOCATION altogether. Select Create new location (see
figure_grass_location_2).

6. Entrez un nom pour le SECTEUR – nous avons utilisé ‘alaska’ – et cliquez sur le bouton [Suivant].

7. Define the projection by clicking on the radio button Projection to enable the projection list.

8. We are using Albers Equal Area Alaska (feet) projection. Since we happen to know that it is represented
by the EPSG ID 2964, we enter it in the search box. (Note: If you want to repeat this process for another

LOCATION and projection and haven’t memorized the EPSG ID, click on the CRS Status icon in the lower
right-hand corner of the status bar (see section Utiliser les projections)).

9. Saisissez 2964 dans le Filtre pour sélectionner la projection.

10. Cliquez sur [Suivant].

11. To define the default region, we have to enter the LOCATION bounds in the north, south, east, and west
directions. Here, we simply click on the button [Set current |qg| extent], to apply the extent of the loaded
layer alaska.shp as the GRASS default region extent.

12. Cliquez sur [Suivant].

16.3. Secteur et Jeu de données GRASS 179



QGIS User Guide, Version 2.8

13. Nous avons aussi besoin de définir un Jeu de données dans notre nouveau SECTEUR (étape indispens-
able lors de la création d’un nouveau SECTEUR). Vous pouvez l’appeler comme vous le souhaitez - nous
utiliserons ‘demo’. GRASS crée automatiquement un Jeu de données spécial appelé PERMANENT,
conçu pour stocker les données essentielles du projet, son emprise spatiale par défaut et la définition du
système de coordonnées (voir Neteler & Mitasova 2008 Bibliographie).

14. Vérifiez le résumé pour vous assurez que tout est correct et cliquez sur [Terminer].

15. Le nouveau SECTEUR ‘alaska’ et les deux Jeux de données ‘démo’ et ‘PERMANENT’ sont créés.
Le jeu de données ouvert à ce moment est ‘démo’, tel que vous l’avez défini.

16. Notez que certains outils de la barre d’outils GRASS qui n’étaient pas accessibles le sont maintenant.

Figure 16.2: Creating a new GRASS LOCATION or a new MAPSET in QGIS

If that seemed like a lot of steps, it’s really not all that bad and a very quick way to create a LOCATION. The
LOCATION ‘alaska’ is now ready for data import (see section Importer des données dans un SECTEUR GRASS).
You can also use the already-existing vector and raster data in the sample GRASS LOCATION ‘alaska’, included
in the QGIS ‘Alaska’ dataset Échantillon de données, and move on to section Le modèle vecteur de GRASS.

16.3.2 Ajouter un nouveau Jeu de données

A user has write access only to a GRASS MAPSET he or she created. This means that besides access to your own
MAPSET, you can read maps in other users’ MAPSETs (and they can read yours), but you can modify or remove
only the maps in your own MAPSET.

Tous les Jeux de données incluent un fichier WIND qui stocke l’emprise et la résolution raster courante (voir
Neteler & Mitasova 2008 dans Bibliographie et section L’outil région GRASS).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

3. Sélectionnez le répertoire grassdata de la base de données GRASS (GISDBASE) qui contient déjà le
SECTEUR ‘alaska’ et où nous voulons ajouter un autre SECTEUR nommé ‘test’.

4. Cliquez sur [Suivant].

5. We can use this wizard to create a new MAPSET within an existing LOCATION or to create a new
LOCATION altogether. Click on the radio button Select location (see figure_grass_location_2) and
click [Next].

6. Entrez le texte du nom pour le nouveau Jeu de données. En dessous, dans l’assistant, vous pouvez
voir une liste des Jeux de données et de leurs propriétaires.

7. Cliquez sur [Suivant], vérifiez le résumé pour vous assurer qu’il est correct et cliquez sur [Terminer].
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16.4 Importer des données dans un SECTEUR GRASS

This section gives an example of how to import raster and vector data into the ‘alaska’ GRASS LOCATION
provided by the QGIS ‘Alaska’ dataset. Therefore, we use the landcover raster map landcover.img and the
vector GML file lakes.gml from the QGIS ‘Alaska’ dataset (see Échantillon de données).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click the Open MAPSET icon to bring up the MAPSET wizard.

3. Select as GRASS database the folder grassdata in the QGIS Alaska dataset, as LOCATION ‘alaska’, as
MAPSET ‘demo’ and click [OK].

4. Now click the Open GRASS tools icon. The GRASS Toolbox (see section La Boîte à outils GRASS) dialog
appears.

5. Pour importer la couche raster landcover.img, cliquez sur le module r.in.gdal dans l’onglet Ar-
borescence des modules. Ce module GRASS vous permet d’importer les fichiers raster gérés par la librairie
GDAL dans un SECTEUR GRASS. La fenêtre r.in.gdal apparaît.

6. Browse to the folder raster in the QGIS ‘Alaska’ dataset and select the file landcover.img.

7. Définissez landcover_grass comme nom de sortie pour le raster et cliquez sur
[Lancer]. Dans l’onglet Rendu, vous voyez la commande GRASS en cours r.in.gdal -o
input=/path/to/landcover.img output=landcover_grass.

8. When it says Succesfully finished, click [View output]. The landcover_grass raster layer is now
imported into GRASS and will be visualized in the QGIS canvas.

9. Pour importer le fichier GML lakes.gml, cliquez sur le module v.in.ogr dans l’onglet Arbores-
cence des modules. Ce module vous permet d’importer des données vectorielles gérées par OGR dans un
SECTEUR GRASS. La fenêtre v.in.ogr apparaît.

10. Browse to the folder gml in the QGIS ‘Alaska’ dataset and select the file lakes.gml as OGR file.

11. Définissez lakes_grass comme nom de sortie et cliquez sur [Lancer]. Vous n’avez pas besoin des autres
options dans cet exemple. Dans l’onglet Rendu, vous voyez la commande GRASS en cours v.in.ogr -o
dsn=/path/to/lakes.gml output=lakes\_grass.

12. When it says Succesfully finished, click [View output]. The lakes_grass vector layer is now imported
into GRASS and will be visualized in the QGIS canvas.

16.5 Le modèle vecteur de GRASS

It is important to understand the GRASS vector data model prior to digitizing.

In general, GRASS uses a topological vector model.

This means that areas are not represented as closed polygons, but by one or more boundaries. A boundary between
two adjacent areas is digitized only once, and it is shared by both areas. Boundaries must be connected and closed
without gaps. An area is identified (and labeled) by the centroid of the area.

Outre les limites et centroïdes, une couche vectorielle peut également contenir des points et des lignes. Tous ces
éléments de géométrie peuvent être mélangés dans une couche vectorielle et seront représentés dans différentes
‘sous-couches’ dans une carte vectorielle GRASS. Ainsi, une couche GRASS n’est pas un vecteur ou un raster,
mais un niveau à l’intérieur d’une couche vectorielle. Il est important de bien distinguer ceci (même s’il est pos-
sible de mélanger des éléments de géométries différentes, c’est inhabituel et même dans GRASS, on l’utilise dans
des cas particuliers tel que l’analyse de réseau. Normalement, vous devriez stocker des éléments de géométries
différentes dans des couches différentes).

Il est possible de stocker plusieurs ‘sous-couches’ dans une couche vectorielle. Par exemple, des champs, de la
forêt et des lacs peuvent être stockés dans une couche vectorielle. Des forêts et des lacs adjacents partagent les
mêmes limites, mais ils auront des tables attributaires différentes. Il est aussi possible de faire correspondre une
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table attributaire aux limites. Par exemple, la limite entre un lac et une forêt peut être une route qui peut avoir une
table attributaire différente.

La ‘sous-couche’ est définie dans GRASS par un chiffre. Ce chiffre définit s’il y a plusieurs sous-couches
à l’intérieur d’une couche vectorielle (par exemple, il définit s’il s’agit de lac ou de forêt). Pour l’instant, il
s’agit d’un nombre, mais dans des versions futures GRASS pourra utiliser des noms pour les sous-couches dans
l’interface utilisateur.

Attributes can be stored inside the GRASS LOCATION as dBase or SQLite3 or in external database tables, for
example, PostgreSQL, MySQL, Oracle, etc.

Les données attributaires sont liées à la géométrie par le biais d’un champ ‘category’.

‘Category’ (clé, ID) est un entier attaché à la géométrie, et il est utilisé comme lien vers une colonne de clé dans
la table de base de données.

Astuce: Apprendre le modèle vecteur de GRASS
Le meilleur moyen d’apprendre le modèle vecteur de GRASS et ses possibilités est de télécharger
un des nombreux tutoriels GRASS où le modèle vecteur est décrit plus précisément. Voir
http://grass.osgeo.org/documentation/manuals/ pour plus d’informations, livres et tutoriels dans différentes
langues.

16.6 Création d’une nouvelle couche vectorielle GRASS

To create a new GRASS vector layer with the GRASS plugin, click the Create new GRASS vector toolbar icon. Enter
a name in the text box, and you can start digitizing point, line or polygon geometries following the procedure
described in section Numérisation et édition de couche vectorielle GRASS.

In GRASS, it is possible to organize all sorts of geometry types (point, line and area) in one layer, because GRASS
uses a topological vector model, so you don’t need to select the geometry type when creating a new GRASS vector.
This is different from shapefile creation with QGIS, because shapefiles use the Simple Feature vector model (see
section Créer de nouvelles couches vecteur).

Astuce: Creating an attribute table for a new GRASS vector layer
If you want to assign attributes to your digitized geometry features, make sure to create an attribute table with
columns before you start digitizing (see figure_grass_digitizing_5).

16.7 Numérisation et édition de couche vectorielle GRASS

The digitizing tools for GRASS vector layers are accessed using the Edit GRASS vector layer icon on the toolbar.
Make sure you have loaded a GRASS vector and it is the selected layer in the legend before clicking on the edit
tool. Figure figure_grass_digitizing_2 shows the GRASS edit dialog that is displayed when you click on the edit
tool. The tools and settings are discussed in the following sections.

Astuce: Numérisation de polygones dans GRASS
If you want to create a polygon in GRASS, you first digitize the boundary of the polygon, setting the mode to ‘No
category’. Then you add a centroid (label point) into the closed boundary, setting the mode to ‘Next not used’.
The reason for this is that a topological vector model links the attribute information of a polygon always to the
centroid and not to the boundary.

Barre d’outils

In figure_grass_digitizing_1, you see the GRASS digitizing toolbar icons provided by the
GRASS plugin. Table table_grass_digitizing_1 explains the available functionalities.
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Figure 16.3: GRASS Digitizing Toolbar

Icône Outil Fonction

Nouveau Point Numérise un nouveau point

Nouvelle Ligne Numérise une nouvelle ligne

Nouveau
Contour

Digitize new boundary (finish by selecting new tool)

Nouveau
Centroïde

Numérise un nouveau centroïde (permet d’étiqueter un polygone existant)

Move vertex Move one vertex of existing line or boundary and identify new position

Add vertex Add a new vertex to existing line

Delete vertex Delete vertex from existing line (confirm selected vertex by another click)

Move element Move selected boundary, line, point or centroid and click on new position

Split line Split an existing line into two parts

Delete element Delete existing boundary, line, point or centroid (confirm selected element by
another click)

Edit attributes Edit attributes of selected element (note that one element can represent more
features, see above)

Close Close session and save current status (rebuilds topology afterwards)

Tableau Numérisation avec GRASS 1 : outils d’édition GRASS

Category Tab

The Category tab allows you to define the way in which the category values will be assigned to a new geometry
element.

Figure 16.4: GRASS Digitizing Category Tab

• Mode: The category value that will be applied to new geometry elements.

– Next not used - Apply next not yet used category value to geometry element.

– Manual entry - Manually define the category value for the geometry element in the ‘Category’ entry
field.
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– No category - Do not apply a category value to the geometry element. This is used, for instance, for
area boundaries, because the category values are connected via the centroid.

• Category - The number (ID) that is attached to each digitized geometry element. It is used to connect each
geometry element with its attributes.

• Field (layer) - Each geometry element can be connected with several attribute tables using different GRASS
geometry layers. The default layer number is 1.

Astuce: Creating an additional GRASS ‘layer’ with |qg|
If you would like to add more layers to your dataset, just add a new number in the ‘Field (layer)’ entry box and
press return. In the Table tab, you can create your new table connected to your new layer.

Settings Tab

The Settings tab allows you to set the snapping in screen pixels. The threshold defines at what distance new points
or line ends are snapped to existing nodes. This helps to prevent gaps or dangles between boundaries. The default
is set to 10 pixels.

Figure 16.5: GRASS Digitizing Settings Tab

Symbology Tab

The Symbology tab allows you to view and set symbology and color settings for various geometry types and their
topological status (e.g., closed / opened boundary).

Figure 16.6: GRASS Digitizing Symbology Tab

Table Tab
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The Table tab provides information about the database table for a given ‘layer’. Here, you can add new columns
to an existing attribute table, or create a new database table for a new GRASS vector layer (see section Création
d’une nouvelle couche vectorielle GRASS).

Figure 16.7: GRASS Digitizing Table Tab

Astuce: Droits d’édition GRASS
Vous devez être propriétaire du Jeu de données que vous voulez éditer. Il est impossible de modifier des
informations d’un Jeu de données qui n’est pas à vous, même si vous avez des droits en écriture.

16.8 L’outil région GRASS

La définition d’une région (définir une emprise spatiale de travail) dans GRASS est très importante pour travailler
avec des couches rasters. Le travail d’analyse vecteur n’est, par défaut, pas limitée à une région définie. Mais, tous
les rasters nouvellement créés auront l’emprise spatiale et la résolution de la région GRASS en cours d’utilisation,
indépendamment de leur emprise et résolution d’origine. La région courante GRASS est stockée dans le fichier
$LOCATION/$MAPSET/WIND, et celui-ci définit les limites Nord, Sud, Est et Ouest, le nombre de lignes et de
colonnes ainsi que la résolution spatiale horizontale et verticale.

It is possible to switch on and off the visualization of the GRASS region in the QGIS canvas using the
Display current GRASS region button.

With the Edit current GRASS region icon, you can open a dialog to change the current region and the symbology of
the GRASS region rectangle in the QGIS canvas. Type in the new region bounds and resolution, and click [OK].
The dialog also allows you to select a new region interactively with your mouse on the QGIS canvas. Therefore,
click with the left mouse button in the QGIS canvas, open a rectangle, close it using the left mouse button again
and click [OK].

Le module GRASS g.region propose un grand nombre de paramètres pour définir de façon appropriée les
limites et la résolution d’une région pour faire de l’analyse raster. Vous pouvez vous servir de ces paramètres dans
la boîte à outils GRASS décrite dans la section La Boîte à outils GRASS.

16.9 La Boîte à outils GRASS

The Open GRASS Tools box provides GRASS module functionalities to work with data inside a selected GRASS
LOCATION and MAPSET. To use the GRASS Toolbox you need to open a LOCATION and MAPSET that you
have write permission for (usually granted, if you created the MAPSET). This is necessary, because new raster or
vector layers created during analysis need to be written to the currently selected LOCATION and MAPSET.
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Figure 16.8: La Boîte à outils GRASS et la l’Arborescence des modules

16.9.1 Travailler avec les modules GRASS

La console de la Boîte à outils GRASS vous donne accès à pratiquement tous les modules GRASS (plus de 300)
en ligne de commande. Afin d’offrir un environnement de travail plus agréable, environ 200 d’entre eux sont
disponibles via l’interface graphique de la Boîte à outils GRASS.

A complete list of GRASS modules available in the graphical Toolbox in QGIS version 2.8 is available in the
GRASS wiki at http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.

Il est aussi possible de personnaliser le contenu de la boîte à outils GRASS. Ceci est décrit dans la section
Paramètrer la boîte à outils GRASS.

Comme indiqué sur la figure figure_grass_toolbox_1, vous pouvez chercher le module GRASS approprié en util-
isant l’onglet Arborescence des modules ou en utilisant l’onglet Liste des Modules pour faire une recherche.

Lorsque vous cliquez sur un module, un nouvel onglet apparaît proposant trois sous-onglets : Options, Rendu et
Manuel.

Options

The Options tab provides a simplified module dialog where you can usually select a raster or vector layer visualized
in the QGIS canvas and enter further module-specific parameters to run the module.

The provided module parameters are often not complete to keep the dialog clear. If you want to use further module
parameters and flags, you need to start the GRASS shell and run the module in the command line.

A new feature since QGIS 1.8 is the support for a Show Advanced Options button below the simplified module
dialog in the Options tab. At the moment, it is only added to the module v.in.ascii as an example of use, but
it will probably be part of more or all modules in the GRASS Toolbox in future versions of QGIS. This allows you
to use the complete GRASS module options without the need to switch to the GRASS shell.

Rendu

L’onglet Rendu fournit des informations sur l’état de sortie du module. Quand vous cliquez sur le bouton [Lancer],
le module passe sur l’onglet Rendu et vous voyez les informations sur le processus en cours. Si tout se passe bien,
vous verrez finalement le message Terminé avec succès.

Manuel

L’onglet Manuel montre la page HTML d’aide du module GRASS. Vous pouvez vous en servir pour voir les autres
paramètres du module et pour avoir une connaissance plus approfondie de l’objet du module. À la fin de chaque
page d’aide d’un module, vous avez des liens vers Main Help index (index principal), Thematic.index
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Figure 16.9: Boîte à outils GRASS, onglet Options d’un module

Figure 16.10: Boîte à outils GRASS, onglet Sortie d’un module
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Figure 16.11: Boîte à outils GRASS, onglet Manuel d’un module

(index par thème) et Full.index (index complet). Ces liens vous donnent les mêmes informations que si vous
utilisiez directement g.manual.

Astuce: Afficher les résultats immédiatement
Si vous voulez voir immédiatement dans votre fenêtre carte le résultat des calculs du module, vous pouvez utiliser
le bouton ‘Vue’ au bas de l’onglet du module.

16.9.2 Exemples de modules GRASS

Les exemples suivants décrivent les possibilités de certains modules GRASS.

Création de courbes de niveau

Le premier exemple permet de créer une couche vectorielle de courbes de niveau à partir d’un modèle numérique
de terrain (MNT). Ici, nous considérerons que le SECTEUR Alaska a été installé comme décrit dans la section
Importer des données dans un SECTEUR GRASS.

• First, open the location by clicking the Open mapset button and choosing the Alaska location.

• Now load the gtopo30 elevation raster by clicking Add GRASS raster layer and selecting the gtopo30
raster from the demo location.

• Now open the Toolbox with the Open GRASS tools button.

• Dans la liste des outils double-cliquez sur Raster -> Gestion de surface -> Générer des lignes vectorielles
de contours.

• Now a single click on the tool r.contour will open the tool dialog as explained above (see Travailler avec
les modules GRASS). The gtopo30 raster should appear as the Name of input raster.
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• Type into the Increment between Contour levels the value 100. (This will create contour lines at
intervals of 100 meters.)

• Saisisez dans le champ Nom de la couche vectorielle en sortie, le nom ctour_100.

• Cliquer sur [Lancer] pour lancer le traitement. Attendez quelques instants que le message Terminé avec
succès apparaisse à l’écran. Cliquez enfin sur [Vue] puis [Fermer].

Comme il s’agit d’une grande région, cela prendra un certain temps à s’afficher. Une fois l’affichage terminé, vous
pouvez ouvrir la fenêtre de propriétés de la couche pour changer la couleur des courbes de niveau afin qu’elles
apparaissent clairement au dessus de la couche raster d’élévation comme décrit dans Fenêtre Propriétés d’une
couche vecteur.

Zoomez sur une petite région montagneuse du centre de l’Alaska. Avec un zoom important, vous constaterez
que les courbes de niveau sont constituées de lignes brisées avec des angles vifs. GRASS offre la possibilité de
généraliser les cartes vecteurs à l’aide de l’outil v.generalize, tout en conservant leur forme générale. L’outil utilise
différents algorithmes ayant différents objectifs. Certains de ces algorithmes (par exemple : Douglas Peucker et
Réduction de Vertex) simplifient les lignes en supprimant des sommets. La couche simplifiée se chargera plus
rapidement. Cette commande est utile lorsque vous avez une couche vectorielle très détaillée et que vous créez
une carte à petite échelle où les détails ne sont donc pas nécessaires.

Astuce: L’outil de simplification
Note that the QGIS fTools plugin has a Simplify geometries → tool that works just like the GRASS v.generalize
Douglas-Peuker algorithm.

Cependant, le but de cet exemple est différent. Les courbes de niveau créées avec r.contour ont des angles vifs
qui doivent être lissés. Parmi les algorithmes de v.generalize, il y a l’algorithme de Chaiken qui fait justement ça
(comme Hermite splines). Gardez à l’esprit que ces algorithmes peuvent ajouter des sommets supplémentaires
au vecteur, l’amenant à se charger encore plus lentement.

• Ouvrez la Boîte à outils GRASS et double cliquez sur Vecteur -> Développer la carte -> Généralisation.
Cliquez alors sur le module v.generalize pour ouvrir sa fenêtre d’options.

• rifier que la couche vectorielle ‘ctour_100’ apparait dans le champ Nom de la couche vectorielle en entrée.

• Dans la liste des algorithmes choisissez Chaiken. Laisser les autres options par défaut et descendez à la
dernière ligne pour donner le nom de la couche d’information à créer : Nom de la couche vectorielle en
sortie ‘ctour_100_smooth’, et cliquez sur [Lancer].

• Cela peut prendre plusieurs minutes. Lorsque le texte Terminé avec succès apparait, cliquez sur le
bouton [Vue] puis sur [Fermer].

• Vous pouvez changer la couleur de cette couche vectorielle pour qu’elle apparaisse clairement sur le raster
et qu’elle contraste aussi avec la couche de départ.Vous remarquerez que les nouvelles courbes de niveau
ont des angles plus arrondis que l’original tout en restant fidèle à la forme globale d’origine.

Astuce: Autres utilisations de r.contour
La procédure décrite ci-dessus peut être utilisée dans d’autres cas similaires. Si vous disposez d’une couche
d’informations raster représentant des précipitations, par exemple, vous pouvez utiliser la même méthode pour
créer des isohyètes (lignes reliant des points d’égales quantités de précipitations).

Créer un ombrage avec effet 3D

Différentes méthodes sont utilisées pour afficher les modèles numérique de terrain et donner un effet 3D au carte.
L’utilisation de courbes de niveau comme décrit ci-dessus est un des moyens souvent utilisés pour produire des
cartes topographiques. Un autre moyen de rendre cet effet 3D est d’utiliser l’ombrage. L’ombrage est créé à
partir du modèle numérique de terrain (MNT) en calculant d’abord les pentes et les expositions puis en simulant
la position du soleil dans le ciel ce qui donne à chaque cellule une valeur de réflectance. Les pentes éclairées par
le soleil sont plus claires et les pentes à l’abri du soleil sont plus sombres.
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Figure 16.12: Module GRASS v.generalize utilisé pour simplifier une couche vectorielle

• Commencez par ouvrir la couche raster gtopo30. Ouvrez la Boîte à outils GRASS et dans la catégorie
Raster double cliquez sur Analyse spatiale → Analyse de terrain.

• Cliquez ensuite sur r.shaded.relief pour lancer le module.

• Change the azimuth angle 270 to 315.

• Saisissez gtopo30_shade comme nom pour la nouvelle couche d’ombrage et cliquez sur le bouton
[Lancer].

• Quand le calcul est terminé, ajoutez le raster d’ombrage à la fenêtre carte. Normalement, il devrait s’afficher
en niveau de gris.

• Pour voir les deux couches d’informations ombrage et gtopo30 en même temps, placez la couche ombrage
sous la couche gtopo30 dans le gestionnaire de couches et ouvrez la fenêtre Propriétés de la couche
gtopo30, allez sur l’onglet Transparence et fixez la transparence à environ 25%.

Vous devriez maintenant avoir la couche gtopo30 en couleur et en transparence, affiché au dessus de la
couche d’ombrage en niveau de gris. Pour bien visualiser l’effet d’ombrage, décochez puis recochez la couche
gtopo30_shade dans la légende.

Utiliser la console GRASS

The GRASS plugin in QGIS is designed for users who are new to GRASS and not familiar with all the modules
and options. As such, some modules in the Toolbox do not show all the options available, and some modules do
not appear at all. The GRASS shell (or console) gives the user access to those additional GRASS modules that
do not appear in the Toolbox tree, and also to some additional options to the modules that are in the Toolbox with
the simplest default parameters. This example demonstrates the use of an additional option in the r.shaded.relief
module that was shown above.

Le module r.shaded.relief possède un paramètre zmult qui multiplie la valeur de l’altitude (exprimé dans la
même unité que les coordonnées X - Y) ce qui a pour effet d’accentuer le relief.

• Ouvrez le raster gtopo30 comme ci-dessus, lancez la Boîte à outils GRASS et ouvrez la
console GRASS. Dans la console, entrez la ligne suivante r.shaded.relief map=gtopo30
shade=gtopo30_shade2 azimuth=315 zmult=3 et pressez [Entrée].
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Figure 16.13: La console GRASS utilisation du module r.shaded.relief

• After the process finishes, shift to the Browse tab and double-click on the new gtopo30_shade2 raster
to display it in QGIS.

• Comme expliqué ci-dessus, placez le raster d’ombrage sous le raster gtopo30 puis vérifiez la transparence
du raster gtopo30. Vous devriez constater que le relief apparaît plus marqué qu’avec le premier raster
d’ombrage.

Statistiques raster avec des couches vectorielles

L’exemple suivant comment un module GRASS peut aggréger des données raster et ajouter des colonnes de
statistiques pour chaque polygone d’une couche vectorielle.

• Encore une fois, nous allons utiliser le jeu de données Alaska. Référez vous à Importer des données dans
un SECTEUR GRASS pour importer les shapefiles contenus dans le répetoire shapefiles dans GRASS.

• Un étape intermédiaire est nécessaire : des centroïdes doivent importés afin d’avoir une couche GRASS
vecteur complète (qui inclue les contours et les centroïdes).

• Dans la Boîte à outils choisissez Vecteur -> Gestion des entités et ouvrez le module v.centroids.

• Entrez ‘forest_areas’ comme nom de couche en sortie et lancez le module.

• Now load the forest_areas vector and display the types of forests - deciduous, evergreen, mixed - in

different colors: In the layer Properties window, Symbology tab, choose from Legend type ‘Unique
value’ and set the Classification field to ‘VEGDESC’. (Refer to the explanation of the symbology tab in
Onglet Style of the vector section.)

• Réouvrez la Boîte à outils GRASS et ouvrez Vecteur -> Mise à jour vectorielle via d’autres cartes.

• Cliquez sur le module v.rast.stats. Saisissez gtopo30 et forest_areas.

• Un seul paramètre additionnel est requis : Entrez elev pour le column prefix, et cliquez sur le bouton
[Lancer]. C’est un opération lourde qui peut durer longtemps (jusqu’à deux heures).
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Figure 16.14: Affichage du relief ombré créé avec le module GRASS r.shaded.relief

• Pour finir, ouvrez la table attributaire de forest_areas, et vérifiez que plusieurs nouvelles colonnes ont
étés ajoutées dont elev_min, elev_max, elev_mean, etc., pour chaque polygone de forêt.

16.9.3 Working with the GRASS LOCATION browser

Another useful feature inside the GRASS Toolbox is the GRASS LOCATION browser. In figure_grass_module_7,
you can see the current working LOCATION with its MAPSETs.

In the left browser windows, you can browse through all MAPSETs inside the current LOCATION. The right
browser window shows some meta-information for selected raster or vector layers (e.g., resolution, bounding box,
data source, connected attribute table for vector data, and a command history).

The toolbar inside the Browser tab offers the following tools to manage the selected LOCATION:

• Add selected map to canvas

• Copy selected map

• Rename selected map

• Delete selected map

• Set current region to selected map

• Refresh browser window

The Rename selected map and Delete selected map only work with maps inside your currently selected
MAPSET. All other tools also work with raster and vector layers in another MAPSET.
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Figure 16.15: GRASS LOCATION browser

16.9.4 Paramètrer la boîte à outils GRASS

Pratiquement tous les modules GRASS peuvent être ajoutés à la Boîte à outils. Une interface XML est fournie
pour analyser les fichiers XML très simples qui configurent l’apparence et les paramètres des modules dans la
boîte à outils.

Un exemple de fichier XML pour le module v.buffer (v.buffer.qgm) est donné ci-dessous :

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

The parser reads this definition and creates a new tab inside the Toolbox when you select the module. A more
detailed description for adding new modules, changing a module’s group, etc., can be found on the QGIS wiki at
http://hub.qgis.org/projects/quantum-gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox.

.
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CHAPTER 17

QGIS processing framework

.

17.1 Introduction

This chapter introduces the QGIS processing framework, a geoprocessing environment that can be used to call
native and third-party algorithms from QGIS, making your spatial analysis tasks more productive and easy to
accomplish.

Dans les sections suivantes, seront exposés les éléments graphiques de ce module et comment les exploiter au
maximum.

There are four basic elements in the framework GUI, which are used to run algorithms for different purposes.
Choosing one tool or another will depend on the kind of analysis that is to be performed and the particular
characteristics of each user and project. All of them (except for the batch processing interface, which is called
from the toolbox, as we will see) can be accessed from the Processing menu item. (You will see more than four
entries. The remaining ones are not used to execute algorithms and will be explained later in this chapter.)

• La Boîte à outils. Il s’agit de l’élément principal de l’interface du module de Traitements et permet de lancer
les algorithmes individuellement ou par lot.

Figure 17.1: Processing Toolbox
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• Le modeleur graphique. Les algorithmes peuvent être combinés graphiquement en utilisant le modeleur
pour définir une chaîne de traitements, composée de plusieurs étapes de traitement

Figure 17.2: Processing Modeler

• Le gestionnaire d’historiques. Toutes les actions réalisées par un élément précité sont sauvegardées dans un
fichier d’historique et peuvent être aisément reproduites grâce au gestionnaire d’historiques.

• Le gestionnaire de traitement par lot. Cette interface permet d’exécuter des traitements par lots et
d’automatiser l’exécution d’un même traitement sur plusieurs sources de données.

Dans les sections suivantes, chacun de ces éléments sera détaillé.

.

17.2 La boîte à outils

La Boîte à outils est l’élément principal du module de Traitements et probablement celui que vous utiliserez le
plus au quotidien. Elle montre la liste des algorithmes disponibles, regroupés en plusieurs catégories. C’est aussi
par son intermédiaire qu’il est possible d’exécuter un algorithme sur un jeu de données en entrée, ponctuellement
ou par lot.

The toolbox contains all the available algorithms, divided into predefined groups. All these groups are found under
a single tree entry named Geoalgorithms.

Additionally, two more entries are found, namely Models and Scripts. These include user-created algorithms, and
they allow you to define your own workflows and processing tasks. We will devote a full section to them a bit
later.

Dans la partie haute de la boîte à outils se trouve un champ texte. Pour réduire le nombre d’algorithmes affichés
dans la boîte à outils et vous permettre de trouver celui qui vous convient, il vous suffit d’entrer un mot-clé ou une
phrase dnas ce champ. La liste des algorithmes contenant ce texte est filtrée au fur et à mesure de la saisie.

In the lower part, you will find a box that allows you to switch between the simplified algorithm list (the one
explained above) and the advanced list. If you change to the advanced mode, the toolbox will look like this:
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Figure 17.3: Processing History

Figure 17.4: Batch Processing interface
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Figure 17.5: Processing Toolbox

Figure 17.6: Processing Toolbox (advanced mode)
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In the advanced view, each group represents a so-called ‘algorithm provider’, which is a set of algorithms coming
from the same source, for instance, from a third-party application with geoprocessing capabilities. Some of
these groups represent algorithms from third-party applications like SAGA, GRASS or R, while others contain
algorithms directly coded as part of the processing plugin, not relying on any additional software.

This view is recommended to those users who have a certain knowledge of the applications that are backing the
algorithms, since they will be shown with their original names and groups.

Also, some additional algorithms are available only in the advanced view, such as LiDAR tools and scripts based
on the R statistical computing software, among others. Independent QGIS plugins that add new algorithms to the
toolbox will only be shown in the advanced view.

In particular, the simplified view contains algorithms from the following providers:

• GRASS

• SAGA

• OTB

• Native QGIS algorithms

In the case of running QGIS under Windows, these algorithms are fully-functional in a fresh installation of QGIS,
and they can be run without requiring any additional installation. Also, running them requires no prior knowledge
of the external applications they use, making them more accesible for first-time users.

If you want to use an algorithm not provided by any of the above providers, switch to the advanced mode by
selecting the corresponding option at the bottom of the toolbox.

Pour exécuter un algorithme, double-cliquez simplement sur son nom dans la boîte à outils.

17.2.1 La fenêtre Algorithme

Once you double-click on the name of the algorithm that you want to execute, a dialog similar to that in the figure
below is shown (in this case, the dialog corresponds to the SAGA ‘Convergence index’ algorithm).

Figure 17.7: Parameters Dialog

This dialog is used to set the input values that the algorithm needs to be executed. It shows a table where input
values and configuration parameters are to be set. It of course has a different content, depending on the require-

17.2. La boîte à outils 199



QGIS User Guide, Version 2.8

ments of the algorithm to be executed, and is created automatically based on those requirements. On the left side,
the name of the parameter is shown. On the right side, the value of the parameter can be set.

Les algorithmes différeront par le nombre et le type de paramètres, mais la structure sera la même pour tous. Les
paramètres présents dans la table pourront être un des types suivants.

• A raster layer, to select from a list of all such layers available (currently opened) in QGIS. The selector
contains as well a button on its right-hand side, to let you select filenames that represent layers currently not
loaded in QGIS.

• A vector layer, to select from a list of all vector layers available in QGIS. Layers not loaded in QGIS can
be selected as well, as in the case of raster layers, but only if the algorithm does not require a table field
selected from the attributes table of the layer. In that case, only opened layers can be selected, since they
need to be open so as to retrieve the list of field names available.

Vous verrez un bouton pour chaque sélecteur de couche de vecteur, comme le montre la figure ci-dessous.

Figure 17.8: Vector iterator button

Si l’algorithme propose plusieurs boutons d’itération, vous ne pourrez en activer qu’un seul. Si un bouton cor-
respondant à une couche vecteur est activé, l’algorithme s’exécutera successivement sur chacune des entités de
la couche plutôt que sur la couche en entier, produisant alors autant de sorties que de nombre d’exécution de
l’algorithme. Cela permet d’automatiser un traitement qui doit être réalisé sur chaque entité d’une couche séparé-
ment.

• A table, to select from a list of all available in QGIS. Non-spatial tables are loaded into QGIS like vector
layers, and in fact they are treated as such by the program. Currently, the list of available tables that you will
see when executing an algorithm that needs one of them is restricted to tables coming from files in dBase
(.dbf) or Comma-Separated Values (.csv) formats.

• Une option, à choisir dans une liste d’options possibles.

• A numerical value, to be introduced in a text box. You will find a button by its side. Clicking on it, you
will see a dialog that allows you to enter a mathematical expression, so you can use it as a handy calculator.
Some useful variables related to data loaded into QGIS can be added to your expression, so you can select
a value derived from any of these variables, such as the cell size of a layer or the northernmost coordinate
of another one.

Figure 17.9: Number Selector
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• Un intervalle, où doivent être remplies les valeurs minimales et maximales.

• Une chaîne de texte, à mettre dans le champ correspondant.

• Le num d’un champ, à choisir dans la liste des attributs d’une couche vectorielle ou d’une table préalable-
ment sélectionnées.

• Un système de coordonnées de référence. Vous pouvez saisir le code EPSG directement dans la zone de
texte ou le sélectionner depuis la fenêtre de sélection du SCR qui apparaît lorsque vous cliquez sur le bouton
à droite

• Une emprise, à entrer sous la forme des quatre limites xmin, xmax, ymin, ymax. En cliquant sur le bouton
situé à droite du sélecteur, un menu apparaîtra, vous permettant de choisir l’emprise courante du canevas ou
de le sélectionner avec la souris sur le canevas.

Figure 17.10: Extent selector

Dans le premier cas s’affichera une fenêtre comme celle-ci.

Figure 17.11: Extent List

Dans le second cas, la fenêtre de paramètres sera cachée afin de vous permettre de cliquer et glisser sur le
canevas. Une fois le rectangle délimité, la fenêtre réapparaîtra, contenant les valeurs de l’emprise choisie.

Figure 17.12: Extent Drag

• A list of elements (whether raster layers, vector layers or tables), to select from the list of such layers
available in QGIS. To make the selection, click on the small button on the left side of the corresponding row
to see a dialog like the following one.

• Une petite table, à éditer par l’utilisateur, pour définir certains paramètres tels que tables de recherche ou le
produit de convolution.
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Figure 17.13: Multiple Selection

Cliquez sur le bouton sur le côté droit pour voir la table et éditer ses valeurs.

Figure 17.14: Fixed Table

Selon l’algorithme, les lignes sont modifiables ou non, en utilisant les boutons situés à droite de la fenêtre.

You will find a [Help] tab in the the parameters dialog. If a help file is available, it will be shown, giving you
more information about the algorithm and detailed descriptions of what each parameter does. Unfortunately, most
algorithms lack good documentation, but if you feel like contributing to the project, this would be a good place to
start.

A propos des projections

Algorithms run from the processing framework — this is also true of most of the external applications whose
algorithms are exposed through it. Do not perform any reprojection on input layers and assume that all of them
are already in a common coordinate system and ready to be analized. Whenever you use more than one layer as
input to an algorithm, whether vector or raster, it is up to you to make sure that they are all in the same coordinate
system.

Note that, due to QGIS‘s on-the-fly reprojecting capabilities, although two layers might seem to overlap and
match, that might not be true if their original coordinates are used without reprojecting them onto a common
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coordinate system. That reprojection should be done manually, and then the resulting files should be used as input
to the algorithm. Also, note that the reprojection process can be performed with the algorithms that are available
in the processing framework itself.

By default, the parameters dialog will show a description of the CRS of each layer along with its name, making it
easy to select layers that share the same CRS to be used as input layers. If you do not want to see this additional
information, you can disable this functionality in the processing configuration dialog, unchecking the Show CRS
option.

Si vous essayez d’exécuter un algorithme avec deux ou plusieurs couches en entrée avec des SCR non identiques,
une fenêtre d’alerte s’affichera.

Vous pourrez toujours exécuter l’algorithme mais sachez que dans la plupart des cas, ceci générera des résultats
erronés, comme des couches vides du fait de couches en entrée qui ne se superposent pas.

17.2.2 Les données générées par les algorithmes

Les données générées par un algorithme peuvent être des types suivants :

• Une couche raster

• Une couche vectorielle

• Une table

• Un fichier HTML (utilisé pour les sorties texte et graphiques)

These are all saved to disk, and the parameters table will contain a text box corresponding to each one of these
outputs, where you can type the output channel to use for saving it. An output channel contains the information
needed to save the resulting object somewhere. In the most usual case, you will save it to a file, but the architecture
allows for any other way of storing it. For instance, a vector layer can be stored in a database or even uploaded
to a remote server using a WFS-T service. Although solutions like these are not yet implemented, the processing
framework is prepared to handle them, and we expect to add new kinds of output channels in a near feature.

To select an output channel, just click on the button on the right side of the text box. That will open a save file
dialog, where you can select the desired file path. Supported file extensions are shown in the file format selector
of the dialog, depending on the kind of output and the algorithm.

The format of the output is defined by the filename extension. The supported formats depend on what is supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it, if you are directly
typing the file path instead). If the extension of the file path you entered does not match any of the supported
formats, a default extension (usually .dbf‘ for tables, .tif for raster layers and .shp for vector layers) will
be appended to the file path, and the file format corresponding to that extension will be used to save the layer or
table.

If you do not enter any filename, the result will be saved as a temporary file in the corresponding default file
format, and it will be deleted once you exit QGIS (take care with that, in case you save your project and it contains
temporary layers).

You can set a default folder for output data objects. Go to the configuration dialog (you can open it from the
Processing menu), and in the General group, you will find a parameter named Output folder. This output folder
is used as the default path in case you type just a filename with no path (i.e., myfile.shp) when executing an
algorithm.

Lorsque vous lancez un algorithme qui utilise une couche vectorielle en mode itératif, le chemin de fichier entré
est pris comme chemin de base pour tous les fichiers de sortie, dont le nom correspondra au nom du fichier de
base suivi du numéro d’index d’itération. L’extension du fichier (et le format) sera la même pour tous les fichiers
générés.

Apart from raster layers and tables, algorithms also generate graphics and text as HTML files. These results are
shown at the end of the algorithm execution in a new dialog. This dialog will keep the results produced by any
algorithm during the current session, and can be shown at any time by selecting Processing → Results viewer from
the QGIS main menu.
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Some external applications might have files (with no particular extension restrictions) as output, but they do not
belong to any of the categories above. Those output files will not be processed by QGIS (opened or included into
the current QGIS project), since most of the time they correspond to file formats or elements not supported by
QGIS. This is, for instance, the case with LAS files used for LiDAR data. The files get created, but you won’t see
anything new in your QGIS working session.

Pour les autres types de résultat, vous pourrez choisir de les charger ou non à l’issue de l’exécution de l’algorithme
en cochant la case. Par défaut, tous les fichiers sont chargés.

Optional outputs are not supported. That is, all outputs are created. However, you can uncheck the corresponding
checkbox if you are not interested in a given output, which essentially makes it behave like an optional output (in
other words, the layer is created anyway, but if you leave the text box empty, it will be saved to a temporary file
and deleted once you exit QGIS).

17.2.3 Configurer le Module de Traitements

Comme mentionné précédemment, le menu de configuration permet d’accéder à une nouvelle fenêtre dans laque-
lle vous pouvez paramétrer le fonctionnement des algorithmes. Les paramètres sont regroupés en blocs sélec-
tionnables sur la partie gauche.

Along with the aforementioned Output folder entry, the General block contains parameters for setting the default
rendering style for output layers (that is, layers generated by using algorithms from any of the framework GUI
components). Just create the style you want using QGIS, save it to a file, and then enter the path to that file in the
settings so the algorithms can use it. Whenever a layer is loaded by SEXTANTE and added to the QGIS canvas,
it will be rendered with that style.

Le rendu des styles peut être configuré pour chaque algorithme et pour chacune de ses sorties. Cliquez avec le
bouton droit sur le nom de l’algorithme dans la boîte à outils et sélectionnez Éditer les styles de rendu. Une fenêtre
comme celle-ci apparaitra.

Figure 17.15: Rendering Styles

Sélectionnez le fichier de style (.qml) que vous souhaitez appliquer à chaque résultat et appuyez sur [OK].

Les autres paramètres de configuration du groupe Général sont les suivants :

• Utiliser le nom de fichier comme nom de couche. Le nom de chaque couche créée par un algorithme est
défini par l’algorithme lui-même. Dans certains cas, un nom fixe peut être utilisé, ce qui signifie que le
même nom sera utilisé, quelle que soit la couche utilisée en entrée. Dans d’autres cas, le nom peut dépendre
du nom de la couche d’entrée ou de certains des paramètres utilisés pour exécuter l’algorithme. Si cette case
est cochée, le nom sera plutôt issu de celui du fichier de sortie. Notez, que, si la sortie est enregistrée dans
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un fichier temporaire, le nom de ce fichier temporaire est généralement long et créé de manière à éviter les
collisions avec d’autres noms de fichiers déjà existants.

• N’utiliser que les entités sélectionnées. Si cette option est sélectionnée, chaque fois qu’une couche vecteur
est utilisée comme entrée pour un algorithme, seules ses entités sélectionnées seront utilisées. Si aucune
entité de la couche n’est sélectionnée, toutes seront utilisées.

• Script Pré-exécution et Script Post-exécution. Ces paramètres font référence à des scripts écrits à l’aide des
fonctions du menu Traitements et sont expliqués dans la section abordant les algorithmes et la console.

Vous trouverez également un bloc Général pour chaque fournisseur d’algorithmes. Chaque bloc contient une
rubrique Activé pour le faire apparaître dans la boîte à outils. De plus, certains fournisseurs ont leurs propres
options de configuration. Cela sera détaillé dans la description de chaque fournisseur.

.

17.3 Le modeleur graphique

The graphical modeler allows you to create complex models using a simple and easy-to-use interface. When
working with a GIS, most analysis operations are not isolated, but rather part of a chain of operations instead.
Using the graphical modeler, that chain of processes can be wrapped into a single process, so it is as easy and
convenient to execute as a single process later on a different set of inputs. No matter how many steps and different
algorithms it involves, a model is executed as a single algorithm, thus saving time and effort, especially for larger
models.

Le modeleur peut être ouvert à partir du menu Traitements.

Le modeleur possède un espace de travail où sont représentés la structure du modèle et le flux de traitement. Sur
la partie gauche se trouve un panneau avec deux onglets pour ajouter de nouveaux éléments au modèle.

Figure 17.16: Modeler

Deux étapes sont nécessaires pour la création d’un modèle:
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1. Définir les entrées nécessaires. Ces entrées seront ajoutées à la fenêtre des paramètres, afin que l’utilisateur
puisse y fixer les valeurs nécessaires à l’excéution du modèle. Le modèle en lui-même est un algorithme.
Ainsi la fenêtre des paramètres est générée automatiquement comme cela est le cas pour tous les algorithmes
fournis avec le Module de Traitements.

2. Définir le flux de traitements. A partir des données d’entrée du modèle, le flux de traitements est défini
en ajoutant des algorithmes et en sélectionnant comment ces derniers utiliseront les données ou d’autres
données générées par d’autres algorithmes déjà présents dans le modèle.

17.3.1 Définition des données d’entrée

La première étape pour créer un modèle est de définir les données d’entrées nécessaires. Vous trouverez les
éléments suivants dans l’onglet Entrées dans la partie gauche de la fenêtre du modeleur :

• Couche raster

• Couche vectorielle

• Chaîne de caractères

• Champ d’une table

• Table

• Etendue

• Nombre

• Booléen

• Fichier

Double cliquez sur ces éléments pour faire apparaître une fenêtre avec leurs détails. Selon le paramètre, cette
fenêtre peut contenir une simple description (que l’utilisateur verra à l’exécution du modèle) ou d’autres informa-
tions. Par exemple, à l’ajout d’une valeur numérique, à la description devront être définies la valeur par défaut
ainsi que la liste des valeurs valides. La figure suivante illustre cette fenêtre.

Figure 17.17: Model Parameters

Pour chaque donnée d’entrée ajoutée, un nouvel élément apparaît dans l’espace de travail du modeleur.

Figure 17.18: Model Parameters

Vous pouvez également ajouter des données d’entrée en faisant glisser le type choisi depuis la liste et en le déposant
dans le modèle à l’endroit souhaité.
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17.3.2 Définition d’un flux de traitements

Une fois les données d’entrée définies, il faut à présent ajouter les algorithmes de traitement. Ces algorithmes se
situent dans l’onglet Algorithmes, regroupés par fournisseur comme dans la boîte à outils.

Figure 17.19: Model Parameters

The appearance of the toolbox has two modes here as well: simplified and advanced. However, there is no element
to switch between views in the modeler, so you have to do it in the toolbox. The mode that is selected in the toolbox
is the one that will be used for the list of algorithms in the modeler.

To add an algorithm to a model, double-click on its name or drag and drop it, just like it was done when adding
inputs. An execution dialog will appear, with a content similar to the one found in the execution panel that is shown
when executing the algorithm from the toolbox. The one shown next corresponds to the SAGA ‘Convergence
index’ algorithm, the same example we saw in the section dedicated to the toolbox.

Comme vous pouvez le voir, quelques différences existent entre les deux fenêtres. Ainsi, le nom de fichier en
sortie de l’algorithme est remplacé par un simple champ texte. Pour créer une couche temporaire en sortie pour
être utilisée par un autre algorithme et supprimée à la fin, laissez le champ texte vide. Dans le cas contraire, la
couche résultante sera un résultat final de l’algorithme et portera le nom défini dans le champ de texte. C’est ce
nom que verra l’utilisateur du modèle à son exécution.

La sélection des valeurs de chaque paramètre s’effectue également différemment, en raison de la différence de
contexte entre le modeleur et la boite à outils. Détaillons les valeurs pour chaque type de paramètre.

• Layers (raster and vector) and tables. These are selected from a list, but in this case, the possible values are
not the layers or tables currently loaded in QGIS, but the list of model inputs of the corresponding type, or
other layers or tables generated by algorithms already added to the model.

• Les valeurs numériques. Les valeurs littérales peuvent être directement indiquées dans le champ correspon-
dant. Mais ce dernier peut aussi être rempli à partir d’une donnée d’entrée du modèle. Dans ce cas, la valeur
sera paramétrée par l’utilisateur à l’exécution du modèle.

• Les chaînes de caractères. Comme pour les valeurs numériques, les chaînes peuvent être fixées une fois
pour toute ou à l’exécution du modèle.
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Figure 17.20: Model Parameters

• Un champ de table. Les champs d’une table ou d’une couche ne sont pas connus au moment de la conception
du modèle, puisqu’ils seront définis à l’exécution du modèle. Pour remplir ce paramètre, entrez le nom du
champ directement dans le champ texte correspondant, ou sélectionnez-le dans la liste des champs des tables
déjà présentes dans le modèle. La validité du champ sélectionné sera vérifiée à l’exécution.

Dans tous les cas, vous trouverez un paramètre supplémentaire nommé Algorithme parent qui n’est pas disponible
lors de l’appel de l’algorithme via la boîte à outils. Ce paramètre vous permet de choisir dans quel ordre seront
exécutés les algorithmes, en définissant explicitement un algorithme qui sera parent d’un autre, son exécution sera
forcée en premier.

When you use the output of a previous algorithm as the input of your algorithm, that implicitly sets the previous
algorithm as parent of the current one (and places the corresponding arrow in the modeler canvas). However,
in some cases an algorithm might depend on another one even if it does not use any output object from it (for
instance, an algorithm that executes an SQL sentence on a PostGIS database and another one that imports a layer
into that same database). In that case, just select the previous algorithm in the Parent algorithms parameter and
the two steps will be executed in the correct order.

Une fois tous les paramètres remplis, validez avec le bouton [OK] et l’algorithme sera ajouté au canevas. Il sera
lié aux autres éléments déjà présents, données d’entrée ou algorithmes fournissant des objets à utiliser comme
entrée.

Les éléments peuvent être disposés et rangés en les glissant dans l’espace de travail. Cela améliore la lecture et
la compréhension du modèle. Les liens entre éléments sont mis à jour automatiquement. Vous pouvez zoomer et
dé-zoomer avec la molette de la souris.

You can run your algorithm anytime by clicking on the [Run] button. However, in order to use the algorithm from
the toolbox, it has to be saved and the modeler dialog closed, to allow the toolbox to refresh its contents.

17.3.3 Sauvegarder et charger les modèles

Utilisez le bouton [Sauvegarder] pour sauvegarder le modèle courant et le bouton [Ouvrir] pour restaurer un
précédent modèle. Les modèles sont sauvegardés dans un fichier avec l’extension .model. Si le modèle a
précédemment été sauvegardé à partir du modeleur, vous n’aurez pas à redonner de nom de fichier, ce nom étant
déjà associé au modèle sera réutilisé.
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Avant de sauvegarder un modèle, il faudra définir son nom et le groupe auquel il appartient. Pour cela, remplissez
les deux champs texte situés sur la partie haute de la fenêtre.

Les modèles sauvegardés dans le répertoire models (le répertoire par défaut) apparaîtront dans la boîte à outils
dans le groupe correspondant. Lorsque la boîte à outils est ouverte, tous les fichiers portant l’extension .model
du répertoire models sont chargés. Comme le modèle fait maintenant partie des algorithmes, il peut être utilisé
comme tous les autres depuis la boite à outils ou depuis le modeleur.

The models folder can be set from the processing configuration dialog, under the Modeler group.

Les modèles sauvegardés dans le répertoire models apparaîtront dans la boîte à outils dans le groupe correspon-
dant ainsi que dans la liste des Algorithmes proposés dans le modeleur. Cela signifie qu’il peut être utilisé comme
tous les autres depuis la boite à outils ou depuis le modeleur.

In some cases, a model might not be loaded because not all the algorithms included in its workflow are available.
If you have used a given algorithm as part of your model, it should be available (that is, it should appear in the
toolbox) in order to load that model. Deactivating an algorithm provider in the processing configuration window
renders all the algorithms in that provider unusable by the modeler, which might cause problems when loading
models. Keep that in mind when you have trouble loading or executing models.

17.3.4 Editer un modèle

Vous pouvez éditerle modèle sur lequel vous travaillez, en redéfinissant le flux de traitements et les relations entre
algorithmes et données d’entrée.

Si vous cliquez avec le bouton droit sur un algorithme de l’espace de travail du modèle, le menu contextuel suivant
apparaîtra:

Figure 17.21: Modeler Right Click

Choisissez l’option Enlever pour supprimer l’algorithme sélectionné. Un algorithme ne peut être enlevé que si
aucun autre algorithme ne dépend de lui, c’est-à-dire si aucune de ses sorties n’est utilisée par ailleurs. Si vous
tentez de supprimer un algorithme utilisé par ailleurs, le message d’avertissement suivant s’affichera :

Figure 17.22: Cannot Delete Algorithm

Selecting the Edit option or simply double-clicking on the algorithm icon will show the parameters dialog of the
algorithm, so you can change the inputs and parameter values. Not all input elements available in the model will
appear in this case as available inputs. Layers or values generated at a more advanced step in the workflow defined
by the model will not be available if they cause circular dependencies.

Sélectionnez les nouvelles valeurs et validez avec le bouton [OK]. Les liens entre les éléments du modèle seront
actualisés dans l’espace de travail du modeleur.
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17.3.5 Editer l’aide et les métadonnées

Vous pouvez documenter vos modèles. Cliquez sur le bouton [Éditer l’aide du modèle] et une fenêtre semblable
à celle-ci apparaîtra.

Figure 17.23: Help Edition

Sur la partie droite apparaîtra une simple page HTML, créée à partir de la description des paramètres d’entrées et
des sorties de l’algorithme, ainsi que d’autres éléments tels que description générale du modèle ou ses auteurs. A la
première ouverture de l’éditeur d’aide, ces champs seront vides, mais vous pouvez les éditer à partir des éléments
situés à gauche de la fenêtre. Sélectionnez un élément dans la partie supérieure puis remplissez sa description
dans la partie inférieure.

Model help is saved in a file in the same folder as the model itself. You do not have to worry about saving it, since
it is done automatically.

17.3.6 A propos des algorithmes disponibles

Vous remarquerez que certains algorithmes présents dans la boîte à outils n’apparaissent pas dans la liste depuis
le modeleur. Pour pouvoir être utilisé dans un modèle, un algorithme doit présenter une syntaxe correcte pour
pouvoir être lié aux autres traitements. Si cela n’est pas le cas, par exemple si le nombre de couche en sortie n’est
pas connu à l’avance, alors il ne sera pas possible de l’utiliser au sein d’un modèle et n’apparaîtra donc pas dans
la liste du modeleur.

De même, certains algorithmes du modeleur ne sont pas disponibles dans la boîte à outils. Ils sont destinés à
être utilisés dans un modèle et n’ont que peu d’intérêt en dehors de ce contexte. C’est par exemple le cas de la
‘Calculatrice’ : c’est un simple calculateur arithmétique qui vous permet de modifier une valeur numérique (saisie
par l’utilisateur ou générée par un autre algorithme). Cet outil peut être utile dans un modèle, mais n’a que peu
d’intérêt en dehors de ce contexte.

.

210 Chapter 17. QGIS processing framework



QGIS User Guide, Version 2.8

17.4 L’interface de traitement par lot

17.4.1 Introduction

Les algorithmes (dont les modèles) peuvent être exécutés par lot. C’est à dire qu’ils peuvent être exécutés en
utilisant non pas une mais plusieurs entrées, exécutant les algorithmes autant de fois que nécessaire. Ceci est utile
lors du traitement de gros volume de données, puisqu’il n’est pas nécessaire de lancer l’algorithme plusieurs fois
à partir de la boîte à outils.

Pour exécuter un algorithme en traitement par lots, cliquez avec le bouton droit sur son nom dans la boîte à outis
et sélectionnez l’option Exécution par lots dans le menu contextuel qui apparaît.

Figure 17.24: Batch Processing Right Click

17.4.2 La table des paramètres

L’exécution d’un traitement par lots est semblable à l’exécution simple d’un algorithme. Les valeurs des
paramètres peuvent être définies, mais dans le cas présent, il est nécessaire de définir les valeurs pour chaque
exécution de l’algorithme. Ces valeurs sont à donner dans la table suivante.

Figure 17.25: Batch Processing

Chaque ligne de la table correspond à une itération de l’algorithme et chaque cellule contient la valeur de chaque
paramètre. Ce sont les mêmes paramètres que dans la boîte à outils, mais présentés différemment.

Par défaut, la table contient seulement deux lignes. Vous pouvez ajouter ou retirer des lignes en utilisant les
boutons situés en bas de la fenêtre.

Une fois le nombre de lignes souhaitées atteint, vous pouvez remplir les paramètres avec les valeurs correspon-
dantes.
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17.4.3 Remplir la table de paramètres

Pour la plupart des paramètres, la valeur à fixer est triviale. Selon le type de paramètre, entrez simplement la
valeur ou sélectionnez l’option adéquate dans la liste de choix.

The main differences are found for parameters representing layers or tables, and for output file paths. Regarding
input layers and tables, when an algorithm is executed as part of a batch process, those input data objects are taken
directly from files, and not from the set of them already opened in QGIS. For this reason, any algorithm can be
executed as a batch process, even if no data objects at all are opened and the algorithm cannot be run from the
toolbox.

Filenames for input data objects are introduced directly typing or, more conveniently, clicking on the button
on the right hand of the cell, which shows a typical file chooser dialog. Multiple files can be selected at once. If
the input parameter represents a single data object and several files are selected, each one of them will be put in a
separate row, adding new ones if needed. If the parameter represents a multiple input, all the selected files will be
added to a single cell, separated by semicolons (;).

Output data objects are always saved to a file and, unlike when executing an algorithm from the toolbox, saving to
a temporary file is not permitted. You can type the name directly or use the file chooser dialog that appears when
clicking on the accompanying button.

Une fois le fichier choisi, une nouvelle fenêtre apparaît permettant le remplissage automatique des autres cellules
d’une même colonne (même paramètre).

Figure 17.26: Remplissage automatique des paramètres de traitement par lot

Si la valeur par défaut (‘Ne pas autocompléter’) est choisie, seule la cellule sélectionnée sera remplie, avec le nom
du fichier sélectionné. Dans le cas contraire, toutes les cellules sous la ligne sélectionnée seront remplies à partir
de la valeur choisie. Ainsi, il est aisée de remplir la table de paramètres et le traitement par lots s’en trouve facilité.

Le remplissage automatique peut également effectué en concaténant un compteur au nom de fichier, ou en ajoutant
un champ à un autre dans la même ligne. Cela peut être utile pour nommer des résultats en fonction de la donnée
d’entrée.

Figure 17.27: Batch Processing File Path

17.4.4 Exécuter le traitement par lots

Pour exécuter un traitement par lots une fois définies toutes les valeurs nécessaires, cliquez simplement sur le
bouton [OK]. La progression du traitement s’affiche alors dans la partie basse de la fenêtre.

.
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17.5 Utiliser les algorithmes du module de traitements depuis la
console Python

La console permet aux utilisateurs confirmés d’accroître leur productivité en réalisant des opérations complexes
qui ne pourraient par être réalisées à partir de l’interface graphique du module de Traitements. Les modèles impli-
quant plusieurs algorithmes peuvent être définis à partir de l’interface en lignes de commandes et des opérations
additionnelles comme les boucles ou les branchements conditionnels permettent de créer des flux de traitements
plus puissants et plus flexibles.

There is not a proccesing console in QGIS, but all processing commands are available instead from the QGIS
built-in Python console. That means that you can incorporate those commands into your console work and connect
processing algorithms to all the other features (including methods from the QGIS API) available from there.

Le code exécuté à partir de la console Python, même s’il n’utilise pas de méthodes de traitements particulières,
peut être converti en un nouveau algorithme pour être réutilisé dans la boîte à outils, le modeleur ou dans un autre
flux de traitements, comme tout autre algorithme. Ainsi certains algorithmes que vous pouvez trouver dans la
boîte à outils sont en fait de simples scripts.

In this section, we will see how to use processing algorithms from the QGIS Python console, and also how to write
algorithms using Python.

17.5.1 Appeler des algorithmes depuis la console Python

La première chose à faire est d’importer les fonctions de traitement à l’aide de l’instruction suivante:

>>> import processing

A présent, la seule instruction (intéressante) à faire est d’exécuter un algorithme. Cela est effectué en utilisant la
méthode runalg(), qui prend en premier paramètre le nom de l’algorithme à lancer, puis tous les paramètres
nécessaires à son exécution. Vous devez donc connaître le nom de commande de l’algorithme, qui peut être
différent de celui affiché dans la boîte à outils. Pour le trouver, utilisez alglist() dans la console et tapez :

>>> processing.alglist()

Vous devriez avoir quelque chose qui ressemble à ceci.

Accumulated Cost (Anisotropic)---------------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)------------------>saga:accumulatedcost(isotropic)
Add Coordinates to points--------------------->saga:addcoordinatestopoints
Add Grid Values to Points--------------------->saga:addgridvaluestopoints
Add Grid Values to Shapes--------------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points-------------->saga:addpolygonattributestopoints
Aggregate------------------------------------->saga:aggregate
Aggregate Point Observations------------------>saga:aggregatepointobservations
Aggregation Index----------------------------->saga:aggregationindex
Analytical Hierarchy Process------------------>saga:analyticalhierarchyprocess
Analytical Hillshading------------------------>saga:analyticalhillshading
Average With Mask 1--------------------------->saga:averagewithmask1
Average With Mask 2--------------------------->saga:averagewithmask2
Average With Thereshold 1--------------------->saga:averagewiththereshold1
Average With Thereshold 2--------------------->saga:averagewiththereshold2
Average With Thereshold 3--------------------->saga:averagewiththereshold3
B-Spline Approximation------------------------>saga:b-splineapproximation
...

Il s’agit de la liste des algorithmes disponibles, par ordre alphabétique, accompagnés des noms de commande.

Vous pouvez également passer une chaine de caractères en paramètre de cette méthode. Au lieu de retourner la
liste complète des algorithmes, elle filtrera les résultats selon la chaîne fournies. Par exemple, si vous recherchez
un algorithme permettant de calculer la pente d’un MNT, l’instruction alglist("slope") donnera le résultat
suivant :
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DTM Filter (slope-based)---------------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient------------------->saga:downslopedistancegradient
Relative Heights and Slope Positions---------->saga:relativeheightsandslopepositions
Slope Length---------------------------------->saga:slopelength
Slope, Aspect, Curvature---------------------->saga:slopeaspectcurvature
Upslope Area---------------------------------->saga:upslopearea
Vegetation Index[slope based]----------------->saga:vegetationindex[slopebased]

Ce résultat peut différer d’un système à l’autre selon les algorithmes disponibles.

Il est ainsi facile de trouver l’algorithme recherché et son nom de commande, ici
saga:slopeaspectcurvature.

Une fois trouvé le nom de commande de l’algorithme, il s’agit de connaître la bonne syntaxe pour l’exécuter.
Cela comprend la liste et l’ordre des paramètres à fournir à l’appel de la méthode runalg(). Une méthode
est destinée à décrire en détail un algorithme et renvoie la liste des paramètres nécessaires et le type de sorties
générées : il s’agit de la méthode alghelp(nom_de_l_algorithme). Veillez à bien utiliser le nom de
commande et non le nom descriptif.

L’appel à la méthode avec le paramètre saga:slopeaspectcurvature donnera la description suivante :

>>> processing.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Vous avez à présent tout ce qu’il faut pour exécute n’importe quel algorithme. Comme indiqué précédemment,
l’instruction runalg() suffit pour exécuter un algorithme. Sa syntaxe est la suivante:

>>> processing.runalg(name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

La liste des paramètres et des sorties à fournir dépend de l’algorithme à exécuter et correspond au résultat, dans
l’ordre donné, de la méthode alghelp().

Selon le type de paramètre, les valeurs peuvent être fournies selon plusieurs manières. Une rapide description de
ces possibilités est donnée pour chaque type de paramètre d’entrée :

• Raster Layer, Vector Layer or Table. Simply use a string with the name that identifies the data object to use
(the name it has in the QGIS Table of Contents) or a filename (if the corresponding layer is not opened, it
will be opened but not added to the map canvas). If you have an instance of a QGIS object representing the
layer, you can also pass it as parameter. If the input is optional and you do not want to use any data object,
use None.

• Sélection. Si un algorithme possède un paramètre sélection, cette valeur doit être une valeur entière.
Pour connaître les options possibles, vous pouvez utilisez la commande algoptions(), comme dans
l’exemple suivant :

>>> processing.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

Dans l’exemple, l’algorithme présente ces types de paramètres, avec sept options. Notez que le premier
élément a pour numéro 0.
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• Entrées multiples. La valeur est une chaîne de caractères, avec les entrées séparées par des points-virgules
(;). Comme pour les couches simples et les tables, chaque élément d’entrée peut être le nom d’une variable
objet ou un nom de fichier.

• Champ de la table XXX. Insérez une chaîne de caractère contenant le nom du champ à utiliser. Ce paramètre
est sensible à la casse.

• Table fixée. Entrez la liste de toutes les valeurs, séparées par des virgules (,) et entre guillemets ("). Les
valeurs commencent par la première ligne et se lisent de gauche à droite. Vous pouvez aussi utiliser un
tableau à deux dimensions pour représenter la table.

• SCR. Entrez le code EPSG du système de coordonnées désiré.

• Étendue. Vous devez fournir une chaîne de caractères avec les valeurs xmin, xmax, ymin et ymax séparées
par des virgules (,).

Booléen, fichier, chaîne de caractères et valeurs numériques ne nécessitent pas d’explications particulières.

Pour spécifier les valeurs par défaut des paramètres tels que chaînes de caractères, booléens ou valeurs numériques,
entrez None dans l’entrée correspondante.

Pour les données en sortie, entrez le chemin à utiliser, comme dans la boîte à outils. Si vous préférez sauvegarder
le résultat dans un fichier temporaire, indiquez None. L’extension du fichier déterminera le format de fichier
utilisé. Si elle n’est pas reconnue par l’algorithme, le format de fichier par défaut sera utilisé et l’extension sera
ajouté à la fin du nom de fichier.

Unlike when an algorithm is executed from the toolbox, outputs are not added to the map canvas if you execute
that same algorithm from the Python console. If you want to add an output to the map canvas, you have to do it
yourself after running the algorithm. To do so, you can use QGIS API commands, or, even easier, use one of the
handy methods provided for such tasks.

La méthode runalg renvoie un dictionnaire Python avec pour clés les noms des sorties (correspondant à la
description des éléments de l’algorithme) et pour valeurs les chemins des résultats. Vous pouvez charger ces
couches de résultat en passant les chemins correspondants à la méthode load().

17.5.2 Fonctions supplémentaires pour gérer des données

Apart from the functions used to call algorithms, importing the processing package will also import some
additional functions that make it easier to work with data, particularly vector data. They are just convenience
functions that wrap some functionality from the QGIS API, usually with a less complex syntax. These functions
should be used when developing new algorithms, as they make it easier to operate with input data.

Below is a list of some of these commands. More information can be found in the classes under the
processing/tools package, and also in the example scripts provided with QGIS.

• getObject(obj): Returns a QGIS object (a layer or table) from the passed object, which can be a
filename or the name of the object in the QGIS Table of Contents.

• values(couche, champs) : Renvoie les valeurs de la table d’attributs de la couche vecteur pour le
champ passé en paramètre. Les champs peuvent être passés en tant que noms de champ ou index du champ
dans la table, en commençant par zero. Renvoie un dictionnaire de listes, dont les clés correspondent à la
liste des champs passée en paramètre. La sélection existante est prise en compte.

• features(couche) : Renvoie un itérateur sur les entités d’une couche vecteur, prenant en compte la
sélection existante.

• uniqueValues(couche, champ) : Renvoie la liste des valeurs uniques trouvées dans un champ. Le
champ peut être passé en paramètre en tant que nom ou index dans la table, en commençant par zéro. La
sélection existante est prise en compte.
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17.5.3 Créer des scripts et les exécuter depuis la boîte à outils

Vous pouvez créer vos propres algorithmes en écrivant le code Python correspondant et en ajoutant quelques lignes
fournissant les informations nécessaires pour le faire fonctionner. Vous trouverez le menu Créer un nouveau script
dans le groupe Outils du bloc Script de la boîte à outils. Double-cliquez dessus pour ouvrir la fenêtre d’édition
de script. C’est ici que vous pouvez écrire votre code. En sauvegardant d’ici votre script dans le répertoire des
scripts (le répertoire par défaut qui s’affiche quand vous ouvrez la fenêtre de sauvegarde) avec l’extension
.py, vous créez automatiquement l’algorithme correspondant.

Le nom de l’algorithme (celui qui apparaît dans la boîte à outils) est généré à partir du nom de fichier, en enlevant
son extension et en remplaçant les underscores (‘_’) par des espaces.

Voici par exemple le code permettant de calculer l’Indice d’Humidité Topographique (Topographic Wetness Index,
TWI) directement à partir d’un MNT.

##dem=raster
##twi=output
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

Comme vous pouvez le voir, le calcul utilise trois algorithmes, provenant de SAGA. Le dernier calcule le TWI,
mais nécessite de une couche représentant la pente et une autre d’accumulation des flux. Dans la mesure où ces
deux couches n’existent pas mais que nous disposons d’un MNT, nous allons les calculer en faisant appel aux
algorithmes SAGA adéquats.

Le bout de code où le traitement est effectué n’est pas compliqué à comprendre si vous avez lu les sections
précédentes. Cependant, les premières lignes nécessitent quelques explications. Elles fournissent les informations
nécessaires pour convertir votre code en un algorithme utilisable à partir d’autres contextes, comme la boîte à
outils ou le modeleur graphique.

Ces lignes débutent par deux symboles de commentaire Python (##) et présentent la structure suivante :

[parameter_name]=[parameter_type] [optional_values]

Voici la liste des types de paramètres gérés par les scripts de traitement, leur syntaxe ainsi que quelques exemples.

• raster. Une couche raster.

• vector. Une couche vectorielle.

• table. Une table.

• number. Une valeur numérique. Une valeur par défaut doit être définie. Par exemple, depth=number
2.4.

• string. Une chaîne de caractère. Comme pour les valeurs numériques, une valeur par défaut doit être
définie. Par exemple, name=string Victor.

• boolean. Une valeur booléenne. Ajoutez True (Vrai) ou False (Faux) pour définir la valeur par défaut.
Par exemple, verbose=boolean True pour plus un rendu plus parlant.

• multiple raster. Un ensemble de couches raster en entrée.

• multiple vector. Un ensemble de couches vectorielles en entrée.

• field. Un champ dans la table d’attributs d’une couche vectorielle. Le nom de la couche doit être ajoutée
après l’étiquette field. Par exemple, si vous déclarez une couche vectorielle macouche=vector en
entrée, vous pouvez utilisez monchamp=champ1 macouche pour ajouter en paramètre le champ de
cette couche.

• folder. Un répertoire.

• file. Un nom de fichier.
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Le nom du paramètre correspond à ce qui sera affiché lorsque l’utilisateur exécutera l’algorithme, ainsi qu’au
nom de variable à utiliser dans le script. La valeur saisie par l’utilisateur pour ce paramètre sera assignée à cette
variable, portant ce nom.

A l’affichage du nom de paramètre, les underscores (‘_’) sont convertis en espaces pour améliorer la lisibilité.
Ainsi, par exemple, si vous souhaitez que l’utilisateur saisisse une valeur appelée ‘Valeur numérique’, vous devez
utiliser une variable nommée Valeur_numérique.

Layers and table values are strings containing the file path of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the file paths to all selected object, separated by semicolons (;).

Les sorties sont définies de la même manière, avec les étiquettes suivantes:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

La valeur attribuée à une variable de sortie est toujours une chaîne de caractères contenant le chemin de l’objet. Si
le nom est vide, un fichier temporaire sera créé.

When you declare an output, the algorithm will try to add it to QGIS once it is finished. That is why, although the
runalg() method does not load the layers it produces, the final TWI layer will be loaded (using the case of our
previous example), since it is saved to the file entered by the user, which is the value of the corresponding output.

N’utilisez donc pas la méthode load() dans vos scripts, mais uniquement à partir de la console. Si un algorithme
définit une couche en sortie, celle-ci doit être déclarée ainsi. Dans le cas contraire, vous ne pourriez pas l’utiliser
dans le modeleur parce que sa syntaxe (comme définie par ses étiquettes, exposées précédemment) ne correspond
pas à ce que l’algorithme crée effectivement.

Les sorties masquées (nombres ou chaînes) n’ont pas de valeur. C’est à vous de leur assigner une valeur. Pour
cela, affecter une valeur à la variable pour la déclarer en sortie. Par exemple, vous pourriez utiliser la déclaration
suivante,

##average=output number

l’instruction suivante fixe la valeur de sortie à 5:

average = 5

En complément des étiquettes définissant les paramètres et les sorties, vous pouvez définir la catégorie dans
laquelle l’algorithme apparaîtra, en utilisant l’étiquette group.

Si votre algorithme est long, il est conseillé d’informer l’utilisateur de l’avancée du traitement de
l’algorithme. Vous disposez de la variable globale progress, avec deux méthodes, setText(text) et
setPercentage(percent) pour modifier le message et la barre de progression.

Plusieurs exemples sont fournis. Veuillez vous y reporter pour servir d’exemples. Cliquez avec le bouton droit sur
un script et choisissez Éditer le script pour voir et éditer le code correspondant.

17.5.4 Documenter ses scripts

Comme pour les modèles, vous pouvez ajouter des commentaires à vos scripts, pour expliciter le traitement effec-
tué et son utilisation. Dans la fenêtre d’édition du script se situe un bouton [Editer l’aide], qui vous amènera à
la fenêtre d’édition de l’aide. Veuillez vous reporter à la section Modeleur graphique pour plus d’information sur
cette fenêtre.
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Les fichiers d’aide sont sauvegardés dans le même répertoire que les scripts, avec l’extension .help. Veuillez
noter qu’à la première édition de l’aide, la fermeture de la fenêtre ne sauvegarde pas vos modifications. Par contre,
si le fichier a déjà été sauvegardé une fois préalablement, les modifications seront conservées.

17.5.5 Scripts de pré et post-exécution

Des scripts peuvent également être utilisés en amont et en aval de l’exécution d’un algorithme. Ce mécanisme
peut être utilisé pour automatiser des tâches qui doivent être lancées à chaque fois qu’un algorithme est exécuté.

La syntaxe est identique à celle qui est expliquée plus haut mais une variable globale nommée alg est disponible.
Elle représente l’objet alogrithme qui vient (ou qui va) être lancé.

Dans le groupe Général de la boîte de dialogue de configuration des géo-traitements, vous trouverez deux entrées
nommées Script de pré-exécution et Script de post-exécution où les noms des scripts à lancer dans chacun des cas
peuvent être saisis.

.

17.6 Le gestionnaire d’historique

17.6.1 L’historique des traitements

A chaque exécution d’un algorithme, les informations du traitement, paramètres utilisés, date et heure d’exécution,
sont sauvegardées dans le gestionnaire d’historiques.

This way, it is easy to track and control all the work that has been developed using the processing framework, and
easily reproduce it.

Le gestionnaire d’historiques est un ensemble d’entrées de registre, regroupées selon la date d’exécution, permet-
tant de retrouver facilement quel algorithme a été exécuté à un moment donné.

Figure 17.28: Historique
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Les informations de traitement sont sauvegardées sous forme de ligne de commande, même si l’algorithme a
été exécuté depuis la boîte à outils. Cela permet également de comprendre l’interface en ligne de commande en
visualisant la commande effectivement lancée depuis la boîte à outils.

Pour ré-exécuter une commande présente dans l’historique, double-cliquez sur l’entrée correspondante.

Along with recording algorithm executions, the processing framework communicates with the user by means of
the other groups of the registry, namely Errors, Warnings and Information. In case something is not working
properly, having a look at the Errors might help you to see what is happening. If you get in contact with a
developer to report a bug or error, the information in that group will be very useful for her or him to find out what
is going wrong.

Third-party algorithms are usually executed by calling their command-line interfaces, which communicate with
the user via the console. Although that console is not shown, a full dump of it is stored in the Information group
each time you run one of those algorithms. If, for instance, you are having problems executing a SAGA algorithm,
look for an entry named ‘SAGA execution console output’ to check all the messages generated by SAGA and try
to find out where the problem is.

Some algorithms, even if they can produce a result with the given input data, might add comments or additional
information to the Warning block if they detect potential problems with the data, in order to warn you. Make sure
you check those messages if you are having unexpected results.

17.7 Écrire de nouveaux algorithmes sous la forme de scripts
python

Vous pouvez créer vos propres algorithmes en écrivant le code Python correspondant et en ajoutant quelques lignes
supplémentaires nécessaires à la définition de la sémantique de l’algorithme. Vous pouvez trouver un Créer un
nouveau script sous le menu Outils du bloc Script de la boîte à outils. Double-cliquez dessus pour ouvrir la fenêtre
d’édition de script. C’est ici que vous pouvez écrire votre code. En sauvegardant votre script dans le répertoire
des scripts (le répertoire par défaut qui s’affiche quand vous ouvrez la fenêtre de sauvegarde) avec l’extension
.py, vous créez automatiquement l’algorithme correspondant.

The name of the algorithm (the one you will see in the toolbox) is created from the filename, removing its extension
and replacing low hyphens with blank spaces.

Voici par exemple le code permettant de calculer l’Indice Topographique d’Humidité (Topographic Wetness Index,
TWI) directement à partir d’un MNE

##dem=raster
##twi=output raster
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindextwi, ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

As you can see, it involves 3 algorithms, all of them coming from SAGA. The last one of them calculates the TWI,
but it needs a slope layer and a flow accumulation layer. We do not have these ones, but since we have the DEM,
we can calculate them calling the corresponding SAGA algorithms.

Le bout de code où le traitement est effectué n’est pas compliqué à comprendre si vous avez lu les sections
précédentes. Cependant, les premières lignes nécessitent quelques explications. Elles fournissent les informa-
tions nécessaires pour convertir votre code en un algorithme utilisable à partir d’autres contextes de l’interface
graphique, comme la boîte à outils ou le modeleur graphique.

Ces lignes commencent par deux symboles de commentaires Python (##) et ont la structure suivante :

[parameter_name]=[parameter_type] [optional_values]

Here is a list of all the parameter types that are supported in processign scripts, their syntax and some examples.
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• raster. Une couche raster

• vector. Une couche vectorielle

• table. Un tableau

• number. Une valeur numérique. Une valeur par défaut doit être définie. Par exemple, depth=number
2.4

• string. Une chaîne de caractères. Comme pour les valeurs numériques, une valeur pas défaut doit être
ajoutée. Par exemple, name=string Victor

• longstring. Comme pour la chaîne de caractères, mais ici une plus large zone de texte sera affichée, ce
qui est mieux adaptée pour les longues chaînes de texte, comme pour un script attendant un petit extrait de
code.

• boolean. Une valeur booléenne. Ajoutez True ou False après avoir défini une valeur par défaut. Par
exemple, verbose=boolean True.

• multiple raster. Une série de couches raster.

• multiple vector. Un ensemble de couches vectorielles.

• field. Un champ de la table d’attributs d’une couche vectorielle. Le nom de la couche doit être ajoutée
après l’étiquette field. Par exemple, si vous déclarez une couche vectorielle macouche=vector en
entrée, vous pouvez utilisez monchamp=field macouche pour ajouter en paramètre le champ de cette
couche.

• folder. Un répertoire

• file. Un nom de fichier

• crs. Système de coordonnées de référence

Le nom du paramètre correspond à ce qui sera affiché lorsque l’utilisateur exécutera l’algorithme, ainsi qu’au
nom de variable à utiliser dans le script. La valeur saisie par l’utilisateur pour ce paramètre sera assignée à cette
variable, portant ce nom.

When showing the name of the parameter to the user, the name will be edited it to improve its appearance, replacing
low hyphens with spaces. So, for instance, if you want the user to see a parameter named A numerical
value, you can use the variable name A_numerical_value.

Layers and tables values are strings containing the filepath of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the filepaths to all selected objects, separated by semicolons (;).

Les sorties sont définies de la même manière, avec les étiquettes suivantes :

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

• output extent

La valeur attribuée à une variable de sortie est toujours une chaîne de caractères contenant le chemin de l’objet. Si
le nom est vide, un fichier temporaire sera créé.

En complément des étiquettes définissant les paramètres et les sorties, vous pouvez définir la catégorie dans
laquelle l’algorithme apparaîtra, en utilisant l’étiquette group.

La dernière étiquette que vous pouvez utiliser dans votre en-tête de script est ##nomodeler. L’utiliser indique
que vous ne voulez pas que votre algorithme soit affiché dans la fenêtre du modeleur. Elle doit être utilisée pour
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les algorithmes qui n’ont pas une syntaxe claire (par exemple su le nombre de couches à créer n’est pas connu à
l’avance au moment de la modélisation), ce qui les rend non disponibles dans le modeleur graphique.

17.8 Gérer les données produites par l’algorithme

When you declare an output representing a layer (raster, vector or table), the algorithm will try to add it to QGIS
once it is finished. That is the reason why, although the runalg() method does not load the layers it produces,
the final TWI layer will be loaded, since it is saved to the file entered by the user, which is the value of the
corresponding output.

N’utilisez donc pas la méthode load() dans vos scripts, mais uniquement à partir de la console. Si un algorithme
définit une couche en sortie, celle-ci doit être déclarée ainsi. Dans le cas contraire, vous ne pourriez pas l’utiliser
dans le modeleur parce que sa syntaxe (comme définie par ses étiquettes, exposées précédemment) ne correspond
pas à ce que l’algorithme crée effectivement.

Les sorties masquées (nombres ou chaînes) n’ont pas de valeur. C’est à vous de leur assigner une valeur. Pour
cela, affecter une valeur à la variable pour la déclarer en sortie. Par exemple, vous pourriez utiliser la déclaration
suivante,

##average=output number

l’instruction suivante fixe la valeur de sortie à 5:

average = 5

17.9 Communiquer avec l’utilisateur

Si votre algorithme requiert un temps assez long de calcul, il est conseillé d’informer l’utilisateur de l’avancée
du traitement de l’algorithme. Vous disposez de la variable globale progress, avec deux méthodes,
setText(text) et setPercentage(percent) pour modifier le message et la barre de progression.

Si vous devez fournir de l’information à l’utilisateur sans rapport avec la progression de l’algorithme, vous pouvez
utiliser la méthode setInfo(text) de l’objet progress.

Si votre script rencontre des problèmes, le moyen correct de propager l’erreur est de lever une exception de type
GeoAlgorithmExecutionException(). Vous pouvez y passer un message comme argument dans le con-
structeur de l’exception. Les Traitements tiennent compte de cette exception et communiquent avec l’utilisateur
en fonction de l’endroit où l’algorithme a été exécuté (boîte à outils, modeleur, console Python, etc.).

17.10 Documenter ses scripts

As in the case of models, you can create additional documentation for your script, to explain what they do and
how to use them. In the script editing dialog you will find a [Edit script help] button. Click on it and it will take
you to the help editing dialog. Check the chapter about the graphical modeler to know more about this dialog and
how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Notice that
you can edit your script’s help before saving it for the first time. If you later close the script editing dialog without
saving the script (i.e. you discard it), the help content you wrote will be lost. If your script was already saved and
is associated to a filename, saving is done automatically.

17.11 Exemples de scripts:

Plusieurs exemples sont disponibles sur la collection de scripts en ligne dont vous pouvez avoir accès en sélection-
nant l’outil Récupérer un script de la collection de scripts en ligne dans l’entrée Scripts/outils de la boîte à outils.
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Veuillez vous y reporter pour visualiser des exemples réels de création d’algorithmes avec les classes de l’API des
Traitements. Cliquez avec le bouton droit sur un script et choisissez Éditer le script pour voir et éditer le code
correspondant.

17.12 Bonnes pratiques d’écriture de scripts d’algorithmes

Voici un rapide résumé des idées à retenir lorsque vous créez vos scripts d’algorithmes et que vous souhaitez les
partager avec d’autres utilisateurs QGIS. En suivant ces quelques règles, vous vous assurerez de fournir des élé-
ments constants sur toutes les interfaces du menu Traitements telles que la boîte à outils, le modeleur et l’interface
de commande.

• Ne chargez pas les couches de résultat. Laissez les Traitements gérer ces résultats et charger vos couches si
besoin.

• Déclarez toujours les sorties des algorithmes que vous avez créés. Évitez de déclarer une sortie et d’utiliser
le nom de fichier de destination de cette sortie comme un emplacement de collection de fichiers. Cela brise
la syntaxe correcte des algorithmes et empêche un fonctionnement correct dans le modeleur. Si vous devez
écrire un tel algorithme, assurez-vous d’utiliser l’étiquette ##nomodeler.

• N’affichez pas de boîte à messages ou n’utilisez pas d’éléments graphiques depuis le script. Si
vous voulez communiquer avec l’utilisateur, utilisez la méthode setInfo() ou lancez une exception
GeoAlgorithmExecutionException.

• La règle d’or consiste à ne pas oublier que votre algorithme peut être exécuté dans un contexte différent de
la boîte à outils des Traitements.

17.13 Scripts de pré et post-exécution

Des scripts peuvent également être utilisés en amont et en aval de l’exécution d’un algorithme. Ce mécanisme
peut être utilisé pour automatiser des tâches qui doivent être lancées à chaque fois qu’un algorithme est exécuté.

La syntaxe est identique à celle qui est expliquée plus haut mais une variable globale nommée alg est disponible.
Elle représente l’objet algorithme qui vient (ou qui va) être lancé.

Dans le groupe Général de la boîte de dialogue de configuration des traitements, vous trouverez deux entrées
nommées Script de pré-exécution et Script de post-exécution où les noms des scripts à lancer dans chacun des cas
peuvent être saisis.

.

17.14 Configuration des applications tierces

The processing framework can be extended using additional applications. Currently, SAGA, GRASS, OTB (Orfeo
Toolbox) and R are supported, along with some other command-line applications that provide spatial data analysis
functionalities. Algorithms relying on an external application are managed by their own algorithm provider.

Cette section vous montrera comment configurer le module de Traitements pour inclure ces applications addition-
nelles et vous expliquera quelques fonctionnalités propres à leurs algorithmes. Une fois le système configuré, vous
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pourrez exécuter les algorithmes externes depuis tous les composants du module tels que la boîte à outils ou le
modeleur graphique, comme vous pourriez le faire avec n’importe quel géoalgorithme.

By default, all algorithms that rely on an external appplication not shipped with QGIS are not enabled. You can
enable them in the configuration dialog. Make sure that the corresponding application is already installed in your
system. Enabling an algorithm provider without installing the application it needs will cause the algorithms to
appear in the toolbox, but an error will be thrown when you try to execute them.

This is because the algorithm descriptions (needed to create the parameters dialog and provide the information
needed about the algorithm) are not included with each application, but with QGIS instead. That is, they are part
of QGIS, so you have them in your installation even if you have not installed any other software. Running the
algorithm, however, needs the application binaries to be installed in your system.

17.14.1 Note pour les utilisateurs de Windows

If you are not an advanced user and you are running QGIS on Windows, you might not be interested in reading
the rest of this chapter. Make sure you install QGIS in your system using the standalone installer. That will
automatically install SAGA, GRASS and OTB in your system and configure them so they can be run from QGIS.
All the algorithms in the simplified view of the toolbox will be ready to be run without needing any further
configuration. If installing through OSGeo4W application, make sure you select for insttallation SAGA and OTB
as well.

Si vous voulez en savoir plus sur le fonctionnement de ces fournisseurs ou si vous souhaitez utiliser des algorithmes
non incluses dans la barre d’outils simplifiée (telles que des scripts R), continuez donc à lire.

17.14.2 A propos des formats de fichiers

When using an external software, opening a file in QGIS does not mean that it can be opened and processed as
well in that other software. In most cases, other software can read what you have opened in QGIS, but in some
cases, that might not be true. When using databases or uncommon file formats, whether for raster or vector layers,
problems might arise. If that happens, try to use well-known file formats that you are sure are understood by both
programs, and check the console output (in the history and log dialog) to know more about what is going wrong.

Si vous utilisez des couches raster GRASS, par exemple, vous allez peut-être rencontrer des problèmes et ne pas
pouvoir mener à bien votre travail si vous appelez des algorithmes externes ayant cette couche comme entrée.
C’est pour cette raison que ces couches ne seront pas disponibles pour les algorithmes.

You should, however, find no problems at all with vector layers, since QGIS automatically converts from the
original file format to one accepted by the external application before passing the layer to it. This adds extra
processing time, which might be significant if the layer has a large size, so do not be surprised if it takes more
time to process a layer from a DB connection than it does to process one of a similar size stored in a shapefile.

Providers not using external applications can process any layer that you can open in QGIS, since they open it for
analysis through QGIS.

Regarding output formats, all formats supported by QGIS as output can be used, both for raster and vector layers.
Some providers do not support certain formats, but all can export to common raster layer formats that can later
be transformed by QGIS automatically. As in the case of input layers, if this conversion is needed, that might
increase the processing time.

If the extension of the filename specified when calling an algorithm does not match the extension of any of the
formats supported by QGIS, then a suffix will be added to set a default format. In the case of raster layers, the
.tif extension is used, while .shp is used for vector layers.

17.14.3 A propos des sélections sur les couches vectorielles

External applications may also be made aware of the selections that exist in vector layers within QGIS. However,
that requires rewriting all input vector layers, just as if they were originally in a format not supported by the
external application. Only when no selection exists, or the Use only selected features option is not enabled in the
processing general configuration, can a layer be directly passed to an external application.
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Dans les cas où l’export de la sélection est nécessaire cela rallonge les temps d’exécution.

SAGA

SAGA algorithms can be run from QGIS if you have SAGA installed in your system and you configure the pro-
cessing framework properly so it can find SAGA executables. In particular, the SAGA command-line executable
is needed to run SAGA algorithms.

If you are running Windows, both the stand-alone installer and the OSGeo4W installer include SAGA along with
QGIS, and the path is automatically configured, so there is no need to do anything else.

If you have installed SAGA yourself (remember, you need version 2.1), the path to the SAGA executable must be
configured. To do this, open the configuration dialog. In the SAGA block, you will find a setting named SAGA
Folder. Enter the path to the folder where SAGA is installed. Close the configuration dialog, and now you are
ready to run SAGA algorithms from QGIS.

If you are running Linux, SAGA binaries are not included with SEXTANTE, so you have to download and install
the software yourself. Please check the SAGA website for more information. SAGA 2.1 is needed.

In this case, there is no need to configure the path to the SAGA executable, and you will not see those folders.
Instead, you must make sure that SAGA is properly installed and its folder is added to the PATH environment
variable. Just open a console and type saga_cmd to check that the system can find where the SAGA binaries are
located.

17.14.4 A propos des limitations du système de grille de SAGA

Most SAGA algorithms that require several input raster layers require them to have the same grid system. That is,
they must cover the same geographic area and have the same cell size, so their corresponding grids match. When
calling SAGA algorithms from QGIS, you can use any layer, regardless of its cell size and extent. When multiple
raster layers are used as input for a SAGA algorithm, QGIS resamples them to a common grid system and then
passes them to SAGA (unless the SAGA algorithm can operate with layers from different grid systems).

La définition de cette grille commune est contrôlée par l’utilisateur et peut se faire selon plusieurs paramètres,
présents dans le groupe SAGA de la fenêtre de configuration. Deux façons de procéder existent:

• La configuration manuelle. Vous définissez l’emprise à l’aide des paramètres suivants:

– Rééchantillonner la valeur minimum de X

– Rééchantillonner la valeur maximum de X

– Rééchantillonner la valeur minimum de Y

– Rééchantillonner la valeur maximum de Y

– Rééchantillonner la taille de la cellule

Notice that QGIS will resample input layers to that extent, even if they do not overlap with it.

• La configuration automatique à partir des couches en entrée. Pour choisir cette option, activez l’option
Utiliser la grille minimale pour le rééchantillonnage. Toutes les autres options seront ignorées et l’emprise
minimum couvrant toutes les couches sera utilisée. La taille de la cellule de la couche cible sera la plus
grande des tailles de cellules des couches en entrée.

Pour les algorithmes qui n’utilisent pas plusieurs couches raster, ou pour ceux qui n’ont pas besoin d’une grille
unique, le rééchantillonnage n’est pas nécessaire et ces paramètres ne seront pas utilisés.

17.14.5 Limitations pour les couches multi-bandes

Unlike QGIS, SAGA has no support for multi-band layers. If you want to use a multiband layer (such as an RGB or
multispectral image), you first have to split it into single-banded images. To do so, you can use the ‘SAGA/Grid
- Tools/Split RGB image’ algorithm (which creates three images from an RGB image) or the ‘SAGA/Grid -
Tools/Extract band’ algorithm (to extract a single band).
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17.14.6 Limitations dans la résolution

SAGA suppose que la couche raster possède la même résolution en X et en Y. Si vous travaillez sur une couche
avec des résolutions différentes entre les deux axes, les résultats peuvent être incohérents. Dans ce cas, un message
d’avertissement est ajouté au journal, indiquant que la couche n’est pas adaptée au traitement par SAGA.

17.14.7 Suivi du journal

When QGIS calls SAGA, it does so using its command-line interface, thus passing a set of commands to perform
all the required operations. SAGA shows its progress by writing information to the console, which includes the
percentage of processing already done, along with additional content. This output is filtered and used to update
the progress bar while the algorithm is running.

Both the commands sent by QGIS and the additional information printed by SAGA can be logged along with other
processing log messages, and you might find them useful to track in detail what is going on when QGIS runs a
SAGA algorithm. You will find two settings, namely Log console output and Log execution commands, to activate
that logging mechanism.

La plupart des autres fournisseurs tiers qui sont appelés par la ligne de commandes ont des options similaires, que
vous trouverez dans la rubrique configuration du module.

R. Creating R scripts

R integration in QGIS is different from that of SAGA in that there is not a predefined set of algorithms you can run
(except for a few examples). Instead, you should write your scripts and call R commands, much like you would do
from R, and in a very similar manner to what we saw in the section dedicated to processing scripts. This section
shows you the syntax to use to call those R commands from QGIS and how to use QGIS objects (layers, tables)
in them.

The first thing you have to do, as we saw in the case of SAGA, is to tell QGIS where your R binaries are located.
You can do this using the R folder entry in the processing configuration dialog. Once you have set that parameter,
you can start creating and executing your own R scripts.

Une fois encore, pour Linux, cela est légèrement différent : vous n’avez qu’à vérifier que le répertoire R est inclus
dans la variable d’environnement PATH. Si vous pouvez lancer R en tapant R dans un terminal, alors vous êtes
prêt pour la suite.

To add a new algorithm that calls an R function (or a more complex R script that you have developed and you
would like to have available from QGIS), you have to create a script file that tells the processing framework how
to perform that operation and the corresponding R commands to do so.

Les fichiers de scripts R ont l’extension .rsx et leur création est relativement simple si vous connaissez la syntaxe
et le langage de script de R. Ils seront sauvegardés dans le répertoire de scripts de R. Vous pouvez configurer ce
répertoire dans le groupe de configuration de R (dans la fenêtre Options du module de traitements), comme vous
le feriez pour un script ordinaire.

Let’s have a look at a very simple script file, which calls the R method spsample to create a random grid within
the boundary of the polygons in a given polygon layer. This method belongs to the maptools package. Since
almost all the algorithms that you might like to incorporate into QGIS will use or generate spatial data, knowledge
of spatial packages like maptools and, especially, sp, is mandatory.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

The first lines, which start with a double Python comment sign (##), tell QGIS the inputs of the algorithm de-
scribed in the file and the outputs that it will generate. They work with exactly the same syntax as the SEXTANTE
scripts that we have already seen, so they will not be described here again.
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When you declare an input parameter, QGIS uses that information for two things: creating the user interface to
ask the user for the value of that parameter and creating a corresponding R variable that can later be used as input
for R commands.

In the above example, we are declaring an input of type vector named polyg. When executing the algorithm,
QGIS will open in R the layer selected by the user and store it in a variable also named polyg. So, the name of a
parameter is also the name of the variable that we can use in R for accesing the value of that parameter (thus, you
should avoid using reserved R words as parameter names).

Spatial elements such as vector and raster layers are read using the readOGR() and brick() commands (you
do not have to worry about adding those commands to your description file – QGIS will do it), and they are stored
as Spatial*DataFrame objects. Table fields are stored as strings containing the name of the selected field.

Les tables sont ouvertes par la commande read.csv(). Si la table à charger n’est pas au format CSV, il faudra
la convertir avant de l’importer dans R.

De plus, les couches raster peuvent être lues avec la commande readGDAL() au lieu de brick(), en utilisant
##usereadgdal.

If you are an advanced user and do not want QGIS to create the object representing the layer, you can use the
##passfilename tag to indicate that you prefer a string with the filename instead. In this case, it is up to you
to open the file before performing any operation on the data it contains.

Avec l’information ci-dessus, nous pouvons maintenant comprendre la première ligne de notre premier exemple
de script (la première ligne qui n’est pas un commentaire Python).

pts=spsample(polyg,numpoints,type="random")

La variable polygon contient déjà un objet SpatialPolygonsDataFrame, l’appel de la méthode
spsample est donc simple. Il en est de même pour la méthode numpoints qui renvoit le nombre de points à
ajouter pour créer la grille.

Comme nous avons déclaré une sortie de type vecteur nommée out, nous devons créer cette variable out et lui
affecter un objet Spatial*DataFrame (dans notre cas, un SpatialPointsDataFrame). Vous pouvez
utiliser n’importe quel nom pour les variables intermédiaires. Assurez-vous simplement que la variable qui stocke
la valeur finale ait le même nom que la variable de sortie définie au début ainsi qu’une valeur compatible.

In this case, the result obtained from the spsample method has to be converted explicitly into a
SpatialPointsDataFrame object, since it is itself an object of class ppp, which is not a suitable class
to be returned to QGIS.

Si votre algorithme génère des couches raster, la façon dont elles sont sauvegardées varie si vous avez utilisé
l’option #dontuserasterpackage ou pas. If oui, les couches seront sauvegardées en utilisant la méthode
writeGDAL(). Si non, la méthode writeRaster() du paquet raster sera utilisée.

Si vous avez utilisé l’option #passfilename, les sorties sont générées à l’aide du package raster (avec
writeRaster()), bien qu’il ne soit pas utilisé en entrée.

Si votre algorithme ne renvoie pas de couche mais plutôt un résultat texte dans la console, vous devez préciser
que la console doit s’afficher à la fin de son exécution. Pour cela, commencez les lignes qui doivent renvoyer
les résultats par le signe >. Les sorties des autres lignes seront masquées. Par exemple, voici la description d’un
algorithme qui réalise un test de normalisation sur un champ donné (ou une colonne) de la table d’attributs d’une
couche vectorielle :

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

The output of the last line is printed, but the output of the first is not (and neither are the outputs from other
command lines added automatically by QGIS).

Si votre algorithme crée des graphiques (par la méthode plot()), ajoutez la ligne suivante:
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##showplots

This will cause QGIS to redirect all R graphical outputs to a temporary file, which will be opened once R execution
has finished.

Les graphiques et les résultats dans la console seront affichés dans le gestionnaire de résultats.

For more information, please check the script files provided with SEXTANTE. Most of them are rather simple and
will greatly help you understand how to create your own scripts.

Note: rgdal and maptools libraries are loaded by default, so you do not have to add the corresponding
library() commands (you just have to make sure that those two packages are installed in your R distribution).
However, other additional libraries that you might need have to be explicitly loaded. Just add the necessary com-
mands at the beginning of your script. You also have to make sure that the corresponding packages are installed in
the R distribution used by QGIS. The processing framework will not take care of any package installation. If you
run a script that requires a package that is not installed, the execution will fail, and Processing will try to detect
which packages are missing. You must install those missing libraries manually before you can run the algorithm.

GRASS

Configuring GRASS is not much different from configuring SAGA. First, the path to the GRASS folder has to be
defined, but only if you are running Windows. Additionaly, a shell interpreter (usually msys.exe, which can be
found in most GRASS for Windows distributions) has to be defined and its path set up as well.

By default, the processing framework tries to configure its GRASS connector to use the GRASS distribution that
ships along with QGIS. This should work without problems in most systems, but if you experience problems, you
might have to configure the GRASS connector manually. Also, if you want to use a different GRASS installation,
you can change that setting and point to the folder where the other version is installed. GRASS 6.4 is needed for
algorithms to work correctly.

Sous Linux, assurez-vous simplement que GRASS est correctement installé et qu’il peut être lancé depuis un
terminal.

GRASS algorithms use a region for calculations. This region can be defined manually using values similar to
the ones found in the SAGA configuration, or automatically, taking the minimum extent that covers all the input
layers used to execute the algorithm each time. If the latter approach is the behaviour you prefer, just check the
Use min covering region option in the GRASS configuration parameters.

The last parameter that has to be configured is related to the mapset. A mapset is needed to run GRASS, and the
processing framework creates a temporary one for each execution. You have to specify if the data you are working
with uses geographical (lat/lon) coordinates or projected ones.

GDAL

No additional configuration is needed to run GDAL algorithms. Since they are already incorporated into QGIS,
the algorithms can infer their configuration from it.

La boîte à outils Orfeo (OTB)

Orfeo Toolbox (OTB) algorithms can be run from QGIS if you have OTB installed in your system and you have
configured QGIS properly, so it can find all necessary files (command-line tools and libraries).

As in the case of SAGA, OTB binaries are included in the stand-alone installer for Windows, but they are not
included if you are runing Linux, so you have to download and install the software yourself. Please check the
OTB website for more information.

Once OTB is installed, start QGIS, open the processing configuration dialog and configure the OTB algorithm
provider. In the Orfeo Toolbox (image analysis) block, you will find all settings related to OTB. First, ensure that
algorithms are enabled.
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Ensuite, configurez l’emplacement des exécutables et des librairies OTB :

• habituellement, le répertoire Applications OTB pointe vers /usr/lib/otb/applications et celui
des Outils OTB en ligne de commande est /usr/bin.

• If you use the OSGeo4W installer, then install otb-bin package and enter
C:\OSGeo4W\apps\orfeotoolbox\applications as OTB applications folder and
C:\OSGeo4W\bin as OTB command line tools folder. These values should be configured by de-
fault, but if you have a different OTB installation, configure them to the corresponding values in your
system.

TauDEM

To use this provider, you need to install TauDEM command line tools.

17.14.8 Windows

Please visit the TauDEM homepage for installation instructions and precompiled binaries for 32-bit and 64-bit
systems. IMPORTANT: You need TauDEM 5.0.6 executables. Version 5.2 is currently not supported.

17.14.9 Linux

There are no packages for most Linux distributions, so you should compile TauDEM by yourself. As TauDEM
uses MPICH2, first install it using your favorite package manager. Alternatively, TauDEM works fine with Open
MPI, so you can use it instead of MPICH2.

Download TauDEM 5.0.6 source code and extract the files in some folder.

Ouvrez le fichier lienarpart.h et, après la ligne

#include "mpi.h"

ajoutez la ligne suivante

#include <stdint.h>

afin d’obtenir ceci

#include "mpi.h"
#include <stdint.h>

Sauvegardez les modifications et fermez le fichier. À présent, ouvrez le fichier tiffIO.h, trouvez la ligne
#include "stdint.h" dans laquelle vous remplacerez les quotes ("") par des <>, pour obtenir ceci

#include <stdint.h>

Save the changes and close the file. Create a build directory and cd into it

mkdir build
cd build

Configure your build with the command

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..

and then compile

make

Finally, to install TauDEM into /usr/local/bin, run
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sudo make install

.

17.15 La ligne de commande QGIS

Les outils de traitement intègrent un outil très pratique qui vous permet de lancer des algorithmes sans avoir à
ouvrir la boite à outils. Il suffit juste de saisir le nom de l’algorithme que vous voulez exécuter.

Il s’agit de l’outil Ligne de commande qui se matérialise par une simple zone de texte à complètement automatique
où saisir le nom de la commande à lancer.

Figure 17.29: The QGIS Commander

The Commander is started from the Analysis menu or, more practically, by pressing Shift + Ctrl + M (you
can change that default keyboard shortcut in the QGIS configuration if you prefer a different one). Apart from
executing Processing algorithms, the Commander gives you access to most of the functionality in QGIS, which
means that it gives you a practical and efficient way of running QGIS tasks and allows you to control QGIS with
reduced usage of buttons and menus.

Moreover, the Commander is configurable, so you can add your custom commands and have them just a few
keystrokes away, making it a powerful tool to help you become more productive in your daily work with QGIS.

17.15.1 Commandes disponibles

Les commandes disponibles sont classées en différentes catégories :

• Algorithmes. Ils apparaissent sous la forme Processing algorithm: <nom de
l’algorithme>.

• Menu items. These are shown as Menu item: <menu entry text>. All menus items available
from the QGIS interface are available, even if they are included in a submenu.

• Fonctions Python. Vous pouvez créer de courtes fonctions Python qui feront ensuite partie de la liste des
commandes disponibles. Elles se présentent sous la forme Function: <nom de la fonction>.

Pour lancer une des commandes ci-dessus, commencez à taper puis sélectionnez la commande depuis la liste qui
apparaît alors, filtrée dynamiquement par le texte que vous tapez.

In the case of calling a Python function, you can select the entry in the list, which is pre-
fixed by Function: (for instance, Function: removeall), or just directly type the
function name (‘‘removeall in the previous example). There is no need to add brackets after the func-
tion name.
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17.15.2 Créer des fonctions personnalisées

Custom functions are added by entering the corresponding Python code in the commands.py file that is found
in the .qgis/sextante/commander directory in your user folder. It is just a simple Python file where
you can add the functions that you need.

The file is created with a few example functions the first time you open the Commander. If you haven’t launched
the Commander yet, you can create the file yourself. To edit the commands file, use your favorite text editor. You
can also use a built-in editor by calling the edit command from the Commander. It will open the editor with the
commands file, and you can edit it directly and then save your changes.

Par exemple, vous pouvez ajouter la fonction suivante, qui supprime toutes les couches :

from qgis.gui import *

def removeall():
mapreg = QgsMapLayerRegistry.instance()
mapreg.removeAllMapLayers()

Une fois la fonction ajoutée, elle sera disponible depuis la Ligne de commandes et vous pourrez l’appeler en tapant
removeall. Il n’y a rien d’autre à faire à part écrire la fonction elle-même.

Les fonctions peuvent recevoir des paramètres. Ajoutez‘‘*args‘‘ à la définition de votre fonction pour accepter
des paramètres. Lors de l’appel à cette fonction depuis la Ligne de commande, les paramètres doivent être passés
en les séparant pas des espaces.

Voici un exemple de fonction qui charge une couche et prend comme paramètre le nom de la couche à charger.

import processing

def load(*args):
processing.load(args[0])

If you want to load the layer in /home/myuser/points.shp, type load /home/myuser/points.shp
in the Commander text box.

.
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Composeur d’Impression

With the Print Composer you can create nice maps and atlasses that can be printed or saved as PDF-file, an
image or an SVG-file. This is a powerfull way to share geographical information produced with QGIS that can be
included in reports or published.

The Print Composer provides growing layout and printing capabilities. It allows you to add elements such as
the QGIS map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML
frames. You can size, group, align, position and rotate each element and adjust the properties to create your layout.
The layout can be printed or exported to image formats, PostScript, PDF or to SVG (export to SVG is not working
properly with some recent Qt4 versions; you should try and check individually on your system). You can save the
layout as a template and load it again in another session. Finally, generating several maps based on a template can
be done through the atlas generator. See a list of tools in table_composer_1:
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Bou-
ton

Fonction Bou-
ton

Fonction

Enregistrer le projet Nouveau composeur

Dupliquer une composition Gestionnaire de Compositions

Charger depuis un modèle Enregistrer le modèle

Print or export as PostScript Exporter dans un format d’image

Exporter au format SVG Exporter au format PDF

Annuler la dernière modification Restaurer la dernière modification

Zoom sur l’emprise totale Zoom to 100%

Zoom + Zoom -

Refresh View

Pan Zoom to specific region

Sélectionner/déplacer les objets dans le
composeur de cartes

Déplacer le contenu

Ajouter une nouvelle carte à partir de la fenêtre
principale de QGIS

Ajouter une image au composeur de
cartes

Ajouter une étiquette au composeur de cartes Ajouter une nouvelle légende au
composeur de cartes

Add scale bar to print composition Ajouter une forme basique au
composeur de cartes

Ajouter une flèche au composeur de cartes Ajouter une table d’attributs dans le
composeur de cartes

Add an HTML frame

Grouper des objets du composeur d’impression Dégrouper des objets du composeur
d’impression

Lock Selected Items Unlock All items

Remonter l’objet sélectionné Descendre l’objet sélectionné

Amener les objets sélectionnés au premier plan Descendre les objets sélectionnés en
arrière plan

Aligner les objets sélectionnés à gauche Aligner les objets sélectionnés à droite

Aligner les objets sélectionnés au centre Aligner les objets sélectionnés au centre
verticalement

Aligner les objets sélectionnés en haut Aligner les objets sélectionnés en bas

Preview Atlas First Feature

Previous Feature Next Feature

Last feature Print Atlas

Export Atlas as Image Atlas Settings

Table Composeur d’Impression 1 : Outils du Composeur d’Impression

Tous les outils du composeur d’impression sont disponibles dans les menus et la barre d’outils. Cette barre peut
être affichée ou masquée en effectuant un clic droit dessus.
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18.1 Premiers pas

18.1.1 Créer un nouveau modèle de composeur d’impression

Before you start to work with the Print Composer, you need to load some raster and vector layers in the QGIS
map canvas and adapt their properties to suit your own convenience. After everything is rendered and symbolized

to your liking, click the New Print Composer icon in the toolbar or choose File → New Print Composer. You will
be prompted to choose a title for the new Composer.

18.1.2 Overview of the Print Composer

Opening the Print Composer provides you with a blank canvas that represents the paper surface when using the
print option. Initially you find buttons on the left beside the canvas to add map composer items; the current QGIS
map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML frames. In
this toolbar you also find toolbar buttons to navigate, zoom in on an area and pan the view on the composer and
toolbar buttons to select a map composer item and to move the contents of the map item.

Figure_composer_overview shows the initial view of the Print Composer before any elements are added.

Figure 18.1: Composeur d’Impression

On the right beside the canvas you find two panels. The upper panel holds the tabs Items and Command History
and the lower panel holds the tabs Composition, Item properties and Atlas generation.
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• The Items tab provides a list of all map composer items added to the canvas.

• The Command history tab displays a history of all changes applied to the Print Composer layout. With a
mouse click, it is possible to undo and redo layout steps back and forth to a certain status.

• The Composition tab allows you to set paper size, orientation, the page background, number of pages and

print quality for the output file in dpi. Furthermore, you can also activate the Print as raster checkbox.
This means all items will be converted to raster before printing or saving as PostScript or PDF. In this tab,
you can also customize settings for grid and smart guides.

• The Item Properties tab displays the properties for the selected item. Click the Select/Move item icon to
select an item (e.g., legend, scale bar or label) on the canvas. Then click the Item Properties tab and
customize the settings for the selected item.

• The Atlas generation tab allows you to enable the generation of an atlas for the current Composer and gives
access to its parameters.

• Finally, you can save your print composition with the Save Project button.

In the bottom part of the Print Composer window, you can find a status bar with mouse position, current page
number and a combo box to set the zoom level.

You can add multiple elements to the Composer. It is also possible to have more than one map view or legend or
scale bar in the Print Composer canvas, on one or several pages. Each element has its own properties and, in the
case of the map, its own extent. If you want to remove any elements from the Composer canvas you can do that
with the Delete or the Backspace key.

Outils de navigation

To navigate in the canvas layout, the Print Composer provides some general tools:

• Zoom +

• Zoom -

• Zoom full

• Zoom to 100%

• Refresh view (if you find the view in an inconsistent state)

• Pan composer

• Zoom (zoom to a specific region of the Composer)

You can change the zoom level also using the mouse wheel or the combo box in the status bar. If you need to
switch to pan mode while working in the Composer area, you can hold the Spacebar or the the mouse wheel.
With Ctrl+Spacebar, you can temporarily switch to zoom mode, and with Ctrl+Shift+Spacebar, to
zoom out mode.

18.1.3 Sample Session

To demonstrate how to create a map please follow the next instructions.

1. On the left site, select the Add new map toolbar button and draw a rectangle on the canvas holding down
the left mouse button. Inside the drawn rectangle the QGIS map view to the canvas.

2. Select the Add new scalebar toolbar button and place the map item with the left mouse button on the Print
Composer canvas. A scalebar will be added to the canvas.
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3. Select the Add new legend toolbar button and draw a rectangle on the canvas holding down the left mouse
button. Inside the drawn rectangle the legend will be drawn.

4. Select the Select/Move item icon to select the map on the canvas and move it a bit.

5. While the map item is still selected you can also change the size of the map item. Click while holding down
the left mouse button, in a white little rectangle in one of the corners of the map item and drag it to a new
location to change it’s size.

6. Click the Item Properties tab on the left lower panel and find the setting for the orientation. Change the
value of the setting Map orientation to ‘15.00° ‘. You should see the orientation of the map item change.

7. Finally, you can save your print composition with the Save Project button.

18.1.4 Print Composer Options

From Settings → Composer Options you can set some options that will be used as default during your work.

• Compositions defaults let you specify the default font to use.

• With Grid appearance, you can set the grid style and its color. There are three types of grid: Dots, Solid
lines and Crosses.

• Grid and guide defaults defines spacing, offset and tolerance of the grid.

18.1.5 Onglet Composition — Paramètres généraux de mise en page

Dans l’onglet Composition, vous pouvez définir les paramètres généraux de votre mise en page.

• You can choose one of the Presets for your paper sheet, or enter your custom width and height.

• Composition can now be divided into several pages. For instance, a first page can show a map canvas, and
a second page can show the attribute table associated with a layer, while a third one shows an HTML frame
linking to your organization website. Set the Number of pages to the desired value. You can choose the

page Orientation and its Exported resolution. When checked, print as raster means all elements will be
rasterized before printing or saving as PostScript or PDF.

• Grid and guides lets you customize grid settings like spacings, offsets and tolerance to your need. The
tolerance is the maximum distance below which an item is snapped to smart guides.

Snap to grid and/or to smart guides can be enabled from the View menu. In this menu, you can also hide or show
the grid and smart guides.

18.1.6 Composer items common options

Composer items have a set of common properties you will find on the bottom of the Item Properties tab: Position
and size, Rotation, Frame, Background, Item ID and Rendering (See figure_composer_common_1).

• Position et taille permet de définir la taille et la position du cadre contenant l’élément. Vous pouvez égale-
ment choisir le Point de référence dont les coordonnées X et Y sont définies.

• The Rotation sets the rotation of the element (in degrees).

• The Frame shows or hides the frame around the label. Use the Frame color and Thickness menus to
adjust those properties.

• Use the Background color menu for setting a background color. With the dialog you can pick a color (see
Color Picker ).
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Figure 18.2: Fenêtres Propriétés générales

• Use the Item ID to create a relationship to other Print Composer items. This is used with QGIS server and
any potential web client. You can set an ID on an item (e.g., a map and a label), and then the web client can
send data to set a property (e.g., label text) for that specific item. The GetProjectSettings command will list
what items and which IDs are available in a layout.

• Rendering mode can be selected in the option field. See Rendering_Mode.

Note:

• If you checked Use live-updating color chooser dialogs in the QGIS general options, the color button
will update as soon as you choose a new color from Color Dialog windows. If not, you need to close the
Color Dialog.

• The Data defined override icon next to a field means that you can associate the field with data in the map item
or use expressions. These are particularly helpful with atlas generation (See atlas_data_defined_overrides).

18.2 Mode de rendu

QGIS now allows advanced rendering for Composer items just like vector and raster layers.

Figure 18.3: Mode de rendu

• Transparency : You can make the underlying item in the Composer visible with this
tool. Use the slider to adapt the visibility of your item to your needs. You can also make a precise definition
of the percentage of visibility in the menu beside the slider.
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• Exclude item from exports: You can decide to make an item not visible in all exports. After activating
this checkbox, the item will not be included in PDF’s, prints etc..

• Blending mode: You can achieve special rendering effects with these tools that you previously only may
know from graphics programs. The pixels of your overlaying and underlaying items are mixed through the
settings described below.

– Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to blend with
the pixel beneath it; the colors aren’t mixed.

– Lighten: This selects the maximum of each component from the foreground and background pixels.
Be aware that the results tend to be jagged and harsh.

– Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This
mode is most useful for mixing the texture of one layer with another layer (e.g., you can use a hillshade
to texture another layer).

– Dodge: Dodge will brighten and saturate underlying pixels based on the lightness of the top pixel. So,
brighter top pixels cause the saturation and brightness of the underlying pixels to increase. This works
best if the top pixels aren’t too bright; otherwise the effect is too extreme.

– Addition: This blend mode simply adds pixel values of one layer with pixel values of the other. In case
of values above 1 (as in the case of RGB), white is displayed. This mode is suitable for highlighting
features.

– Darken: This creates a resultant pixel that retains the smallest components of the foreground and
background pixels. Like lighten, the results tend to be jagged and harsh.

– Multiply: Here, the numbers for each pixel of the top layer are multiplied with the numbers for the
corresponding pixel of the bottom layer. The results are darker pictures.

– Burn: Darker colors in the top layer cause the underlying layers to darken. Burn can be used to tweak
and colorise underlying layers.

– Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light
parts become lighter and dark parts become darker.

– Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge.
This mode is supposed to emulate shining a soft light onto an image.

– Lumière dure : Ce mode est très similaire au mode revêtement. Il est censé émuler une lumière très
intense projetée dans l’image.

– Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to
always get a positive value. Blending with black produces no change, as the difference with all colors
is zero.

– Subtract: This blend mode simply subtracts pixel values of one layer with pixel values of the other. In
case of negative values, black is displayed.

18.3 Éléments du composeur

18.3.1 The Map item

Click on the Add new map toolbar button in the Print Composer toolbar to add the QGIS map canvas. Now, drag
a rectangle onto the Composer canvas with the left mouse button to add the map. To display the current map, you
can choose between three different modes in the map Item Properties tab:

• Rectangle est l’option par défaut. Elle n’affiche qu’un cadre vide avec un message ‘La carte sera imprimée
ici’.

• Cache renders the map in the current screen resolution. If you zoom the Composer window in or out, the
map is not rendered again but the image will be scaled.
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• Render means that if you zoom the Composer window in or out, the map will be rendered again, but for
space reasons, only up to a maximum resolution.

Cache is the default preview mode for newly added Print Composer maps.

You can resize the map element by clicking on the Select/Move item button, selecting the element, and dragging
one of the blue handles in the corner of the map. With the map selected, you can now adapt more properties in the
map Item Properties tab.

To move layers within the map element, select the map element, click the Move item content icon and move the
layers within the map item frame with the left mouse button. After you have found the right place for an item,

you can lock the item position within the Print Composer canvas. Select the map item and use the toolbar
Lock Selected Items or the Items tab to Lock the item. A locked item can only be selected using the Items tab. Once

selected you can use the Items tab to unlock individual items. The Unlock All Items icon will unlock all locked
composer items.

Propriétés principales

The Main properties dialog of the map Item Properties tab provides the following functionalities (see fig-
ure_composer_map_1):

Figure 18.4: Onglet Propriétés d’une carte

• The Preview area allows you to define the preview modes ‘Rectangle’, ‘Cache’ and ‘Render’, as described
above. If you change the view on the QGIS map canvas by changing vector or raster properties, you can
update the Print Composer view by selecting the map element in the Print Composer and clicking the
[Update preview] button.

• Le champ Échelle permet de préciser manuellement une valeur d’échelle.
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• The field Map rotation allows you to rotate the map element content clockwise in degrees. The
rotation of the map view can be imitated here. Note that a correct coordinate frame can only be added with
the default value 0 and that once you defined a Map rotation it currently cannot be changed.

• Draw map canvas items lets you show annotations that may be placed on the map canvas in the main
QGIS window.

• You can choose to lock the layers shown on a map item. Check Lock layers for map item. After this
is checked, any layer that would be displayed or hidden in the main QGIS window will not appear or be
hidden in the map item of the Composer. But style and labels of a locked layer are still refreshed according
to the main QGIS interface. You can prevent this by using Lock layer styles for map item.

• The button allows you to add quickly all the presets views you have prepared in QGIS. Clicking on

the button you will see the list of all the preset views: just select the preset you want to display. The

map canvas will automatically lock the preset layers by enabling the Lock layers for map item: if you

want to unselect the preset, just uncheck the and press on the button. See Map Legend to find out
how to create presets views.

Emprise

The Extents dialog of the map item tab provides the following functionalities (see figure_composer_map_2):

Figure 18.5: Définition de l’emprise de la carte

• The Map extents area allows you to specify the map extent using X and Y min/max values and by clicking
the [Set to map canvas extent] button. This button sets the map extent of the composer map item to the
extent of the current map view in the main QGIS application. The button [View extent in map canvas]
does exactly the opposite, it updates the extent of the map view in the QGIS application to the extent of the
composer map item.

If you change the view on the QGIS map canvas by changing vector or raster properties, you can update the Print
Composer view by selecting the map element in the Print Composer and clicking the [Update preview] button in
the map Item Properties tab (see figure_composer_map_1).

Grids

The Grids dialog of the map Item Properties tab provides the possibility to add several grids to a map item.

• With the plus and minus button you can add or remove a selected grid.

• With the up and down button you can move a grid in the list and set the drawing priority.

When you double click on the added grid you can give it another name.

After you have added a grid, you can activate the checkbox Show grid to overlay a grid onto the map element.
Expand this option to provide a lot of configuration options, see Figure_composer_map_4.
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Figure 18.6: Map Grids Dialog

Figure 18.7: Draw Grid Dialog
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As grid type, you can specify to use a ‘Solid’, ‘Cross’, ‘Markers’ or ‘Frame and annotations only’. ‘Frame and
annotations only’ is especially useful when working with rotated maps or reprojected grids. In the devisions
section of the Grid Frame Dialog mentioned below you then have a corresponding setting. Symbology of the grid
can be chosen. See section Rendering_Mode. Furthermore, you can define an interval in the X and Y directions,
an X and Y offset, and the width used for the cross or line grid type.

Figure 18.8: Grid Frame Dialog

• There are different options to style the frame that holds the map. Following options are available: No Frame,
Zebra, Interior ticks, Exterior ticks, Interior and Exterior ticks and Lineborder.

• With ‘LatitudeY/ only’ and ‘Longitude/X only’ setting in the devisions section you have the possibility to
prevent a mix of latitude/y and longitude/x coordinates showing on a side when working with rotated maps
or reprojected grids.

• Advanced rendering mode is also available for grids (see section Rendering_mode).

• The Draw coordinates checkbox allows you to add coordinates to the map frame. You can choose
the annotation numeric format, the options range from decimal to degrees, minute and seconds, with or
without suffix, and aligned or not. You can choose which annotation to show. The options are: show all,
latitude only, longitude only, or disable(none). This is useful when the map is rotated. The annotation can
be drawn inside or outside the map frame. The annotation direction can be defined as horizontal, vertical
ascending or vertical descending. In case of map rotation you can Finally, you can define the annotation
font, the annotation font color, the annotation distance from the map frame and the precision of the drawn
coordinates.

Overviews

The Overviews dialog of the map Item Properties tab provides the following functionalities:

You can choose to create an overview map, which shows the extents of the other map(s) that are available in the
composer. First you need to create the map(s) you want to include in the overview map. Next you create the map
you want to use as the overview map, just like a normal map.

• With the plus and minus button you can add or remove an overview.

• With the up and down button you can move an overview in the list and set the drawing priority.

Open Overviews and press the green plus icon-button to add an overview. Initially this overview is named
‘Overview 1’ (see Figure_composer_map_7). You can change the name when you double-click on the overview
item in the list named ‘Overview 1’ and change it to another name.

When you select the overview item in the list you can customize it.
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Figure 18.9: Grid Draw Coordinates dialog

Figure 18.10: Map Overviews Dialog
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• The Draw “<name_overview>” overview needs to be activated to draw the extent of selected map
frame.

• The Map frame combo list can be used to select the map item whose extents will be drawn on the present
map item.

• The Frame Style allows you to change the style of the overview frame.

• The Blending mode allows you to set different transparency blend modes. See Rendering_Mode.

• The Invert overview creates a mask around the extents when activated: the referenced map extents are
shown clearly, whereas everything else is blended with the frame color.

• The Center on overview puts the extent of the overview frame in the center of the overview map. You
can only activate one overview item to center, when you have added several overviews.

18.3.2 The Label item

To add a label, click the Add label icon, place the element with the left mouse button on the Print Composer
canvas and position and customize its appearance in the label Item Properties tab.

The Item Properties tab of a label item provides the following functionality for the label item (see Fig-
ure_composer_label):

Figure 18.11: Onglet Propriétés d’une zone de texte

Propriétés principales

• The main properties dialog is where the text (HTML or not) or the expression needed to fill the label is
added to the Composer canvas.

• Labels can be interpreted as HTML code: check Render as HTML. You can now insert a URL, a
clickable image that links to a web page or something more complex.

• You can also insert an expression. Click on [Insert an expression] to open a new dialog. Build an ex-
pression by clicking the functions available in the left side of the panel. Two special categories can be
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useful, particularly associated with the atlas functionality: geometry functions and records functions. At the
bottom, a preview of the expression is shown.

Appearance

• Define Font by clicking on the [Font...] button or a Font color selecting a color using the color selection
tool.

• You can specify different horizontal and vertical margins in mm. This is the margin from the edge of the
composer item. The label can be positioned outside the bounds of the label e.g. to align label items with
other items. In this case you have to use negative values for the margin.

• Using the Alignment is another way to position your label. Note that when e.g. using the Horizontal
alignment in Center Position the Horizontal margin feature is disabled.

18.3.3 The Image item

To add an image, click the Add image icon, place the element with the left mouse button on the Print Composer
canvas and position and customize its appearance in the image Item Properties tab.

The picture Item Properties tab provides the following functionalities (see figure_composer_image_1):

Figure 18.12: Onglet Propriétés d’une image

You first have to select the image you want to display. There are several ways to set the image source in the Main
properties area.

1. Use the browse button of image source to select a file on your computer using the browse dialog. The
browser will start in the SVG-libraries provided with QGIS. Besides SVG, you can also select other image
formats like .png or .jpg.
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2. You can enter the source directly in the image source text field. You can even provide a remote URL-address
to an image.

3. From the Search directories area you can also select an image from loading previews ... to set the image
source.

4. Use the data defined button to set the image source from a record or using a regular expression.

With the Resize mode option, you can set how the image is displayed when the frame is changed, or choose to
resize the frame of the image item so it matches the original size of the image.

You can select one of the following modes:

• Zoom: Enlarges the image to the frame while maintaining aspect ratio of picture.

• Stretch: Stretches image to fit inside the frame, ignores aspect ratio.

• Clip: Use this mode for raster images only, it sets the size of the image to original image size without scaling
and the frame is used to clip the image, so only the part of the image inside the frame is visible.

• Zoom and resize frame: Enlarges image to fit frame, then resizes frame to fit resultant image.

• Resize frame to image size: Sets size of frame to match original size of image without scaling.

Selected resize mode can disable the item options ‘Placement’ and ‘Image rotation’. The Image rotation is active
for the resize mode ‘Zoom’ and ‘Clip’.

With Placement you can select the position of the image inside it’s frame. The Search directories area allows
you to add and remove directories with images in SVG format to the picture database. A preview of the pictures
found in the selected directories is shown in a pane and can be used to select and set the image source.

Images can be rotated with the Image rotation field. Activating the Sync with map checkbox synchronizes
the rotation of a picture in the QGIS map canvas (i.e., a rotated north arrow) with the appropriate Print Composer
image.

It is also possible to select a north arrow directly. If you first select a north arrow image from Search directories

and then use the browse button of the field Image source, you can now select one of the north arrow from
the list as displayed in figure_composer_image_2.

Note: Many of the north arrows do not have an ‘N’ added in the north arrow, this is done on purpose for languages
that do not use an ‘N’ for North, so they can use another letter.

18.3.4 The Legend item

To add a map legend, click the Add new legend icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the legend Item Properties tab.

The Item properties of a legend item tab provides the following functionalities (see figure_composer_legend_1):

Propriétés principales

The Main properties dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_legend_2):

In Main properties you can:

• Change the title of the legend.

• Set the title alignment to Left, Center or Right.

• You can choose which Map item the current legend will refer to in the select list.

• You can wrap the text of the legend title on a given character.
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Figure 18.13: North arrows available for selection in provided SVG library

Figure 18.14: Onglet Propriétés d’une légende

Figure 18.15: Propriétés principales d’une légende
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Éléments de légende

The Legend items dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_legend_3):

Figure 18.16: Modification des objets de légende

• The legend will be updated automatically if Auto-update is checked. When Auto-update is unchecked
this will give you more control over the legend items. The icons below the legend items list will be activated.

• The legend items window lists all legend items and allows you to change item order, group layers, remove
and restore items in the list, edit layer names and add a filter.

– The item order can be changed using the [Up] and [Down] buttons or with ‘drag-and-drop’ function-
ality. The order can not be changed for WMS legend graphics.

– Use the [Add group] button to add a legend group.

– Use the [plus] and [minus] button to add or remove layers.

– The [Edit] button is used to edit the layer-, groupname or title, first you need to select the legend item.

– The [Sigma] button adds a feature count for each vector layer.

– Use the [filter] button to filter the legend by map content, only the legend items visible in the map will
be listed in the legend.

After changing the symbology in the QGIS main window, you can click on [Update All] to adapt the
changes in the legend element of the Print Composer.

Fonts, Columns, Symbol

The Fonts, Columns and Symbol dialogs of the legend Item Properties tab provide the following functionalities
(see figure_composer_legend_4):

• Vous pouvez changer la police du titre de la légende, du groupe, du sous-groupe et de l’élément (de couche)
dans la légende. Cliquez sur la catégorie concernée pour ouvrir la fenêtre Choisir une police.

• You provide the labels with a Color using the advanced color picker, however the selected color will be
given to all font items in the legend..

• Legend items can be arranged over several columns. Set the number of columns in the Count field.

– Equal column widths sets how legend columns should be adjusted.

– The Split layers option allows a categorized or a graduated layer legend to be divided between
columns.

• You can change the width and height of the legend symbol in this dialog.
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Figure 18.17: Fenêtres Polices de légende, Colonnes, Symbole et Espacement

WMS LegendGraphic and Spacing

The WMS LegendGraphic and Spacing dialogs of the legend Item Properties tab provide the following function-
alities (see figure_composer_legend_5):

Figure 18.18: WMS LegendGraphic Dialogs

When you have added a WMS layer and you insert a legend composer item, a request will be send to the WMS
server to provide a WMS legend. This Legend will only be shown if the WMS server provides the GetLegend-
Graphic capability. The WMS legend content will be provided as a raster image.

WMS LegendGraphic is used to be able to adjust the Legend width and the Legend height of the WMS legend
raster image.

Spacing around title, group, subgroup, symbol, icon label, box space or column space can be customized through
this dialog.
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18.3.5 The Scale Bar item

To add a scale bar, click the Add new scalebar icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the scale bar Item Properties tab.

The Item properties of a scale bar item tab provides the following functionalities (see fig-
ure_composer_scalebar_1):

Figure 18.19: Scale Bar Item properties Tab

Propriétés principales

The Main properties dialog of the scale bar Item Properties tab provides the following functionalities (see fig-
ure_composer_scalebar_2):

Figure 18.20: Scale Bar Main properties Dialog

• First, choose the map the scale bar will be attached to.

• Then, choose the style of the scale bar. Six styles are available:

– Single box and Double box styles, which contain one or two lines of boxes alternating colors.

– Middle, Up or Down line ticks.

– Numeric, where the scale ratio is printed (i.e., 1:50000).

Unités et segments

The Units and Segments dialogs of the scale bar Item Properties tab provide the following functionalities (see
figure_composer_scalebar_3):

In these two dialogs, you can set how the scale bar will be represented.
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Figure 18.21: Scale Bar Units and Segments Dialogs

• Select the map units used. There are four possible choices: Map Units is the automated unit selection;
Meters, Feet or Nautical Miles force unit conversions.

• The Label field defines the text used to describe the units of the scale bar.

• The Map units per bar unit allows you to fix the ratio between a map unit and its representation in the scale
bar.

• You can define how many Segments will be drawn on the left and on the right side of the scale bar, and how
long each segment will be (Size field). Height can also be defined.

Display

The Display dialog of the scale bar Item Properties tab provide the following functionalities (see fig-
ure_composer_scalebar_4):

Figure 18.22: Scale Bar Display

You can define how the scale bar will be displayed in its frame.

• Box margin : space between text and frame borders

• Labels margin : space between text and scale bar drawing

• Line width : line widht of the scale bar drawing

• Join style : Corners at the end of scalebar in style Bevel, Rounded or Square (only available for Scale bar
style Single Box & Double Box)

• Cap style : End of all lines in style Square, Round or Flat (only available for Scale bar style Line Ticks Up,
Down and Middle)

• Alignment : Puts text on the left, middle or right side of the frame (works only for Scale bar style Numeric)
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Fonts and colors

The Fonts and colors dialog of the scale bar Item Properties tab provide the following functionalities (see fig-
ure_composer_scalebar_5):

Figure 18.23: Scale Bar Fonts and colors Dialogs

You can define the fonts and colors used for the scale bar.

• Use the [Font] button to set the font

• Font color: set the font color

• Fill color: set the first fill color

• Secondary fill color: set the second fill color

• Stroke color: set the color of the lines of the Scale Bar

Fill colors are only used for scale box styles Single Box and Double Box. To select a color you can use the list
option using the dropdown arrow to open a simple color selection option or the more advanced color selection
option, that is started when you click in the colored box in the dialog.

18.3.6 The Basic Shape Items

To add a basic shape (ellipse, rectangle, triangle), click the Add basic shape icon or the Add Arrow icon, place
the element holding down the left mouse. Customize the appearance in the Item Properties tab.

When you also hold down the Shift key while placing the basic shape you can create a perfect square, circle or
triangle.

Figure 18.24: Onglet Propriétés d’une forme

The Shape item properties tab allows you to select if you want to draw an ellipse, rectangle or triangle inside the
given frame.
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You can set the style of the shape using the advanced symbol style dialog with which you can define its outline
and fill color, fill pattern, use markers etcetera.

For the rectangle shape, you can set the value of the corner radius to round of the corners.

Note: Unlike other items, you can not style the frame or the background color of the frame.

18.3.7 The Arrow item

To add an arrow, click the Add Arrow icon, place the element holding down the left mouse button and drag a line
to draw the arrow on the Print Composer canvas and position and customize the appearance in the scale bar Item
Properties tab.

When you also hold down the Shift key while placing the arrow, it is placed in an angle of exactly 45° .

The arrow item can be used to add a line or a simple arrow that can be used, for example, to show the relation
between other print composer items. To create a north arrow, the image item should be considered first. QGIS
has a set of North arrows in SVG format. Furthermore you can connect an image item with a map so it can rotate
automatically with the map (see the_image_item).

Figure 18.25: Onglet Propriétés d’une flèche

Item Properties

The Arrow item properties tab allows you to configure an arrow item.

The [Line style ...] button can be used to set the line style using the line style symbol editor.

In Arrows markers you can select one of three radio buttons.

• Default : To draw a regular arrow, gives you options to style the arrow head

• None : To draw a line without arrow head

• SVG Marker : To draw a line with an SVG Start marker and/or End marker

For Default Arrow marker you can use following options to style the arrow head.

• Arrow outline color : Set the outline color of the arrow head

• Arrow fill color : Set the fill color of the arrow head
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• Arrow outline width : Set the outline width of the arrow head

• Arrow head width: Set the size of the arrow head

For SVG Marker you can use following options.

• Start marker : Choose an SVG image to draw at the beginning of the line

• End marker : Choose an SVG image to draw at the end of the line

• Arrow head width: Sets the size of Start and/or End marker

SVG images are automatically rotated with the line. The color of the SVG image can not be changed.

18.3.8 The Attribute Table item

It is possible to add parts of a vector attribute table to the Print Composer canvas: Click the Add attribute table

icon, place the element with the left mouse button on the Print Composer canvas, and position and customize the
appearance in the Item Properties tab.

The Item properties of an attribute table item tab provides the following functionalities (see fig-
ure_composer_table_1):

Figure 18.26: Attribute table Item properties Tab

Propriétés principales

The Main properties dialogs of the attribute table Item Properties tab provide the following functionalities (see
figure_composer_table_2):

• For Source you can normally select only ‘Layer features’.

• With Layer you can choose from the vector layers loaded in the project.

• The button [Refresh table data] can be used to refresh the table when the actual contents of the table has
changed.

• In case you activated the Generate an atlas option in the Atlas generation tab, there are two additional
Source possible: ‘Current atlas feature’ (see figure_composer_table_2b) and ‘Relation children’ (see fig-
ure_composer_table_2c). Choosing the ‘Current atlas feature’ you won’t see any option to choose the layer,
and the table item will only show a row with the attributes from the current feature of the atlas coverage
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Figure 18.27: Attribute table Main properties Dialog

layer. Choosing ‘Relation children’, an option with the relation name will show up. The ‘Relation children’
option can only be used if you have defined a relation using your atlas coverage layer as parent, and it will
show the children rows of the atlas coverage layer’s current feature (for further information about the atlas
generation see atlasgeneration).

Figure 18.28: Attribute table Main properties for ‘Current atlas feature’

Figure 18.29: Attribute table Main properties for ‘Relation children’

• The button [Attributes...] starts the Select attributes menu, see figure_composer_table_3, that can be used
to change the visible contents of the table. After making changes use the [OK] button to apply changes to
the table.

In the Columns section you can:

– Remove an attribute, just select an attribute row by clicking anywhere in a row and press the minus
button to remove the selected attribute.

– Add a new attribute use the plus button. At the end a new empty row appears and you can select empty
cell of the column Attribute. You can select a field attribute from the list or you can select to build a

new attribute using a regular expression ( button). Of course you can modify every already existing
attribute by means of a regular expression.

– Use the up and down arrows to change the order of the attributes in the table.

– Select a cel in the Headings column to change the Heading, just type in a new name.

– Select a cel in the Alignment column and you can choose between Left, Center or Right alignment.

– Select a cel in the Width column and you can change it from Automatic to a width in mm, just type a
number. When you want to change it back to Automatic, use the cross.

– The [Reset] button can always be used to restore it to the original attribute settings.

In the Sorting section you can:
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– Add an attribute to sort the table with. Select an attribute and set the sorting order to ‘Ascending’ or
‘Descending’ and press the plus button. A new line is added to the sort order list.

– select a row in the list and use the up and down button to change the sort priority on attribute level.

– use the minus button to remove an attribute from the sort order list.

Figure 18.30: Fenêtre de Sélection d’attributs

Feature filtering

The Feature filtering dialogs of the attribute table Item Properties tab provide the following functionalities (see
figure_composer_table_4):

Figure 18.31: Attribute table Feature filtering Dialog

You can:

• Define the Maximum rows to be displayed.

• Activate Remove duplicate rows from table to show unique records only.

• Activate Show only visible features within a map and select the corresponding Composer map to display
the attributes of features only visible on selected map.

• Activate Show only features intersecting Atlas feature is only available when Generate an atlas is
activated. When activated it will show a table with only the features shown on the map of that particular
page of the atlas.
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• Activate Filter with and provide a filter by typing in the input line or insert a regular expression using

the given expression button. A few examples of filtering statements you can use when you have loaded
the airports layer from the Sample dataset:

– ELEV > 500

– NAME = ’ANIAK’

– NAME NOT LIKE ’AN%

– regexp_match( attribute( $currentfeature, ’USE’ ) , ’[i]’)

The last regular expression will include only the arpoirts that have a letter ‘i’ in the attribute field ‘USE’.

Appearance

The Appearance dialogs of the attribute table Item Properties tab provide the following functionalities (see fig-
ure_composer_table_5):

Figure 18.32: Attribute table appearance Dialog

• Click Show empty rows to make empty entries in the attribute table visible.

• With Cell margins you can define the margin around text in each cell of the table.

• With Display header you can select from a list one of ‘On first frame’, ‘On all frames’ default option, or
‘No header’.

• The option Empty table controls what will be displayed when the result selection is empty.

– Draw headers only, will only draw the header except if you have choosen ‘No header’ for Display
header.

– Hide entire table, will only draw the background of the table. You can activate Don’t draw
background if frame is empty in Frames to completely hide the table.

– Draw empty cells, will fill the attribute table with empty cells, this option can also be used to provide
additional empty cells when you have a result to show!

– Show set message, will draw the header and adds a cell spanning all columns and display a message
like ‘No result’ that can be provided in the option Message to display

• The option Message to display is only activated when you have selected Show set message for Empty table.
The message provided will be shown in the table in the first row, when the result is an empty table.

• With Background color you can set the background color of the table.

Show grid

The Show grid dialog of the attribute table Item Properties tab provide the following functionalities (see fig-
ure_composer_table_6):

256 Chapter 18. Composeur d’Impression



QGIS User Guide, Version 2.8

Figure 18.33: Attribute table Show grid Dialog

• Activate Show grid when you want to display the grid, the outlines of the table cells.

• With Stroke width you can set the thickness of the lines used in the grid.

• The Color of the grid can be set using the color selection dialog.

Fonts and text styling

The Fonts and text styling dialog of the attribute table Item Properties tab provide the following functionalities
(see figure_composer_table_7):

Figure 18.34: Attribute table Fonts and text styling Dialog

• You can define Font and Color for Table heading and Table contents.

• For Table heading you can additionally set the Alignment and choose from Follow column align-
ment, Left, Center or Right. The column alignment is set using the Select Attributes dialog (see Fig-
ure_composer_table_3 ).

Frames

The Frames dialog of the attribute table Item Properties tab provide the following functionalities (see fig-
ure_composer_table_8):

Figure 18.35: Attribute table Frames Dialog
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• With Resize mode you can select how to render the attribute table contents:

– Use existing frames displays the result in the first frame and added frames only.

– Extent to next page will create as many frames (and corresponding pages) as necessary to display the
full selection of attribute table. Each frame can be moved around on the layout. If you resize a frame,
the resulting table will be divided up between the other frames. The last frame will be trimmed to fit
the table.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.

• Use the [Add Frame] button to add another frame with the same size as selected frame. The result of the
table that will not fit in the first frame will continue in the next frame when you use the Resize mode Use
existing frames.

• Activate Don’t export page if frame is empty prevents the page to be exported when the table frame has
no contents. This means all other composer items, maps, scalebars, legends etc. will not be visible in the
result.

• Activate Don’t draw background if frame is empty prevents the background to be drawn when the table
frame has no contents.

18.3.9 The HTML frame item

It is possible to add a frame that displays the contents of a website or even create and style your own HTML page
and display it!

Click the Add HTML frame icon, place the element by dragging a rectangle holding down the left mouse but-
ton on the Print Composer canvas and position and customize the appearance in the Item Properties tab (see
figure_composer_html_1).

Figure 18.36: HTML frame, the item properties Tab

HTML Source

As an HTML source, you can either set a URL and activate the URL radiobutton or enter the HTML source
directly in the textbox provided and activate the Source radiobutton.

The HTML Source dialog of the HTML frame Item Properties tab provides the following functionalities (see
figure_composer_html_2):
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Figure 18.37: HTML frame, the HTML Source properties

• In URL you can enter the URL of a webpage you copied from your internet browser or select an HTML file

using the browse button . There is also the option to use the Data defined override button, to provide
an URL from the contents of an attribute field of a table or using a regular expression.

• In Source you can enter text in the textbox with some HTML tags or provide a full HTML page.

• The [insert an expression] button can be used to insert an expression like [%Year($now)%] in the
Source textbox to display the current year. This button is only activated when radiobutton Source is selected.
After inserting the expression click somewhere in the textbox before refreshing the HTML frame, otherwise
you will lose the expression.

• Activate Evaluate QGIS expressions in HTML code to see the result of the expression you have included,
otherwise you will see the expression instead.

• Use the [Refresh HTML] button to refresh the HTML frame(s) to see the result of changes.

Frames

The Frames dialog of the HTML frame Item Properties tab provides the following functionalities (see fig-
ure_composer_html_3):

Figure 18.38: HTML frame, the Frames properties

• With Resize mode you can select how to render the HTML contents:

– Use existing frames displays the result in the first frame and added frames only.

– Extent to next page will create as many frames (and corresponding pages) as necessary to render the
height of the web page. Each frame can be moved around on the layout. If you resize a frame, the
webpage will be divided up between the other frames. The last frame will be trimmed to fit the web
page.

– Repeat on every page will repeat the upper left of the web page on every page in frames of the same
size.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.
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• Use the [Add Frame] button to add another frame with the same size as selected frame. If the HTML page
that will not fit in the first frame it will continue in the next frame when you use Resize mode or Use existing
frames.

• Activate Don’t export page if frame is empty prevents the map layout from being exported when the
frame has no HTML contents. This means all other composer items, maps, scalebars, legends etc. will not
be visible in the result.

• Activate Don’t draw background if frame is empty prevents the HTML frame being drawn if the frame
is empty.

Use smart page breaks and User style sheet

The Use smart page breaks dialog and Use style sheet dialog of the HTML frame Item Properties tab provides the
following functionalities (see figure_composer_html_4):

Figure 18.39: HTML frame, Use smart page breaks and User stylesheet properties

• Activate Use smart page breaks to prevent the html frame contents from breaking mid-way a line of text
so it continues nice and smooth in the next frame.

• Set the Maximum distance allowed when calculating where to place page breaks in the html. This distance
is the maximum amount of empty space allowed at the bottom of a frame after calculating the optimum
break location. Setting a larger value will result in better choice of page break location, but more wasted
space at the bottom of frames. This is only used when Use smart page breaks is activated.

• Activate User stylesheet to apply HTML styles that often is provided in cascading style sheets. An
example of style code is provide below to set the color of <h1> header tag to green and set the font and
fontsize of text included in paragraph tags <p>.

h1 {color: #00ff00;
}
p {font-family: "Times New Roman", Times, serif;

font-size: 20px;
}

• Use the [Update HTML] button to see the result of the stylesheet settings.

18.4 Manage items

18.4.1 Size and position

Each item inside the Composer can be moved/resized to create a perfect layout. For both operations the first step is

to activate the Select/Move item tool and to click on the item; you can then move it using the mouse while holding
the left button. If you need to constrain the movements to the horizontal or the vertical axis, just hold the Shift
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while moving the mouse. If you need a better precision, you can move a selected item using the Arrow keys
on the keyboard; if the movement is too slow, you can speed up it by holding Shift.

A selected item will show squares on its boundaries; moving one of them with the mouse, will resize the item
in the corresponding direction. While resizing, holding Shift will maintain the aspect ratio. Holding Alt will
resize from the item center.

The correct position for an item can be obtained using snapping to grid or smart guides. Guides are set by clicking
and dragging in the rulers. Guides are moved by clicking in the ruler, level with the guide and dragging to a new
place. To delete a guide move it off the canvas. If you need to disable the snap on the fly just hold Ctrl while
moving the mouse.

You can choose multiple items with the Select/Move item button. Just hold the Shift button and click on all the
items you need. You can then resize/move this group just like a single item.

Once you have found the correct position for an item, you can lock it by using the items on the toolbar or ticking
the box next to the item in the Items tab. Locked items are not selectable on the canvas.

Locked items can be unlocked by selecting the item in the Items tab and unchecking the tickbox or you can use
the icons on the toolbar.

To unselect an item, just click on it holding the Shift button.

Inside the Edit menu, you can find actions to select all the items, to clear all selections or to invert the current
selection.

18.4.2 Alignment

Raising or lowering functionalities for elements are inside the Raise selected items pull-down menu. Choose an
element on the Print Composer canvas and select the matching functionality to raise or lower the selected element
compared to the other elements (see table_composer_1). This order is shown in the Items tab. You can also raise
or lower objects in the Items tab by clicking and dragging an object’s label in this list.

There are several alignment functionalities available within the Align selected items pull-down menu (see ta-
ble_composer_1). To use an alignment functionality, you first select some elements and then click on the matching
alignment icon. All selected elements will then be aligned within to their common bounding box. When moving
items on the Composer canvas, alignment helper lines appear when borders, centers or corners are aligned.

18.4.3 Copy/Cut and Paste items

The print composer includes actions to use the common Copy/Cut/Paste functionality for the items in the layout.
As usual first you need to select the items using one of the options seen above; at this point the actions can be
found in the Edit menu. When using the Paste action, the elements will be pasted according to the current mouse
position.

Note: HTML items can not be copied in this way. As a workaround, use the [Add Frame] button in the Item
Properties tab.

18.5 Outils Annuler et Restaurer

During the layout process, it is possible to revert and restore changes. This can be done with the revert and restore
tools:

• Revert last change

• Restore last change
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Figure 18.40: Guides pour l’alignement dans le Composeur d’Impression
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This can also be done by mouse click within the Command history tab (see figure_composer_29).

Figure 18.41: Historique des commandes du Composeur d’Impression

18.6 Génération d’atlas

The Print Composer includes generation functions that allow you to create map books in an automated way. The
concept is to use a coverage layer, which contains geometries and fields. For each geometry in the coverage layer,
a new output will be generated where the content of some canvas maps will be moved to highlight the current
geometry. Fields associated with this geometry can be used within text labels.

Every page will be generated with each feature. To enable the generation of an atlas and access generation
parameters, refer to the Atlas generation tab. This tab contains the following widgets (see Figure_composer_atlas):

Figure 18.42: Onglet Génération d’atlas

• Generate an atlas, which enables or disables the atlas generation.

• A Coverage layer combo box that allows you to choose the (vector) layer containing the geometries
on which to iterate over.

• An optional Hidden coverage layer that, if checked, will hide the coverage layer (but not the other ones)
during the generation.

• An optional Filter with text area that allows you to specify an expression for filtering features from the
coverage layer. If the expression is not empty, only features that evaluate to True will be selected. The
button on the right allows you to display the expression builder.

• Le Nom du fichier en sortie est utilisé pour générer un nom de fichier pour chaque planche. Il est basé sur
une expression. Il n’est utile que lorsque plusieurs fichiers sont produits.
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• A Single file export when possible that allows you to force the generation of a single file if this is possible
with the chosen output format (PDF, for instance). If this field is checked, the value of the Output filename
expression field is meaningless.

• An optional Sort by that, if checked, allows you to sort features of the coverage layer. The associated
combo box allows you to choose which column will be used as the sorting key. Sort order (either ascending
or descending) is set by a two-state button that displays an up or a down arrow.

You can use multiple map items with the atlas generation; each map will be rendered according to the coverage

features. To enable atlas generation for a specific map item, you need to check Controlled by Atlas under the
item properties of the map item. Once checked, you can set:

• A radiobutton Margin around feature that allows you to select the amount of space added around each
geometry within the allocated map. Its value is meaningful only when using the auto-scaling mode.

• A Predefined scale (best fit). It will use the best fitting option from the list of predefined scales in your
project properties settings (see Project –> Project Properties –> General –> Project Scales to configure
these predefined scales).

• A Fixed scale that allows you to toggle between auto-scale and fixed-scale mode. In fixed-scale mode,
the map will only be translated for each geometry to be centered. In auto-scale mode, the map’s extents are
computed in such a way that each geometry will appear in its entirety.

18.6.1 Labels

In order to adapt labels to the feature the atlas plugin iterates over, you can include expressions. For example, for
a city layer with fields CITY_NAME and ZIPCODE, you could insert this:

The area of [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’ format_number($area/1000000,2) %] km2

The information [% upper(CITY_NAME) || ‘,’ || ZIPCODE || ‘ is ‘ format_number($area/1000000,2) %] is an
expression used inside the label. That would result in the generated atlas as:

The area of PARIS,75001 is 1.94 km2

18.6.2 Data Defined Override Buttons

There are several places where you can use a Data Defined Override button to override the selected setting. These
options are particularly usefull with Atlas Generation.

For the following examples the Regions layer of the QGIS sample dataset is used and selected for Atlas Generation.
We also assume the paper format A4 (210X297) is selected in the Composition tab for field Presets.

With a Data Defined Override button you can dynamically set the paper orientation. When the height (north-
south) of the extents of a region is greater than it’s width (east-west), you rather want to use portrait instead of
landscape orientation to optimize the use of paper.

In the Composition you can set the field Orientation and select Landscape or Portrait. We want to set the orienta-

tion dynamically using an expression depending on the region geometry. press the button of field Orientation,
select Edit ... so the Expression string builder dialog opens. Give following expression:

CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN ’Landscape’ ELSE ’Portrait’ END

Now the paper orients itself automatically for each Region you need to reposition the location of the composer

item as well. For the map item you can use the button of field Width to set it dynamically using following
expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN 297 ELSE 210 END) - 20
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Use the button of field Heigth to provide following expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN 210 ELSE 297 END) - 20

When you want to give a title above map in the center of the page, insert a label item above the map. First use the
item properties of the label item to set the horizontal alignment to Center. Next activate from Reference point
the upper middle checkbox. You can provide following expression for field X :

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN 297 ELSE 210 END) / 2

For all other composer items you can set the position in a similar way so they are correctly positioned when page
is automatically rotated in portrait or landscape.

Information provided is derived from the excellent blog (in english and portugese) on the Data Defined Override
options Multiple_format_map_series_using_QGIS_2.6 .

This is just one example of how you can use Data Defined Overrides.

18.6.3 Preview

Once the atlas settings have been configured and map items selected, you can create a preview of all the pages by
clicking on Atlas → Preview Atlas and using the arrows, in the same menu, to navigate through all the features.

18.6.4 Génération

The atlas generation can be done in different ways. For example, with Atlas → Print Atlas, you can directly print
it. You can also create a PDF using Atlas → Export Atlas as PDF: The user will be asked for a directory for saving

all the generated PDF files (except if the Single file export when possible has been selected). If you need to
print just a page of the atlas, simply start the preview function, select the page you need and click on Composer
→ Print (or create a PDF).

18.7 Hide and show panels

To maximise the space available to interact with a composition you can use View –> Hide panels or press F10.

:: note:

It’s also possible to switch to a full screen mode to have more space to interact by pressing
:kbd:‘F11‘ or using :guilabel:‘View --> |checkbox| :guilabel:‘Toggle full screen‘.

18.8 Création de carte

Figure_composer_output shows the Print Composer with an example print layout, including each type of map
item described in the sections above.

Before printing a layout you have the possibility to view your composition without bounding boxes. This can be

enabled by deactivating View –> Show bounding boxes or pressing the shortcut Ctrl+Shift+B.

The Print Composer allows you to create several output formats, and it is possible to define the resolution (print
quality) and paper size:

• The Print icon allows you to print the layout to a connected printer or a PostScript file, depending on
installed printer drivers.
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Figure 18.43: Print Composer with map view, legend, image, scale bar, coordinates, text and HTML frame added

• The Export as image icon exports the Composer canvas in several image formats, such as PNG, BPM, TIF,
JPG,...

• Export as PDF saves the defined Print Composer canvas directly as a PDF.

• The Export as SVG icon saves the Print Composer canvas as an SVG (Scalable Vector Graphic).

If you need to export your layout as a georeferenced image (i.e., to load back inside QGIS), you need to enable

this feature under the Composition tab. Check World file on and choose the map item to use. With this option,
the ‘Export as image’ action will also create a world file.

Note:
• Currently, the SVG output is very basic. This is not a QGIS problem, but a problem with the underlying Qt

library. This will hopefully be sorted out in future versions.

• Exporting big rasters can sometimes fail, even if there seems to be enough memory. This is also a problem
with the underlying Qt management of rasters.

18.9 Gestionnaire de compositions

With the Save as template and Add items from template icons, you can save the current state of a Print Composer
session as a .qpt template and load the template again in another session.

The Composer Manager button in the QGIS toolbar and in Composer → Composer Manager allows you to add a
new Composer template, create a new composition based on a previously saved template or to manage already
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existing templates.

Figure 18.44: Le Gestionnaire de Compositions

By default, the Composer manager searches for user templates in ~/.qgis2/composer_template.

The New Composer and Duplicate Composer buttons in the QGIS toolbar and in Composer → New Composer
and Composer → Duplicate Composer allow you to open a new Composer dialog, or to duplicate an existing
composition from a previously created one.

Finally, you can save your print composition with the Save Project button. This is the same feature as in the QGIS
main window. All changes will be saved in a QGIS project file.

.
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CHAPTER 19

Extensions

.

19.1 QGIS Plugins

QGIS has been designed with a plugin architecture. This allows many new features and functions to be easily
added to the application. Many of the features in QGIS are actually implemented as plugins.

Vous pouvez gérer vos extensions dans la fenêtre qui s’ouvre via le menu Extension > Installer/Gérer les exten-
sions.

When a plugin needs to be updated, and if plugins settings have been set up accordingly, QGIS main interface
could display a blue link in the status bar to tell you that there are some updates for plugins waiting to be applied.

19.1.1 La fenêtre des Extensions

The menus in the Plugins dialog allow the user to install, uninstall and upgrade plugins in different ways. Each
plugin have some metadatas displayed in the right panel:

• information if the plugin is experimental

• la description

• rating vote(s) (you can vote for your prefered plugin!)

• les mots-clé

• some useful links as the home page, tracker and code repository

• le ou les auteurs

• la version disponible

Vous pouvez utilisez un filtre pour trouver une extension spécifique.

All

Here, all the available plugins are listed, including both core and external plugins. Use [Upgrade all] to look
for new versions of the plugins. Furthermore, you can use [Install plugin], if a plugin is listed but not installed,
and [Uninstall plugin] as well as [Reinstall plugin], if a plugin is installed. If a plugin is installed, it can be
de/activated using the checkbox.

Installed

Dans cet onglet, vous trouverez uniquement les extensions installées. Les extensions complémentaires peuvent
être désinstallées ou ré-installées en utilisant les boutons [Désinstaller] et [Ré-installer l’extension]. Vous pouvez
également [Tout mettre à jour] ici.
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Figure 19.1: The All menu

Figure 19.2: The Installed menu
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Non installées

This menu lists all plugins available that are not installed. You can use the [Install plugin] button to implement a
plugin into QGIS.

Figure 19.3: The Not installed menu

Upgradeable

If you activated Show also experimental plugins in the Settings menu, you can use this menu to look for
more recent plugin versions. This can be done with the [Upgrade plugin] or [Upgrade all] buttons.

Settings

Dans cet onglet, vous pouvez :

• Check for updates on startup. Whenever a new plugin or a plugin update is available, QGIS will inform
you ‘every time QGIS starts’, ‘once a day’, ‘every 3 days’, ‘every week’, ‘every 2 weeks’ or ‘every month’.

• Show also experimental plugins. QGIS will show you plugins in early stages of development, which are
generally unsuitable for production use.

• Afficher également les extensions obsolètes. Ces extensions sont dépréciées et déconseillées pour un
usage en production.

Pour ajouter des dépôts de contributeurs, cliquez sur [Ajouter...] dans la zone Dépôts d’extensions. Si vous ne
voulez pas un ou plusieurs dépôts ajoutés, ils peuvent être désactivés via le bouton [Éditer...], ou complètement
supprimés avec le bouton [Supprimer].

The Search function is available in nearly every menu (except Settings). Here, you can look for specific
plugins.

Astuce: Core and external plugins
QGIS plugins are implemented either as Core Plugins or External Plugins. Core Plugins are maintained by
the QGIS Development Team and are automatically part of every QGIS distribution. They are written in one of
two languages: C++ or Python. External Plugins are currently all written in Python. They are stored in external
repositories and are maintained by the individual authors.
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Figure 19.4: The Upgradeable menu

Figure 19.5: The Settings menu
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Detailed documentation about the usage, minimum QGIS version, home page, authors, and other important in-
formation are provided for the ‘Official’ QGIS Repository at http://plugins.qgis.org/plugins/. For other external
repositories, documentation might be available with the external plugins themselves. In general, it is not included
in this manual.

.
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19.2 Using QGIS Core Plugins

Bou-
ton

Extension Description Référence dans le manuel

Accuracy
Assessment

Generate an error matrix accuracy

CadTools Perform CAD-like functions in QGIS cadtools

Saisie de
coordonnées

Saisie les coordonnées de la souris dans des
systèmes de coordonnées différents

Extension de Saisie de
Coordonnées

DB Manager Manage your databases within QGIS Extension DB Manager

Convertisseur DXF
vers Shapefile

Convertit depuis un fichier DXF vers un
fichier SHP

Extension Convertisseur
Dxf2Shp

eVis Outil de visualisation d’évènements Extension eVis

fTools Ensemble d’outils vectoriels Extension fTools

Outils GPS Outils pour charger et importer des données
GPS

Extension GPS

GRASS Fonctionnalités GRASS Intégration du SIG GRASS

Outils GDALTools Fonctionnalités GDAL sur des couches raster Extension GDALTools

Géoréférenceur
GDAL

Géoréférenceur de couches raster à l’aide de
GDAL

Extension de
géoréférencement

Carte de chaleur Crée des cartes raster de chaleur à partir de
couches vectorielles de points

Extension Carte de chaleur

Extension
d’interpolation

Interpolation sur la base des vertex d’une
couche vectorielle

Extension Interpolation

Edition hors-ligne Edition hors-ligne avec synchronisation de la
base de données

Extension d’Édition
hors-ligne

Géoraster Oracle
Spatial

Accède aux Géorasters d’Oracle Spatial Extension GeoRaster Oracle
Spatial

Gestionnaire
d’Extension

Gestion des extensions principales et
complémentaires

La fenêtre des Extensions

Analyse des
modèles de terrain

Calcule les caractéristiques
géomorphologiques depuis des MNT

Extension d’Analyse Raster
de Terrain

Extension Graphe
Routier

Recherche du plus court chemin Extension Graphe routier

SQL Anywhere
plugin

Access SQL anywhere DB sqlanywhere

Requête spatiale Réalise des requêtes spatiales sur des couches
vectorielles

Extension Requête Spatiale

SPIT Shapefile to PostgreSQL/PostGIS Import Tool Extension SPIT

Statistiques de
zones

Statistiques des pixels contenus dans des
polygones

Extension Statistiques de
zone

MetaSearch Interagir avec des service de catalogage de
métadonnées (CSW)

Client MetaSearch pour les
Services de Catalogage

.
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19.3 Extension de Saisie de Coordonnées

L’extension Saisie de Coordonnées est simple d’utilisation et offre la possibilité d’afficher des coordonnées sur la
carte en sélectionnant deux systèmes de coordonnées de référence (SCR) différents.

Figure 19.6: Coordinate Capture Plugin

1. Start QGIS, select Project Properties from the Settings (KDE, Windows) or File (Gnome, OSX) menu

and click on the Projection tab. As an alternative, you can also click on the CRS status icon in the lower
right-hand corner of the status bar.

2. Cochez l’option Autoriser la projection ‘à la volée’ et sélectionnez le système de coordonnées de votre
choix (voir également la Section Utiliser les projections).

3. Activez l’extension Saisie de Coordonnées depuis le Gestionnaire d’Extension (voir la Section La fenêtre
des Extensions) puis assurez-vous que l’extension est activée en allant dans Vue > Panneaux pour vérifier

que la fonction Saisie de Coordonnées est cochée. La fenêtre Saisie de Coordonnées apparaît alors
comme indiqué dans la Figure figure_coordinate_capture_1. Vous pouvez également aller dans Vecteur →
Saisie de Coordonnées et vérifier que Saisie de Coordonnées est activé.

4. Appuyez sur le bouton Cliquez pour sélectionner le SCR à utiliser pour l’affichage des coordonnées et sélectionnez un SCR
différent de celui que vous avez choisi plus haut.

5. Pour lancer la capture de coordonnées, appuyez sur [Débuter la capture]. Vous pouvez maintenant cliquer
n’importe où sur la carte et l’extension affichera les coordonnées dans chacun des deux SCR sélectionnés.

6. Pour activer le suivi des coordonnées par le curseur, appuyez sur le bouton Suivi du curseur.

7. Vous pouvez également copier les coordonnées dans le presse-papier.

.

19.4 Extension DB Manager

The DB Manager Plugin is officially part of the QGIS core and is intended to replace the SPIT Plugin and,

additionally, to integrate all other database formats supported by QGIS in one user interface. The DB Manager

Plugin provides several features. You can drag layers from the QGIS Browser into the DB Manager, and it will
import your layer into your spatial database. You can drag and drop tables between spatial databases and they will
get imported. .. _figure_db_manager:

Le menu Base de données vous permet de se connecter à une base de données existante, d’ouvrir une fenêtre de
requête SQL et de sortir de l’extension DB manager. Une fois connecté à une base existante, les menus Schéma et
Table apparaissent.

Le menu Schéma inclut des outils pour créer et pour effacer des schémas (vides) et, si la topologie est activée (par
exemple dans PostGIS 2), de lancer le TopoViewer.

The Table menu allows you to create and edit tables and to delete tables and views. It is also possible to empty
tables and to move tables from one schema to another. As further functionality, you can perform a VACUUM
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Figure 19.7: DB Manager dialog

and then an ANALYZE for each selected table. Plain VACUUM simply reclaims space and makes it available
for reuse. ANALYZE updates statistics to determine the most efficient way to execute a query. Finally, you can
import layers/files, if they are loaded in QGIS or exist in the file system. And you can export database tables to
shape with the Export File feature.

The Tree window lists all existing databases supported by QGIS. With a double-click, you can connect to the
database. With the right mouse button, you can rename and delete existing schemas and tables. Tables can also be
added to the QGIS canvas with the context menu.

Si une connexion à une base de données est active, la fenêtre principale de DB Manager présente trois onglets.
L’onglet Info affiche les informations concernant la table et sa géométrie ainsi que mes champs, contraintes et
index existants. Il est également possible d’exécuter un Vacuum Analyse et de créer un index spatial sur une table,
s’il n’existe pas. L’onglet Table affiche les attributs et l’onglet Aperçu génère un aperçu des géométries.

19.4.1 Utilisation de la fenêtre SQL

You can also use the DB Manager to execute SQL queries against your spatial database and then view the spatial
output for queries by adding the results to QGIS as a query layer. It is possible to highlight a portion of the SQL
and only that portion will be executed when you press F5 or click the Execute (F5) button.

.

19.5 Extension Convertisseur Dxf2Shp

L’extension Convertisseur Dxf2Shape permet de convertir des données vectorielles du format DXF au format
shapefile. Avant d’être exécutée, elle requiert les réglages suivants:

• Fichier DXF en entrée : Entrer la localisation du fichier DXF à convertir.

• Fichier SHP en sortie : Entrer le nom souhaité du fichier shapefile à créer.
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Figure 19.8: Executing SQL queries in the DB Manager SQL window

Figure 19.9: Extension Convertisseur Dxf2Shape
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• Type de fichier de sortie : Spécifier le type géométrique du shapefile créé. Les formats implémentés pour
le moment sont point, polyligne et polygone.

• Exporter les étiquettes : Si cette case est cochée, une couche supplémentaire shapefile de type point sera
créée et la table dbf associée contiendra des informations à propos des champs “TEXT” trouvés dans le
fichier DXF ainsi que les chaînes de caractères elles-mêmes.

19.5.1 Mettre en œuvre l’extension

1. Start QGIS, load the Dxf2Shape plugin in the Plugin Manager (see La fenêtre des Extensions) and click

on the Dxf2Shape Converter icon, which appears in the QGIS toolbar menu. The Dxf2Shape plugin dialog
appears, as shown in Figure_dxf2shape_1.

2. Entrez la localisation du fichier DXF ainsi qu’un nom et un type pour le shapefile à créer.

3. Cochez la case Exporter les étiquettes si vous souhaitez créer une couche point supplémentaire contenant
les étiquettes.

4. Appuyez sur [Ok].

.

19.6 Extension eVis

(Cette section est issue de l’ouvrage Horning, N., K. Koy, P. Ersts. 2009. eVis (v1.1.0) User’s
Guide. American Museum of Natural History, Center for Biodiversity and Conservation. Disponible sur
http://biodiversityinformatics.amnh.org/ et sortie sous licence GNU FDL.)

The Biodiversity Informatics Facility at the American Museum of Natural History’s (AMNH) Center for Biodi-
versity and Conservation (CBC) has developed the Event Visualization Tool (eVis), another software tool to add
to the suite of conservation monitoring and decision support tools for guiding protected area and landscape plan-
ning. This plugin enables users to easily link geocoded (i.e., referenced with latitude and longitude or X and Y
coordinates) photographs, and other supporting documents, to vector data in QGIS.

eVis is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be disabled
and enabled using the Plugin Manager (see La fenêtre des Extensions).

L’extension consiste en 3 modules : l’outil de ‘Connexion à une base de données’, l’outil ‘ID d’évènements’ et le
‘Navigateur d’évènement’. Ils fonctionnent ensemble pour permettre l’affichage de documents géoéréfrencés qui
sont liés à des entités enregistrées dans des fichiers vectoriels, des bases de données ou des feuilles de tableur.

19.6.1 Navigateur d’évènement

The Event Browser module provides the functionality to display geocoded photographs that are linked to vector
features displayed in the QGIS map window. Point data, for example, can be from a vector file that can be input
using QGIS or it can be from the result of a database query. The vector feature must have attribute information
associated with it to describe the location and name of the file containing the photograph and, optionally, the
compass direction the camera was pointed when the image was acquired. Your vector layer must be loaded into
QGIS before running the Event Browser.

Afficher le navigateur d’évènement

Pour lancer le Navigateur d’évènement , cliquez sur le menu Base de données > eVis > Navigateur d’évènements
eVis. Ceci ouvrira la fenêtre du Navigateur d’évènements.

La fenêtre de navigateur affiche 3 onglets dans sa partie supérieure. L’onglet Affichage est utilisé pour voir la
photographie et les données attributaires correspondantes. L’onglet des options fournit une série de paramètres
qui peuvent être ajustés pour contrôler le comportement de l’extension eVis. Enfin, l’onglet de configurer les
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applications externes contient une table des extensions de fichiers et des applications qui leur sont associées pour
permettre à eVis d’afficher des documents autre qu’une image.

La fenêtre Affichage

Pour voir la fenêtre Affichage, cliquez sur l’onglet Affichage du navigateur d’évènement. Cette fenêtre est utilisée
pour visualiser les photographies et leurs données attributaires.

Figure 19.10: La fenêtre Affichage d’eVIS

1. Zone d’affichage : emplacement où s’affichera l’image.

2. Bouton Zoom + : Zoomez pour voir plus de détails. Si l’image ne peut être affichée entièrement dans la
fenêtre, des barres de défilement apparaîtront sur les bords gauches et inférieures pour que vous puissiez
bouger l’image.

3. Bouton Zoom - : Zoomez en arrière pour avoir une vue d’ensemble.

4. Bouton Zoomer sur l’emprise : Affiche l’emprise maximale de la photographie.

5. Zone d’informations : Toutes les informations attributaires pour le point associé à la photographie sélec-
tionnée sont affichées ici. Si le type de fichier référencé n’est pas une image, mais d’un type renseigné dans
l’onglet configurer les applications externes (il sera alors affiché en vert), un double clic lancera l’application
désignée.

6. Boutons de navigation : Utilisez les boutons [Suivant] et [Précédent] pour charger une autre entité lorsque
plusieurs sont sélectionnées.
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Figure 19.11: La fenêtre Options d’eVis
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La fenêtre Options

1. Chemin du fichier : Une liste déroulante permet de spécifier quel est l’attribut contenant le chemin d’accès
vers le document devant être affiché. Si l’emplacement est un chemin relatif alors la case située juste en
dessous doit être cochée. Le chemin de base peut être saisi dans la zone de texte. Les informations à propos
des différentes options pour indiquer le chemin sont expliquées dans la section Spécifier un emplacement et
le nom d’une photographie, ci-dessous.

2. Orientation de la boussole : Une liste déroulante pour définir le champ d’attribut qui contient l’orientation
de la boussole associé à la photo affichée. Si des informations d’orientation de la boussole est disponible, il
est nécessaire de cocher la case dessous le titre de menu déroulant.

3. Compass offset: Compass offsets can be used to compensate for declination (to adjust bearings collected
using magnetic bearings to true north bearings). Click the Manual radio button to enter the offset in
the text box or click the From Attribute radio button to select the attribute field containing the offsets.
For both of these options, east declinations should be entered using positive values, and west declinations
should use negative values.

4. Chemin de base : C’est le chemin à partir duquel le chemin relatif (A) définit dans la figure Figure_eVis_2
sera établi.

5. Remplacer le chemin : Si cette case est cochée alors seul le nom du fichier sera ajouté au chemin de base.

6. Appliquer la règle à tous les documents : Si cochée, la règle définie pour les photographies sera utilisée
pour les autres documents tels que les fichiers textes, les vidéos et les fichiers audio. Dans le cas contraire,
les règles s’appliqueront seulement aux photographies.

7. Se souvenir de : Si cette case est cochée, les valeurs des paramètres correspondants seront enregistrées pour
la prochaine session au moment de la fermeture de la fenêtre ou quand le bouton [Enregistrer] est cliqué.

8. Réinitialiser : Remet les valeurs par défaut pour ce paramètre.

9. Restaurer les valeurs par défaut : Réinitialise tous les paramètres à leur valeur par défaut. Il équivaut à
cliquer sur tous les boutons [Réinitialiser].

10. Enregistrer : Ceci enregistrera les valeurs sans fermer l’onglet des options.

La fenêtre Configurer les applications externes

Figure 19.12: La fenêtre Configuration des applications externes d’eVis

1. Tableau des références : Une table contient tous les types de fichiers qui peuvent être ouverts par eVis.
Chaque type de fichier doit avoir une extension qui lui est propre et un chemin vers une application pour
l’ouvrir. Ce la permet d’utiliser un large éventail de documents autre que des images.

2. Ajouter un nouveau type de fichier : Ajoute un nouveau type de fichier avec son extension et une appli-
cation dédiée.

3. Effacer la cellule courante : Effacer le type de fichier sélectionné dans la table.
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19.6.2 Spécifier un emplacement et le nom d’une photographie

Le nom et l’emplacement d’une photographie peuvent être enregistrés avec un chemin absolu ou relatif ou une
URL si l’image se trouve sur un serveur Internet. Des exemples de ces différentes approches sont listés dans la
table evis_examples.

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinformatics.amnh.org/\

evis_testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.testsite.com/attachments.php?\

attachment_id-12 76

19.6.3 Spécifier l’emplacement et le nom d’un document autre qu’une image

Les documents texte, vidéos ou audio peuvent aussi être affichés par eVis. Pour ce faire, il est nécessaire d’ajouter
une entrée dans la table des références fichiers qui pourra être utilisé par l’une des applications externes définies.
Il est aussi nécessaire d’avoir le chemin vers le fichier dans la table attributaire de la couche vectorielle. Une pos-
sibilité supplémentaire est de spécifier l’extension du fichier avant le chemin (par exemple avi:/chemin/du/fichier),
ce qui est très utile pour accéder à des documents placés sur des sites ou des wikis utilisant une base de données
pour la gestion de leurs pages (voir la table evis_examples).

19.6.4 Utiliser le Navigateur d’évènements

Quand la fenêtre du Navigateur d’évènements s’ouvre, une photographie apparaîtra dans l’onglet d’affichage
si le document référencé dans la table attributaire du fichier vectoriel est une image et que les paramètres
d’emplacement sont correctement renseignés. Si la photographie voulue n’apparaît pas, c’est qu’il vous est néces-
saire d’ajuster les paramètres de l’onglet des options.

Si un format de document géré (ou une image n’ayant pas d’extension reconnue par eVis) est référencé dans la
table attributaire, le champ contenant le chemin vers le fichier sera surligné en vert dans la liste des références
fichiers si cette extension a été définie dans la table de configuration des applications externes. Pour l’ouvrir,
faites un double-clic sur la ligne en vert. Si un document est référencé, mais non surligné en vert, il est nécessaire
d’ajouter une entrée pour son extension. Si le chemin est bien surligné en vert, mais qu’un double-clic reste sans
effet, il faudra alors vérifier que l’application associée à l’extension est bien renseignée dans l’onglet Options.

Si aucune indication de boussole n’est fournie dans les options, un astérisque rouge sera affiché au-dessus de
l’entité vectorielle concernée par l’image affichée. Si cette indication est disponible alors une flèche pointant la
direction de l’objectif apparaîtra. La flèche sera centrée sur le point associé à la photographie ou au document.

Pour fermer le Navigateur, cliquez sur le bouton [Fermer] de l’onglet d’Affichage.

19.6.5 Outil ID évènement

The ‘Event ID’ module allows you to display a photograph by clicking on a feature displayed in the QGIS map
window. The vector feature must have attribute information associated with it to describe the location and name of
the file containing the photograph and, optionally, the compass direction the camera was pointed when the image
was acquired. This layer must be loaded into QGIS before running the ‘Event ID’ tool.

Lancement du module Id évènement

To launch the ‘Event ID’ module, either click on the Event ID icon or click on Database → eVis → Event ID
Tool. This will cause the cursor to change to an arrow with an ‘i’ on top of it signifying that the ID tool is active.

To view the photographs linked to vector features in the active vector layer displayed in the QGIS map window,
move the Event ID cursor over the feature and then click the mouse. After clicking on the feature, the Event
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Browser window is opened and the photographs on or near the clicked locality are available for display in the
browser. If more than one photograph is available, you can cycle through the different features using the [Previ-
ous] and [Next] buttons. The other controls are described in the ref:evis_browser section of this guide.

19.6.6 Connexion à une base de données

Cet outil permet de se connecter et d’interroger une base de données ou une ressource ODBC telle qu’un tableur.

eVis peut se connecter directement à ces types de bases de données : PostgreSQL, MySQL et SQLite et peut
utiliser des connexions ODBC (par exemple Access). Pour des connexions ODBC (par exemple un fichier Excel),
il est nécessaire de configurer votre driver ODBC en fonction de votre système d’exploitation.

L’outil de connexion à une base de données

To launch the ‘Database Connection’ module, either click on the appropriate icon eVis Database Connection or click
on Database → eVis → Database Connection. This will launch the Database Connection window. The window
has three tabs: Predefined Queries, Database Connection, and SQL Query. The Output Console window at the
bottom of the window displays the status of actions initiated by the different sections of this module.

Se connecter à une base

Click on the Database Connection tab to open the database connection interface. Next, use the Database Type

combo box to select the type of database that you want to connect to. If a password or username is required,
that information can be entered in the Username and Password textboxes.

Entrez le nom de l’hôte de la base de données dans la zone de texte Hôte de la base de données. Cette option n’est
pas disponible si vous avez sélectionné ‘MS Access’ comme type de base de données. Si la base de données est
localisée sur votre ordinateur, vous pouvez entrer “localhost”.

Renseignez le nom de la base de données dans la zone de texte Nom de la base de données. Si vous avez sélectionné
‘ODBC’ comme type de base de données, il vous faudra entrer le nom de la source de données.

Quand tous les paramètres sont corrects, cliquez sur le bouton [Connecter]. Si la connexion est réussie, un
message sera affiché dans la console de sortie. En cas d’échec, il vous faudra vérifier les paramètres.

1. Type de base de données : Une liste déroulante pour spécifier le type de base de données qui sera utilisée.

2. Hôte de la base de données : le nom de l’hôte de la base.

3. Port : Le numéro du port dans le cas d’une base de données MySQL ou PostGreSQL.

4. Nom de la base de données : Le nom de la base de données.

5. Connecter : Ce bouton établit la connexion avec les paramètres définis ci-dessus.

6. Console de sortie : Console où sont affichés les messages relatifs au déroulement des processus.

7. Nom d’utilisateur : Nécessaire quand la base est protégée en accès.

8. **Mot de passe **: Nécessaire quand la base est protégée en accès.

9. Requêtes Prédéfinies : Onglet ouvrant la fenêtre de Requêtes Prédéfinies.

10. Connexion à une base de données : Onglet ouvrant la fenêtre de Connexion à une base de données.

11. Requête SQL : Onglet ouvrant la fenêtre de Requête SQL.

12. Aide : Affiche l’aide en ligne.

13. OK : Ferme la fenêtre principale.
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Figure 19.13: La fenêtre Connexion à une base de données d’eVIS

Faire une requête SQL

SQL queries are used to extract information from a database or ODBC resource. In eVis, the output from these
queries is a vector layer added to the QGIS map window. Click on the SQL Query tab to display the SQL query
interface. SQL commands can be entered in this text window. A helpful tutorial on SQL commands is available at
http://www.w3schools.com/sql. For example, to extract all of the data from a worksheet in an Excel file, select
* from [sheet1$] where sheet1 is the name of the worksheet.

Cliquez sur le bouton [Exécuter la requête] pour exécuter la commande. Si la requête est fructueuse, une fenêtre
de sélection sera affichée. Dans le cas contraire, un message d’erreur apparaîtra dans la console de sortie.

Dans cette nouvelle fenêtre, entrez le nom de la couche qui sera créée à partir des résultats dans la zone de texte
Nom de la Nouvelle Couche.

1. Zone de texte de requête SQL : Une zone poursaisir vos requêtes.

2. Exécuter la requête : Ce bouton exécute la requête écrite.

3. Console : Console où sont affichés les messages relatifs au déroulement de la connexion.

4. Aide : Affiche l’aide en ligne.

5. OK : Ferme la fenêtre Connexion à une base de données.

Use the X Coordinate and Y Coordinate combo boxes to select the fields from the database that
stores the X (or longitude) and Y (or latitude) coordinates. Clicking on the [OK] button causes the vector layer
created from the SQL query to be displayed in the QGIS map window.

To save this vector file for future use, you can use the QGIS ‘Save as...’ command that is accessed by right-clicking
on the layer name in the QGIS map legend and then selecting ‘Save as...’

Astuce: Créer une couche vectorielle depuis un fichier Microsoft Excel

284 Chapter 19. Extensions

http://www.w3schools.com/sql


QGIS User Guide, Version 2.8

Figure 19.14: L’onglet Requête SQL d’eVis

When creating a vector layer from a Microsoft Excel Worksheet, you might see that unwanted zeros (“0”) have
been inserted in the attribute table rows beneath valid data. This can be caused by deleting the values for these
cells in Excel using the Backspace key. To correct this problem, you need to open the Excel file (you’ll need to
close QGIS if you are connected to the file, to allow you to edit the file) and then use Edit → Delete to remove the
blank rows from the file. To avoid this problem, you can simply delete several rows in the Excel Worksheet using
Edit → Delete before saving the file.

Exécuter des requête prédéfinies

Avec les requêtes prédéfinies, vous pouvez sélectionner des requêtes déjà écrites et stockées au format XML. Cela
peut être utile si vous n’êtes pas familier avec les commandes SQL. Cliquez sur l’onglet Requêtes prédéfinies pour
afficher l’interface.

To load a set of predefined queries, click on the Open File icon. This opens the Open File window, which is used
to locate the file containing the SQL queries. When the queries are loaded, their titles as defined in the XML file
will appear in the drop-down menu located just below the Open File icon. The full description of the query is
displayed in the text window under the drop-down menu.

Sélectionnez la requête que vous voulez exécuter depuis la liste déroulante et ensuite cliquez sur l’onglet de
requête SQL pour observer la requête qui vient d’être chargée. Si c’est la première fois que vous exécutez une
requête prédéfinie ou que vous changez de base de travail, vous devrez vous connecter à la base de données.

Cliquez sur le bouton [Exécuter la requête] dans l’onglet Requête SQL pour lancer la commande. Si la requête
est fructueuse, une fenêtre de sélection sera affichée. Dans le cas contraire, un message d’erreur apparaîtra dans la
console de sortie.

1. Ouvrir le fichier: lance l’explorateur de fichier “ouvrir le fichier” afin de charger le fichier XML contenant
les requêtes prédéfinies.
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Figure 19.15: L’onglet Requêtes prédéfinies d’eVis

2. Requêtes prédéfinies : Une liste déroulante affichant toutes les requêtes prédéfinies dans le fichier XML.

3. Description de la requête : Une courte description de la requête.

4. Console : Console où sont affichés les messages relatifs au déroulement de la connexion.

5. Aide : Affiche l’aide en ligne.

6. OK : Ferme la fenêtre principale.

Le format XML pour les requêtes d’eVis

Les balises XML reconnues par eVis
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Balise Description
query Définit le début et la fin d’une requête.
shortde-
scription

Une courte description qui apparaît dans le menu déroulant.

descrip-
tion

Une description plus détaillée.

database-
type

Le type de base de données, défini dans la liste déroulante de l’onglet de connexion.

database-
port

Le port tel que défini dans la liste déroulante de l’onglet de connexion.

database-
name

Le nom de la base de données tel que défini dans la liste déroulante de l’onglet de connexion.

databaseuser-
name

Le nom d’utilisateur tel que défini dans la liste déroulante de l’onglet de connexion.

databasep-
assword

Le mot de passe tel que défini dans la liste déroulante de l’onglet de connexion.

sqlstate-
ment

La commande SQL.

autocon-
nect

Un interrupteur (“vrai” or “faux”) pour spécifier si les balises précédentes doivent être utilisées
pour se connecter automatiquement à une base de données sans passer par les routines de
connexion de l’onglet.

Voici un exemple complet avec 3 requêtes:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>

<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
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<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

.

19.7 Extension fTools

Le but de l’extension Python fTools est de fournir un outil unique pour un certain nombre de traitements SIG
vectoriels, sans avoir recours à des logiciels, des bibliothèques ou des constructions complexes supplémentaires.
Elle fournit un ensemble grandissant de fonctions de gestion et d’analyse des données spatiales qui sont à la fois
rapides et fonctionnelles.

fTools is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be
disabled and enabled using the Plugin Manager (see La fenêtre des Extensions). When enabled, the fTools plugin
adds a Vector menu to QGIS, providing functions ranging from Analysis and Research Tools to Geometry and
Geoprocessing Tools, as well as several useful Data Management Tools.

19.7.1 Outils d’analyse

Bou-
ton

Outil Fonction

Matrice des
distances

Mesure les distances entre deux couches de points et renvoie les résultats sous la
forme de a) Matrice de distance standard, b) Matrice des distances en ligne, ou c)
Résumé des distances (moyenne, min, max, écart type). Il est possible de limiter les
distances aux k entités les plus proches.

Total des
longueurs de
lignes

Calcule la somme totale des longueurs de lignes présentes dans chaque entité d’une
couche de polygones.

Points dans un
polygone

Compte le nombre de points inclus dans chaque entité d’une couche de polygones.

Liste les
valeurs
uniques

Liste toutes les valeurs uniques d’un champ d’une couche vecteur.

Statistiques
basiques

Calcule des statistiques de base (moyenne, écart type, max, min, nombre, somme,
CV) sur un champ donné.

Analyse du
plus proche
voisin

Calcule des statistiques sur le plus proche voisin pour évaluer le niveau de
clustering dans une couche vecteur de points.

Coordonnée(s)
moyenne(s)

Calcule le centre moyen normal ou pondéré soit d’une couche vecteur entière, soit
des entités partageant un même identifiant.

Intersections
de lignes

Localise les intersections entre lignes et renvoie les résultats sous la forme d’un
shapefile de points. Utile pour localiser les croisements de route ou de rivières.
Ignore les intersections de ligne d’une longueur supérieure à zéro.

Table fTools 1 : Outils d’analyse fTools
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19.7.2 Outils de recherche

Bou-
ton

Outil Fonction

Sélection aléatoire Sélectionne aléatoirement un nombre ou un pourcentage n d’entités.

Sélectionne aléatoirement
des entités au sein de
sous-ensemble

Sélectionne aléatoirement des entités au sein d’un sous-ensemble défini
par un champ identifiant.

Points aléatoires Génère des points pseudo-aléatoires sur une couche de données.

Points réguliers Génère une grille régulière de points sur une zone spécifiée et les
exporte dans un shapefile de points.

Grille vecteur Génère une grille formée par des lignes ou des polygones à partir d’un
espacement défini par l’utilisateur.

Sélection par localisation Sélectionne des entités en fonction de leur localisation par rapport à
une autre couche puis crée une nouvelle sélection, ajoute ou retire de la
sélection courante.

Créer un polygone à partir
de l’étendue de la couche

Crée une couche polygone contenant un unique rectangle couvrant
l’étendue d’une couche raster ou vecteur.

Table fTools 2: Outils de recherche fTools

19.7.3 Outils de géotraitement

Bou-
ton

Outil Fonction

Enveloppe(s)
convexe(s)

Crée l’enveloppe(s) minimale(s) convexe(s) pour une couche données ou des
sous-ensembles définis par un champ identifiant.

Tampon(s) Crée une(des) zone(s) tampon(s) autour des entités, basée(s) soit sur la distance soit
sur la valeur d’un champ donné.

Intersection Intersecte deux couches de sorte que la couche renvoyée contienne uniquement les
aires appartenant aux deux couches entrées.

Union Intersecte deux couches de sorte que la couche renvoyée contienne à la fois les aires
appartenant aux deux couches et celles n’appartenant qu’à l’une des deux.

Différencia-
tion
symétrique

Superpose les couches de sorte que la couche renvoyée ne contienne que les aires
des deux couches ne s’intersectant pas.

Couper Superpose deux couches de sorte que la couche renvoyée contienne les aires de la
couche d’entrée qui intersectent celles de la couche de découpage.

Différencia-
tion

Superpose deux couches de sorte que la couche renvoyée contienne les aires de la
couche d’entrée qui n’intersectent pas celles de la couche de découpage.

Regroupement Regroupe les entités selon un champ. Toutes les entités ayant des valeurs identiques
de ce champ sont combinées pour former une seule entité.

Supprimer les
débordements

Merges selected features with the neighbouring polygon with the largest area or
largest common boundary.

Table fTools 3: Outils de géotraitement fTools
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19.7.4 Outils de géométrie

Bou-
ton

Outil Fonction

Vérifier la validité
géométrique

Check polygons for intersections, closed holes, and fix node ordering. You can
choose the engine used by the in the options dialog, digitizing tab Change the
Validate geometries value. There is two engines: QGIS and GEOS which have
pretty different behaviour. Another tools exists which shows different result as
well: Topology Checker plugin and ‘must not have invalid geometries’ rule.

Exporter/ajouter des
colonnes de
géométrie

Ajoute des informations de géométrie sur une couche vecteur de points
(XCOORD, YCOORD), de lignes (LENGTH - longueur), ou de polygones
(AREA - aire, PERIMETER - périmètre).

Centroïdes de
polygones

Calcule le centroïde réel de chaque entité d’une couche de polygones.

Triangulation de
Delaunay

Calcule et renvoie (sous forme de couche de polygones) la triangulation de
Delaunay d’une couche vecteur de points.

Polygones de
Voronoï

Calcule les polygones de Voronoï d’une couche vecteur de points.

Simplifier la
géométrie

Généralise les lignes ou les polygones avec l’algorithme modifié de
Douglas-Peucker.

Densification de
géométrie

Ajoute des vertex aux lignes et aux polygones.

Morceaux multiples
vers morceaux
uniques

Convertit des entités constituées de plusieurs parties en des entités en une seule
partie. Crée des polygones et des lignes simples.

Morceaux uniques
vers morceaux
multiples

Fusionne plusieurs entités possédant le même identifiant sur un champ donné
en des entités multipartites.

Polygones vers
lignes

Convertit des polygones en lignes, des polygones multipartites en lignes
multipartites.

Lignes vers
polygones

Convertit les lignes en polygones, les lignes multi-partie en plusieurs
polygones mono-parties.

Extraction de
noeuds

Extrait les noeuds d’une couche de ligne ou de polygone et renvoie une couche
de points.

Table fTools 4: Outils de géométrie fTools

Note: L’outil Simplifier la géométrie permet de retirer les noeuds en double de lignes ou de polygones. L’astuce
consiste à mettre la Tolérance de simplification à 0.

290 Chapter 19. Extensions



QGIS User Guide, Version 2.8

19.7.5 Outils de gestion de données

Bou-
ton

Outil Fonction

Définir la
projection
courante

Définit le système de coordonnées pour les shapefiles qui n’en ont pas.

Joindre les
attributs par
localisation

Joint des attributs supplémentaires à une couche vecteur en fonction de la
localisation. Les attributs d’une couche vecteur sont ajoutés à ceux d’une autre
couche et exportés en shapefile.

Séparer une
couche
vectorielle

Sépare une couche en plusieures couches distinctes selon un identifiant spécifié.

Fusionner les
shapefiles

Fusionne les shapefiles présents dans un répertoire en un nouveau shapefile de
même type (point, ligne ou polygone).

Créer un index
spatial

Crée un index spatial pour les formats gérés par OGR.

Table fTools 5: Outils de gestion de données

.

19.8 Extension GDALTools

19.8.1 Qu’est-ce que GDALTools ?

Les outils GDALTools offrent une interface graphique aux outils de la bibliothèque Geospatial Data Abstraction
Library, (http://gdal.osgeo.org). Ce sont des outils de gestion de raster qui permettent d’interroger, de reprojeter
et de manipuler une large palette de formats. Il y a également des outils pour créer des contours vectoriels ou un
relief ombré à partir d’un MNT, pour produire un VRT (Virtual Raster Tile au format XML) depuis un ensemble
de rasters. Tous ces outils sont disponibles lorsque l’extension GDALTools est activée.

La bibliothèque GDAL

The GDAL library consists of a set of command line programs, each with a large list of options. Users comfortable
with running commands from a terminal may prefer the command line, with access to the full set of options. The
GDALTools plugin offers an easy interface to the tools, exposing only the most popular options.

19.8.2 Liste des outils GDAL

Figure 19.16: Le menu GDALTools
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Projections

Warp
(Reproject)

Cet outil permet de déformer et de reprojeter des images. Le programme peut reprojeter dans
n’importe quelles projections supportées, et appliquer les points d’amer stockés avec l’image
si l’image est fournie « brute ». Pour plus d’informations, se reporter au site web GDAL
http://www.gdal.org/gdalwarp.html.

Assign
projection

Cet utilitaire vous permet de définir la projection d’un raster qui aurait déjà été géoréférencé
mais dont il manque les informations de projection. Il permet également de modifier la
projection définie. Le traitement peut s’effectue sur un ou plusieurs fichiers simultanément.
Pour plus d’informations, se reporter au site web GDAL http://www.gdal.org/gdalwarp.html.

Extract
projection

Cet utilitaire permet d’extraire les informations de projection d’un fichier en entrée. Il peut
être utilisé en mode par lot pour extraire les projections des fichiers de tout un répertoire. Il
crée des fichiers .prj et .wld.

Conversion

Rasterize
Ce programme marque des géométries vecteur (points, lignes et polygones) dans une ou
plusieurs bandes raster d’une image. Les vecteurs utilisés sont dans des formats utilisés par
OGR. Notez que les données vecteur doivent être dans le même système de coordonnées; la
projection à la volée n’est pas possible. Pour plus d’informations voir
http://www.gdal.org/gdal_rasterize.html.

Poly-
gonize

Cet utilitaire crée des polygones vectoriels à partir des zones de pixels connectés partageant la
même valeur de cellule. Chaque polygone est créé avec un attribut indiquant la valeur du pixel
sous-jacent. Il créera la couche de données vectorielles en sortie si elle n’existe pas encore, le
format par défaut étant le ESRI shapefile. Pour plus d’informations, se reporter à
http://www.gdal.org/gdal_polygonize.html.

Translate
L’utilitaire de conversion permet de traduire un raster dans un autre format raster, ainsi que
d’appliquer d’autres opérations telles que le rééchantillonnage, le changement de taille des pixels
ou l’extraction d’un sous-secteur. Pour plus d’informations, se reporter à
http://www.gdal.org/gdal_translate.html.

RGB
to PCT

Ce programme va calculer une table de pseudo-couleurs (PCT) optimale à partir d’une image
RVB en utilisant un algorithme médian sur un histogramme RVB réduit. L’image sera convertie
en une image dotée de pseudo-couleurs tirées de la table de couleurs créée. Cette conversion
utilise la correction Floyd-Steinberg afin d’améliorer la qualité visuelle. Pour plus
d’informations, se reporter à http://www.gdal.org/rgb2pct.html.

PCT
to RGB

Ce programme convertit une bande de couleurs indexées en RVB. Pour plus d’informations, se
reporter à http://www.gdal.org/pct2rgb.html.

Extraction

Con-
tour

Ce programme génère un fichier de contours vectoriels à partir d’un raster d’élévation
(DEM/MNE/MNT). Pour plus d’informations, se reporter à
http://www.gdal.org/gdal_contour.html.

Clip-
per

Cet utilitaire vous permet d’extraire une zone d’une ou plusieurs images selon une emprise de
coordonnées ou selon une couche de masquage. Pour plus d’informations, se reporter à
http://www.gdal.org/gdal_translate.html.
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Analyse

Sieve Cet utilitaire efface les surfaces rasters plus petites que la taille donnée (en pixel) et les
remplace par la valeur de la surface voisine la plus importante. Le résultat peut être
appliqué à la bande raster existante ou être sauvegardé dans un nouveau fichier. Pour plus
d’informations, se reporter à http://www.gdal.org/gdal_sieve.html.

Near
Black

Cet utilitaire scanne une image et essaye de convertir les pixels qui sont dans une couleur
presque noire (ou presque blanche) dans une couleur noire totale (ou blanche). Cela permet
de corriger des images compressés afin de pouvoir spécifier une couleur comme
transparente. Pour plus d’informations, se reporter à http://www.gdal.org/nearblack.html.

Fill
nodata

Cet utilitaire remplit des zones sélectionnées d’un raster (le plus souvent des pixels
‘no-data’) en interpolant les valeurs des pixels valides en bordure de zone. Pour plus
d’informations, se reporter à http://www.gdal.org/gdal_fillnodata.html.

Proximity Cet utilitaire génère une carte raster de proximité qui indique la distance entre le centre de
chaque pixel et le centre du pixel le plus proche qui est désigné comme un pixel cible. Les
cibles sont les pixels qui correspondent à une valeur de pixel précise. Pour plus
d’informations, se reporter à http://www.gdal.org/gdal_proximity.html.

Grid (In-
terpolation)

Ce programme créé une grille régulière (raster) depuis les données sources. Les données
sources peuvent être interpolées afin de remplir les nœuds de la grille avec des valeurs et
vous pouvez choisir parmi plusieurs méthodes d’interpolation. Pour plus d’informations, se
reporter à http://www.gdal.org/gdal_grid.html.

DEM
(Terrain
models)

Outils pour l’analyse et la visualisation de MNT. Il est possible de créer un raster
d’ombrage, de pente, d’aspect, de relief coloré, d’Indice de Rugosité du terrain (TRI),
d’Indice de Position Topographique (TPI) et de rugosité depuis tous les types de format
raster supportés par GDAL. Pour plus d’informations, voir
http://www.gdal.org/gdaldem.html.

Divers

Build Virtual
Raster (Catalog)

Ce programme construit un VRT (un fichier virtuel) qui affiche en mosaïque une liste de
rasters GDAL. Pour plus d’informations, se reporter à
http://www.gdal.org/gdalbuildvrt.html.

Merge Ce programme fusionnera automatiquement une série d’images. Toutes les images
doivent avoir le même système de coordonnées et posséder le même nombre de bandes,
elles peuvent se superposer ou être de résolutions différentes. Dans les zones de
superposition, la dernière image de la liste sera copiée sur les autres. Pour plus
d’informations, se reporter à http://www.gdal.org/gdal_merge.html.

Information Ce programme liste les diverses informations d’un raster supporté par GDAL. Pour plus
d’informations, se reporter à http://www.gdal.org/gdalinfo.html.

Build
Overviews

Ce programme permet de construire ou de reconstruire des aperçus (pyramides) pour
une image selon plusieurs algorithmes. Pour plus d’informations, se reporter à
http://www.gdal.org/gdaladdo.html.

Tile Index Ce programme construit un shapefile où chaque entité correspond à un fichier raster,
avec un champ attribut contenant le nom du fichier et une géométrie de type polygone
correspondant à l’emprise du raster. Pour plus d’informations, se reporter à
http://www.gdal.org/gdaltindex.html.
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Paramètres de GDALTools

Cette fenêtre permet de définir vos propres variables GDAL.

.

19.9 Extension de géoréférencement

L’extension de géoréférencement est un outil permettant de renseigner les coordonnées de rasters en générant les
fichiers “world” (fichiers de référence indiquant les paramètres de translation, rotation et mise à l’échelle) ou de les
transformer dans un nouveau système. La première étape pour le géoréférencement d’une image est de localiser,
sur le raster, des points dont vous pouvez déterminer les coordonnées avec précision.

Fonctionnalités

Bouton Description Bouton Description

Ouvrir un raster Commencer le géoréférencement

Générer le script GDAL Charger les points de contrôle

Sauvegarder les points de contrôle Paramètres de transformation

Ajouter un point Effacer un point

Déplacer un point Se déplacer

Zoom + Zoom -

Zoom sur la couche Zoom précédent

Zoom suivant Link Georeferencer to QGIS

Link QGIS to Georeferencer Histogramme complet

Histogramme de l’emprise locale

Table Géoréférenceur 1: Outils de géoréférencement

19.9.1 Procédures courantes

Pour déterminer des coordonnées X et Y (notées en DMS (dd mm ss.ss), DD (dd.dd) ou en coordonnées projetées
(mmmm.mm)) qui correspondent au point sélectionné sur l’image, deux procédures peuvent être suivies :

• Par le raster lui-même : quelquefois les coordonnées sont littéralement écrites (p. ex., les graticules). Dans
ce cas, vous pouvez les saisir manuellement.

• Using already georeferenced layers. This can be either vector or raster data that contain the same ob-
jects/features that you have on the image that you want to georeference and with the projection that you
want for your image. In this case, you can enter the coordinates by clicking on the reference dataset loaded
in the QGIS map canvas.

La procédure standard pour le géoréférencement d’une image implique la sélection de plusieurs points sur le raster,
en spécifiant leurs coordonnées et en choisissant la transformation appropriée. En se basant sur les paramètres
entrés et les données, l’extension calculera les paramètres du fichier “world”. Plus il y a de coordonnées fournies,
meilleur sera le résultat.

The first step is to start QGIS, load the Georeferencer Plugin (see La fenêtre des Extensions) and click on Raster
→ Georeferencer , which appears in the QGIS menu bar. The Georeferencer Plugin dialog appears as shown in
figure_georeferencer_1.
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En guise d’exemple, nous allons utiliser une carte topographique du Dakota du Sud publiée par le SDGS. Elle
pourra par la suite être affichée avec les données du secteur GRASS spearfish60. Cette carte topographique peut
être téléchargée à l’adresse suivante : http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.

Figure 19.17: Fenêtre de Géoréférencement

Saisir des points de contrôle (GCP)

1. To start georeferencing an unreferenced raster, we must load it using the button. The raster will show
up in the main working area of the dialog. Once the raster is loaded, we can start to enter reference points.

2. Using the Add Point button, add points to the main working area and enter their coordinates (see Figure
figure_georeferencer_2). For this procedure you have three options:

• En cliquant en un point de la carte raster et entrant les coordonnées X et Y manuellement.

• Click on a point in the raster image and choose the From map canvas button to add the X and Y
coordinates with the help of a georeferenced map already loaded in the QGIS map canvas.

• With the button, you can move the GCPs in both windows, if they are at the wrong place.

3. Continuez d’entrer des points jusqu’à en avoir au moins quatre. Des outils additionnels situés dans la partie
supérieure de cette fenêtre permettent de zoomer et de se déplacer dans l’espace de travail.

The points that are added to the map will be stored in a separate text file ([filename].points) usually
together with the raster image. This allows us to reopen the Georeferencer plugin at a later date and add new
points or delete existing ones to optimize the result. The points file contains values of the form: mapX, mapY,

pixelX, pixelY. You can use the Load GCP points and Save GCP points as buttons to manage the files.
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Figure 19.18: Ajout de points de contrôle à l’image raster

Configurer la transformation

Après avoir ajouté vos points de contrôle, vous devez sélectionner la méthode de transformation qui sera utilisée
pour le géoréférencement.

Figure 19.19: Définition des paramètres de la transformation pour le géoréférencement

Algorithmes de transformation disponibles

Selon le nombre de points que vous saisissez, vous aurez à utiliser différents algorithmes de transformation. Le
choix d’un algorithme dépend aussi du type et de la qualité de vos sources de données et du niveau de distorsion
géométrique que vous êtes prêt à accepter dans le résultat final.

Actuellement les types de transformation suivants sont disponibles :

• L’algorithme Linéaire est utilisé pour créer un fichier world. Il est différent des autres algorithmes en ce sens
qu’il ne transforme pas le raster. Cet algorithme ne sera vraisemblablement pas suffisant pour géoréférencer
des données scannées.

• L’algorithme Helmert applique de simples translation, rotation et mise à l’échelle.
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• The Polynomial algorithms 1-3 are among the most widely used algorithms introduced to match source
and destination ground control points. The most widely used polynomial algorithm is the second-order
polynomial transformation, which allows some curvature. First-order polynomial transformation (affine)
preserves colliniarity and allows scaling, translation and rotation only.

• L’algorithme Thin Plate Spline (TPS) est une méthode plus moderne qui est capable d’introduire des dé-
formations sur des secteurs précis de l’image. Il est très pratique quand des sources de faible qualité sont
utilisées.

• L’algorithme Projective est une rotation linéaire puis une translation des coordonnées.

Définir la méthode de rééchantillonage

Le type de ré-échantillonnage à effectuer dépendra de votre donnée en entrée et de l’objectif de l’exercice. Si
vous ne voulez pas changer les statistiques de l’image, vous devriez sélectionner la méthode du plus proche voisin
tandis que le ré-échantillonnage cubique produira un résultat plus lisse.

Il est possible de choisir entre 5 méthodes de ré-échantillonnage :

1. Au plus proche voisin

2. Linéaire

3. Cubique

4. Cubic Spline

5. Lanczos

Définir les paramètres de transformation

Plusieurs paramètres doivent être renseignés afin de créer un raster géoréférencé.

• La case Créer un fichier de coordonnées est uniquement disponible lorsque la méthode de transformation
linéaire est choisie, et ce, parce que votre image ne sera alors pas transformée en sortie. Dans ce cas précis,
le champ raster de sortie ne sera pas activé, car seul le fichier de coordonnées sera créé.

• Pour tous les autres types de transformations, vous pouvez saisir un Raster de sortie. Par défaut, le nouveau
fichier s’intitulera ([nomdefichier]_georef) et sera enregistré dans le même répertoire que le raster original.

• L’étape suivante est la définition du SCR cible pour le raster géoréférencé (lire Utiliser les projections).

• Si vous le désirez, vous pouvez demander à générer une carte PDF ou générer un rapport PDF qui inclut
tous les paramètres définis ainsi qu’une image avec tous les résidus et une liste des points de contrôles et
leurs erreurs RMS.

• Vous pouvez cocher la case Définir la résolution de la cible et préciser la résolution de pixel du raster
généré. La résolution horizontale et verticale par défaut est de 1.

• Lorsque la case Employer 0 pour la transparence si nécessaire est cochée, cela indique que la valeur 0
sera transparente lors de la visualisation. Dans notre exemple, toutes les zones blanches seront transparentes.

• Finally, Load in QGIS when done loads the output raster automatically into the QGIS map canvas when
the transformation is done.

Afficher et modifier les propriétés raster

En cliquant sur Propriétés du raster dans le menu Paramètres s’ouvre la fenêtre des propriétés du raster que vous
voulez géoréférencer.
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Configurer le géoreferenceur

• You can define whether you want to show GCP coordiniates and/or IDs.

• Les résidus peuvent être exprimés en unités de la carte ou en pixel.

• Vous pouvez modifier les marges et la taille de papier du rapport PDF.

• Enfin, vous pouvez aussi activer la case Afficher la fenêtre de géoréférencement dans la fenêtre princi-
pale.

Lancer la transformation

After all GCPs have been collected and all transformation settings are defined, just press the Start georeferencing

button to create the new georeferenced raster.

.

19.10 Extension Carte de chaleur

The Heatmap plugin uses Kernel Density Estimation to create a density (heatmap) raster of an input point vector
layer. The density is calculated based on the number of points in a location, with larger numbers of clustered
points resulting in larger values. Heatmaps allow easy identification of “hotspots” and clustering of points.

19.10.1 Activer l’extension Carte de chaleur

D’abord, cette extension principale doit être activée en utilisant le Gestionnaire d’Extensions (consultez La fenêtre

des Extensions). Après activation, l’icône de carte de chaleur est disponible dans la barre d’outil Raster et
sous le menu Raster → Heatmap.

Sélectionnez le menu Vue → Barre d’outils → Raster pour afficher la barre d’outils Raster si elle n’est pas visible.

19.10.2 Utiliser l’extension Carte de chaleur

En cliquant sur le bouton Carte de chaleur vous ouvrez la fenêtre de l’extension Carte de chaleur (voir
figure_heatmap_2).

Cette fenêtre a les options suivantes:

• Couche de points de saisie : liste toutes les couches ponctuelles chargées dans le projet actuel et permet de
sélectionner la couche à analyser.

• Output raster: Allows you to use the button to select the folder and filename for the output raster
the Heatmap plugin generates. A file extension is not required.

• Output format: Selects the output format. Although all formats supported by GDAL can be choosen, in
most cases GeoTIFF is the best format to choose.

• Rayon : utilisé pour définir le rayon de recherche de la carte de chaleur (ou bande passante du noyau) en
mètre ou en unité de carte. Le rayon définit la distance autour d’un point au delà de laquelle l’influence d’un
point sera nul. Les valeurs les plus grandes résultent en un plus grand lissage, mais des valeurs plus petites
génèrent plus de détails et de variations en densité de points.

Lorsque la case Avancé est cochée, des options supplémentaires sont disponibles :
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• Lignes et Colonnes : utilisé pour modifier les dimensions du raster en sortie. Ces valeurs sont aussi liées
aux valeurs Taille en X et Taille en Y. Augmenter le nombre de lignes ou de colonnes diminuera la taille
de la cellule et augmentera la taille du fichier en sortie. Les valeurs de lignes et de colonnes sont aussi
liées, donc, doubler le nombre de lignes doublera automatiquement le nombre de colonnes et les tailles des
cellules seront aussi diminuées de moitié. La zone géographique du raster en sortie restera la même !

• Taille en X et Taille en Y : contrôle la taille géographique de chaque pixel dans le raster sortie. Changer
ces valeurs changera le nombre de lignes et de colonnes dans le raster en sortie.

• Kernel shape: The kernel shape controls the rate at which the influence of a point decreases as the distance
from the point increases. Different kernels decay at different rates, so a triweight kernel gives features
greater weight for distances closer to the point then the Epanechnikov kernel does. Consequently, triweight
results in “sharper” hotspots, and Epanechnikov results in “smoother” hotspots. A number of standard
kernel functions are available in QGIS, which are described and illustrated on Wikipedia.

• Taux de décroissance: peut être utilisé avec les noyaux triangulaires afin de mieux contrôler comment la
chaleur à partir d’une entité diminue avec la distance à partir de l’entité.

– Une valeur de 0 ( = minimum) indique que la chaleur sera concentrée au centre du rayon donné et
complètement nulle au bord.

– Une valeur de 0.5 indique que les pixels au bord du rayon seront à la moitié de la chaleur des pixels
au centre du rayon de recherche.

– Une valeur de 1 indique que la chaleur sera répartie uniformément sur tout le cercle formé par le rayon
de recherche. (C’est l’équivalent du noyau ‘Uniforme’.)

– Une valeur supérieure à 1 indique que la chaleur sera plus importante au bord du cercle formé par le
rayon de recherche qu’au centre.

Les champs attributaires de la couche de points en entrée peuvent permettre de paramétrer la carte de chaleur :

• Utiliser le rayon depuis : permet de définir le champ de la table d’attributs à partir duquel le rayon de
recherche sera défini.

• Utiliser le poids depuis : identifie le champ de la table d’attributs indiquant la pondération à utiliser. Ce
paramètre permet d’augmenter l’importance de certaines entités sur le résultat.

Quand la couche raster de sortie est renseignée, le bouton [OK] est actionné pour créer la carte de chaleur.

19.10.3 Tutorial : Créer une carte de chaleur

For the following example, we will use the airports vector point layer from the QGIS sample dataset
(see Échantillon de données). Another exellent QGIS tutorial on making heatmaps can be found at
http://qgis.spatialthoughts.com.

La figure Figure_Heatmap_1 montre les aéroports de l’Alaska.

1. Sélectionnez le bouton |heatmap|‘Carte de chaleur‘ pour ouvrir la fenêtre de l’extension (voir Fig-
ure_Heatmap_2).

2. In the Input point layer field, select airports from the list of point layers loaded in the current
project.

3. Specify an output filename by clicking the button next to the Output raster field. Enter the filename
heatmap_airports (no file extension is necessary).

4. Laissez la valeur par défaut, GeoTIFF, dans le champ Format en sortie.

5. Changez le Rayon à 1000000 mètres.

6. Cliquez sur [OK] pour créer et charger la carte de chaleur des aéroports (voir Figure_Heatmap_3).

QGIS will generate the heatmap and add the results to your map window. By default, the heatmap is shaded in
greyscale, with lighter areas showing higher concentrations of airports. The heatmap can now be styled in QGIS
to improve its appearance.
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Figure 19.20: Airports of Alaska

Figure 19.21: The Heatmap Dialog
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Figure 19.22: The heatmap after loading looks like a grey surface

1. Ouvrez les propriétés de la couche chaleur_aéroports (sélectionnez la couche
chaleur_aeroports, faites un clic-droit et dans le menu qui apparaît, sélectionnez Propriétés).

2. Sélectionner l’onglet Style.

3. Change the Render type to ‘Singleband pseudocolor’.

4. Select a suitable Color map , for instance YlOrRed.

5. Cliquez sur le bouton [Charger] pour récupérer les valeurs minimale et maximale du raster puis cliquez sur
le bouton [Classer].

6. Pressez [OK] pour mettre à jour la couche.

La figure Figure_Heatmap_4 montre le résultat obtenu.

.

19.11 Extension Interpolation

The Interplation plugin can be used to generate a TIN or IDW interpolation of a point vector layer. It is very
simple to handle and provides an intuitive graphical user interface for creating interpolated raster layers (see
Figure_interpolation_1). The plugin requires the following parameters to be specified before running:

• Input Vector layers: Specify the input point vector layer(s) from a list of loaded point layers. If several
layers are specified, then data from all layers is used for interpolation. Note: It is possible to insert lines or
polygons as constraints for the triangulation, by specifying either “points”, “structure lines” or “break lines”

in the Type combo box.

• Attribut d’interpolation : sélectionner la colonne attributaire à utiliser pour l’interpolation ou cocher la

case Utiliser les coordonnées Z pour l’interpolation afin d’utiliser une couche contenant des valeurs Z.

• Interpolation Method: Select the interpolation method. This can be either ‘Triangulated Irregular Network
(TIN)’ or ‘Inverse Distance Weighted (IDW)’. With the TIN method you can create a surface formed by
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Figure 19.23: Styled heatmap of airports of Alaska

triangles of nearest neighbour points. To do this, circumcircles around selected sample points are created
and their intersections are connected to a network of non overlapping and as compact as possible triangles.
The resulting surfaces are not smooth. When using the IDW method the sample points are weighted during
interpolation such that the influence of one point relative to another declines with distance from the unknown
point you want to create. The IDW interpolation method also has some disadvantages: the quality of the
interpolation result can decrease, if the distribution of sample data points is uneven. Furthermore, maximum
and minimum values in the interpolated surface can only occur at sample data points. This often results in
small peaks and pits around the sample data points.

• Nombre de colonnes/cellules : définir le nombre de colonnes et de lignes du raster de sortie.

• Fichier en sortie : attribuer un nom au fichier raster en sortie.

• Ajouter le résultat au projet chargera automatiquement le raster de résultat dans la légende du projet en
courant.

Note that using lines as constraints for the interpolation the triangulation (TIN method) you can either use ‘struc-
ture lines’ or ‘break lines’. When using ‘break lines’ you produce sharp breaks in the surface while using ‘structure
lines’ you produce continous breaks. The triangulation is modified by both methods such that no edge crosses a
breakline or structure line.

19.11.1 Mettre en œuvre l’extension

1. Start QGIS and load a point vector layer (e.g., elevp.csv).

2. Load the Interpolation plugin in the Plugin Manager (see La fenêtre des Extensions) and click on the Raster

→ Interpolation → Interpolation , which appears in the QGIS menu bar. The Interpolation plugin
dialog appears as shown in Figure_interpolation_1.

3. Select an input layer (e.g., elevp ) and column (e.g., ELEV) for interpolation.

4. Sélectionnez une méthode d’interpolation (par exemple, ‘Interpolation Triangulaire (TIN)’), puis définissez
le nombre de colonnes et de cellules, par exemple, 5000 ainsi qu’un nom pour le fichier raster de sortie (par
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Figure 19.24: Interpolation Plugin

exemple, elevation_tin).

5. Appuyez sur [Ok].

.

19.12 Client MetaSearch pour les Services de Catalogage

19.12.1 Introduction

MetaSearch est une extension QGIS permettant d’interagir avec des services de catalogage de données.
MetaSearch supporte le standard OGC CSW (Catalogue Service for the Web)

MetaSearch fournit une approche simple et intuitive ainsi qu’une interface conviviale pour la recherche de cata-
logues de métadonnées depuis QGIS.

19.12.2 Installation

MetaSearch is included by default with QGIS 2.0 and higher. All dependencies are included within MetaSearch.

Installer MetaSearch depuis le gestionnaire d’extensions QGIS, ou manuellement depuis
http://plugins.qgis.org/plugins/MetaSearch.
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19.12.3 Travailler avec des Catalogues de Métadonnées dans QGIS

CSW (Catalogue Service for the Web)

CSW (Catalogue Service for the Web) is an OGC (Open Geospatial Consortium) specification, that defines com-
mon interfaces to discover, browse, and query metadata about data, services, and other potential resources.

Démarrage

To start MetaSearch, click the MetaSearch icon or select Web / MetaSearch / MetaSearch via the QGIS main
menu. The MetaSearch dialog will appear. The main GUI consists of two tabs: ‘Services’ and ‘Search’.

Gérer les Services de Catalogage

The ‘Services’ tab allows the user to manage all available catalogue services. MetaSearch provides a default list
of Catalogue Services, which can be added by pressing ‘Add default services’ button.

Pour la liste complète des Services de Catalogage, cliquer sur la liste déroulante.

To add a Catalogue Service entry, click the ‘New’ button, and enter a Name for the service, as well as the
URL/endpoint. Note that only the base URL is required (not a full GetCapabilities URL). Clicking ok will add
the service to the list of entries.

To edit an existing Catalogue Service entry, select the entry you would like to edit and click the ‘Edit’ button, and
modify the Name or URL values, then click ok.

To delete a Catalogue Service entry, select the entry you would like to delete and click the ‘Delete’ button. You
will be asked to confirm deleting the entry.

MetaSearch allows for loading and saving connections to an XML file. This is useful when you need to share
settings between applications. Below is an example of the XML file format.

<?xml version="1.0" encoding="UTF-8"?>
<qgsCSWConnections version="1.0">

<csw name="Data.gov CSW" url="http://catalog.data.gov/csw-all"/>
<csw name="Geonorge - National CSW service for Norway" url="http://www.geonorge.no/geonetwork/srv/eng/csw"/>
<csw name="Geoportale Nazionale - Servizio di ricerca Italiano" url="http://www.pcn.minambiente.it/geoportal/csw"/>
<csw name="LINZ Data Service" url="http://data.linz.govt.nz/feeds/csw"/>
<csw name="Nationaal Georegister (Nederland)" url="http://www.nationaalgeoregister.nl/geonetwork/srv/eng/csw"/>
<csw name="RNDT - Repertorio Nazionale dei Dati Territoriali - Servizio di ricerca" url="http://www.rndt.gov.it/RNDT/CSW"/>
<csw name="UK Location Catalogue Publishing Service" url="http://csw.data.gov.uk/geonetwork/srv/en/csw"/>
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<csw name="UNEP/GRID-Geneva Metadata Catalog" url="http://metadata.grid.unep.ch:8080/geonetwork/srv/eng/csw"/>
</qgsCSWConnections>

To load a list of entries, click the ‘Load’ button. A new window will appear; click the ‘Browse’ button and
navigate to the XML file of entries you wish to load and click ‘Open’. The list of entries will be displayed. Select
the entries you wish to add from the list and click ‘Load’.

The ‘Service info’ button displays information about the selected Catalogue Service such as service identification,
service provider and contact information. If you would like to view the raw XML response, click the ‘GetCapa-
bilities response’ button. A separate window will open displaying Capabilities XML.

Recherche de Services de Catalogage

The ‘Search’ tab allows the user to query Catalogue Services for data and services, set various search parameters
and view results.

Les paramètres de recherche suivants sont disponibles :

• Keywords: free text search keywords

• From: the Catalogue Service to perform the query against

• Bounding box: the spatial area of interest to filter on. The default bounding box is the map view / canvas.
Click ‘Set global’ to do a global search, or enter custom values as desired

• Records: the number of records to return when searching. Default is 10 records

Clicking the ‘Search’ button will search the selected Metadata Catalogue. Search results are displayed in a list and
are sortable by clicking on the column title. You can navigate through search results with the directional buttons
below the search results. Clicking the ‘View search results as XML’ button opens a window with the service
response in raw XML format.

Clicking a result will show the record’s abstract in the ‘Abstract’ window and provides the following options:

• si l’élément de métadonnée a une zone géographique associée, l’empreinte de cette zone géographique sera
visible sur la carte

• double-cliquer sur l’enregistrement affiche l’élément de métadonnée ainsi que les hyperliens associés. Cli-
quer sur un lien l’ouvre dans le navigateur internet de l’utilisateur

• if the record is an OGC web service (WMS/WMTS, WFS, WCS), the appropriate ‘Add to
WMS/WMTS|WFS|WCS’ buttons will be enabled for the user to add to QGIS. When clicking this but-
ton, MetaSearch will verify if this is a valid OWS. The OWS will then be added to the appropriate QGIS
connection list, and the appropriate WMS/WMTS|WFS|WCS connection dialogue will then appear
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Paramètres

You can fine tune MetaSearch with the following settings:

• Connection naming: when adding an OWS connection (WMS/WMTS|WFS|WCS), the connection is
stored with the various QGIS layer provider. Use this setting to set whether to use the name provided
from MetaSearch, whether to overwrite or to use a temporary name

• Results paging: when searching metadata catalogues, the number of results to show per page

• Timeout: when searching metadata catalogues, the number of seconds for blocking connection attempt.
Default value is 10

.

19.13 Extension d’Édition hors-ligne

Pour les collectes de données, il est commun d’aller sur le terrain avec un ordinateur ou un téléphone portable. De
retour sur le réseau, les modifications doivent être synchronisées avec la source de données initiale (par exemple
une base de données PostGIS). Si plusieurs personnes travaillent ensembles sur les mêmes jeux de données, il est
difficile de fusionner les éditions à la main, même si les utilisateurs ne changent pas les mêmes entités.

The Offline Editing Plugin automates the synchronisation by copying the content of a datasource (usually PostGIS
or WFS-T) to a SpatiaLite database and storing the offline edits to dedicated tables. After being connected to the
network again, it is possible to apply the offline edits to the master dataset.

19.13.1 Utiliser l’extension

• Ouvrez des couches vecteurs (par exemple d’une source de données PostGIS ou WFS-T).

• Sauvez-les dans un projet.

• Go to Database → Offline Editing → Convert to offline project and select the layers to save. The content
of the layers is saved to SpatiaLite tables.

• Éditez les couches hors-ligne.

• After being connected again, upload the changes using Database → Offline Editing → Synchronize.
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Figure 19.25: Crée un projet hors ligne depuis PostGIS ou des couches WFS

.

19.14 Extension GeoRaster Oracle Spatial

In Oracle databases, raster data can be stored in SDO_GEORASTER objects available with the Oracle Spatial

extension. In QGIS, the Oracle Spatial GeoRaster plugin is supported by GDAL and depends on Oracle’s database
product being installed and working on your machine. While Oracle is proprietary software, they provide their
software free for development and testing purposes. Here is one simple example of how to load raster images to
GeoRaster:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

Le raster va être chargé dans la table par défaut, GDAL_IMPORT, en tant que colonne nommée RASTER.

19.14.1 Gérer les connexions

Firstly, the Oracle GeoRaster Plugin must be enabled using the Plugin Manager (see La fenêtre des Extensions).
The first time you load a GeoRaster in QGIS, you must create a connection to the Oracle database that contains

the data. To do this, begin by clicking on the Add Oracle GeoRaster Layer toolbar button – this will open the Select
Oracle Spatial GeoRaster dialog window. Click on [New] to open the dialog window, and specify the connection
parameters (See Figure_oracle_raster_1):

• Nom : Entrez un nom pour la connexion.

• Instance de base de données : Entrez le nom de la base de données à laquelle vous voulez vous connecter.

• Nom d’utilisateur : Indiquez le nom d’utilisateur permettant de se connecter à la base de données.
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• Mot de passe : Saisissez le mot de passe associé au nom d’utilisateur.

Figure 19.26: Créer une boite de dialogue de connexion Oracle

Dans la fenêtre principale GeoRaster Oracle Spatial (voir Figure_oracle_raster_2), utilisez la liste déroulante
pour choisir une connexion, et cliquez sur [Connecter] pour accéder à la base de données. Vous pouvez égale-
ment éditer les paramètres de connexion en cliquant sur [Éditer], ou supprimer la connexion en choisissant [Sup-
primer].

19.14.2 Sélection d’un GeoRaster

Une fois connecté, les noms des tables de la base contenant des colonnes GeoRaster compatibles au format GDAL
vont s’afficher dans la fenêtre des sous-jeux de données.

Cliquez sur l’un de ces sous-jeux de données puis sur [Sélectionner] pour choisir la table. Une nouvelle liste
affiche maintenant les noms des colonnes GeoRaster dans cette table, il s’agit généralement d’une courte liste car
la plupart des utilisateurs n’ont pas plus d’une ou deux colonnes GeoRaster dans une même table.

Cliquez sur l’une des sous-jeux puis sur [Sélectionner] pour choisir une combinaison d’une table et d’une colonne
La fenêtre montrera alors toutes les lignes contenant un objet GeoRaster Vous remarquerez que la liste affichera
la table de données raster et les identifiants Raster.

A tout moment la sélection peut être éditée manuellement pour pointer directement le GeoRaster voulu ou re-
tourner au début pour prendre une autre table.

L’entrée de sélection de données peut également être utilisée pour définir une clause WHERE à la fin de la
chaîne d’identification (par exemple geor:scott/tiger@orcl,gdal_import,raster,geoid=). Voir
la page http://www.gdal.org/frmt_georaster.html pour plus d’information.

19.14.3 Afficher un GeoRaster

Finally, by selecting a GeoRaster from the list of Raster Data Tables and Raster Ids, the raster image will be loaded
into QGIS.

La fenêtre de Sélection de GeoRaster Oracle Spatial peut maintenant être fermée, la connexion sera conservée
pour une prochaine ouverture, la même liste de sous-jeux de données sera ainsi disponible, ce qui facilitera
l’affichage de nouvelles images dans le même contexte.

Note: GeoRasters that contain pyramids will display much faster, but the pyramids need to be generated outside
of QGIS using Oracle PL/SQL or gdaladdo.

L’exemple suivant utilise gdaladdo:

gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 -r
nearest 2 4 6 8 16 32

Cet exemple utilise PL/SQL:
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Figure 19.27: Sélectionner la boîte de dialogue GeoRaster d’Oracle

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

.

19.15 Extension d’Analyse Raster de Terrain

The Raster Terrain Analysis Plugin can be used to calculate the slope, aspect, hillshade, ruggedness index
and relief for digital elevation models (DEM). It is very simple to handle and provides an intuitive graphical user
interface for creating new raster layers (see Figure_raster_terrain_1).

Description de l’analyse:

• Pente : Calcule l’angle de la pente pour chaque cellule (en degrés, en se basant sur une estimation dérivée
de 1er ordre).

• Aspect: Calcule l’exposition (en degrés dans le sens horaire inverse et en commençant par 0 pour une
direction nord).

• Ombrage : crée une carte ombragée en utilisant la lumière et les ombres pour fournir un apparence plus
tri-dimensionnelle à une carte de relief ombragé. La carte produite est mono-bande en dégradé de gris
correspondant aux valeurs de gris des pixels.

• Facteur de rugosité : Une mesure quantitative de l’hétérogénéité du terrain, tel que décrit par Riley et al.
(1999). Elle est calculée en tout point en mesurant les changements d’élévation dans une grille de 3 par 3
pixels.
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• Relief : crée une carte de relief ombragé à partir de données numériques d’élévation. La méthode implé-
mentée permet de choisir les couleurs des élévations par l’analyse de la distribution des fréquences. La carte
produite est multibandes en couleur ayant trois bandes correspondant aux valeurs RVB du relief ombragé.

Figure 19.28: Extension d’Analyse Raster de Terrain (calcul de pente)

19.15.1 Mettre en oeuvre l’extension

1. Start QGIS and load the gtopo30 raster layer from the GRASS sample location.

2. Chargez l’extension via le Gestionnaire d’Extension (voir La fenêtre des Extensions).

3. Sélectionnez une méthode d’analyse (par exemple, Raster → Analyse de Terrain → Pente). La fenêtre Pente
apparaît comme indiqué sur Figure_raster_terrain_1.

4. Spécifiez un chemin de sortie et le type de fichier produit.

5. Cliquez sur le bouton [OK].

.

19.16 Extension Graphe routier

The Road Graph Plugin is a C++ plugin for QGIS that calculates the shortest path between two points on any
polyline layer and plots this path over the road network.

Fonctionnalités principales:

• Calcule le chemin, sa longueur et le temps de trajet.

• Optimise par la longueur ou par le temps de trajet.

• Exporte le chemin en couche vectorielle.

• Met en couleur les directions de la route (cette option est lente et surtout utile pour déboguer et pour tester
le paramétrage).

As a roads layer, you can use any polyline vector layer in any QGIS-supported format. Two lines with a common
point are considered connected. Please note, it is required to use layer CRS as project CRS while editing a roads
layer. This is due to the fact that recalculation of the coordinates between different CRSs introduces some errors
that can result in discontinuities, even when ‘snapping’ is used.

Dans la table attributaire de la couche, les champs suivants peuvent être utilisés:

• Vitesse sur la section de route (champ numérique).

• Direction (n’importe quel type qui peut être écrit en chaîne de caractères). Les directions avant et arrière de
la géométrie correspondent à une route à sens unique, les deux directions à une route à double sens.

Si des champs n’ont pas de valeur ou n’existent pas, les valeurs par défaut sont utilisées. Vous pouvez modifier
ces valeurs par défaut ainsi que d’autres options dans la fenêtre de paramétrage de l’extension.
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Figure 19.29: Road Graph Plugin

19.16.1 Usage

After plugin activation, you will see an additional panel on the left side of the main QGIS window. Now, en-
ter some parameters into the Road graph plugin settings dialog in the Vector → Road Graph menu (see fig-
ure_road_graph_2).

Après avoir configuré Unité de temps, Unité de distance et Tolérance topologique, vous pouvez choisir la couche
vectorielle dans l’onglet Couche de transport. Là, vous pouvez aussi indiquer le Champ de direction et le Champ
de vitesse. Dans l’onglet Paramètres par défaut, vous pouvez indiquer la Direction pour les calculs.

Enfin, dans le panneau Chemin le plus court, sélectionnez un point d’origine et un point de destination sur la
couche du réseau routier et cliquez sur bouton [Calculer].

.

19.17 Extension Requête Spatiale

The Spatial Query Plugin allows you to make a spatial query (i.e., select features) in a target layer with reference to
another layer. The functionality is based on the GEOS library and depends on the selected source feature layer.

Les opérateurs disponibles sont :

• Contient

• Egale

• Recouvre

• Croise

• Intersecte
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Figure 19.30: Road graph plugin settings

• Est disjoint

• Touche

• Est à l’intérieur

19.17.1 Mettre en oeuvre l’extension

Nous souhaitons par exemple trouver les régions dans le jeu de données Alaska qui ont des aéroports. Les étapes
suivantes sont à effectuer :

1. Start QGIS and load the vector layers regions.shp and airports.shp.

2. Load the Spatial Query plugin in the Plugin Manager (see La fenêtre des Extensions) and click on the
Spatial Query icon, which appears in the QGIS toolbar menu. The plugin dialog appears.

3. Sélectionnez la couche régions comme couche source et aéroports comme couche de référence.

4. Sélectionnez ‘A l’intérieur’ comme opérateur et cliquez sur [Appliquer].

Vous obtenez alors une liste d’identifiants des entités satisfaisant la requête. Vous avez ensuite plusieurs options
comme indiqué en figure figure_spatial_query_1.

• Click on Create layer with list of items.

• Select an ID from the list and click on Create layer with selected.

• Select ‘Remove from current selection’ in the field And use the result to .

• Vous pouvez Zoom sur l’objet ou Enregistrer les messages.

• Additionally in Result Feature ID’s with the options ‘Invalid source’ and ‘Invalid reference’ you can have a
look at features with geometries errors. These features aren’t used for the query.

.
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Figure 19.31: Spatial Query analysis - regions contain airports

19.18 Extension SPIT

QGIS comes with a plugin named SPIT (Shapefile to PostGIS Import Tool). SPIT can be used to load multiple
shapefiles at one time and includes support for schemas. To use SPIT, open the Plugin Manager from the Plugins

menu, in the Installed menu check the box next to the SPIT and click [OK].

To import a shapefile, use Database → Spit → Import Shapefiles to PostgreSQL from the menu bar to open the
SPIT - Shapefile to PostGIS Import Tool dialog. Select the PostGIS database you want to connect to and click on
[Connect]. If you want, you can define or change some import options. Now you can add one or more files to the
queue by clicking on the [Add] button. To process the files, click on the [OK] button. The progress of the import
as well as any errors/warnings will be displayed as each shapefile is processed. .

19.19 Extension Vérificateur de topologie

La topologie décrit les relations entre les points, lignes et polygones qui représentent des entités dans une région
géographique. Avec l’extension Vérificateur de topologie vous pouvez analyser vos couches vectorielles et leur
topologie en testant différentes règles de topologie. Ces règles permettent de vérifier les relations spatiales entre
entités, si elles ‘se superposent’, ‘se contiennent’, ‘se recouvrent’, ‘sont disjointes’, ‘se touchent’, etc. La règle à
vérifier dépend de votre problématique (par exemple, en temps normal, les lignes d’une même couche ne doivent
pas se terminer en croisant une autre ligne mais elles peuvent représenter des impasses et avoir un sens dans votre
couche).

QGIS has a built-in topological editing feature, which is great for creating new features without errors. But existing
data errors and user-induced errors are hard to find. This plugin helps you find such errors through a list of rules.

Il est très simple de créer des règles de topologie avec l’extension de vérification de topologie.

Sur les couches de points, les règles suivantes sont disponibles :
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Figure 19.32: Utilisation de l’extension SPIT pour importer un shapefile dans une base PostGIS

Figure 19.33: Extension Vérificateur de topologie
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• doit être recouvert par : Ici, vous pouvez choisir une couche vecteur de votre projet. Chaque point non
couvert par la couche choisie est signalé comme ‘Erreur’.

• doivent être recouverts par les points terminaux : Ici, vous pouvez sélectionner un point d’une couche
de votre projet.

• Must be inside: Here you can choose a polygon layer from your project. The points must be inside a
polygon. Otherwise, QGIS writes an ‘Error’ for the point.

• ne doit pas avoir de doublons : Une ‘erreur’ est signalée à chaque fois qu’un point est présent plus d’une
fois.

• ne doit pas avoir de géométrie invalide : Vérifie si les géométries sont valides.

• ne doit pas avoir de géométrie multi-partie : Une ‘erreur’ est signalée à chaque fois qu’une entité est
multi-partie.

Sur les couches de lignes, les règles suivantes sont disponibles :

• les points terminaux doivent être recouverts par : Ici, vous pouvez sélectionner une couche de points de
votre projet.

• ne doivent pas avoir de nœud isolé : Cela permet de voir les mauvaises connexions entre lignes d’une
même couche.

• ne doit pas avoir de doublons : Une ‘erreur’ est signalée à chaque fois qu’une ligne est présente plus d’une
fois.

• ne doit pas avoir de géométrie invalide : Vérifie si les géométries sont valides.

• ne doit pas avoir d’entité multi-parties : Parfois une entité correspond à une collection d’éléments
géométriques simples. Une telle géométrie est appelée multi-partie. S’il n’y a qu’un seul type de géométrie,
il s’agit de multi-points, polyligne ou multi-polygones. Toutes les entités composées de plusieurs lignes
sont signalées comme ‘Erreur’.

• Must not have pseudos: A line geometry’s endpoint should be connected to the endpoints of two other
geometries. If the endpoint is connected to only one other geometry’s endpoint, the endpoint is called a
psuedo node.

Sur les couches de polygones, les règles suivantes sont disponibles :

• doit contenir : Chacun des polygones de la couche doit contenir au moins un point d’une autre couche.

• ne doit pas avoir de doublons : Une ‘erreur’ est signalée à chaque fois qu’un polygone est présent plus
d’une fois.

• ne doit pas avoir de trou : Aucun trou ne doit être présent entre des polygones adjacents. Comme c’est
le cas par exemple pour des limites administratives (il n’y a pas de trous entre les polygones des départe-
ments...).

• ne doit pas avoir de géométrie invalide : Vérifie si les géométries sont valides. Les principales règles qui
définissent si la géométrie est valide sont :

– Les anneaux formant des trous dans des polygones doivent être fermés.

– Les anneaux formant des trous doivent être entièrement inclus dans des polygones.

– Les anneaux ne doivent pas s’intersecter (ni se toucher ni se croiser).

– Les anneaux ne doivent pas toucher d’autres anneaux, sauf en un unique sommet.

• ne doit pas avoir d’entité multi-parties : Parfois une entité correspond à une collection d’éléments
géométriques simples. Une telle géométrie est appelée multi-partie. S’il n’y a qu’un seul type de géométrie,
il s’agit de multi-points, polyligne ou multi-polygones. Par exemple, un pays constitué de plusieurs îles peut
être représenté par un multi-polygone.

• ne doit pas se superposer : Des polygones adjacents ne doivent pas présenter de partie commune.

• **ne doit pas se superposer à ** : Chacun des polygones de la couche ne doit pas intersecter un seul des
polygones d’une autre couche.

19.19. Extension Vérificateur de topologie 315



QGIS User Guide, Version 2.8

.

19.20 Extension Statistiques de zone

With the Zonal statistics plugin, you can analyze the results of a thematic classification. It allows you
to calculate several values of the pixels of a raster layer with the help of a polygonal vector layer (see fig-
ure_zonal_statistics). You can calculate the sum, the mean value and the total count of the pixels that are within a
polygon. The plugin generates output columns in the vector layer with a user-defined prefix.

Figure 19.34: Zonal statistics dialog (KDE)

.
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Aide et support

20.1 Listes de diffusion

QGIS is under active development and as such it won’t always work like you expect it to. The preferred way to
get help is by joining the qgis-users mailing list. Your questions will reach a broader audience and answers will
benefit others.

20.1.1 qgis-users

This mailing list is used for discussion of QGIS in general, as well as specific questions regarding its
installation and use. You can subscribe to the qgis-users mailing list by visiting the following URL:
http://lists.osgeo.org/mailman/listinfo/qgis-user

20.1.2 fossgis-talk-liste

For the German-speaking audience, the German FOSSGIS e.V. provides the fossgis-talk-liste mailing list. This
mailing list is used for discussion of open-source GIS in general, including QGIS. You can subscribe to the fossgis-
talk-liste mailing list by visiting the following URL: https://lists.fossgis.de/mailman/listinfo/fossgis-talk-liste

20.1.3 qgis-developer

Si vous êtes un développeur et que vous êtes face à un problème plus technique, il est préférable de rejoindre la
liste de diffusion qgis-developer : http://lists.osgeo.org/mailman/listinfo/qgis-developer

20.1.4 qgis-commit

Each time a commit is made to the QGIS code repository, an email is posted to this list. If you
want to be up-to-date with every change to the current code base, you can subscribe to this list at:
http://lists.osgeo.org/mailman/listinfo/qgis-commit

20.1.5 qgis-trac

Cette liste envoie une notification par courriel liée à la gestion du projet, incluant les rapports de bugs, tâches et de-
mandes de fonctionnalités. Vous pouvez vous inscrire à cette liste ici : http://lists.osgeo.org/mailman/listinfo/qgis-
trac
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20.1.6 qgis-community-team

Cette liste reçoit les courriels des thématiques liés à la documentation, aux aides contextuelles, au guide util-
isateur, aux listes de diffusion, forums et efforts de traduction. Si vous voulez travailler sur le guide utilisateur,
cette liste est un bon point de départ pour poser vos questions. Vous pouvez vous inscrire à cette liste ici :
http://lists.osgeo.org/mailman/listinfo/qgis-community-team

20.1.7 qgis-release-team

Cette liste reçoit les courriels concernant les procédures de publication de versions, paquetages binaires pour
différents systèmes d’exploitation et annonce les nouvelles versions à une plus large audience. Vous pouvez vous
inscrire à cette liste ici : http://lists.osgeo.org/mailman/listinfo/qgis-release-team

20.1.8 qgis-tr

This list deals with the translation efforts. If you like to work on the translation of the manuals or the graphical
user interface (GUI), this list is a good starting point to ask your questions. You can subscribe to this list at:
http://lists.osgeo.org/mailman/listinfo/qgis-tr

20.1.9 qgis-edu

This list deals with QGIS education efforts. If you would like to work on QGIS education ma-
terials, this list is a good starting point to ask your questions. You can subscribe to this list at:
http://lists.osgeo.org/mailman/listinfo/qgis-edu

20.1.10 qgis-psc

This list is used to discuss Steering Committee issues related to overall management and direction of QGIS. You
can subscribe to this list at: http://lists.osgeo.org/mailman/listinfo/qgis-psc

You are welcome to subscribe to any of the lists. Please remember to contribute to the list by answering questions
and sharing your experiences. Note that the qgis-commit and qgis-trac lists are designed for notification only and
are not meant for user postings.

20.2 IRC

Nous maintenons une présence sur IRC - rejoignez-nous sur le canal #qgis sur irc.freenode.net. Faites preuve de
patience avant d’obtenir une réponse puisque la plupart des personnes font autre chose et cela peut leur prendre
un peu de temps avant de remarquer votre question. Si vous avez raté une discussion sur IRC, pas de soucis, nous
archivons tous les échanges ! Rendez-vous sur http://qgis.org/irclogs pour lire les logs IRC.

Un support commercial pour QGIS est disponible. Regardez la page du site http://qgis.org/en/commercial-
support.html pour plus d’informations.

20.3 BugTracker

While the qgis-users mailing list is useful for general ‘How do I do XYZ in QGIS?’-type questions, you
may wish to notify us about bugs in QGIS. You can submit bug reports using the QGIS bug tracker at
http://hub.qgis.org/projects/quantum-gis/issues. When creating a new ticket for a bug, please provide an email
address where we can contact you for additional information.
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Garder en mémoire que votre bug peut ne pas avoir la priorité à laquelle vous vous attendiez (cela dépendra de sa
sévérité). Certains bugs peuvent nécessiter du travail supplémentaire de la part des développeurs pour y remédier
et la personne compétente n’est pas forcément disponible.

Les demandes de fonctionnalités supplémentaires peuvent être soumises également en utilisant le même système
de ticket que pour les bugs. Assurez-vous de sélectionner le type Feature.

If you have found a bug and fixed it yourself, you can submit this patch also. Again, the lovely redmine ticketsys-
tem at http://hub.qgis.org/wiki/quantum-gis/issues has this type as well. Check the Patch supplied checkbox
and attach your patch before submitting your bug. One of the developers will review it and apply it to QGIS. Please
don’t be alarmed if your patch is not applied straight away – developers may be tied up with other commitments.

20.4 Blog

The QGIS community also runs a weblog at http://planet.qgis.org/planet/, which has some interesting articles for
users and developers as well provided by other blogs in the community. You are invited to contribute your own
QGIS blog!

20.5 Extensions

The website http://plugins.qgis.org provides the official QGIS plugins web portal. Here, you find a list of all stable
and experimental QGIS plugins available via the ‘Official QGIS Plugin Repository’.

20.6 Wiki

Enfin, nous maintenons un site web wiki sur http://hub.qgis.org/projects/quantum-gis/wiki où vous pouvez trou-
ver diverses informations utiles liées au développement de QGIS, planning des versions, liens vers les sites de
téléchargement, astuces de traduction des messages et bien plus. Parcourez le, on y trouve mille choses intéres-
santes !

.
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CHAPTER 21

Annexe

21.1 licence GNU General Public License

Version 2, Juin 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

La copie et la distribution de copies exactes de ce document sont autorisées, mais aucune modification n’est
permise.

Préambule

Les licences d’utilisation de la plupart des programmes sont définies pour limiter ou supprimer toute liberté à
l’utilisateur. À l’inverse, la GNU General Public License est destinée à vous garantir la liberté de partager et de
modifier les logiciels libres, et de s’assurer que ces logiciels sont effectivement accessibles à tout utilisateur. Cette
Licence Publique Générale s’applique à la plupart des programmes de la Free Software Foundation, comme à
tout autre programme dont l’auteur l’aura décidé (d’autres logiciels de la FSF sont couverts pour leur part par la
Licence Publique Générale pour Bibliothèques GNU (LGPL)). Vous pouvez aussi appliquer les termes de cette
Licence à vos propres programmes, si vous le désirez.

Liberté des logiciels ne signifie pas nécessairement gratuité. Notre Licence est conçue pour vous assurer la liberté
de distribuer des copies des programmes, gratuitement ou non, de recevoir le code source ou de pouvoir l’obtenir,
de modifier les programmes ou d’en utiliser des éléments dans de nouveaux programmes libres, en sachant que
vous y êtes autorisé.

Afin de garantir ces droits, nous avons dû introduire des restrictions interdisant à quiconque de vous les refuser ou
de vous demander d’y renoncer. Ces restrictions vous imposent en retour certaines obligations si vous distribuez
ou modifiez des copies de programmes protégés par la Licence.

Par exemple, si vous distribuez des copies de ce programme, soit gratuitement, soit contre une certaine somme
d’argent, vous devez transmettre aux destinataires tous les droits que vous possédez. Vous devez vous assurer
d’expédier aux destinataires le code source ou bien tenir celui-ci à leur disposition. Enfin, vous devez leur remettre
cette Licence afin qu’ils prennent connaissance de leurs droits.

Nous protégeons vos droits de deux façons : d’abord par le copyright du logiciel, ensuite par la remise de cette
Licence qui vous autorise légalement à copier, distribuer et/ou modifier le logiciel.

En outre, pour protéger chaque auteur ainsi que la FSF, nous affirmons solennellement que le programme concerné
ne fait l’objet d’aucune garantie. Si un tiers le modifie puis le redistribue, tous ceux qui en recevront une copie
doivent savoir qu’il ne s’agit pas de l’original afin qu’une copie défectueuse n’entache pas la réputation de l’auteur
du logiciel.

Enfin, tout programme libre est sans cesse menacé par des dépôts de brevets. Nous souhaitons à tout prix éviter
que des distributeurs puissent déposer des brevets sur les Logiciels Libres pour leur propre compte. Pour éviter
cela, nous stipulons bien que tout dépôt éventuel de brevet doit accorder expressément à tout un chacun le libre
usage du produit.
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Les dispositions précises et les conditions de copie, de distribution et de modification de nos logiciels sont les
suivantes : STIPULATIONS ET CONDITIONS RELATIVES A LA COPIE, LA DISTRIBUTION ET LA MOD-
IFICATION

0. La présente Licence s’applique à tout Programme (ou autre travail) où figure une note, placée par le déten-
teur des droits, stipulant que ledit Programme ou travail peut être distribué selon les termes de la présente
Licence. Le terme Programme désigne aussi bien le Programme lui-même que tout travail qui en est dérivé
selon la loi, c’est-à-dire tout ouvrage reproduisant le Programme ou une partie de celui-ci, à l’identique ou
bien modifié, et/ou traduit dans une autre langue (la traduction est considérée comme une modification).
Chaque personne concernée par la Licence Publique Générale sera désignée par le terme Vous.

Les activités autres que copie, distribution et modification ne sont pas couvertes par la présente Licence et
sortent de son cadre. Rien ne restreint l’utilisation du Programme et les données issues de celui-ci ne sont
couvertes que si leur contenu constitue un travail basé sur le logiciel (indépendemment du fait d’avoir été
réalisé en lançant le Programme). Tout dépend de ce que le Programme est censé produire.

1. Vous pouvez copier et distribuer des copies conformes du code source du Programme, tel que Vous l’avez
reçu, sur n’importe quel support, à condition de placer sur chaque copie un copyright approprié et une
restriction de garantie, de ne pas modifier ou omettre toutes les stipulations se référant à la présente Licence
et à la limitation de garantie, et de fournir avec toute copie du Programme un exemplaire de la Licence.

Vous pouvez demander une rétribution financière pour la réalisation de la copie et demeurez libre de pro-
poser une garantie assurée par vos soins, moyennant finances.

2. Vous pouvez modifier votre copie ou vos copies du Programme ou partie de celui-ci, ou d’un travail basé
sur ce Programme, et copier et distribuer ces modifications selon les termes de l’article 1, à condition de
Vous conformer également aux conditions suivantes :

(a) Ajouter aux fichiers modifiés l’indication très claire des modifications effectuées, ainsi que la date de
chaque changement.

(b) Distribuer sous les termes de la Licence Publique Générale l’ensemble de toute réalisation contenant
tout ou partie du Programme, avec ou sans modifications.

(c) Si le Programme modifié lit des commandes de manière interactive lors de son exécution, faire en
sorte qu’il affiche, lors d’une invocation ordinaire, le copyright approprié en indiquant clairement la
limitation de garantie (ou la garantie que Vous Vous engagez à fournir Vous-même), qu’il stipule que
tout utilisateur peut librement redistribuer le Programme selon les conditions de la Licence Publique
Générale GNU, et qu’il montre à tout utilisateur comment lire une copie de celle-ci (exception : si
le Programme original est interactif mais n’affiche pas un tel message en temps normal, tout travail
dérivé de ce Programme ne sera pas non plus contraint de l’afficher).

Toutes ces conditions s’appliquent à l’ensemble des modifications. Si des éléments identifiables de ce travail
ne sont pas dérivés du Programme et peuvent être raisonnablement considérés comme indépendants, la
présente Licence ne s’applique pas à ces éléments lorsque Vous les distribuez seuls. Mais, si Vous distribuez
ces mêmes éléments comme partie d’un ensemble cohérent dont le reste est basé sur un Programme soumis
à la Licence, ils lui sont également soumis, et la Licence s’étend ainsi à l’ensemble du produit, quel qu’en
soit l’auteur.

Cet article n’a pas pour but de s’approprier ou de contester vos droits sur un travail entièrement réalisé par
Vous, mais plutôt d’ouvrir droit à un contrôle de la libre distribution de tout travail dérivé ou collectif basé
sur le Programme.

En outre, toute fusion d’un autre travail, non basé sur le Programme, avec le Programme (ou avec un travail
dérivé de ce dernier), effectuée sur un support de stockage ou de distribution, ne fait pas tomber cet autre
travail sous le contrôle de la Licence.

3. Vous pouvez copier et distribuer le Programme (ou tout travail dérivé selon les conditions énoncées dans
l’article 1) sous forme de code objet ou exécutable, selon les termes des articles 0 et 1, à condition de
respecter l’une des clauses suivantes :

(a) Fournir le code source complet du Programme, sous une forme lisible par un ordinateur et selon les
termes des articles 0 et 1, sur un support habituellement utilisé pour l’échange de données ; ou,
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(b) Faire une offre écrite, valable pendant au moins trois ans, prévoyant de donner à tout tiers qui en fera
la demande une copie, sous forme lisible par un ordinateur, du code source correspondant, pour un
tarif n’excédant pas le coût de la copie, selon les termes des articles 0 et 1, sur un support couramment
utilisé pour l’échange de données informatiques ; ou,

(c) Informer le destinataire de l’endroit où le code source peut être obtenu (cette solution n’est recevable
que dans le cas d’une distribution non commerciale, et uniquement si Vous avez reçu le Programme
sous forme de code objet ou exécutable avec l’offre prévue à l’alinéa b ci-dessus).

Le code source d’un travail désigne la forme de cet ouvrage sous laquelle les modifications sont les plus
aisées. Sont ainsi désignés la totalité du code source de tous les modules composant un Programme exé-
cutable, de même que tout fichier de définition associé, ainsi que les scripts utilisés pour effectuer la com-
pilation et l’installation du Programme exécutable. Toutefois, l’environnement standard de développement
du système d’exploitation mis en oeuvre (source ou binaire) – compilateurs, bibliothèques, noyau, etc. –
constitue une exception, sauf si ces éléments sont diffusés en même temps que le Programme exécutable.

Si la distribution de l’exécutable ou du code objet consiste à offrir un accès permettant de copier le Pro-
gramme depuis un endroit particulier, l’offre d’un accès équivalent pour se procurer le code source au
même endroit est considéré comme une distribution de ce code source, même si l’utilisateur choisit de ne
pas profiter de cette offre.

4. Vous ne pouvez pas copier, modifier, céder, déposer ou distribuer le Programme d’une autre manière que
l’autorise la Licence Publique Générale. Toute tentative de ce type annule immédiatement vos droits
d’utilisation du Programme sous cette Licence. Toutefois, les tiers ayant reçu de Vous des copies du Pro-
gramme ou le droit d’utiliser ces copies continueront à bénéficier de leur droit d’utilisation tant qu’ils re-
specteront pleinement les conditions de la Licence.

5. Ne l’ayant pas signée, Vous n’êtes pas obligé d’accepter cette Licence. Cependant, rien d’autre ne Vous
autorise à modifier ou distribuer le Programme ou quelque travaux dérivés : la loi l’interdit tant que Vous
n’acceptez pas les termes de cette Licence. En conséquence, en modifiant ou en distribuant le Programme
(ou tout travail basé sur lui), Vous acceptez implicitement tous les termes et conditions de cette Licence.

6. La diffusion d’un Programme (ou de tout travail dérivé) suppose l’envoi simultané d’une licence autorisant
la copie, la distribution ou la modification du Programme, aux termes et conditions de la Licence. Vous
n’avez pas le droit d’imposer de restrictions supplémentaires aux droits transmis au destinataire. Vous
n’êtes pas responsable du respect de la Licence par un tiers.

7. Si, à la suite d’une décision de Justice, d’une plainte en contrefaçon ou pour toute autre raison (liée ou non
à la contrefaçon), des conditions Vous sont imposées (que ce soit par ordonnance, accord amiable ou autre)
qui se révèlent incompatibles avec les termes de la présente Licence, Vous n’êtes pas pour autant dégagé des
obligations liées à celle-ci : si Vous ne pouvez concilier vos obligations légales ou autres avec les conditions
de cette Licence, Vous ne devez pas distribuer le Programme.

Si une partie quelconque de cet article est invalidée ou inapplicable pour quelque raison que ce soit, le reste
de l’article continue de s’appliquer et l’intégralité de l’article s’appliquera en toute autre circonstance.

Le présent article n’a pas pour but de Vous pousser à enfreindre des droits ou des dispositions légales ni en
contester la validité ; son seul objectif est de protéger l’intégrité du système de distribution du Logiciel Libre.
De nombreuses personnes ont généreusement contribué à la large gamme de Programmes distribuée de cette
façon en toute confiance ; il appartient à chaque auteur/donateur de décider de diffuser ses Programmes selon
les critères de son choix.

Cette section a pour but de rendre totalement limpide ce que l’on pense être une conséquence du reste de la
présente Licence.

8. Si la distribution et/ou l’utilisation du Programme est limitée dans certains pays par des brevets ou des
droits sur des interfaces, le détenteur original des droits qui place le Programme sous la Licence Publique
Générale peut ajouter explicitement une clause de limitation géographique excluant ces pays. Dans ce cas,
cette clause devient une partie intégrante de la Licence.

9. La Free Software Foundation se réserve le droit de publier périodiquement des mises à jour ou de nou-
velles versions de la Licence. Rédigées dans le même esprit que la présente version, elles seront cependant
susceptibles d’en modifier certains détails à mesure que de nouveaux problèmes se font jour.
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Chaque version possède un numéro distinct. Si le Programme précise un numéro de version de cette Licence
et « toute version ultérieure », Vous avez le choix de suivre les termes et conditions de cette version ou de
toute autre version plus récente publiée par la Free Software Foundation. Si le Programme ne spécifie aucun
numéro de version, Vous pouvez alors choisir l’une quelconque des versions publiées par la Free Software
Foundation.

10. Si vous désirez incorporer des éléments du Programme dans d’autres Programmes libres dont les conditions
de distribution diffèrent, vous devez écrire à l’auteur pour lui en demander la permission. Pour ce qui est des
programmes directement déposés par la Free Software Foundation, écrivez-nous : une exception est toujours
envisageable. Notre décision sera basée sur notre volonté de préserver la liberté de notre Programme ou de
ses dérivés et celle de promouvoir le partage et la réutilisation du logiciel en général.

LIMITATION DE GARANTIE

11. Parce que l’utilisation de ce Programme est libre et gratuite, aucune garantie n’est fournie, comme le permet
la loi. Sauf mention écrite, les détenteurs du copyright et/ou les tiers fournissent le Programme en l’état, sans
aucune sorte de garantie explicite ou implicite, y compris les garanties de commercialisation ou d’adaptation
dans un but particulier. Vous assumez tous les risques quant à la qualité et aux effets du Programme. Si le
Programme est défectueux, Vous assumez le coût de tous les services, corrections ou réparations nécessaires.

12. Sauf lorsqu’explicitement prévu par la Loi ou accepté par écrit, ni le détenteur des droits, ni quiconque
autorisé à modifier et/ou redistribuer le Programme comme il est permis ci-dessus ne pourra être tenu pour
responsable de tout dommage direct, indirect, secondaire ou accessoire (pertes financières dues au manque
à gagner, à l’interruption d’activités ou à la perte de données, etc., découlant de l’utilisation du Programme
ou de l’impossibilité d’utiliser celui-ci).

Exception Qt à la GPL pour QGIS

De plus, l’équipe de développement de QGIS vous donne la permission, à titre d’exception spéciale,
de lier le code de ce programme avec la bibliothèque Qt, incluant sans limite les versions suivantes
(à la fois libres et commerciales): Qt/Non-commerical Windows, Qt/Windows, Qt/X11, Qt/Mac, and
Qt/Embedded (ou avec des versions modifiées de Qt qui utilisent la même licence que Qt) et de
distribuer des combinaisons liées incluant les deux. Vous devez respecter la GNU General Public
Licence pour tout le code qui ne concerne pas Qt. Si vous modifiez ce fichier, vous pouvez étendre
cette exception à votre version de ce fichier mais vous n’êtes pas obligé de le faire. Si vous ne voulez
pas le faire, supprimez cette déclaration d’exception de votre version.

21.2 Licence GNU de documentation libre

Version 1.3, 3 Novembre 2008

Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc

<http://fsf.org/>

Tout le monde est autorisé à copier et redistribuer à l’identique le texte de cette licence, mais le modifier n’est pas
autorisé.

Préambule

Le but de cette Licence est de rendre un manuel, un livre, ou un autre document fonctionnel et utile “libre” :
d’assurer à tout le monde la liberté effective de le copier et de le redistribuer, en le modifiant ou non, commer-
cialement ou bénévolement. Accessoirement, cette Licence donne la possibilité à l’auteur et à l’éditeur d’être
crédités de leur travail, sans être considérés comme responsables des modifications faites par d’autres.

Cette Licence est une sorte de “gauche d’auteur” (“copyleft”), ce qui signifie que les œuvres dérivées du document
doivent elles aussi être libres. Elle est le complément de la licence publique générale GNU, qui est une licence de
type gauche d’auteur conçue pour les logiciels libres.

Nous avons conçu cette Licence pour l’utiliser dans les manuels de logiciel libre, parce que les logiciels libres
nécessitent de la documentation libre : un programme libre doit être fourni avec des manuels assurant des libertés
identiques à celles qu’assure le logiciel. Mais cette Licence n’est pas limitée aux manuels de logiciels ; elle peut
être utilisée pour n’importe quelle œuvre textuelle, quel que soit le sujet traité, que cette œuvre soit publiée en tant
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que livre imprimé, ou non. Nous recommandons cette Licence principalement pour les œuvres à but éducatif ou
pour les manuels de référence.

1. APPLICABILITÉ ET DÉFINITIONS

Cette Licence s’applique à tout manuel ou autre œuvre, sur n’importe quel support, qui contient une mention,
placée par le détenteur des droits d’auteur, disant que le manuel ou l’œuvre peut être distribuée selon les termes
de cette Licence. Une telle mention accorde une autorisation valable dans le monde entier, gratuite, sans limite
de durée, d’utiliser l’œuvre selon les conditions établies ici. Le terme “Document”, utilisé ci-après désigne tout
manuel ou œuvre contenant une telle mention. Tout membre du public est un licencié, et est désigné par “vous”.
Vous acceptez la licence si vous copiez, modifiez ou distribuez l’œuvre d’une façon qui requiert une permission
selon la loi sur le droit d’auteur.

Une “Version Modifiée” du Document désigne toute œuvre contenant le Document ou une portion du Document,
copié à l’identique, ou copié avec des modifications ou traduit dans une autre langue.

Une “Section Secondaire” est une annexe portant un nom spécifique ou une section préliminaire du Document
qui traite exclusivement de la relation des éditeurs ou des auteurs du Document au thème général du Document
(ou à des thèmes liés) et ne contient rien qui pourrait relever directement de ce thème général. (Ainsi, si le
Document est en partie un manuel de mathématiques, une Section Secondaire ne peut donner aucune explication
en mathématiques.) La relation peut être une connexion historique avec le sujet ou avec des sujets liés, ou elle
peut être un point de vue juridique, commercial, philosophique, éthique ou politique sur ces sujets.

Les “Sections Invariantes” sont certaines Sections Secondaires, dont les titres sont désignés comme étant des
Sections Invariantes dans la mention disant que le Document est publié selon les termes de cette Licence. Si
une section ne correspond pas à la définition de Section Secondaire établie ci-dessus, alors il n’est pas permis de
la désigner comme Invariante. Le Document peut contenir zéro Section Invariante. Si le Document n’identifie
aucune Section Invariante, alors il n’y en a aucune.

Les “Textes De Couverture” sont certains courts passages de texte qui sont mentionnés comme Textes De Pre-
mière De Couverture ou Textes De Quatrième De Couverture dans la mention disant que le Document est publié
selon les termes de cette Licence. Un Texte De Première De Couverture peut contenir 5 mots au maximum, et un
Texte De Quatrième De Couverture peut contenir 25 mots au maximum.

Une copie “Transparente” du Document désigne une copie lisible par une machine, représentée dans un format
dont les spécifications sont disponibles pour le grand public, qui permet de corriger facilement le document avec
des éditeurs de texte génériques ou (pour les images composées de pixels) avec des éditeurs d’image génériques
ou (pour les dessins) avec des éditeurs de dessin largement disponibles, et qui est approprié pour servir de données
d’entrée aux formateurs de texte ou pour être traduit automatiquement dans une variété de formats appropriés
pour servir de données d’entrée aux formateurs de texte. Une copie faite dans un format de fichier par ailleurs
Transparent, mais dont le marquage, ou l’absence de marquage, a été conçu de façon à empêcher ou décourager les
lecteurs de faire des modifications ultérieurement n’est pas Transparente. Un format d’image n’est pas Transparent
s’il est utilisé pour afficher toute quantité substantielle de texte. Une copie qui n’est pas “Transparente” est appelée
“Opaque”.

Voici des exemples de formats appropriés pour faire des copies Transparentes : du texte brut ASCII sans marquage
; le format d’entrée de Texinfo ; le format d’entrée de LaTeX ; le format SGML ou XML en utilisant une DTD
disponible publiquement ; du HTML simple et conforme aux standards ; du PostScript ou du PDF conçu pour
être modifié par des humains. Voici des exemple de formats d’image transparents : PNG, XCF et JPG. Voici des
exemples de formats opaques : les formats privateurs qui ne peuvent être lus et modifiés que par des logiciels
de traitement de texte privateurs ; du SGML ou du XML dont la DTD ou les outils de traitement ne sont pas
largement disponibles ; le HTML généré par une machine ; du PostScript ou du PDF produit par un logiciel de
traitement de texte dans un but d’affichage seulement.

La “Page De Titre” désigne, pour un livre imprimé, la page de titre elle-même, plus les pages suivantes nécessaires
pour contenir, lisiblement, les mentions que cette Licence oblige à inscrire dans la page de titre. Pour les œuvres
dont le format ne possède pas de page de titre en tant que telle, “Page De Titre” désigne le texte placé à côté de
l’inscription la plus en vue du titre de l’œuvre, qui précède le début du corps du texte.

L’ “éditeur” désigne toute personne ou entité qui distribue des copies du Document au public.

Une section “Intitulée XYZ” désigne soit une sous-unité du Document dont le titre est exactement XYZ, soit une
sous-unité du Document dont le titre contient XYZ entre parenthèses après le texte traduisant XYZ dans une autre
langue. (Ici XYZ représente un nom de section spécifique mentionné ci-après, tel que “Acknowledgements”
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[Remerciements], “Dedications” [Dédicaces], “Endorsements” [Approbations], ou “History” [Historique]).
“Conserver le Titre” d’une telle section, quand vous modifiez le Document, signifie que cette section reste une
section “Intitulée XYZ” selon la présente définition.

Le Document peut inclure des Mentions De Limitation De Garantie à côté de la mention indiquant que cette
Licence s’applique au Document. Ces Mentions De Limitation De Garantie sont considérées comme incluses
par référence dans cette Licence, mais elles ne peuvent que limiter des garanties : toute autre implication que
ces Mentions De Limitation De Garantie pourraient avoir est nulle et n’a aucun effet sur la signification de cette
Licence.

2. COPIE À L’IDENTIQUE

Vous pouvez copier et distribuer le Document sur tout support, commercialement ou bénévolement, à condition
que cette Licence, les mentions de droit d’auteur, et la mention disant que cette Licence s’applique au Document
soient reproduites dans toutes les copies, et que vous n’ajoutiez absolument aucune autre condition aux conditions
de cette Licence. Vous ne pouvez pas utiliser de mesures techniques pour entraver ou contrôler la lecture ou la
copie des copies que vous faites ou distribuez. Toutefois, vous pouvez accepter une rémunération en échange de
copies. Si vous distribuez un nombre de copies suffisamment important, vous devez aussi vous conformer aux
conditions de la section 3.

Vous pouvez aussi prêter des copies, selon les mêmes conditions que ci-dessus, et vous pouvez afficher publique-
ment des copies.

3. COPIE EN GRANDE QUANTITÉ

Si vous publiez plus de 100 copies imprimées (ou 100 copies dans un média qui a communément une couverture
imprimée) du Document, et que la mention de licence du Document indique qu’il y a des Textes De Couverture,
vous devez insérer chaque copie dans une couverture qui porte, clairement et lisiblement, tous ces Textes De
Couverture : les Textes De Première De Couverture sur la première de couverture, et les Textes De Quatrième De
Couverture sur la quatrième de couverture. Ces deux pages de couvertures doivent aussi vous identifier clairement
et lisiblement comme l’éditeur de ces copies. La première de couverture doit présenter le titre complet, et tous
les mots du titre doivent avoir la même importance et la même visibilité. Vous pouvez ajouter d’autres choses
en supplément sur la couverture. Faire des copies avec des changements uniquement sur la couverture, tant que
les copies conservent le titre du Document et satisfont ces conditions, est considéré comme faire des copies à
l’identique.

Si les textes requis pour l’une ou l’autre des pages de couverture sont trop volumineux pour y figurer lisiblement,
vous devez mettre les premiers de la liste (autant qu’il est possible d’en mettre de façon lisible) sur la page de
couverture elle-même, et mettre le reste sur les pages adjacentes.

Si vous publiez ou distribuez plus de 100 copies Opaques du Document, vous devez soit inclure une copie Trans-
parente et lisible par une machine avec chaque copie Opaque, soit indiquer dans chaque copie Opaque (ou dans
une notice accompagnant chaque copie opaque) un emplacement sur le réseau informatique à partir duquel le
grand public utilisant le réseau peut accéder au téléchargement, en utilisant des protocoles réseau publics et stan-
dards, d’une copie complète et Transparente du Document, sans aucun ajout. Si vous utilisez cette dernière option,
vous devez prendre des précautions raisonnablement prudentes, quand vous commencez la distribution de copies
Opaques en grande quantité, pour garantir que cette copie Transparente restera accessible par les moyens et à
l’emplacement indiqués pendant au moins un an après la dernière distribution de copie Opaque (directement ou
par l’intermédiaire de vos agents ou de vos revendeurs au détail) de cette édition au public.

Il est demandé, sans que cela soit une obligation, que vous contactiez les auteurs du Document bien avant de
redistribuer tout nombre important de copies, pour leur donner une chance de vous fournir une version mise à jour
du Document.

4. MODIFICATIONS

Vous pouvez copier et distribuer une Version Modifiée du Document selon les conditions des sections 2 et 3 ci-
dessus, à condition que vous accordiez le droit à tous ceux à qui vous distribuez la Version Modifiée de copier
et de distribuer la Version Modifiée selon les termes de cette Licence, avec la Version Modifiée jouant le rôle
du Document, autorisant ainsi la distribution et la modification de la Version Modifiée à toute personne qui en
possède une copie. De plus, vous devez faire les choses suivantes dans la Version Modifiée :

1. Utiliser dans la Page De Titre (et sur la couverture, s’il y en a) un titre distinct de celui du Document et
de ceux des précédentes versions (qui devraient, s’il y en a, être énumérées dans la section History de ce
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Document). Vous pouvez utiliser le même titre que celui d’une version précédente si l’éditeur original de
cette version vous en donne la permission.

2. Citer sur la Page De Titre, en tant qu’auteurs, une ou plusieurs personnes ou entités responsables des modi-
fications faites dans la Version Modifiée, ainsi qu’au moins cinq des auteurs principaux du Document (tous
les auteurs principaux, s’il y en a moins de cinq), sauf s’ils vous dispensent de cette obligation.

3. Spécifier sur la Page de titre le nom de l’éditeur de la Version Modifiée, en précisant que c’est lui l’éditeur.

4. Conserver toutes les mentions de droit d’auteur du Document.

5. Ajouter une mention appropriée indiquant vos droits d’auteur pour les modifications que vous avez faites ;
cette mention doit être adjacente aux autres mentions de droit d’auteur.

6. Inclure, immédiatement après les mentions de droit d’auteur, une mention de licence donnant la permission
au public d’utiliser la Version Modifiée selon les termes de cette Licence, en respectant la forme indiquée
dans la section Addendum ci-dessous.

7. Conserver dans cette mention de licence les listes complètes des Sections Invariantes et des Textes De
Couverture inscrites dans la mention de licence du Document.

8. Inclure une copie non modifiée de cette Licence.

9. Conserver la section Intitulée “History”, Conserver son Titre, et ajouter à cette section un paragraphe indi-
quant au minimum le titre, l’année, les nouveaux auteurs, et l’éditeur de la Version Modifiée comme cela
est fait sur la Page De Titre. S’il n’y a pas de section Intitulée “History” dans le Document, en créer une qui
indique le titre, l’année, les auteurs, et l’éditeur du Document comme cela est fait sur la Page De Titre, et
ensuite ajouter un paragraphe décrivant la Version Modifiée comme indiqué dans la phrase précédente.

10. Conserver l’indication d’emplacement sur le réseau, s’il y en a une, donnée dans le Document pour
l’accès public à une copie Transparente du Document, et Conserver de la même manière les indications
d’emplacement sur le réseau données dans le Document pour les versions précédentes sur lesquelles il
est basé. Celles-ci peuvent être placées dans la section “History”. Vous pouvez omettre une indication
d’emplacement sur le réseau pour une œuvre qui a été publiée au moins quatre ans avant le Document
lui-même, ou si l’éditeur original de la version à laquelle elle réfère vous en donne la permission.

11. Pour toute section Intitulée “Acknowledgements” ou “Dedications”, Conserver le Titre de la section et, à
l’intérieur de la section, toute la substance et le ton de chacun des remerciements aux contributeurs ou de
chacune des dédicaces qui y figure.

12. Conserver toutes les Sections Invariantes du Document, non modifiées dans leurs textes et dans leurs titres.
Les numéros de sections ou leurs équivalents ne sont pas considérés comme faisant partie des titres de
section.

13. Supprimer toute section Intitulée “Endorsements”. Une telle section ne peut pas être incluse dans la Version
Modifiée.

14. Ne pas modifier le titre d’une section existante en lui donnant le titre “Endorsements” ou en lui donnant un
titre qui entre en conflit avec le titre d’une Section Invariante.

15. Conserver toute Mention De Limitation De Garantie.

Si la Version Modifiée inclut de nouvelles sections préliminaires ou de nouvelles annexes qui répondent à la
définition de Sections Secondaires et ne contiennent rien qui soit copié du Document, vous pouvez si vous le
souhaitez désigner certaines ou toutes ces sections comme invariantes. Pour faire cela, ajoutez leurs titres à la liste
des Sections Invariantes dans la mention de licence de la Version Modifiée. Ces titres doivent être distincts de tout
autre titre de section.

Vous pouvez ajouter une section Intitulée “Endorsements”, à condition qu’elle ne contienne que des marques de
soutien pour votre Version Modifiée faites par d’autres parties—par exemple, des déclarations d’évaluation par les
pairs ou des déclarations stipulant que votre texte a été approuvé par une organisation comme définition officielle
d’un standard.

Vous pouvez ajouter un passage de cinq mots au maximum comme Texte De Première De Couverture, et un
passage de 25 mots au maximum comme Texte De Quatrième De Couverture, à la fin de la liste des Textes De
Couverture dans la Version Modifiée. Un seul passage de Texte De Première De Couverture et un seul passage
de Texte De Quatrième De Couverture peut être ajouté par (ou par l’intermédiaire d’arrangements faits par) une
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même entité. Si le Document inclut déjà un texte pour la même page de couverture, précédemment ajouté par
vous ou par arrangement fait par la même entité que celle au nom de laquelle vous agissez, vous ne pouvez pas
en ajouter d’autre ; mais vous pouvez remplacer l’ancien à condition que l’éditeur précédent ayant placé l’ancien
texte vous en donne la permission explicite.

Par cette Licence, l’auteur (ou les auteurs) et l’éditeur (ou les éditeurs) du Document ne donnent pas la permission
d’utiliser leurs noms pour un usage publicitaire ou pour exprimer explicitement ou implicitement leur soutien à
une Version Modifiée.

5. COMBINAISON DE DOCUMENTS

Vous pouvez combiner le Document avec d’autres documents publiés selon les termes de cette Licence, à condition
de respecter les termes définis dans la section 4 ci-dessus pour les Versions Modifiées, et à condition que vous
incluiez dans la combinaison toutes les Sections Invariantes de tous les documents originaux, non modifiées, et
que vous les énumériez toutes comme Sections Invariantes de votre œuvre combinée dans sa mention de licence,
et que de plus vous conserviez toutes les Mentions De Limitation De Garantie de tous les documents originaux.

L’œuvre combinée n’a besoin de contenir qu’une seule copie de cette Licence, et de multiples Sections Invariantes
identiques peuvent être remplacées par une seule d’entre elles. S’il y a plusieurs Sections Invariantes avec le même
nom mais avec des contenus différents, rendez unique le titre de chaque section en question en ajoutant à la fin de
celui-ci, entre parenthèses, le nom de l’auteur ou de l’éditeur original de cette section s’il est connu, ou, à défaut,
un nombre unique. Faites le même ajustement aux titres de section dans la liste des Sections Invariantes figurant
dans la mention de licence de l’œuvre combinée.

Dans la combinaison, vous devez combiner toutes les sections Intitulées “History” de tous les documents orig-
inaux, en formant une unique section Intitulée “History” ; de la même manière, combinez toutes les sections
Intitulées “Acknowledgements”, puis toutes les sections Intitulées “Dedications”. Vous devez supprimer toutes les
sections Intitulées “Endorsements”.

6. COLLECTIONS DE DOCUMENTS

Vous pouvez faire une collection composée du Document et d’autres documents publiés selon les termes de cette
Licence, et remplacer les copies individuelles de cette Licence dans les divers documents par une unique copie
incluse dans la collection, à condition qu’à tous les autres égards et pour chacun des documents vous vous con-
formiez aux règles de cette Licence régissant la copie à l’identique.

Vous pouvez extraire un document d’une telle collection, et le distribuer individuellement selon les termes de cette
Licence, à condition que vous insériez une copie de cette Licence dans le document extrait, et que vous vous
conformiez à cette Licence à tous les autres égards, en ce qui concerne la copie du document extrait.

7. AGRÉGATION AVEC DES ŒUVRES INDÉPENDANTES

Une compilation du Document ou de ses dérivés avec d’autres documents ou œuvres séparés et indépendants, dans
une unité de stockage ou sur un support de distribution, est appelée “agrégat” si le droit d’auteur résultant de la
compilation n’est pas utilisé pour limiter les droits légaux des utilisateurs de la compilation au-delà de ce que les
œuvres individuelles permettent. Quand le Document est inclus dans un agrégat, cette Licence ne s’applique pas
aux autres œuvres de l’agrégat qui ne sont pas elles-mêmes des œuvres dérivées du Document.

Si l’obligation de Texte De Couverture de la section 3 est applicable à ces copies du Document, alors si le Doc-
ument correspond à moins de la moitié de l’agrégat entier, les Textes De Couverture du Document peuvent être
placés sur la couverture qui contient le Document à l’intérieur de l’agrégat, ou l’équivalent électronique de cette
couverture si le Document est sous forme électronique. Dans le cas contraire, elles doivent apparaître sur la
couverture imprimée qui contient l’agrégat entier.

8. TRADUCTION

Une compilation du Document ou de ses dérivés avec d’autres documents ou œuvres séparés et indépendants, dans
une unité de stockage ou sur un support de distribution, est appelée “agrégat” si le droit d’auteur résultant de la
compilation n’est pas utilisé pour limiter les droits légaux des utilisateurs de la compilation au-delà de ce que les
œuvres individuelles permettent. Quand le Document est inclus dans un agrégat, cette Licence ne s’applique pas
aux autres œuvres de l’agrégat qui ne sont pas elles-mêmes des œuvres dérivées du Document.

Si une section du Document est Intitulée “Acknowledgements”, “Dedications”, ou “History”, l’obligation (section
4) de Conserver son Titre (section 1) nécessitera typiquement un ajustement du titre traduit.

9. EXPIRATION
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Vous ne pouvez pas copier, modifier, sous-licencier, ou distribuer le Document sauf aux conditions expressément
prévues par la présente Licence. Toute tentative de le copier, le modifier, le sous-licencier ou le distribuer d’une
autre manière est nulle, et entrainera automatiquement l’expiration des droits qui vous ont été conférés par cette
Licence.

Toutefois, si vous cessez toute violation de cette Licence, alors la licence qui vous a été octroyée par un détenteur
particulier des droits d’auteur est rétablie (a) provisoirement, sauf si et jusqu’à ce que le détenteur des droits
d’auteur annule votre licence de manière explicite et définitive, et (b) définitivement, si le détenteur des droits
d’auteur ne parvient pas à vous notifier la violation par des moyens raisonnables dans un délai de 60 jours après
la cessation de la violation.

De plus, la licence qui vous a été octroyée par un détenteur particulier des droits d’auteur est rétablie définitivement
si ce détenteur des droits d’auteur vous notifie de la violation par des moyens raisonnables, si c’est la première
fois que vous avez reçu une notification de violation de cette Licence (pour toute œuvre) de la part de ce même
détenteur des droits d’auteur, et si vous remédiez à la violation dans un délai de 30 jours après avoir reçu la
notification.

L’expiration de vos droits engendrée par cette section n’entraine pas l’expiration des licences des parties
auxquelles vous avez envoyé des copies en les autorisant à utiliser les copies selon les termes de cette Licence. Si
vos droits ont expirés et n’ont pas été rétablis définitivement, le fait de recevoir une copie de la même œuvre ou
une copie d’une partie de la même œuvre ne vous donne aucun droit de l’utiliser.

10. RÉVISIONS FUTURES DE CETTE LICENCE

Il se peut que de temps en temps la Fondation pour le logiciel libre publie une nouvelle version, révisée,
de la licence GNU de documentation libre. Ces nouvelles versions seront dans le même esprit, mais elles
pourront différer dans les détails, pour répondre à de nouveaux problèmes ou inquiétudes. Référez-vous à
http://www.gnu.org/copyleft/.

Chaque version de la Licence possède un numéro de version distinct. Si le Document spécifie qu’il peut être
utilisé selon les termes d’une version numérotée particulière de cette Licence “ou toute version ultérieure”, vous
avez le choix de vous conformer aux termes et aux conditions de la version spécifiée ou de toute version ultérieure
qui a été publiée (pas en tant que brouillon) par la Fondation pour le logiciel libre. Si le Document ne spécifie
pas de numéro de version, vous pouvez choisir n’importe quelle version publiée (pas en tant que brouillon) par la
Fondation pour le logiciel libre. Si le Document spécifie qu’un serveur mandataire peut décider quelles versions
futures de cette Licence peuvent être utilisées, la déclaration publique d’acceptation d’une version de la part de ce
serveur mandataire vous autorise de manière permanente à choisir cette version pour utiliser le Document.

11. RELICENCIER

“Site de Collaboration Massive Multi-auteur” (ou “Site CMM”) désigne tout serveur du World Wide Web qui
publie des œuvres auxquelles le droit d’auteur est applicable et qui fournit aussi une infrastructure conséquente
permettant à n’importe qui de modifier ces œuvres. Un wiki public que tout le monde peut modifier est un
exemple d’un tel serveur. Une “Collaboration Massive Multi-auteur” (ou “CMM”) contenue dans ce site désigne
tout ensemble d’œuvres concernées par le droit d’auteur ainsi publiées sur le site CMM.

“CC-BY-SA” désigne la licence Creative Commons attribution de paternité, partage à l’identique, 3.0, publiée par
l’organisation Creative Commons, une organisation à but non lucratif basée à San Francisco, en Californie, ainsi
que toute version future de type gauche d’auteur de cette licence, publiée par la même organisation.

“Incorporer” signifie publier ou republier un Document, en entier ou en partie, comme partie d’un autre Document.

Une CMM est “éligible pour relicencier” si elle est licenciée sous cette Licence, et si toutes les œuvres qui ont été
publiées antérieurement sous cette Licence ailleurs que sur cette CMM, et incorporées ensuite en totalité ou en
partie dans la CMM, (1) n’ont pas de textes de couverture ou de sections invariantes, et (2) ont été ainsi incorporées
avant le premier novembre 2008.

L’opérateur d’un Site CMM peut republier une CMM contenue dans le site sous licence CC-BY-SA sur le même
site, à n’importe quelle date avant le premier août 2009, à condition que la CMM soit éligible pour relicencier.

ADDENDUM : Comment utiliser cette Licence dans vos documents

Pour utiliser cette Licence dans un document que vous avez écrit, incluez une copie de cette Licence dans le
document et inscrivez les mentions de droit d’auteur et de licence suivantes juste après la page de titre :
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Copyright © YEAR YOUR NAME. Permission is granted to copy, distribute and/or modify this
document under the terms of the GNU Free Documentation License, Version 1.3 or any later version
published by the Free Software Foundation; with no Invariant Sections, no Front-Cover Texts, and no
Back-Cover Texts. A copy of the license is included in the section entitled “GNU Free Documentation
License”.

Si vous avez des Sections Invariantes, des Textes De Première de Couverture et des Textes De Quatrième De
Couverture, remplacez les lignes “sans Texte . . . ” par :

with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts being LIST, and
with the Back-Cover Texts being LIST.

Si vous avez des Sections Invariantes mais pas de Texte De Couverture, ou une autre combinaison des trois,
fusionner les deux possibilités pour que cela convienne à la situation.

Si votre document contient des exemples non triviaux de code source de logiciel, nous recommandons de publier
ces exemples en parallèle sous une licence de logiciel libre de votre choix, telle que la licence publique générale
GNU, pour permettre leur utilisation dans des logiciels libres.

.
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